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3 1. Présentation

Configuration du système

Système de 
microphone 
sans fil 
UWP-D21 
UWP-D22 
UWP-D26

Récepteur de 
microphone 
sans fil 
URX-P03D

Adaptateur de 
griffe à interfaces 
multiples 
SMAD-P3D

Adaptateur de 
griffe à interfaces 
multiples 
SMAD-P5

Adaptateur de 
monture de type A 
LA-EA3 
LA-EA4

Objectif à 
monture E

Microphone 
ECM-VG1 
ECM-MS2

Unité de 
télécommande 
RM-30BP

Mélangeur 
Multicaméras Live  
MCX-500

Télécommande de grip 
(fournie)

ILME-FX6V/ILME-FX6VK 
ILME-FX6T/ILME-FX6TK

Kit adaptateur XLR 
XLR-K2M 
XLR-K3M

Lampe vidéo 
HVL-LBPC

Cartes mémoire  
CFexpress Type A

Cartes mémoire  
SDXC

Chargeur de 
batterie 
BC-CU1 
(fourni)

Pack batterie 
BP-U35, BP-U60, 
BP‑U60T, BP-U70, 
BP‑U90, BP-U100

Adaptateur CA 
(fourni)

Lecteur de cartes CFexpress Type A/  
lecteur de cartes SD

Chargeur de batterie 
BC-U1A, BC-U2A

Microphone à canon 
ECM-B1M

1. Présentation
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Localisation et fonctions des pièces

Côté gauche et côté avant

11
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1.	 Crochet pour mètre à ruban
Le crochet pour mètre à ruban se trouve au 
même niveau que le capteur d’image. Pour 
mesurer la distance entre le caméscope et le 
sujet de manière précise, utilisez ce crochet 
comme point de référence. Vous pouvez fixer 
l’extrémité d’un mètre à ruban au crochet pour 
mesurer la distance à partir du sujet.

2.	 Fiche du viseur (page 19)

3.	 Fente d’aération

[Remarque]
Ne couvrez pas la fente d’aération.

4.	 Commutateur de sélection TC IN/OUT 
(page 35, 122)

5.	 Connecteur de la télécommande de grip 
(page 20)

6.	  (Marque N) (page 61)
ˎˎ Mettez en contact un smartphone équipé de 
la fonction NFC avec l’unité pour établir une 
connexion sans fil.  
Certains smartphones compatibles avec les 
systèmes de paiement sans fil ne prennent 
pas forcément en charge la technologie 
NFC. Pour plus de détails, reportez-vous au 
manuel d’utilisation du smartphone.
ˎˎ La technologie NFC (Near Field 
Communication) est un protocole de 
communication international pour la 
communication sans fil entre des objets 
proches.

7.	 Fixation de télécommande de grip 
(page 20)

8.	 Bouton de déblocage de la 
télécommande de grip (page 20)

9.	 Antenne Wi-Fi

10.	Témoin d’enregistrement/de signalisation 
(avant) (page 34)

Clignote lorsque la capacité restante de la 
batterie ou du support est faible.

11.	Commutateur FOCUS (page 37)

12.	Capteur d’image

13.	Touche PUSH AUTO FOCUS (page 41)

14.	Contacts de signal de l’objectif

[Remarque]
Ne touchez pas directement avec vos mains.

15.	Touche WB SET (réglage de l’équilibre des 
blancs) (page 46)

16.	Bouton de déblocage de l’objectif 
(page 22)
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Côté droit (avant/haut/bas)
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1.	 Touche de balise de plan (page 53, 
71)

2.	 Commutateur HOLD (page 104)

3.	 Touche d’enregistrement START/STOP 
(page 34)

Appuyez sur la touche d’enregistrement 
START/STOP pour démarrer l’enregistrement. 

La LED s’allume en rouge lors de 
l’enregistrement.

4.	 Molette ND VARIABLE (page 44)

5.	 Commutateur ND PRESET/VARIABLE 
(page 44)

6.	 Touches haut/bas ND FILTER POSITION 
(page 44)

7.	 Indicateur ND CLEAR (page 44)

8.	 Touche ND VARIABLE AUTO (page 44)
Appuyez sur la touche ND VARIABLE AUTO 
pour démarrer l’ajustement automatique de 
la densité du filtre ND. La LED s’allume en vert 
lors de l’activation.

9.	 Molette multifonction (page 49)
Lorsque vous visualisez l’image sur le viseur, 
appuyez pour afficher et actionner le menu 
direct .
Lorsqu’un menu est affiché sur le viseur, 
tournez la molette pour déplacer le curseur 
vers le haut/bas et sélectionner des éléments 
ou des réglages de menu. Appuyez pour 
appliquer l’élément sélectionné.
Lorsque le menu n’est pas affiché, vous 
pouvez aussi utiliser la molette comme 
molette personnalisable.

10.	Touche de fonction IRIS (page 43)

11.	Touche CANCEL/BACK (page 70)

12.	Touche THUMBNAIL (page 69)

13.	Touche MENU (page 14, 74)
Appuyez sur la touche MENU pour afficher 
l’écran d’état. Maintenez la touche MENU 
enfoncée pour afficher l’écran de menu 
complet. Appuyez sur la touche durant 
l’affichage de l’écran d’état ou de l’écran 
de menu complet pour revenir à l’affichage 
d’écran précédent.

14.	Touche de fonction ISO/GAIN (page 43)

15.	Commutateur ISO/GAIN (sélection du 
gain) (page 43)

16.	Touche de fonction WHT BAL (équilibre 
des blancs) (page 46)

17.	Commutateur WHT BAL (sélection de 
mémoire d’équilibre des blancs) 
(page 46)

18.	Touche de fonction SHUTTER (page 44)

19.	Prise casque (page 34)

20.	Commutateur POWER (page 34)

Côté droit (arrière) (page 6)
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Côté arrière droit et logement pour carte
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1.	 Antenne Wi-Fi

2.	 Molette AUDIO LEVEL (CH1) (page 47)

3.	 Commutateur CH1 (AUTO/MAN) 
(page 47)

4.	 Touches ASSIGN (personnalisables) 1 à 3 
(page 49)

5.	 Microphone interne (page 47)
Microphone de narration pour 
l’enregistrement du son d’ambiance. 

[Conseil]
Ce microphone est désactivé lorsque la poignée est 
fixée et le microphone interne de la poignée devient 
actif (page 7).

6.	 Touche DISPLAY (page 11)

7.	 Haut-parleur intégré (page 34)

8.	 Indicateur POWER (page 34)

9.	 Touche SLOT SELECT (sélection du 
logement de carte mémoire (A)/(B)) 
(page 34)

10.	Commutateur CH2 (AUTO/MAN) 
(page 47)

11.	Molette AUDIO LEVEL (CH2) (page 47)

12.	Témoin d’accès A (page 26)

13.	Logement de carte CFexpress Type A/SD 
(A) (page 26)

14.	Logement de carte CFexpress Type A/SD 
(B) (page 26)

15.	Témoin d’accès B (page 26)
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Poignée, arrière et bloc de connecteur
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1.	 Commutateur HOLD de la poignée 
(page 104)

Il vous permet de désactiver le 
fonctionnement des commandes de la 
poignée.

[Conseil]
Peut également être réglé pour la touche 
d’enregistrement START/STOP de la poignée 
uniquement.

2.	 Touche d’enregistrement START/STOP de 
la poignée

3.	 Microphone interne de la poignée

4.	 Griffe à interfaces multiples

Pour plus de détails sur les accessoires pris 
en charge par la griffe à interfaces multiples, 
prenez contact avec votre représentant 
commercial.

5.	 Molette personnalisable de la poignée 
(page 49)

6.	 Levier de zoom sur la poignée 
(page 105)

7.	 Touches ASSIGN (personnalisables) 7 à 8 
(page 49)

8.	 Sélecteur multiple (touches 8 voies D-pad 
et de mise en application)

9.	 Griffe pour accessoire (page 7)

10.	Orifices de vis de fixation d’accessoire  
(1/4 po)

Compatible avec les vis 1/4-20 UNC (longueur 
de 6 mm ou moins).

[Remarque]
L’utilisation de vis de plus de 6 mm de long peut 
endommager les pièces extérieures.

11.	Témoin d’enregistrement/de signalisation 
(arrière) (page 34)

12.	Touche BATT RELEASE (page 17)

13.	Entrée d’air

[Remarque]
Ne couvrez pas l’entrée d’air.

14.	Fixation du pack batterie (page 17)

15.	Connecteur USB-C (page 64)

16.	Connecteur INPUT2 (entrée audio 2) 
(page 47)

17.	Connecteur INPUT1 (entrée audio 1) 
(page 47)

18.	Commutateur INPUT2 (LINE/MIC/
MIC+48V) (page 47)

19.	Commutateur INPUT1 (LINE/MIC/
MIC+48V) (page 47)

20.	Orifices de vis pour dispositifs externes
Compatibles avec les vis M3 (longueur de 
4 mm ou moins).

[Remarque]
L’utilisation de vis de plus de 4 mm de long peut 
endommager la surface extérieure.

21.	Connecteur HDMI OUT (page 121)

22.	Connecteur SDI OUT (page 121)

23.	Connecteur TC IN/TC OUT (entrée/sortie 
de code temporel) (page 122)

24.	Connecteur REMOTE
Permet la connexion à l’accessoire à prise 
LANC à usage général.

25.	Connecteur USB/Multi (page 123)

26.	Connecteur DC-IN (prise CC standard) 
(page 18)

Fixation de la griffe pour accessoire

1	 Soulevez l’avant de la plaque à ressort de 
la griffe et poussez la plaque à ressort 
dans la direction opposée à la flèche 
gravée sur la plaque.

Plaque à ressort de la griffe

Griffe pour accessoire

1

2	 Positionnez la griffe pour accessoire sur le 
dispositif de montage de griffe pour 
accessoire, en alignant les saillies de la 
griffe sur les points correspondants du 
dispositif de montage, puis serrez les 
quatre vis.
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3	 Insérez la plaque à ressort de la griffe 
dans la direction de la flèche, de manière 
à ce que la partie en forme de U 
s’enclenche au fond de la griffe pour 
accessoire.

Plaque à 
ressort de la 
griffe

Griffe pour accessoire

2 32 3

Retrait de la griffe pour accessoire

Retirez la plaque à ressort de la griffe comme 
indiqué à l’étape 1 de « Fixation de la griffe 
pour accessoire », desserrez les quatre vis et 
retirez la griffe pour accessoire.

Fixation de la poignée

Positionnez la poignée de manière à ce que 
le connecteur de poignée et les orifices de 
vis soient alignés, enfoncez et tournez les vis 
de fixation de la poignée dans le sens des 
aiguilles d’une montre pour fixer la poignée à 
l’appareil.
Vous pouvez également serrer les deux vis de 
fixation de la poignée en les tournant dans le 
sens des aiguilles d’une montre à l’aide d’une 
clé hexagonale (4 mm).

[Remarque]
Assurez-vous que les deux vis de fixation de la poignée 
sont fermement serrées avant d’utiliser la poignée. La 
poignée risque de se détacher du caméscope si les vis 
ne sont pas bien serrées.

Retrait de la poignée

Procédez au retrait en faisant l’inverse de la 
procédure de fixation.

Fixation du capuchon protecteur du 
connecteur de la poignée (fourni)

Lorsque vous utilisez le caméscope sans la 
poignée, protégez le connecteur en utilisant le 
capuchon protecteur fourni.

[Conseil]
Lorsque vous fixez la poignée, rangez le capuchon 
protecteur fourni en bas de la poignée.

Protection des bornes du connecteur

Fixez le cache sur les connecteurs non utilisés 
pour protéger les bornes du connecteur.

Côté supérieur

1

2 2

2

2

1.	 Connecteur de poignée

2.	 Orifices de vis de fixation d’accessoire  
(1/4 po)

Compatible avec les vis 1/4-20 UNC (longueur 
de 6 mm ou moins).

[Remarque]
L’utilisation de vis de plus de 6 mm de long peut 
endommager les pièces extérieures.
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Côté inférieur

1 2
1.	 Orifices de vis pour trépied (1/4 de pouce, 

3/8 de pouce)
Compatibles avec les vis 1/4-20 UNC et les vis 
3/8-16 UNC. Fixez à un trépied (option, vis de 
5,5 mm ou moins).

2.	 Sortie d’air

[Remarque]
Ne couvrez pas la sortie d’air.

Viseur

Pour plus de détails sur la fixation du viseur 
(fourni), consultez page 19.

1
2
3

4 5

1.	 Touche PEAKING

2.	 Touche ZEBRA

3.	 Touche ASSIGN (personnalisable) 9 
(page 49)

4.	 Panneau tactile
Les opérations tactiles peuvent être 
désactivées à l’aide d’une touche 
personnalisable ou à l’aide du menu 
(page 10).

5.	 Commutateur MIRROR

Télécommande de grip

Pour plus de détails sur la fixation de la 
télécommande de grip (fournie),  
consultez page 20.

4

3
2

1

7
8

6
5

1.	 Levier de zoom

2.	 Touche ASSIGN (personnalisable) 4 
(page 49)

3.	 Molette personnalisable du grip 
(page 49)

4.	 Touche ASSIGN (personnalisable) 6 
(page 49)

5.	 Levier de rotation du grip (page 21)

6.	 Touche d’enregistrement START/STOP

7.	 Sélecteur multiple (touches 8 voies D-pad 
et de mise en application)

8.	 Touche ASSIGN (personnalisable) 5 
(page 49)
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Utilisation du panneau tactile

Précautions d’utilisation du 
panneau tactile

Le viseur de l’appareil est un écran tactile, que 
vous actionnez directement en le touchant 
avec le doigt.
ˎˎ Le panneau tactile est conçu pour être 
touché légèrement avec votre doigt. 
N’appuyez pas sur le panneau avec force et 
ne le touchez pas avec des objets pointus 
ou tranchants (clou, stylo à bille, épingle, 
etc.).
ˎˎ Le panneau tactile risque de ne pas 
répondre s’il est touché dans les 
circonstances suivantes. Notez également 
que cela risque de provoquer un 
dysfonctionnement.
ˎˎ 	Fonctionnement en utilisant le bout des 
ongles
ˎˎ 	Fonctionnement alors que d’autres 
objets touchent la surface
ˎˎ 	Fonctionnement avec une feuille ou un 
autocollant de protection
ˎˎ 	Fonctionnement avec des gouttelettes 
d’eau ou de la condensation sur l’écran
ˎˎ 	Fonctionnement en utilisant des doigts 
mouillés ou moites

Gestes propres au panneau tactile

Toucher
Touchez légèrement un élément, tel qu’une 
icône ou un élément de menu, avec votre 
doigt, puis retirez immédiatement votre doigt.

Faire glisser
Touchez l’écran et faites glisser votre doigt 
jusqu’à la position souhaitée de l’écran, puis 
retirez votre doigt.

Saisir en glissant/Balayer
Touchez l’écran et saisissez en glissant/
balayez rapidement votre doigt vers le haut, le 
bas, la gauche ou la droite.

[Conseil]
Si le contenu de l’affichage continue au-delà des bords 
de l’écran, vous pouvez le faire glisser ou le faire défiler.

Configuration du panneau tactile

Les opérations du panneau tactile peuvent 
être activées/désactivées à l’aide de Touch 
Operation (page 104) dans le menu 
Technical.
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Affichage de l’écran
Pendant la prise de vue (enregistrement/veille) et la lecture, l’état du caméscope et ses réglages 
sont superposés sur l’image affichée dans le viseur.
Vous pouvez afficher/masquer ces informations en utilisant la touche DISPLAY. Même masquées, 
elles s’affichent lorsque vous effectuez des opérations de menu direct (page 49).
Vous pouvez également choisir d’afficher/masquer chaque élément de manière indépendante 
(page 98).

Informations affichées sur l’écran pendant la prise de vue

3 42

6
8

9 1075

11
13 12

14
15

16
17
18

19 20 21 22 23 24 25 26 27 28 29

30

31
32
33
34
35
36
37

138

1.	 Indicateur d’état du réseau (page 13)
Affiche l’état de connexion au réseau sous 
forme d’icône.

2.	 Indicateur de téléchargement/indicateur 
de fichiers restants (page 66)

3.	 Indicateur de zone de mise au point 
(page 38)

Affiche la zone de mise au point pour la mise 
au point automatique.

4.	 Mode d’enregistrement, fente A/B, 
indicateur d’intervalle d’enregistrement 
Interval Rec (page 50)

Affichage Signification

Rec Enregistrement

Stby Veille d’enregistrement

5.	 Indicateur de profondeur de champ

6.	 Indicateur du mode Imager Scan 
(page 25)

Un repère  s’affiche en cas d’incohérence 
entre la taille du cercle d’image de l’objectif 
et le réglage en vigueur pour le mode Imager 
Scan de taille d’image.
Lorsque Imager Scan Mode est réglé sur FF, 
un repère « C » s’affiche dans les modes où 
l’angle de vue est plus étroit (recadré).
Le recadrage survient dans les modes 
suivants.
ˎˎ Lorsque le format d’enregistrement est 
3840×2160 et que la fréquence d’images de 
S&Q Motion est de 100 fps ou 120 fps
ˎˎ Lorsque Codec est réglé sur RAW ou RAW & 
XAVC-I et que le format de sortie RAW est 
de 3840×2160

7.	 Indicateur d’état de fonctionnement de la 
sortie RAW (page 60)

Affiche l’état de sortie du signal RAW.

8.	 Indicateur d’état de la série UWP-D 
(page 13)

Affiche l’intensité du signal de niveau RF sous 
forme d’icône lorsqu’un appareil de série 
UWP-D est connecté à la griffe MI configurée 
pour le transfert audio numérique.

9.	 Indicateur de fréquence d’images de 
prise de vue en ralenti et accéléré 
(page 50)

10.	Indicateur de capacité restante de la 
batterie/de tension DC IN (page 17)

11.	 Indicateur de mode de mise au point 
(page 41)

Signification Affichage

Mode Focus Hold Focus Hold

Mode MF MF

Mode AF AF

Mode AF de suivi en temps réel

Détection des visages/yeux AF (AF/ /Only/ /
)

Icône de détection des 
visages/yeux

Icône de détection des 
visages/yeux AF

Only

Icône de visage de suivi 
enregistré

Icône de pause AF1)

1)	 S’affiche pendant l’opération AF lorsque l’opération 
AF ne peut pas continuer et s’arrête temporairement. 
L’icône disparaît lorsque la cause de l’arrêt de 
l’opération AF est résolue et que l’opération AF 
reprend.

12.	Indicateur de position de mise au point
Affiche la position de mise au point.

13.	Indicateur de position de zoom 
(page 36)

Affiche la position du zoom dans une plage 
de 0 (grand angle) à 99 (téléobjectif) (si un 
objectif prenant en charge l’affichage du 
réglage de zoom est fixé).

Vous pouvez régler l’affichage sur un 
indicateur à barre ou sur un indicateur de 
distance de mise au point (page 106).
Les éléments suivants sont ajoutés à 
l’affichage lorsque Clear Image Zoom est 
activé.

Affichage Signification

Clear Image Zoom est activé

Valeur 
d’agrandissement

Lors de l’utilisation de Clear 
Image Zoom

14.	Indicateur de mode de stabilisation 
d’image

15.	Indicateur du statut Rec Control de sortie 
SDI/sortie HDMI (page 121)

Affiche le statut de sortie du signal de contrôle 
REC.

16.	Indicateur de mise au point (page 37)

17.	 Indicateur de capacité restante du 
support

Affichage Signification

Montage en cours/état de 
montage (support A)

Montage en cours/état de 
montage (support B)

Montage en cours/état de 
montage (support B)1)

(clignotement)

État de montage (non 
enregistrable) (support B)1) 2)

1)	 Enregistrement des données proxy uniquement
2)	Erreur de support, support plein ou toute autre erreur 

survenue au début ou pendant l’enregistrement.

L’icône  s’affiche si la carte mémoire est 
protégée en écriture.
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18.	Indicateur du mode de balance des 
blancs

Affichage Signification

Mode automatique

 Hold Mode automatique en pause

W:P Mode prédéfini

W:A Mode de mémoire A

W:B Mode de mémoire B

19.	Indicateur de verrouillage externe du 
code temporel/affichage des données 
temporelles (page 34)

Affiche « EXT-LK » en cas de verrouillage sur le 
code temporel d’un dispositif externe.

20.	Indicateur de filtre ND (page 44)

Affichage Signification

Mode automatique

Mode de contrôle du bokeh 
(page 53)

21.	Indicateur de fichier de scène 
(page 56)

22.	Indicateur de diaphragme
Affiche la position du diaphragme (valeur F) (si 
un objectif prenant en charge l’affichage du 
réglage du diaphragme est fixé).

23.	Indicateur d’avertissement du niveau de 
vidéo

24.	Indicateur de gain (page 43)
En mode de prise de vue Custom (page 24), 
il affiche la valeur de gain ou la valeur ISO. En 
mode de prise de vue Flexible ISO, il affiche la 
valeur ISO.
En mode de prise de vue Cine EI/Cine EI Quick 
(page 24), il affiche la valeur EI.

Affichage Signification

Mode automatique

H Mode de préréglage H

Affichage Signification

M Mode de préréglage M

L Mode de préréglage L

Mode d’ajustement 
provisoire

Mode de contrôle du 
bokeh (page 53)

25.	Affichage des noms de plans (page 96)
Affiche le nom du plan en cours 
d’enregistrement ou à enregistrer ensuite.

26.	Indicateur d’obturateur (page 44)

27.	Indicateur du mode AE/niveau AE 
(page 43)

28.	Indicateur de niveau à bulle
Affiche le niveau horizontal en incréments de 
±1° à ±15°.

29.	Vumètre audio
Affiche le niveau audio de CH1 à CH4.

30.	Moniteur de signal vidéo (page 52)
Affiche une forme d’onde, un vecteurscope et 
un histogramme.
La ligne orange indique la valeur définie du 
niveau zébré.
En mode de prise de vue Log (page 24), 
le type de LUT cible du moniteur s’affiche en 
haut de l’écran.

31.	Indicateur de sensibilité de base/
indicateur ISO de base (page 43)

En mode de prise de vue Custom (page 24), 
il affiche la sensibilité de base réglée à l’aide 
de Base ISO/Sensitivity sur l’écran d’état Main 
ou de ISO/Gain/EI >Base Sensitivity dans le 
menu Shooting du menu complet.
En mode de prise de vue Flexible ISO/Cine 
EI (page 24), il affiche la sensibilité ISO de 
base réglée à l’aide de Base ISO/Sensitivity sur 
l’écran d’état Main ou de ISO/Gain/EI >Base 
ISO dans le menu Shooting du menu complet.
En mode de prise de vue Cine EI Quick 
(page 24), il affiche la sensibilité ISO de 

base réglée automatiquement en lien avec  
et Exposure Index.

32.	Indicateur d’aide pour l’affichage 
gamma/indicateur Base Look

En mode de prise de vue Custom (page 24), 
il affiche l’état d’aide pour l’affichage 
gamma. Vous pouvez activer/désactiver la 
fonction d’aide pour l’affichage gamma en 
affectant Gamma Display Assist à une touche 
personnalisable (page 49).
En modes de prise de vue Log (page 24), il 
affiche le réglage Base Look (page 92).

33.	Indicateur vidéo pour l’enregistrement 
(page 56)

Affiche le signal vidéo pour l’enregistrement 
sur les cartes mémoire. En mode de prise de 
vue Custom (page 24), il affiche le réglage 
Base Look.
En modes de prise de vue Log (page 24), il 
affiche le réglage Color Gamut (page 86).

34.	Indicateur d’état proxy

Affichage Signification

Enregistrement proxy activé

Enregistrement proxy

 
(clignotement)

Enregistrement proxy non 
prêt

Enregistrement proxy par 
fragments activé

Enregistrement proxy par 
fragments

 
(clignotement)

Enregistrement proxy par 
fragments non prêt

35.	Indicateur de format d’enregistrement 
(codec) (page 85)

Affiche le nom du format pour 
l’enregistrement sur des cartes mémoire.

36.	Indicateur de format d’enregistrement 
(fréquence d’images et méthode de 
balayage)

37.	Indicateur du format d’enregistrement 
(taille d’image) (page 85)

Affiche la taille d’image pour l’enregistrement 
sur des cartes mémoire.

38.	Touche d’arrêt AF de suivi en temps réel 
(page 42)
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Informations affichées sur l’écran pendant la lecture

Les informations suivantes sont superposées sur l’image de lecture.

1

9 10 11 12 13 14

2 3 4 5 6 7 8

1.	 Indicateur d’état du réseau

2.	 Indicateur de téléchargement/indicateur 
de fichiers restants

3.	 Numéro de plan/nombre total de plans

4.	 Indicateur d’état de la lecture

5.	 Indicateur de format de lecture 
(fréquence d’images et méthode de 
balayage)

6.	 Indicateur de format de lecture (taille 
d’image)

7.	 Indicateur de capacité restante de la 
batterie/de tension DC IN

8.	 Indicateur de format de lecture (codec)

9.	 Indicateur de support
L’icône  s’affiche si la carte mémoire est 
protégée en écriture.

10.	Affichage de données temporelles

11.	Affichage des noms de plans

12.	Indicateur d’aide pour l’affichage gamma
En mode de prise de vue Custom (page 24), 
il affiche l’état d’aide pour l’affichage gamma.
En modes de prise de vue Log, il affiche le 
réglage Monitor LUT appliqué.

13.	Vumètre audio
Affiche le niveau audio de lecture.

14.	Indicateur vidéo pour l’enregistrement

Affichage d’icône

Affichage d’icônes de connexion au réseau

Mode réseau État de connexion Icône

Mode de point d’accès Fonctionnement en tant que point 
d’accès

Erreur de fonctionnement du point 
d’accès

Mode de station Connexion Wi-Fi
L’icône change selon l’intensité du 
signal (4 incréments)

   

Wi-Fi déconnecté (y compris pendant 
l’établissement d’une connexion)

Erreur de connexion Wi-Fi

Raccordement modem USB Raccordement modem USB connecté

Raccordement modem USB déconnecté

Erreur du raccordement modem USB

Affichage de l’icône de la série UWP-D

État de l’émetteur État de réception Icône

Hors tension Pas de réception

État de transmission normal Réception en cours
 –   

(niveau de réception 
(4 incréments))

État silencieux Réception en cours 
(silencieux)

État d’avertissement de la capacité 
restante de la batterie

Réception en cours
 (Icône clignotante)

État d’avertissement de la capacité 
restante de la batterie et de silencieux

Réception en cours
 (Icône clignotante)
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Ecran d’état

Vous pouvez vérifier les réglages et l’état du 
caméscope sur l’écran d’état. Les réglages des 
éléments marqués d’un astérisque (*) peuvent 
être modifiés.
L’écran d’état prend en charge les opérations 
tactiles.

Pour afficher l’écran d’état
ˎˎ Appuyez sur la touche MENU.

[Conseil]
Vous pouvez afficher/masquer chaque écran d’état à 
l’aide de Menu Page On/Off (page 105) dans le menu 
Technical.

Pour commuter l’écran d’état
ˎˎ Tournez la molette multifonction.
ˎˎ Poussez le sélecteur multiple vers le haut/
bas
ˎˎ Balayez l’écran d’état vers le haut/le bas.

Pour masquer l’écran d’état
ˎˎ Appuyez sur la touche MENU.

Pour modifier un réglage
Lorsque l’écran d’état est affiché, appuyez 
sur la molette multifonction ou le sélecteur 
multiple pour permettre la sélection d’un 
élément de configuration dans une page. 
Sélectionnez un numéro de page et appuyez 
pour changer de page.
Vous pouvez également sélectionner des 
éléments directement à l’aide d’une opération 
tactile.

[Remarque]
Vous pouvez désactiver les modifications à partir de 
l’écran d’état en réglant Menu Settings >User Menu Only 
(page 105) dans le menu Technical du menu complet 
sur On.

Écran d’état Main

Affiche les principales fonctions de la caméra 
et l’espace disponible sur le support.

Elément affiché Description

S&Q Frame Rate* Réglages de prise de vue et 
de fréquence d’image en 
ralenti et accéléré

Frequency/Scan* Réglages de la fréquence du 
système et de la méthode 
de balayage

Imager Scan* Mode de numérisation du 
capteur d’image

Media Remain 
(A)

Espace libre restant sur le 
support dans la fente A

ND Filter Réglage du filtre ND

ISO/Gain/EI Réglage d’indice ISO/Gain/
Exposition

Base ISO/
Sensitivity*

Réglage ISO/Sensibilité de 
base

Codec* Réglage de codec pour 
l’enregistrement

Media Remain (B) Espace libre restant sur le 
support dans la fente B

Scene File* Réglage du fichier de scène 
utilisé et de son identifiant 
de fichier

Base Look/LUT* Réglage Base Look/LUT

Shutter Réglage de la vitesse 
d’obturation ou de l’angle 
d’obturation

Iris Réglage du diaphragme

Video Format* Taille d’image pour 
l’enregistrement sur des 
cartes mémoire

RAW Output 
Format*

Taille d’image de la sortie 
RAW

White Balance Réglage de la balance des 
blancs

Écran d’état Camera

Affiche l’état de nombreux préréglages de la 
caméra.

Elément affiché Description

White Switch<B> Réglage de la mémoire B de 
balance des blancs

White Switch<A> Réglage de la mémoire A de 
balance des blancs

White Switch<P> Réglage de blanc prédéfini

ND<Preset> Réglages du filtre ND Preset1 
à 3

ISO / Gain1)<L>* Réglage ISO/Gain1)<L>

ISO / Gain1)<M>* Réglage ISO/Gain1)<M>

ISO / Gain1)<H>* Réglage ISO/Gain1)<H>

Base ISO/
Sensitivity*

Réglage ISO/Sensibilité de 
base

Zebra1* Réglage Zebra1 On/Off et 
niveau

Zebra2* Réglage Zebra2 On/Off et 
niveau

VF Gamma/
Gamma

Catégorie et courbe gamma

Scene File* Réglage du fichier de scène 
utilisé et de son identifiant 
de fichier

1)	 Exposure Index en mode de prise de vue Cine EI/Cine 
EI Quick.

Écran d’état Audio

Affiche le réglage d’entrée, le vumètre audio 
et le réglage du moniteur de volume pour 
chaque canal.

Elément affiché Description

CH1 Level 
Control

État d’activation/
désactivation du réglage 
automatique

Level Meter Vumètre audio

Source* Source d’entrée

Reference* Niveau de référence d’entrée

Wind 
Filter*

Réglage du filtre de 
réduction du bruit du vent 
du microphone

CH2 Level 
Control

État d’activation/
désactivation du réglage 
automatique

Level Meter Vumètre audio

Source* Source d’entrée

Reference* Niveau de référence d’entrée

Wind 
Filter*

Réglage du filtre de 
réduction du bruit du vent 
du microphone

CH3 Level 
Control*

État d’activation/
désactivation du réglage 
automatique

Level 
Meter*

Vumètre audio

Source* Source d’entrée

Reference* Niveau de référence d’entrée

Wind 
Filter*

Réglage du filtre de 
réduction du bruit du vent 
du microphone

CH4 Level 
Control*

État d’activation/
désactivation du réglage 
automatique

Level 
Meter*

Vumètre audio

Source* Source d’entrée

Reference* Niveau de référence d’entrée

Wind 
Filter*

Réglage du filtre de 
réduction du bruit du vent 
du microphone
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Elément affiché Description

Audio Input 
Level*

Réglage du niveau d’entrée 
audio (volume principal)

HDMI Output CH* Réglage de canal audio de 
sortie HDMI

Volume* Réglage du volume du 
casque/haut-parleurs 
intégrés

Monitor CH* Réglage de canal de 
contrôle

Écran d’état Project

Affiche les réglages de base liés au projet de 
tournage.

Elément affiché Description

Frequency/Scan* Réglages de la fréquence du 
système et de la méthode 
de balayage

Codec* Réglage de codec pour 
l’enregistrement

Rec Function* Réglage d’activation/
désactivation et réglages 
principaux de la fonction 
d’enregistrement spécial

Simul Rec* Réglage et état d’activation/
de désactivation de la 
fonction d’enregistrement 
simultané sur 2 fentes

Title Prefix1) / 
Reel2)

Partie titre du nom de plan/
Valeurs définies pour Reel 
Number et Camera ID

Imager Scan* Mode de numérisation du 
capteur d’image

Video Format* Taille d’image pour 
l’enregistrement sur des 
cartes mémoire

Picture Cache 
Rec*

Activation/désactivation de 
la fonction d’enregistrement 
en cache d’image et réglage 
de la taille du cache

Elément affiché Description

Number1) / Shot2) Suffixe numérique du nom 
de plan/Valeurs pour Shot 
Number et Camera Position

Shooting Mode* Réglages du mode de prise 
de vue

RAW Output 
Format*

Taille d’image de la sortie 
RAW

Proxy Rec* Réglage d’activation/
désactivation de la fonction 
d’enregistrement proxy

1)	 Lorsque Auto Naming est réglé sur Title
2)	Lorsque Auto Naming est réglé sur Cam ID + Reel#

Écran d’état Monitoring

Affiche les réglages de sortie SDI et HDMI.

Elément affiché Description

SDI Signal* Taille d’image de sortie

Info. 
Disp.*

Réglage d’activation/
désactivation de l’affichage 
de sortie

Color 
Gamut*

Réglage de gamme de 
couleurs/Statut Monitor 
LUT

HDMI Signal* Taille d’image de sortie

Info. 
Disp.*

Réglage d’activation/
désactivation de l’affichage 
de sortie

Color 
Gamut*

Réglage de gamme de 
couleurs/Statut Monitor 
LUT

Stream Signal Taille d’image de sortie

Info. 
Disp.

Affichage de sortie (Off 
(fixe))

Color 
Gamut*

Réglage de gamme de 
couleurs/Statut Monitor 
LUT

VF Color 
Gamut*

Réglage d’aide pour 
l’affichage gamma/Réglage 
de gamme de couleurs/
Statut Monitor LUT

Base Look/LUT* Réglage Base Look/LUT

Elément affiché Description

Gamma Display 
Assist*

Réglage d’activation/de 
désactivation de Gamma 
Display Assist

Écran d’état Assignable Button

Affiche les fonctions attribuées à chacune des 
touches attribuables.

Elément affiché Description

1 Fonction attribuée à la 
touche ASSIGN 1

2 Fonction attribuée à la 
touche ASSIGN 2

3 Fonction attribuée à la 
touche ASSIGN 3

4 Fonction attribuée à la 
touche ASSIGN 4

5 Fonction attribuée à la 
touche ASSIGN 5

6 Fonction attribuée à la 
touche ASSIGN 6

7 Fonction attribuée à la 
touche ASSIGN 7

8 Fonction attribuée à la 
touche ASSIGN 8

9 Fonction attribuée à la 
touche ASSIGN 9

Focus Hold 
Button

Fonction attribuée à la 
touche Focus Hold de 
l’objectif

Multi Function 
Dial

Fonction attribuée à la 
molette multifonction

Grip Dial Fonction attribuée à la 
molette personnalisable du 
grip

Handle Dial Fonction attribuée à la 
molette personnalisable de 
la poignée

Écran d’état Battery

Affiche des informations à propos de la 
batterie et de la source DC IN.

Elément affiché Description

Detected Battery Type de batterie

Remaining Capacité restante (%)

Charge Count Nombre de charges

Capacity Capacité restante (Ah)

Voltage Tension de batterie (V)

Manufacture 
Date

Date de fabrication de la 
batterie

Video Light 
Remaining

Affiche la capacité restante 
de la batterie de la lampe 
vidéo.

Power Source Source d’alimentation

Supplied Voltage Tension de la source 
d’alimentation

Écran d’état Media

Affiche la capacité restante et la durée 
d’enregistrement restante du support 
d’enregistrement.

Elément affiché Description

Informations du 
support A

Affiche l’icône de support 
lorsque le support 
d’enregistrement est inséré 
dans le logement A.

Mesure de la 
capacité restante 
du support A

Affiche la capacité restante 
du support d’enregistrement 
inséré dans le logement A, 
exprimée en pourcentage 
sur un graphique en barres.

Durée 
d’enregistrement 
restante du 
support A

Affiche une estimation de la 
durée d’enregistrement 
restante sur le support 
d’enregistrement inséré 
dans le logement A, en 
minutes et sous les 
conditions d’enregistrement 
actuelles.
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Elément affiché Description

Informations du 
support B

Affiche l’icône de support 
lorsque le support 
d’enregistrement est inséré 
dans le logement B.

Mesure de la 
capacité restante 
du support B

Affiche la capacité restante 
du support d’enregistrement 
inséré dans le logement B, 
exprimée en pourcentage 
sur un graphique en barres.

Durée 
d’enregistrement 
restante du 
support B

Affiche une estimation de la 
durée d’enregistrement 
restante sur le support 
d’enregistrement inséré 
dans le logement B, en 
minutes et sous les 
conditions d’enregistrement 
actuelles.

Écran d’état Network

Affiche l’état de connexion au réseau.

Elément affiché Description

Wireless LAN Réglages du réseau sans fil 
et état de connexion

Wired LAN Réglages du réseau LAN 
filaire et état de connexion

Modem Réglages du réseau sans fil 
et état de connexion du 
raccordement modem USB

Écran d’état File Transfer

Affiche les informations de transfert de 
fichiers.

Elément affiché Description

Auto Upload État d’activation/
désactivation de la fonction 
Auto Upload

Elément affiché Description

Auto Upload 
(Proxy)

État d’activation/
désactivation/par fragments 
de la fonction Auto Upload 
(Proxy)

Total Transfer 
Progress

Progression du transfert de 
toutes les tâches

Default Upload 
Server

Nom du serveur de 
destination Auto Upload 
(Proxy)

Job Status 
(Remain / Total)

Nombre de tâches restantes 
et nombre total de tâches

Current File 
Transfer Progress

Progression du transfert du 
fichier actuel

Current 
Transferring File 
Name

Nom du fichier en cours de 
transfert

Server Address Adresse du serveur de 
destination de transfert de 
fichiers

Destination 
Directory

Répertoire de destination du 
serveur de destination de 
transfert de fichiers

Utilisation des écrans de réglages tactiles

Disposition de l’écran

Élément

Marque indiquant le réglage 
actuel

Touche Set (appliquer)

Curseur de sélection de 
réglage 
(cadre orange)

Nom d’élément

Options de sélection

Fonctionnement

1	 Touchez un élément de configuration.

Toucher

Les options de sélection pour la valeur 
apparaissent.

2	 Faites glisser ou saisissez en glissant un 
réglage pour sélectionner la valeur.

Saisir en glissant

3	 Touchez la touche Set ou le curseur de 
sélection de la valeur.
La valeur est appliquée, et l’affichage 
revient à l’écran précédent.

[Conseils]
ˎˎ Appuyez sur la touche CANCEL/BACK pour retourner à 

la valeur précédente.
ˎˎ Vous pouvez également utiliser la molette 

multifonction ou le sélecteur multiple.
ˎˎ Les opérations tactiles peuvent également être 

désactivées (page 104).
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Alimentation
Vous pouvez utiliser un pack batterie ou une 
alimentation CA à partir d’un adaptateur CA.
Pour des raisons de sécurité, utilisez 
uniquement les packs de batteries et les 
adaptateurs CA Sony listés ci-dessous.

Pack batterie au lithium-ion
Série BP-U

Chargeurs de batterie
BC-CU1 (fourni)
BC-U1A
BC-U2A

Adaptateur CA (fourni)
[ATTENTION]

Ne rangez pas les packs batteries dans des 
endroits exposés aux rayons directs du soleil, 
aux flammes ou à des températures élevées.

[Remarques]
ˎˎ Lors du fonctionnement avec une source 

d’alimentation CA, utilisez l’adaptateur CA fourni.
ˎˎ Réglez toujours le commutateur POWER sur la 

position Off avant de retirer ou d’installer un pack 
batterie ou un adaptateur CA. Si le caméscope est 
retiré ou installé avec le commutateur POWER en 
position On, il est possible, dans certains cas, qu’il 
ne puisse pas démarrer. Si le caméscope ne peut 
pas être démarré, réglez le commutateur POWER 
sur la position Off et enlevez le pack batterie ou 
l’adaptateur CA de manière temporaire, puis attendez 
environ 30 secondes avant de les installer à nouveau. 
(Si l’adaptateur CA est retiré ou installé pendant que 
le caméscope fonctionne sur le pack batterie, ou vice 
versa, il peut être retiré ou installé sans problème 
avec le commutateur POWER en position On.)

Utilisation d’un pack batterie

Pour raccorder un pack batterie, branchez le 
pack batterie dans la prise (page 7), en 
l’enfonçant le plus loin possible, puis abaissez-
le pour le verrouiller en place.

Pour enlever un pack batterie, maintenez la 
touche BATT RELEASE (page 7) enfoncée, 
faites glisser le pack batterie vers le haut et 
retirez-le de sa fixation.

Touche BATT 
RELEASE

[Remarques]
ˎˎ Avant de raccorder un pack batterie, chargez la 

batterie en utilisant le chargeur de batterie BC‑CU1, 
BC-U1A ou BC-U2A dédié.
ˎˎ Charger un pack batterie alors qu’il est encore chaud 

(par exemple, immédiatement après son utilisation) 
risque de ne pas le recharger complètement.

Vérification de la capacité restante
En cas de prise de vue/lecture à l’aide 
d’un pack batterie, la capacité restante 
de la batterie est affichée dans le viseur 
(page 11).

Icône Signification

91% à 100%

71% à 90%

51% à 70%

31% à 50%

11% à 30%

0% à 10%

Le caméscope indique la capacité restante 
en calculant l’autonomie du pack batterie si 
l’appareil continue de fonctionner selon son 
niveau de consommation électrique actuel.

Si le niveau de charge du pack batterie 
devient faible
Si le niveau de charge restant de la batterie 
tombe au-dessous d’un certain niveau au 
cours du fonctionnement (état Low Battery), 
un message de batterie faible s’affiche, le 
témoin d’enregistrement/de signalisation 
commence à clignoter pour vous avertir.
Si la charge restante de la batterie tombe au-
dessous du niveau auquel le fonctionnement 
ne peut pas continuer (état Battery Empty), un 
message de batterie vide s’affiche.
Remplacez pack par un pack batterie chargé.

Modification des niveaux 
d’avertissement
Par défaut, le niveau Low Battery est réglé 
sur 10% de la charge de batterie complète 
et le niveau Battery Empty est réglé sur 3%. 
Vous pouvez changer les réglages de niveau 
d’avertissement en utilisant Camera Battery 
Alarm (page 106) dans le menu Technical du 
menu complet.

Pour charger le pack batterie avec le 
chargeur de batterie fourni (BC‑CU1)

1	 Connectez l’adaptateur CA (fourni) au 
chargeur de batterie et branchez le 
cordon d’alimentation (fourni) à une 
source d’alimentation CA.

2	 Poussez la batterie dedans et glissez-la 
dans le sens de la flèche.
Le témoin CHARGE s’allume en orange et 
le chargement commence.

Témoin CHARGE

Adaptateur CA

Cordon d’alimentation

Témoin CHARGE (orange)
Allumé : charge en cours
Clignote : �erreur de charge ou température 

hors de la plage de fonctionnement 
et la charge est mise en pause

ˎˎ Lorsque la charge est terminée, le témoin 
CHARGE du chargeur de batterie s’éteint.
ˎˎ Utilisez toujours des batteries Sony 
d’origine.
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Temps de charge
Temps approximatif (en minutes) nécessaire 
à la recharge d’un pack batterie totalement 
déchargé.

Pack batterie Temps de recharge 
complète

BP-U35 120 minutes

[Remarque]
Si l’adaptateur CA est débranché du chargeur de batterie 
et que la batterie est restée branchée au chargeur, elle 
commencera à se décharger.

Utilisation de l’alimentation CA

Le raccordement du caméscope à une source 
d’alimentation CA vous permet de l’utiliser 
sans avoir à vous inquiéter de recharger le 
pack batterie.

Connecteur DC IN

Adaptateur CA

Cordon 
d’alimentation

Connectez l’adaptateur CA au connecteur 
DC IN du caméscope et branchez le cordon 
d’alimentation (fourni) à une source 
d’alimentation CA.

Si la tension de sortie de l’adaptateur CA 
devient faible

Si la tension de sortie de l’adaptateur CA 
tombe au-dessous d’un certain niveau au 
cours du fonctionnement (état DC Low 
Voltage1), un message vous informant que la 
tension de sortie de l’adaptateur CA a chuté 
s’affiche, et le témoin d’enregistrement/de 
signalisation commence à clignoter.
Si la tension de sortie de l’adaptateur CA 
tombe au-dessous du niveau auquel le 
fonctionnement ne peut pas continuer (état 
DC Low Voltage2), un message vous informant 
que la tension de sortie de l’adaptateur CA est 
trop faible s’affiche.

Si cela se produit, l’adaptateur CA peut être 
défectueux. Vérifiez l’adaptateur CA, le cas 
échéant.

Modification des tensions 
d’avertissement

Le niveau DC Low Voltage1 est réglé sur 
16,5 V et le niveau DC Low Voltage2 est réglé 
sur 15,5 V par défaut. Vous pouvez changer 
les réglages de niveau d’avertissement en 
utilisant Camera DC IN Alarm (page 106) 
dans le menu Technical.

Adaptateur CA

ˎˎ Ne connectez pas et n’utilisez pas un 
adaptateur CA dans un espace confiné, 
comme par exemple entre un mur et des 
meubles.
ˎˎ Connectez l’adaptateur CA à la 
source d’alimentation CA la plus 
proche. Si un problème se produit 
lors du fonctionnement, débranchez 
immédiatement le cordon d’alimentation de 
la source d’alimentation CA.
ˎˎ Ne court-circuitez pas les pièces métalliques 
de la fiche de l’adaptateur CA. Cela 
entraînerait un dysfonctionnement.
ˎˎ La batterie ne peut pas être chargée 
lorsqu’elle est fixée au caméscope, même si 
l’adaptateur CA est branché.
ˎˎ Lorsque vous débranchez l’adaptateur CA 
de l’appareil, saisissez la fiche et tirez-la tout 
droit. Tirer sur le câble pourrait provoquer 
un dysfonctionnement.
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Fixation de dispositifs

Fixation d’un microphone (vendu 
séparément)

1	 Placez le microphone dans le support de 
microphone.

2	 Branchez le câble du microphone sur le 
connecteur INPUT1 ou INPUT2.

INPUT

1
LINE MIC

+48VMIC

2
LINE MIC

+48VMIC

1

2

Microphone

Support de 
microphone

INPUT1 INPUT2

3	 Placez le câble du microphone dans le 
support de câble comme indiqué sur le 
schéma.

Porte-câble

[Conseils]
ˎˎ Si vous ne pouvez pas fixer le microphone de manière 

sûre, utilisez l’espaceur fourni avec le microphone.
ˎˎ Selon le type d’objectif fixé, la pointe du microphone 

peut apparaître sur l’image du caméscope. Réglez la 
position du microphone.

Fixation du viseur

[Remarque]
Fixez/retirez le viseur lorsque le caméscope est hors 
tension.

Fixation du viseur à l’avant de la 
poignée

1	 Insérez l’adaptateur du collier de fixation 
du viseur dans la fixation du viseur de la 
poignée () et tournez la vis (fournie) 
dans le sens des aiguilles d’une montre 
pour le fixer en position ().
Vous pouvez fixer librement l’adaptateur 
du collier de fixation par incréments de 
45°, mais nous vous conseillons d’opter 
pour la position où le point de fixation se 
trouve directement au-dessus de la vis.

Vis
Adaptateur du collier 
de fixation du viseur

2	 Montez l’attache de viseur sur 
l’adaptateur du collier de fixation du 
viseur () et tournez la molette de 
verrouillage dans le sens des aiguilles 
d’une montre pour fixer en position ().

[Remarque]
Assurez-vous de bien serrer la molette de verrouillage 
lorsque vous utilisez un viseur. Le viseur risque de se 
détacher si la molette de verrouillage n’est pas bien 
serrée.

3	 Alignez la marque  sur le caméscope 
avec la marque  sur le connecteur du 
viseur et insérez le câble.
Assurez-vous que la marque  se trouve 
sur le côté externe avant d’insérer le 
connecteur.

4	 Placez le câble dans le porte-câble 
comme indiqué sur le schéma.

Porte-câble
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Fixation du viseur à l’arrière de la 
poignée

Il existe deux points de fixation à l’arrière de 
la poignée () et deux autres à l’arrière du 
caméscope () pour fixer un viseur. Fixez 
le viseur comme indiqué dans la section 
« Fixation du viseur à l’avant de la poignée ».

Ajustement de la position du viseur

Inclinez le viseur vers le haut/bas/l’avant/
l’arrière pour ajuster l’angle du viseur.
Vous pouvez utiliser le commutateur MIRROR 
pour retourner l’image lorsque vous la 
regardez depuis l’avant du caméscope, par 
exemple.

[Conseil]
Lorsque vous n’utilisez pas l’appareil ou lorsque vous 
le transportez, nous vous conseillons de placer le viseur 
dans la position indiquée sur le schéma suivant pour le 
protéger.

Retrait du viseur

Desserrez la molette de verrouillage du viseur 
et utilisez la procédure inverse de celle utilisée 
pour la fixation du viseur.

Fixation du cache du viseur

1	 Ouvrez les attaches métalliques sur le 
cache du viseur.

2	 Fixez l’attache métallique située sur le 
haut du cache du viseur au crochet situé 
sur le haut du viseur puis fixez l’attache 
métallique située en bas du cache du 
viseur au crochet situé en bas du viseur.

Crochets de fixation

3	 Appuyez sur la plaque de verrouillage 
située sous le cache du viseur dans la 
direction de la flèche pour verrouiller le 
cache du viseur.

Plaque de 
verrouillage

Ouverture du cache du viseur

Tirez la partie centrale inférieure du cache du 
viseur vers vous, puis tirez vers le haut pour 
ouvrir le cache.

[Remarque]
Lorsque vous déplacez le viseur, empoignez le corps du 
viseur, puis déplacez-le. Ne saisissez pas le cache du 
viseur.

Retrait du cache du viseur

Retirez le verrou du cache du viseur, puis 
retirez le cache du viseur du viseur.

Fixation de la télécommande de 
grip

[Remarque]
Fixez/retirez la télécommande de grip lorsque le 
caméscope est hors tension.

1	 Branchez le câble sur le connecteur de la 
télécommande de grip.
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2	 Alignez la fixation de la télécommande de 
grip du caméscope et le repère d’index 
pour monture sur le grip (), fixez le grip 
sur le caméscope et tournez-la lentement 
dans le sens contraire des aiguilles d’une 
montre ().
Un clic se fait entendre lors du 
verrouillage en place.

Repère d’index

[Remarque]
Si vous ne parvenez pas à fixer correctement, fixez 
à nouveau sans exercer une force excessive sur la 
télécommande de grip ou le caméscope.

3	 Insérez le câble qui a été connecté à 
l’étape 2 sous la fente de la 
télécommande de grip conformément aux 
indications du schéma.

[Remarque]
Si vous ne placez pas le câble sous la fente, la 
modification de l’angle de fixation du grip peut exercer 
une force excessive sur le câble ou le câble risque de se 
coincer dans le mécanisme rotatif.

Ajustement de l’angle de la 
télécommande de grip

Vous pouvez régler l’angle de la 
télécommande de grip selon la plage indiquée 
sur le schéma suivant, en fonction du style de 
prise de vue.

Position standard

Rotation vers l’objectif (90° max.)

Rotation vers l’arrière (83° max.)

1	 Amenez le levier de rotation du grip à la 
position indiquée sur le schéma et 
tournez le grip tout en appuyant sur le 
levier.

2	 Ôtez le doigt du levier de rotation du grip 
à proximité de la position souhaitée.

3	 Déplacez lentement le grip jusqu’à 
entendre un clic indiquant qu’il est fixé en 
position.
Quand le grip est fixé, remettez le levier 
de rotation du grip à sa position d’origine.

[Remarques]
ˎˎ Après avoir modifié la position, vérifiez toujours que 

le grip est fermement positionné.
ˎˎ Vous ne pouvez pas régler l’angle au-delà de la plage 

de réglage. N’exercez pas une force excessive lorsque 
vous tournez le grip.

Tenir le grip (méthode recommandée)

Il n’existe aucune règle concernant la manière 
de tenir le grip, mais l’exemple suivant vous 
montre une position permettant de l’utiliser 
facilement.

Lors de l’utilisation de la touche ASSIGN 5 ou 
du sélecteur multiple

A : actionnez la molette personnalisable du 
grip à l’aide de votre index.
B : actionnez le sélecteur multiple et la touche 
ASSIGN 5 à l’aide de votre pouce.
C : tenez fermement le grip avec votre majeur, 
votre annulaire et votre auriculaire.
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Lors de l’utilisation du zoom

A : actionnez le levier de zoom à l’aide de 
votre index et de votre majeur.
B : tenez fermement la dragonne à l’aide de 
votre pouce.
C : tenez fermement le grip avec votre 
annulaire et votre auriculaire.

Retrait du grip

[Remarque]
Lorsque vous retirez le grip, veillez à placer le 
caméscope sur une surface plane, comme un bureau.

1	 Débranchez le câble du connecteur de la 
télécommande de grip.

2	 Maintenez enfoncé le bouton de 
déblocage de la télécommande de grip 
sur le caméscope, et tournez le grip dans 
le sens des aiguilles d’une montre jusqu’à 
ce qu’il se détache.

Bouton de déblocage de la télécommande 
de grip

[Conseil]
Une rosette peut être attachée au point d’attache du 
grip sur l’unité et au point de fixation correspondant sur 
le grip.
Pour plus de détails sur l’achat de rosettes, contactez 
votre revendeur Sony.
–– Côté caméscope : 4-546-932- (en option)
–– Côté grip : 4-547-089- (en option)
–– Vis de fixation* 

Côté caméscope : 7-627-556- (en option) 
Côté grip : 7-627-556- (en option)

*	 Quatre vis sont nécessaires pour chaque rosette (les 
orifices de vis sont indiqués par les cercles du schéma 
suivant). L’utilisation d’autres vis que celles spécifiées 
pourrait endommager les pièces extérieures.

Côté 
caméscope

Côté grip

Fixation d’un objectif

[ATTENTION]

Ne laissez pas l’objectif orienté en plein soleil. 
Les rayons directs du soleil peuvent entrer par 
l’objectif, se concentrer dans le caméscope et 
provoquer un incendie.

[Remarques]
ˎˎ Fixez/retirez l’objectif lorsque le caméscope est hors 

tension.
ˎˎ Un objectif est un composant de précision. Ne 

placez pas l’objectif sur une surface avec le côté 
de la monture d’objectif tourné vers le bas. Fixez le 
capuchon de la monture d’objectif fourni.

[Conseil]
Pour de plus amples informations concernant les 
objectifs pouvant être utilisés avec le caméscope, 
contactez votre technicien Sony.

Fixation d’un objectif à monture E

1	 Retirez le capuchon de l’objectif et le 
couvercle du caméscope et de l’objectif.

2	 Alignez le repère de monture d’objectif 
(blanc) avec le caméscope, insérez 
prudemment l’objectif, puis tournez 
l’objectif dans le sens des aiguilles d’une 
montre.
Un clic se fait entendre lors du 
verrouillage en place.

Repères de monture (blancs)

[Remarque]
N’appuyez pas sur le bouton de déblocage de l’objectif 
lorsque vous fixez un objectif.

Fixation d’un objectif à monture A
Pour utiliser un objectif à monture A, fixez un 
adaptateur de monture d’objectif (optionnel), 
puis fixez l’objectif à monture A.
[Remarque]
Lorsque vous utilisez un objectif à monture A, le 
diaphragme se règle manuellement et la mise au point 
est paramétrée sur MF.

Retrait d’un objectif
Retirez un objectif en suivant la procédure 
suivante.

1	 Maintenez le bouton de déblocage de 
l’objectif enfoncé et tournez l’objectif 
dans le sens contraire des aiguilles d’une 
montre tout en soutenant l’objectif.

2	 Tirez l’objectif vers l’avant pour l’extraire.
[Remarques]
ˎˎ Lors du retrait d’un objectif, alignez le repère de 

monture sur la bague de verrouillage de l’objectif 
avec le repère de monture du caméscope.
ˎˎ Saisissez fermement l’objectif à la main pour 

empêcher qu’il ne tombe.
ˎˎ Si un autre objectif n’est pas immédiatement fixé, 

replacez toujours le capuchon de boîtier.

Réglages de diaphragme pour les 
objectifs dotés d’un commutateur Auto 
Iris
ˎˎ Quand l’objectif Auto Iris est réglé sur 
AUTO, le diaphragme est automatiquement 
ajusté et peut également être ajusté 
manuellement depuis le caméscope.
ˎˎ Quand l’objectif Auto Iris est réglé sur 
MANUAL, le diaphragme peut uniquement 
être ajusté grâce à la bague d’objectif. 
L’utilisation du diaphragme depuis le 
caméscope n’a aucun effet.
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Réglages de mise au point pour les 
objectifs avec commutateur de mise au 
point
ˎˎ Quand le commutateur de mise au point de 
l’objectif est réglé sur AF/MF ou AF, la mise 
au point est automatiquement ajustée et 
peut également être ajustée manuellement 
depuis une télécommande.
ˎˎ Quand le commutateur de mise au point de 
l’objectif est réglé sur MF, la mise au point 
est ajustée à l’aide de la bague d’objectif et 
peut également être ajustée manuellement 
depuis une télécommande.

	 [Remarque]
Lorsque vous utilisez un objectif à monture A, il se 
peut que vous ne puissiez pas utiliser le réglage 
manuel depuis une télécommande.

ˎˎ Quand le commutateur de mise au point 
de l’objectif est réglé sur Full MF, la mise au 
point peut uniquement être ajustée grâce à 
la bague d’objectif. L’utilisation de la mise 
au point depuis le caméscope n’a aucun 
effet.

Fixation à un trépied
Utilisez les orifices de vis du trépied sur le 
caméscope lorsque vous fixez un trépied. 
Utiliser la monture pour trépied sur l’objectif 
pourrait provoquer des dommages.

Objectifs anamorphiques

Lors de la prise de vue avec un objectif 
anamorphique, consultez « Réglage de 
l’affichage dé-squeeze » (page 54) pour 
plus de détails sur la manière de dé-squeezer 
l’image de la sortie HDMI et la manière de dé-
squeezer l’image dans le viseur de l’appareil.
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Configuration des opérations de base du caméscope
L’écran de réglages initiaux s’affiche dans le 
viseur la première fois que le caméscope est 
mis sous tension ou après le déchargement 
total de la batterie de secours.
Réglez la date et l’heure de l’horloge interne 
en utilisant cet écran.

Time Zone
La fonction Time Zone définit le décalage 
horaire par rapport au temps universel. 
Changez le réglage si nécessaire.

Réglage de la date et de l’heure

Utilisez le sélecteur multiple (page 7) ou 
la molette multifonction (page 5) pour 
sélectionner des éléments et des réglages, 
puis appuyez sur la touche de mise en 
application du sélecteur multiple ou la molette 
multifonction pour appliquer les réglages et 
lancer le fonctionnement de l’horloge.
Une fois que l’écran de réglages est fermé, 
vous pouvez changer la date, l’heure et 
le fuseau horaire à l’aide de Clock Set 
(page 111) dans le menu Maintenance.

[Remarques]
ˎˎ Si le réglage d’horloge est perdu pour cause de 

déchargement complet de la batterie de secours suite 
à une longue déconnexion de l’alimentation (pas de 
pack batterie et pas de source d’alimentation DC IN), 
l’écran de réglages initiaux s’affiche lors de la mise 
sous tension suivante du caméscope.
ˎˎ Pendant que l’écran de réglages initiaux est affiché, 

aucune autre opération n’est possible, sauf la 
mise hors tension, jusqu’à ce que vous finissiez les 
réglages sur cet écran.
ˎˎ Le caméscope possède une batterie rechargeable 

intégrée afin de stocker la date, l’heure et d’autres 
réglages, même lorsque le caméscope est éteint.

Avant la prise de vue, configurez les 
opérations de base du caméscope dans l’écran 
d’état Project pour les adapter à l’application.

Mode de prise de vue

Vous pouvez commuter le mode de prise de 
vue, entre « Custom » pour créer librement 
des images sur place et « prises de vue Log 
(Flexible ISO, Cine EI Quick, Cine EI) » pour 
lequel le caméscope fonctionne comme une 
caméra de film, avec des images qui seront 
développées en post-production.
Configurez le mode de prise de vue à l’aide de 
Shooting Mode (page 15) sur l’écran d’état 
Project.

[Conseil]
Vous pouvez également configurer le mode de prise 
de vue à l’aide de Base Setting >Shooting Mode 
(page 85) dans le menu Project du menu complet.

Custom

En mode de prise de vue Custom, vous pouvez 
sélectionner la norme vidéo.
Vous pouvez configurer la norme vidéo à l’aide 
de Base Setting >Target Display (page 85) 
dans le menu Project du menu complet.
ˎˎ SDR(BT.709) : prise de vue conforme à la 
norme de diffusion HD
ˎˎ HDR(HLG) : prise de vue conforme à la 
norme de diffusion 4K nouvelle génération

Pour plus de détails, consultez page 56.

Modes de prise de vue Log (Cine EI, Cine EI Quick, Flexible ISO)

En modes de prises de vue Log, vous pouvez sélectionner la gamme de couleurs de base 
pour les signaux enregistrés et les signaux de sortie. La gamme de couleurs sélectionnée ici 
représente la gamme de couleurs de la sortie vidéo lorsque MLUT est réglé sur Off.
Vous pouvez configurer la gamme de couleurs à l’aide de Cine EI/Flex.ISO Set >Color Gamut 
(page 86) dans le menu Project du menu complet.
ˎˎ S-Gamut3.Cine/SLog3 : gamme de couleurs facile à ajuster pour le mode de cinéma 
numérique (DCI-P3).
ˎˎ S-Gamut3/SLog3 : large gamme de couleurs Sony qui couvre la gamme de couleurs ITU-R 
BT.2020.

Pour plus de détails, consultez « Prise de vue avec réglage d’apparence en post-production » 
(page 58).
Il existe trois modes de prise de vue Log : Flexible ISO, Cine EI et Cine EI Quick.
ˎˎ Flexible ISO : enregistre le contenu S-Log3 avec des réglages d’exposition reflétant la 
sensibilité ISO correspondant à la scène filmée.
ˎˎ Cine EI/Cine EI Quick : enregistre le contenu S-Log3 à une sensibilité de base sélectionnée 
(fixe), mais vous permet de modifier la distribution entre les zones claires et les zones sombres 
à l’aide de Exposure Index. En mode de prise de vue Cine EI Quick, une sensibilité de base 
adaptée au réglage Exposure Index est sélectionnée automatiquement.

[Remarque]
Lors de l’enregistrement en mode Cine EI Quick ou Cine EI, il est recommandé de maintenir le réglage Exposure Index 
constant. Si vous modifiez le réglage Exposure Index, la correction de la luminosité peut être très difficile à réaliser en 
post-production, ce qui peut rendre impossible la reproduction de l’état dans lequel l’image a été filmée à l’origine.

Les restrictions fonctionnelles pour chaque mode de prise de vue sont indiquées ci-dessous.
Oui : pris en charge
Non : non pris en charge

Élément Custom Prise de vue Log

Flexible ISO Cine EI Quick Cine EI

ISO/GAIN Oui Oui (ISO 
uniquement)

Non Non

AGC Oui Oui Non Non

Base Sensitivity Oui Non Non Non

Base ISO Non Oui Oui (auto) Oui

Exposure Index Non Non Oui Oui

Auto Shutter Oui Oui Non Non

ATW Oui Oui Non Non

LUT On/Off Non Oui Oui Oui

Paint/Look (à l’exclusion de 
Base Look)

Oui Non Non Non

Codecs incluant RAW Non Oui Oui Oui
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Fréquence du système

Configurez la fréquence du système à l’aide 
de Frequency/Scan (page 15) sur l’écran 
d’état Project. Le caméscope peut redémarrer 
automatiquement après avoir commuté, selon 
la valeur sélectionnée.

[Conseil]
Vous pouvez également configurer la fréquence du 
système à l’aide de Rec Format >Frequency (page 85) 
dans le menu Project du menu complet.

[Remarque]
Vous ne pouvez pas commuter la fréquence du système 
pendant l’enregistrement ou la lecture.

Mode de numérisation par 
imageur

Vous pouvez régler la taille d’image effective 
et la résolution du capteur d’image.
Configurez le mode de numérisation à l’aide 
de Imager Scan (page 15) sur l’écran d’état 
Project.
ˎˎ FF : taille plein format.
ˎˎ S35 : taille Super 35 mm.

[Conseil]
Vous pouvez également configurer le mode de 
numérisation à l’aide de Rec Format >Imager Scan Mode 
(page 85) dans le menu Project du menu complet.

[Remarques]
ˎˎ Vous ne pouvez pas commuter le mode Imager Scan 

pendant l’enregistrement ou la lecture.
ˎˎ Lorsqu’il est réglé sur S35, le format vidéo est limité à 

1920×1080.

Codec

Configurez le codec à l’aide de Codec 
(page 15) sur l’écran d’état Project.

[Conseil]
Vous pouvez également configurer le codec à l’aide de 
Rec Format >Codec (page 85) dans le menu Project 
du menu complet.

[Remarque]
Vous ne pouvez pas commuter le codec pendant 
l’enregistrement ou la lecture.

Format vidéo

Vous pouvez régler le format vidéo pour 
l’enregistrement. Configurez le format vidéo à 
l’aide de Video Format (page 15) sur l’écran 
d’état Project.

[Conseil]
Vous pouvez également configurer le format vidéo à 
l’aide de Rec Format >Video Format (page 85) dans le 
menu Project du menu complet.

[Remarques]
ˎˎ Vous ne pouvez pas commuter le format vidéo 

pendant l’enregistrement ou la lecture.
ˎˎ Des restrictions peuvent s’appliquer au signal des 

connecteurs SDI OUT et HDMI OUT, selon le réglage 
du format vidéo.
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Ce caméscope permet d’effectuer des enregistrements audio et vidéo sur des cartes mémoire 
CFexpress Type A (disponibles séparément) ou des cartes mémoire SDXC (disponibles 
séparément) insérées dans les logements pour carte. Les cartes mémoire sont également 
utilisées pour l’enregistrement proxy et stocker/charger des réglages, ainsi que lors de la mise à 
niveau (mise à jour du logiciel).

À propos des cartes mémoire CFexpress Type A

Utilisez les cartes mémoire* Sony CFexpress Type A répertoriées dans « Support recommandé » 
(page 27) dans le caméscope.
Pour plus de détails sur le fonctionnement avec des supports provenant d’autres fabricants, 
reportez-vous au mode d’emploi du support ou consultez les informations du fabricant.
* �Désignées sous le nom de « cartes CFexpress » dans ce document.

À propos des cartes mémoire SDXC

Utilisez les cartes mémoire* SDXC répertoriées dans « Support recommandé » (page 27) dans 
le caméscope.
* �Désignées sous le nom de « cartes SD » dans ce document.

Utilisation de cartes mémoire
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Support recommandé

Les conditions de fonctionnement garanti varient en fonction des réglages Rec Format et Recording.
Oui : Fonctionnement pris en charge
Non : Le fonctionnement normal n’est pas garanti

Format d’enregistrement CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

RAW Out &  
XAVC-I

4096×2160
Class300

Mode normal 59.94P Oui Non Non Non Non Non Non Oui

50P Oui Non Non Non Non Non Non Oui

29.97P Oui Non Non Non Non Non Oui Oui

25P Oui Non Non Non Non Non Oui Oui

24P Oui Non Non Non Non Non Oui Oui

23.98P Oui Non Non Non Non Non Oui Oui

3840×2160
Class300

Mode normal 59.94P Oui Non Non Non Non Non Non Oui

50P Oui Non Non Non Non Non Non Oui

29.97P Oui Non Non Non Non Non Oui Oui

25P Oui Non Non Non Non Non Oui Oui

23.98P Oui Non Non Non Non Non Oui Oui

S&Q (60fps ou moins) 59.94P Oui Non Non Non Non Non Non Oui

50P Oui Non Non Non Non Non Non Oui

29.97P Oui Non Non Non Non Non Non Oui

25P Oui Non Non Non Non Non Non Oui

23.98P Oui Non Non Non Non Non Non Oui

S&Q (100fps, 120fps) 59.94P Oui Non Non Non Non Non Non Non

50P Oui Non Non Non Non Non Non Non

29.97P Oui Non Non Non Non Non Non Non

25P Oui Non Non Non Non Non Non Non

23.98P Oui Non Non Non Non Non Non Non
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Format d’enregistrement CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 4096×2160
Class300 

Mode normal 59.94P Oui Non Non Non Non Non Non Oui

50P Oui Non Non Non Non Non Non Oui

29.97P Oui Non Non Non Non Non Oui Oui

25P Oui Non Non Non Non Non Oui Oui

24P Oui Non Non Non Non Non Oui Oui

23.98P Oui Non Non Non Non Non Oui Oui

S&Q (60fps ou moins) 59.94P Oui Non Non Non Non Non Non Oui

50P Oui Non Non Non Non Non Non Oui

29.97P Oui Non Non Non Non Non Non Oui

25P Oui Non Non Non Non Non Non Oui

24P Oui Non Non Non Non Non Non Oui

23.98P Oui Non Non Non Non Non Non Oui

3840×2160
Class300 

Mode normal 59.94P Oui Non Non Non Non Non Non Oui

50P Oui Non Non Non Non Non Non Oui

29.97P Oui Non Non Non Non Non Oui Oui

25P Oui Non Non Non Non Non Oui Oui

23.98P Oui Non Non Non Non Non Oui Oui

S&Q (60fps ou moins) 59.94P Oui Non Non Non Non Non Non Oui

50P Oui Non Non Non Non Non Non Oui

29.97P Oui Non Non Non Non Non Non Oui

25P Oui Non Non Non Non Non Non Oui

23.98P Oui Non Non Non Non Non Non Oui

S&Q (100fps, 120fps) 59.94P Oui Non Non Non Non Non Non Non

50P Oui Non Non Non Non Non Non Non

29.97P Oui Non Non Non Non Non Non Non

25P Oui Non Non Non Non Non Non Non

23.98P Oui Non Non Non Non Non Non Non
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Format d’enregistrement CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 1920×1080
Class100

Mode normal 59.94P Oui Non Non Non Non Non Oui Oui

50P Oui Non Non Non Non Non Oui Oui

29.97P Oui Non Non Oui Non Oui Oui Oui

25P Oui Non Non Oui Non Oui Oui Oui

23.98P Oui Non Non Oui Non Oui Oui Oui

S&Q (60fps ou moins) 59.94P Oui Non Non Non Non Non Oui Oui

50P Oui Non Non Non Non Non Oui Oui

29.97P Oui Non Non Non Non Non Oui Oui

25P Oui Non Non Non Non Non Oui Oui

23.98P Oui Non Non Non Non Non Oui Oui

S&Q (100fps, 120fps) 59.94P Oui Non Non Non Non Non Non Oui

50P Oui Non Non Non Non Non Non Oui

29.97P Oui Non Non Non Non Non Non Oui

25P Oui Non Non Non Non Non Non Oui

23.98P Oui Non Non Non Non Non Non Oui

S&Q (150fps, 180fps) 59.94P Oui Non Non Non Non Non Non Non

50P Oui Non Non Non Non Non Non Non

29.97P Oui Non Non Non Non Non Non Non

25P Oui Non Non Non Non Non Non Non

23.98P Oui Non Non Non Non Non Non Non

S&Q (200fps, 240fps) 59.94P Oui Non Non Non Non Non Non Non

50P Oui Non Non Non Non Non Non Non

29.97P Oui Non Non Non Non Non Non Non

25P Oui Non Non Non Non Non Non Non

23.98P Oui Non Non Non Non Non Non Non
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Format d’enregistrement CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 3840×2160
420 

Mode normal 59.94P Oui Non Non Oui Non Oui Oui Oui

50P Oui Non Non Oui Non Oui Oui Oui

29.97P Oui Non Non Oui Non Oui Oui Oui

25P Oui Non Non Oui Non Oui Oui Oui

23.98P Oui Non Non Oui Non Oui Oui Oui

S&Q (60fps ou moins) 59.94P Oui Non Non Oui Non Oui Oui Oui

50P Oui Non Non Oui Non Oui Oui Oui

29.97P Oui Non Non Non Non Non Oui Oui

25P Oui Non Non Non Non Non Oui Oui

23.98P Oui Non Non Non Non Non Non Oui

S&Q (100fps, 120fps) 59.94P Oui Non Non Non Non Non Oui Oui

50P Oui Non Non Non Non Non Oui Oui

29.97P Oui Non Non Non Non Non Non Oui

25P Oui Non Non Non Non Non Non Oui

23.98P Oui Non Non Non Non Non Non Non

1920×1080
HD50

Mode normal 59.94P Oui Non Non Oui Non Oui Oui Oui

50P Oui Non Non Oui Non Oui Oui Oui

29.97P Oui Non Non Oui Non Oui Oui Oui

25P Oui Non Non Oui Non Oui Oui Oui

23.98P Oui Non Non Oui Non Oui Oui Oui

S&Q (60fps ou moins) 59.94P Oui Oui Oui Oui Oui Oui Oui Oui

50P Oui Oui Oui Oui Oui Oui Oui Oui

29.97P Oui Non Non Oui Non Oui Oui Oui

25P Oui Non Non Oui Non Oui Oui Oui

23.98P Oui Non Non Oui Non Oui Oui Oui

S&Q (100fps, 120fps) 59.94P Oui Non Non Oui Non Oui Oui Oui

50P Oui Non Non Oui Non Oui Oui Oui

29.97P Oui Non Non Non Non Non Oui Oui

25P Oui Non Non Non Non Non Oui Oui

23.98P Oui Non Non Non Non Non Oui Oui
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Format d’enregistrement CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 1920×1080
HD50

S&Q (150fps, 180fps) 59.94P Oui Non Non Non Non Non Oui Oui

50P Oui Non Non Non Non Non Oui Oui

29.97P Oui Non Non Non Non Non Non Oui

25P Oui Non Non Non Non Non Non Oui

23.98P Oui Non Non Non Non Non Non Oui

S&Q (200fps, 240fps) 59.94P Oui Non Non Non Non Non Oui Oui

50P Oui Non Non Non Non Non Oui Oui

29.97P Oui Non Non Non Non Non Non Oui

25P Oui Non Non Non Non Non Non Oui

23.98P Oui Non Non Non Non Non Non Oui

1920×1080
HD35

Mode normal 59.94P Oui Oui Oui Oui Oui Oui Oui Oui

50P Oui Oui Oui Oui Oui Oui Oui Oui

29.97P Oui Oui Oui Oui Oui Oui Oui Oui

25P Oui Oui Oui Oui Oui Oui Oui Oui

23.98P Oui Oui Oui Oui Oui Oui Oui Oui

S&Q (60fps ou moins) 59.94P Oui Oui Oui Oui Oui Oui Oui Oui

50P Oui Oui Oui Oui Oui Oui Oui Oui

29.97P Oui Non Non Oui Non Oui Oui Oui

25P Oui Non Non Oui Non Oui Oui Oui

23.98P Oui Non Non Oui Non Oui Oui Oui

S&Q (100fps, 120fps) 59.94P Oui Non Non Oui Non Oui Oui Oui

50P Oui Non Non Oui Non Oui Oui Oui

29.97P Oui Non Non Oui Non Oui Oui Oui

25P Oui Non Non Oui Non Oui Oui Oui

23.98P Oui Non Non Non Non Non Oui Oui

S&Q (150fps, 180fps) 59.94P Oui Non Non Oui Non Oui Oui Oui

50P Oui Non Non Oui Non Oui Oui Oui

29.97P Oui Non Non Non Non Non Oui Oui

25P Oui Non Non Non Non Non Oui Oui

23.98P Oui Non Non Non Non Non Oui Oui

S&Q (200fps, 240fps) 59.94P Oui Non Non Oui Non Oui Oui Oui

50P Oui Non Non Oui Non Oui Oui Oui

29.97P Oui Non Non Non Non Non Oui Oui

25P Oui Non Non Non Non Non Oui Oui

23.98P Oui Non Non Non Non Non Non Oui
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Insertion d’une carte mémoire

1	 Ouvrez le cache du support de la section 
de logements pour carte.

2	 Insérez une carte mémoire.
ˎˎ Pour les cartes CFexpress, l’étiquette est 
orientée vers la gauche.

Étiquette

ˎˎ Pour les cartes SD, l’étiquette est 
orientée vers la droite, avec le coin 
biseauté en bas.

Coin biseauté

L’indicateur d’accès (page 6) est 
allumé en rouge, puis passe au vert si la 
carte est utilisable.

	 [Remarque]
Si l’indicateur d’accès clignote en rouge en continu 
et ne passe pas au vert, éteignez temporairement 
le caméscope, puis retirez et réinsérez la carte 
mémoire.

3	 Fermez le cache du support.

[Remarques]
ˎˎ La carte mémoire, le logement de carte mémoire et 

les données d’images sur la carte mémoire peuvent 
être endommagés si la carte est enfoncée de force 
dans le logement dans le mauvais sens.
ˎˎ Lorsque vous enregistrez sur des supports situés 

dans les logements de carte CFexpress Type A/SD A 
et B, insérez dans ces deux logements des supports 
recommandés pour l’utilisation avec le format 
d’enregistrement.

Éjection d’une carte mémoire

Ouvrez le cache du support de la section de 
logements pour carte et appuyez légèrement 
sur la carte mémoire pour l’éjecter.

[Remarques]
ˎˎ Si le caméscope est arrêté ou la carte mémoire 

enlevée pendant que le système accède à la carte 
mémoire, l’intégrité des données sur la carte ne peut 
pas être garantie. Toutes les données enregistrées 
sur la carte peuvent être supprimées. Assurez-vous 
toujours que l’indicateur d’accès est vert ou éteint 
avant d’arrêter le caméscope ou d’enlever la carte 
mémoire.
ˎˎ Si une carte mémoire est retirée immédiatement 

après l’enregistrement, elle peut être chaude, mais 
cela n’indique pas un problème.

Formatage (initialisation) de cartes 
mémoire

Si une carte mémoire non formatée ou 
une carte mémoire formatée selon une 
spécification différente est insérée, le message 
« Media Needs to be Formatted » s’affiche 
dans le viseur.
Formatez la carte en utilisant la procédure 
suivante.

1	 Sélectionnez Format Media (page 97) 
dans le menu TC/Media du menu 
complet.

2	 Sélectionnez Media(A) (logement A) ou 
Media(B) (logement B), puis sélectionnez 
la méthode de formatage (Full Format ou 
Quick Format).
Un message de confirmation apparaît.
ˎˎ Full Format : initialise complètement le 
support, y compris la zone des données 
et les informations de gestion des 
données.
ˎˎ Quick Format : initialise uniquement les 
informations de gestion des données du 
support.

	 [Remarque]
Si la carte mémoire à formater contient des fichiers 
à transférer, un message supplémentaire (exemple 
d’affichage : « Un fichier cible de transfert existe ») 
apparaît sous le message de confirmation. Dans 
ce cas, confirmez l’initialisation ou non de la carte 
mémoire et exécutez ou annulez l’initialisation.

3	 Sélectionnez Execute.
Un message s’affiche pendant le 
formatage et le voyant d’accès est allumé 
en rouge.
Une fois le formatage terminé, un 
message indiquant la fin de l’opération 
s’affiche. Appuyez sur la molette 
multifonction pour ignorer le message.

[Remarques]
ˎˎ Le formatage d’une carte mémoire efface toutes les 

données, y compris les données vidéo et les fichiers 
de configuration enregistrés.
ˎˎ Des messages peuvent apparaître pendant 

l’exécution selon la durée du processus de formatage.

En cas d’échec du formatage

Les cartes mémoire non prises en charge par 
le caméscope ne peuvent pas être formatées.
Un message d’avertissement est affiché. 
Suivez les instructions pour remplacer la carte 
par une carte mémoire prise en charge.

Pour utiliser une carte formatée sur le 
caméscope dans la fente d’un autre 
dispositif

Effectuez d’abord une copie de sauvegarde 
de la carte, puis reformatez la carte dans le 
dispositif à utiliser.

Vérification de la durée 
d’enregistrement restante

Lors d’une prise de vue (enregistrement/
veille), vous pouvez surveiller la capacité 
restante de la carte mémoire dans chacun des 
logements à l’aide des indicateurs de capacité 
restante du support des logements A/B dans 
le viseur (page 11).
Le temps d’enregistrement restant est calculé 
à partir de la capacité restante du support de 
chaque logement et du format vidéo actuel 
(débit binaire d’enregistrement) et est affiché 
en unités de minutes.
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Synchronisation de remplacement de 
carte mémoire

ˎˎ Quand le temps d’enregistrement total 
restant sur les deux cartes mémoire 
devient inférieur à 5 minutes, le message 
« Media Near Full » s’affiche, le témoin 
d’enregistrement/de signalisation 
commence à clignoter et un signal sonore 
(émis à partir de la sortie casque) vous 
avertit.  
Remplacez les cartes par un support ayant 
de l’espace libre.
ˎˎ Si vous continuez d’enregistrer jusqu’à ce 
que le temps total d’enregistrement restant 
atteigne 0, le message passe à « Media Full » 
et l’enregistrement s’arrête.

[Remarque]
Un maximum de 600 plans environ peut être enregistré 
sur une carte mémoire.

Restauration de cartes mémoire

Si, pour quelque raison que ce soit, une erreur 
se produit dans une carte mémoire, celle-ci 
doit être restaurée avant l’utilisation.
Lorsque vous insérez une carte mémoire qui 
doit être restaurée, un message apparaît sur 
l’écran LCD/du viseur pour vous demander si 
vous souhaitez effectuer la restauration.

Restauration d’une carte

Tournez la molette multifonction (page 5) 
pour sélectionner Execute, puis appuyez sur la 
molette multifonction.
Un message et l’état de progression 
(%) s’affichent pendant le formatage et 
l’indicateur d’accès est allumé en rouge.
À la fin de la restauration, un message 
indiquant la fin de l’opération s’affiche.

En cas d’échec de la restauration

ˎˎ Les cartes mémoire sur lesquelles des 
erreurs de mémoire se sont produites ne 
peuvent pas être restaurées. Un message 
d’avertissement est affiché. Suivez les 
instructions pour remplacer la carte 
mémoire.
ˎˎ Les cartes mémoire sur lesquelles des 
erreurs de mémoire se sont produites 
peuvent être utilisables si vous les 
reformatez.
ˎˎ Dans certains cas, certains plans peuvent 
être restaurés et d’autres non. Les plans 
restaurés peuvent être lus normalement.

[Remarques]
ˎˎ Pour la restauration du support enregistré sur ce 

caméscope, assurez-vous d’utiliser ce caméscope.
ˎˎ Il se peut qu’un support enregistré avec un dispositif 

autre que ce caméscope ou avec un autre caméscope 
d’une version différente (même du même modèle) ne 
soit pas restauré à l’aide de ce caméscope.
ˎˎ Les plans de moins de 2 secondes ne peuvent pas 

être restaurés.
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Procédure d’opération de base
La prise de vue de base s’effectue à l’aide de 
la procédure suivante.

1	 Connectez les dispositifs nécessaires et 
vérifiez que l’alimentation est branchée.

2	 Insérez la/les carte(s) mémoire.

3	 Réglez le commutateur POWER sur on.
L’indicateur POWER s’allume et l’image de 
la caméra apparaît sur le viseur.

4	 Appuyez sur la touche d’enregistrement 
START/STOP (page 5).
Le témoin d’enregistrement/de 
signalisation s’allume et l’enregistrement 
commence.

5	 Pour arrêter l’enregistrement, appuyez à 
nouveau sur la touche d’enregistrement 
START/STOP.
L’enregistrement s’arrête et le caméscope 
passe au mode STBY (veille).

[Remarque]
Si la touche d’enregistrement START/STOP est actionnée 
dans les quelques secondes suivant la mise sous 
tension du caméscope, le témoin d’enregistrement/
de signalisation s’allume pour indiquer que l’unité est 
en état d’enregistrement, mais l’enregistrement sur le 
support peut ne pas se déclencher pour les premières 
secondes, en fonction du format d’enregistrement 
sélectionné.

Sélection alternative des cartes 
mémoire

Lorsque deux cartes mémoire sont chargées, 
appuyez sur la touche SLOT SELECT 
(page 6) pour passer d’une carte à l’autre.
L’enregistrement passe automatiquement 
à la seconde carte mémoire juste avant que 
la capacité restante sur la première carte 
atteigne zéro (enregistrement relais). Lorsque 
vous basculez d’une carte mémoire à l’autre, 
vous pouvez poursuivre l’enregistrement 
continu en remplaçant la carte mémoire pleine 
par une nouvelle.

[Remarques]
ˎˎ Vous ne pouvez pas passer d’une carte mémoire 

à l’autre en mode de lecture. En outre, la lecture 
continue d’un plan situé sur plusieurs supports dans 
la fente A et la fente B n’est pas prise en charge.
ˎˎ Lorsqu’une carte mémoire enregistrable est insérée 

dans le second logement de carte mémoire et si 
seules les données proxy sont enregistrées sur cette 
carte, les cartes mémoire ne passeront pas de l’une 
à l’autre.

Plans (données enregistrées)
Quand vous cessez l’enregistrement, la vidéo, 
l’audio et les données correspondantes 
du début à la fin de l’enregistrement sont 
sauvegardés sous forme de « plan » unique 
sur une carte mémoire.

Noms de plans
Le nom de chaque plan enregistré avec le 
caméscope est attribué automatiquement à 
l’aide du format réglé sous Clip Name Format 
(page 96) du menu TC/Media du menu 
complet.

Durée maximum d’un plan
Jusqu’à 6 heures par plan.
La durée maximum d’un enregistrement 
continu est identique à la durée maximum 
d’un plan. Si la durée d’enregistrement 
dépasse la durée maximum d’un plan, un 
nouveau plan est créé automatiquement et 
l’enregistrement se poursuit. Le nouveau plan 
apparaît comme un plan séparé sur l’écran des 
miniatures.
Les plans multiples sont enregistrés 
successivement pendant l’enregistrement 
relais, mais l’enregistrement s’arrête 
automatiquement après environ 24 heures.

[Remarques]
ˎˎ N’éjectez pas une carte mémoire pendant que des 

données y sont en cours d’enregistrement. Lors de 
l’enregistrement, remplacez uniquement les cartes 
mémoire des logements pour lesquels l’indicateur 
d’accès de logement est éteint.
ˎˎ Quand la capacité restante sur la carte mémoire en 

cours d’enregistrement descend au-dessous d’une 
minute et qu’une carte mémoire enregistrable est 
insérée dans l’autre logement, un message « Will 
Switch Slots Soon » s’affiche. Le message disparaît 
après l’échange de logement de carte mémoire.
ˎˎ L’enregistrement relais peut ne pas fonctionner 

si l’enregistrement est lancé alors que la capacité 
restante de la carte mémoire est inférieure à une 
minute. Pour un enregistrement relais correct, 
vérifiez que la capacité restante de la carte mémoire 
est supérieure à une minute avant de commencer 
l’enregistrement.
ˎˎ La vidéo créée à l’aide de la fonction d’enregistrement 

relais du caméscope ne peut pas être lue sans 
problème sur le caméscope.
ˎˎ Pour combiner la vidéo créée en utilisant la fonction 

d’enregistrement relais du caméscope, utilisez le 
logiciel « Catalyst Browse ».

Surveillance de l’audio

Vous pouvez surveiller l’audio en cours 
d’enregistrement grâce au casque.
En connectant un casque sur la prise casque 
(page 5), vous pourrez surveiller l’audio 
qui est en cours d’enregistrement. 
Vous pouvez également surveiller l’audio 
lu (page 70) en utilisant le haut-parleur 
intégré (page 6) ou le casque.
Vous pouvez régler le volume de l’audio à 
surveiller à l’aide de Volume (page 14) 
sur l’écran d’état Audio ou de Audio Output 
>Volume (page 102) dans le menu Audio du 
menu complet.
Vous pouvez sélectionner le canal à surveiller 
à l’aide de Monitor CH (page 14) sur l’écran 
d’état Audio ou de Audio Output >Monitor CH 
(page 102) dans le menu Audio du menu 
complet.

Spécification des données 
temporelles

Réglage du code temporel

Réglez le code temporel pour enregistrer en 
utilisant Timecode (page 95) dans le menu 
TC/Media du menu complet.

Réglage des bits utilisateur

Vous pouvez ajouter un nombre hexadécimal 
à 8 chiffres à l’image enregistrée en tant que 
bits utilisateur. Vous pouvez également régler 
les bits utilisateur sur l’heure actuelle. Réglez 
à l’aide de Users Bit (page 95) dans le menu 
TC/Media.
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Affichage des données temporelles

Réglez le code temporel à afficher à l’aide de 
TC Display (page 95) >Display Select dans le 
menu TC/Media.
L’activation d’une touche personnalisable 
(page 49) à laquelle DURATION/TC/U-BIT 
est assigné commute l’affichage entre le code 
temporel, les bits d’utilisateur et la durée, dans 
l’ordre.

Commutation de l’entrée/sortie de code 
temporel

Vous pouvez commuter l’entrée/la sortie de 
code temporel en utilisant le commutateur de 
sélection TC IN/OUT (page 4).
Pour plus de détails, consultez page 122.

Passage en revue de 
l’enregistrement (Rec Review)

Vous pouvez revoir le dernier plan enregistré 
sur l’écran (révision d’enregistrement).

[Remarque]
Rec Review n’est pas pris en charge si le format vidéo 
est modifié après l’enregistrement d’un plan.

Méthode de révision d’enregistrement

Attribuez au préalable Rec Review à l’une des 
touches personnalisables.
Quand l’enregistrement est arrêté, appuyez 
sur la touche personnalisable (page 49) à 
laquelle Rec Review est assigné. La lecture du 
dernier plan enregistré commence.
Le plan est lu jusqu’à la fin, Rec Review prend 
fin et le caméscope revient en mode STBY 
(veille).

Pour arrêter Rec Review

Pressez la touche personnalisable à laquelle 
Rec Review est attribué ou pressez la touche 
CANCEL/BACK.

Réglages de la révision 
d’enregistrement

Vous pouvez configurer la position de départ 
de la lecture sur l’un des paramètres suivants 
à l’aide du réglage Rec Review (page 104) du 
menu Technical.
ˎˎ Les 3 dernières secondes du plan
ˎˎ Les 10 dernières secondes du plan
ˎˎ Début du plan

[Conseil]
Si vous souhaitez examiner un plan spécifique après 
avoir enregistré plusieurs plans, appuyez sur la touche 
THUMBNAIL pour afficher l’écran des miniatures et 
sélectionnez le plan pour lancer la lecture.
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Vous pouvez régler le zoom selon les 
conditions de prise de vue.

Lorsqu’un objectif zoom motorisé est fixé, 
vous pouvez régler le zoom à l’aide du levier 
de zoom sur la télécommande de grip ou la 
poignée. La vitesse du zoom varie selon la 
pression appliquée au levier.
Le caméscope est équipé d’une fonction 
de zoom qui utilise un traitement de signal 
d’image appelé Clear Image Zoom. Lorsque 
Clear Image Zoom est activé, le zoom est pris 
en charge même pour des objectifs à distance 
focale fixe (c’est-à-dire à focale fixe). Vous 
pouvez aussi l’utiliser pour étendre la plage 
au-delà de la plage optique sur un objectif 
zoom motorisé.
Le rapport de zoom maximal avec Clear 
Image Zoom varie selon la résolution 
d’enregistrement.
ˎˎ Pour la résolution d’enregistrement 
QFHD/4K : 1,5×
ˎˎ Pour la résolution d’enregistrement HD : 2×

Sélection du type de zoom

Configurez le type de zoom à l’aide de Zoom 
>Zoom Type (page 104) dans le menu 
Technical du menu complet.
Le type de zoom peut varier selon le type de 
l’objectif utilisé.

Objectif 
utilisé

Réglage du Zoom Type

Optical Zoom 
Only

On(Clear Image 
Zoom)

Zoom à 
focale 
fixe/
Objectif à 
zoom 
manuel

L’utilisation du 
zoom à l’aide du 
levier n’est pas 
prise en charge.

Clear Image 
Zoom est pris en 
charge.

Objectif 
utilisé

Réglage du Zoom Type

Optical Zoom 
Only

On(Clear Image 
Zoom)

Objectif 
zoom 
motorisé

Zoom optique 
seulement

Zoom optique et 
Clear Image 
Zoom sont pris 
en charge.

[Remarques]
ˎˎ Clear Image Zoom n’est pas disponible dans les cas 

suivants.
–– Lorsque S&Q Motion >Frame Rate (page 83) 

dans le menu Shooting du menu complet est de 
plus de 60fps

–– Lorsque Rec Format >Codec (page 85) du menu 
Project du menu complet est configuré sur RAW ou 
sur une option incluant RAW.

ˎˎ L’utilisation du commutateur de sélection SERVO/
MANUAL sur un objectif réinitialise l’agrandissement 
de Clear Image Zoom sur 1×. 
ˎˎ Lorsque la mise au point automatique par pression 

(AF-S) est exécutée pendant l’opération Clear Image 
Zoom, l’opération AF donne la priorité à la zone située 
au centre de l’écran.

Réglage du zoom de la poignée

Configurez le zoom de la poignée à l’aide 
de Handle Zoom (page 105) dans le menu 
Technical du menu complet.

Réglage du sens de la bague de 
zoom

Sur certains objectifs à monture E, le sens 
de rotation de la bague de zoom peut être 
inversé.
Configurez le sens de rotation à l’aide de Lens 
>Zoom Ring Direction (page 105) dans le 
menu Technical du menu complet.

Réglage du zoom
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Réglage de la mise au point
Vous pouvez régler automatiquement ou 
manuellement la mise au point, selon les 
conditions de prise de vue.

Réglage manuel de la mise au 
point (Manual Focus)

Pour ajuster manuellement la mise au point, 
réglez le commutateur FOCUS (page 4) sur 
« MAN ».
Ceci vous permet d’ajuster manuellement la 
mise au point en fonction des conditions de 
prise de vue.
La mise au point manuelle est utile pour les 
types suivants de sujets.
ˎˎ Sujets de l’autre côté d’une fenêtre couverte 
de gouttelettes d’eau
ˎˎ Sujets avec un contraste faible par rapport à 
l’arrière-plan
ˎˎ Sujets plus éloignés que les sujets proches

[Conseil]
Vous pouvez aussi utiliser la mise au point automatique 
dans les cas suivants lorsque le réglage manuel est la 
méthode principale d’utilisation.
ˎˎ Lorsque la sensibilité de changement de sujet AF est 

réglée sur 1(Locked)
ˎˎ Lorsque le commutateur FOCUS est réglé sur la 

position « AF »
ˎˎ Lorsque vous utilisez la bague de mise au point (AF 

Assist, page 40)

Mise au point à l’aide d’une opération 
tactile (Spot Focus)

En mode de mise au point manuelle, vous 
pouvez spécifier la position où vous voulez 
régler la mise au point par une opération 
tactile.
Pour utiliser la mise au point sur un point, 
réglez Focus >Touch Function in MF 
(page 83) dans le menu Shooting sur Spot 
Focus.

Un repère de mise au point sur un point 
s’affiche lorsque vous appuyez sur la position 
où vous voulez régler la mise au point.

[Conseils]
ˎˎ En mode de mise au point sur un point, vous 

pouvez appuyer sur une touche personnalisable 
(page 49) attribuée avec Push AF/Push MF pour 
arrêter temporairement la mise au point sur un point 
et activer la mise au point automatique pendant que 
la touche est enfoncée. La mise au point repasse en 
mode manuel quand vous relâchez la touche.
ˎˎ La fonction mise au point sur un point ne fonctionne 

pas si l’objectif est réglé pour la mise au point 
manuelle.
ˎˎ La fonction mise au point sur un point ne fonctionne 

pas lorsque 1.3× ou 2.0× est sélectionné dans De-
Squeeze (page 98) dans le menu Monitoring du 
menu complet.
ˎˎ La position de mise au point sur un point ne peut 

pas être spécifiée pendant que la mise au point est 
agrandie ou lorsque Touch Operation (page 104) 
dans le menu Technical est réglé sur Off.

Utilisation temporaire de la mise au 
point automatique (Push Auto Focus 
(AF))

Lorsque Focus >Push AF Mode (page 83) 
dans le menu Shooting du menu complet 
est réglé sur AF, appuyez sur la touche PUSH 
AUTO FOCUS (page 4) pendant la mise 
au point manuelle pour effectuer la mise au 
point automatiquement alors que la touche 
est enfoncée.
La mise au point s’effectue dans la zone de 
mise au point définie à l’aide de Focus >Focus 
Area (page 83) dans le menu Shooting du 
menu complet.

La mise au point repasse en mode manuel 
quand vous relâchez la touche.
Ceci est utile lorsque vous voulez régler 
lentement la mise au point d’un sujet à un 
autre lors de la mise au point manuelle.

[Conseil]
La même opération est possible avec une touche 
personnalisable (page 49) à laquelle vous avez 
attribué Push AF/Push MF.

[Remarques]
ˎˎ La fonction Push Auto Focus ne fonctionne pas si 

l’objectif est réglé pour la mise au point manuelle.
ˎˎ La fonction Push Auto Focus ne fonctionne pas 

lorsque 1.3× ou 2.0× est sélectionné dans De-Squeeze 
(page 98) dans le menu Monitoring du menu 
complet.

Utilisation de la mise au point 
automatique à prise de vue unique 
(Push Auto Focus (AF-S))

Réglez Focus >Push AF Mode (page 83) 
dans le menu Shooting du menu complet 
sur Single-shot AF(AF-S), puis réglez la zone 
de mise au point à l’aide de Focus >Focus 
Area(AF-S) (page 83) dans le menu 
Shooting du menu complet.
Appuyez sur la touche PUSH AUTO FOCUS 
en mode de mise au point manuelle pour 
effectuer automatiquement la mise au point à 
vitesse élevée. La mise au point cesse dès que 
vous relâchez la touche.
L’indicateur de mise au point vous informe sur 
l’état de la mise au point.
ˎˎ On : la mise au point reste sur la position de 
mise au point.
ˎˎ Clignotant : pas de mise au point. Puisque 
la mise au point n’est pas automatique, 
modifiez les réglages de composition et de 
mise au point pour réaliser la mise au point.

La mise au point repasse en mode manuel 
quand vous relâchez la touche.
Cela est utile lorsque vous voulez faire 
rapidement la mise au point sur un sujet avant 
de lancer une prise de vue.

[Conseils]
ˎˎ La même opération est possible avec une touche 

personnalisable (page 49) à laquelle vous avez 
attribué Push AF/Push MF.
ˎˎ Vous pouvez également attribuer Push AF Mode à 

une touche personnalisable (page 49).
ˎˎ Vous pouvez également attribuer Focus Area(AF-S) à 

une touche personnalisable (page 49).
ˎˎ Vous pouvez afficher/masquer le cadre de la zone de 

mise au point à l’aide de Display On/Off >Focus Area 
Ind.(AF-S) (page 98) dans le menu Monitoring du 
menu complet.
ˎˎ Pendant l’agrandissement de la mise au point, la mise 

au point se règle pour correspondre à la position 
d’affichage agrandie.

[Remarques]
ˎˎ La fonction Push Auto Focus ne fonctionne pas si 

l’objectif est réglé pour la mise au point manuelle.
ˎˎ Le cadre de la zone de mise au point n’est pas 

masqué lorsque vous utilisez la touche DISPLAY.
ˎˎ 	Pendant l’opération Clear Image Zoom, la position du 

cadre de Focus Area(AF-S) ne peut pas être définie. 
Pendant l’opération Push AF-S, l’opération AF donne 
également la priorité à la partie centrale.
ˎˎ La fonction Push Auto Focus ne fonctionne pas 

lorsque 1.3× ou 2.0× est sélectionné dans De-Squeeze 
(page 98) dans le menu Monitoring du menu 
complet.

Mise au point à l’aide de 
l’agrandissement de la vue (Focus 
Magnifier)

Par défaut, la fonction Focus Magnifier ×3/×6 
est affectée à la touche ASSIGN 4 sur la 
télécommande du grip et à la touche ASSIGN 7 
sur la poignée (page 49).
Appuyez sur la touche ASSIGN 4 ou la touche 
ASSIGN 7 pour faire passer le viseur à l’écran 
d’agrandissement de la mise au point, avec 
le centre agrandi environ trois fois. Appuyez 
de nouveau sur la touche pour augmenter 
l’agrandissement jusqu’à environ six fois. Cette 
fonction est utile pour vérifier la mise au point.
Appuyez de nouveau sur la touche pour 
revenir à l’écran normal.
Vous pouvez déplacer la position à élargir 
pendant l’agrandissement de la mise au point 
à l’aide du sélecteur multiple (page 7). 
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Appuyez sur le sélecteur multiple pour revenir 
au centre de l’image.
Lorsque vous utilisez la mise au point 
automatique par pression (AF) lors de 
l’agrandissement de la mise au point, la mise 
au point se produit dans la zone de mise au 
point définie à l’aide de Focus >Focus Area 
(page 83) dans le menu Shooting du menu 
complet.
Si vous utilisez la mise au point automatique 
par pression (AF-S) pendant l’agrandissement 
de la mise au point, la mise au point se règle 
pour correspondre à la position d’affichage 
agrandie.

[Remarques]
ˎˎ L’image enregistrée ou l’image de sortie SDI/HDMI 

n’est pas agrandie lorsque la mise au point est 
agrandie.
ˎˎ Pendant l’agrandissement de la mise au point, 

la touche MENU et les autres opérations sont 
désactivées.
ˎˎ La position agrandie revient au centre de l’écran 

lorsque le caméscope est mis hors tension.

Réglage automatique de la mise 
au point (Auto Focus)

Le caméscope utilise l’AF à détection de phase 
pour une mise au point ultra rapide et l’AF de 
contraste pour une mise au point ultra précise.
La combinaison de ces deux méthodes AF 
permet une mise au point automatique à 
vitesse rapide et haute précision.
Pour ajuster automatiquement la mise 
au point, réglez le commutateur FOCUS 
(page 4) du caméscope sur « AUTO ». 
Si l’objectif est pourvu d’un commutateur 
de sélection de mise au point, réglez le 
commutateur sur la position « AF/MF » ou 
« AF ». Si le commutateur est réglé sur la 
position « Full MF » ou « MF », la mise au point 
de l’objectif ne peut pas être réalisée depuis le 
caméscope (page 23).

[Conseil]
Lorsque vous réglez Focus >AF Assist (page 83) sur 
On dans le menu Shooting du menu complet, vous 
pouvez encore utiliser la bague de mise au point de 
l’objectif pendant la mise au point automatique pour 
régler la mise au point.

[Remarques]
ˎˎ Un objectif prenant en charge la mise au point 

automatique est requis.
ˎˎ Vous risquez de ne pas obtenir une bonne précision 

selon les conditions de prise de vue.
ˎˎ La mise au point ne peut pas être ajustée 

automatiquement sur un objectif à monture A.
ˎˎ La mise au point automatique ne peut pas être 

utilisée lorsque De-Squeeze >Ratio (HDMI/VF) 
(page 98) est réglé sur une valeur autre que 
Off(1.0×) dans le menu Monitoring.

Réglage de la zone/position de mise au 
point automatique (Focus Area)

Vous pouvez régler la zone cible pour la 
mise au point automatique en utilisant Focus 
>Focus Area (page 83) dans le menu 
Shooting du menu complet.

Flexible Spot :
Effectue la mise au point sur une position 
spécifique dans l’image.
Lorsque vous sélectionnez ce réglage, 
spécifiez la position à l’aide du sélecteur 
multiple (page 7).
Vous pouvez revenir à la position centrale en 
maintenant enfoncé le sélecteur multiple.

Zone :
Recherche automatiquement une position de 
mise au point dans la zone spécifiée.

Lorsque vous sélectionnez ce réglage, 
spécifiez la position à l’aide du sélecteur 
multiple (page 7).
Vous pouvez revenir à la position centrale en 
maintenant enfoncé le sélecteur multiple.

Wide :
Recherche un sujet dans un grand angle 
de l’image lors de la mise au point. Aucune 
image ne s’affiche.

[Conseil]
La même opération est possible avec une touche 
personnalisable (page 49) à laquelle vous avez 
attribué Focus Area.
Vous pouvez afficher/masquer le cadre de la zone de 
mise au point à l’aide de Display On/Off >Focus Area 
Indicator (page 98) dans le menu Monitoring du 
menu complet.

[Remarque]
Le cadre de la zone de mise au point n’est pas masqué 
lorsque vous utilisez la touche DISPLAY.

Modification rapide de la zone de mise 
au point (Focus Setting)

Vous pouvez changer rapidement la 
position et la taille de la zone de mise au 
point automatique lors de la prise de vue 
en attribuant Focus Setting à une touche 
personnalisable (page 49).

L’opération varie selon le réglage de la zone 
de mise au point.

Lorsque Focus >Focus Area (page 83) du 
menu Shooting du menu complet est réglé 
sur Flexible Spot ou Zone
Vous pouvez modifier la position de la zone 
de mise au point en appuyant sur la touche 
personnalisable à laquelle vous avez attribué 
Focus Setting et en réglant à l’aide du 
sélecteur multiple (page 7).
Vous pouvez restaurer la position de la zone 
de mise au point au centre lorsque vous 
réglez la position en appuyant sur le sélecteur 
multiple.
Vous pouvez modifier la taille de la zone de 
mise au point en maintenant enfoncée la 
touche personnalisable à laquelle vous avez 
attribué Focus Setting.
Après avoir modifié la taille, définissez la 
position de la zone de mise au point en 
appuyant sur le sélecteur multiple.
Lorsque vous avez terminé, appuyez sur la 
touche personnalisable à laquelle vous avez 
attribué Focus Setting pour revenir à l’écran 
d’origine.

Lorsque Focus >Focus Area (page 83) du 
menu Shooting du menu complet est réglé 
sur Wide
Vous pouvez uniquement modifier la taille 
de la zone de mise au point en maintenant 
enfoncée la touche personnalisable à laquelle 
vous avez attribué Focus Setting. Vous pouvez 
aussi changer la position en modifiant d’abord 
le type sur Flexible Spot ou Zone.

[Conseils]
ˎˎ Lorsque Focus >Push AF Mode (page 83) dans 

le menu Shooting du menu complet est réglé sur 
Single-shot AF(AF-S) et que le commutateur FOCUS 
(page 4) est en position MF, vous pouvez modifier 
la position de la zone de mise au point Focus 
Area(AF-S) (page 83).
ˎˎ Le cadre de la zone de mise au point est affiché en 

orange lorsque la position de la zone de mise au 
point peut être modifiée.
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Déplacement du cadre de la zone de 
mise au point à l’aide des opérations 
tactiles (zone de mise au point tactile)

Vous pouvez modifier la position de la zone 
de mise au point en appuyant sur une touche 
personnalisable (page 49) à laquelle vous 
avez attribué Focus Setting pour faire passer 
l’affichage de la zone de mise au point en 
orange, puis la déplacer par opération tactile.
Touchez l’écran pour déplacer la zone de 
mise au point, avec la zone de mise au point 
centrée sur la position touchée. Faites glisser 
sur l’écran pour déplacer la zone de mise 
au point à la position tracée par votre doigt 
(page 10).

[Conseil]
Vous pouvez activer/désactiver l’opération de mise au 
point tactile sur l’écran de prise de vue à l’aide de la 
touche personnalisable à laquelle vous avez attribué 
Focus Setting.

Toucher n’importe quelle position

La zone de mise au point se déplace, avec la 
zone de mise au point centrée sur la position 
touchée.

Faire glisser pour déplacer la zone de mise au 
point, en suivant la position de votre doigt

[Remarques]
ˎˎ Si vous touchez une position ou faites glisser la zone 

de mise au point vers une position qui dépasse la 
plage de réglage, la zone de mise au point est réglée 
sur le bord supérieur/inférieur/gauche/droit de la 
plage de réglage.
ˎˎ Cette fonction n’est pas disponible dans les 

circonstances suivantes.
–– Lorsque Touch Operation (page 104) dans le 

menu Technical du menu complet est réglé sur Off
–– Lorsque la zone de mise au point est affichée en 

gris ou n’est pas affichée du tout

Ajustement de l’action de mise au point 
automatique (vitesse de transition AF, 
sensibilité de changement de sujet AF)

Vitesse de transition AF
Vous pouvez régler la vitesse d’entraînement 
de la mise au point pour les cas où le sujet 
change à l’aide de Focus >AF Transition Speed 
(page 83) dans le menu Shooting du menu 
complet.
Lors d’un réglage sur une vitesse basse, la 
mise au point se déplace en douceur lorsque 
le sujet à mettre au point change, ce qui 
permet de prendre de magnifiques images.
Lors d’un réglage sur une vitesse élevée, la 
mise au point change rapidement de sujet. 
La mise au point passe immédiatement sur le 
sujet entrant dans le cadre, rendant ce réglage 
idéal pour la prise de vue documentaire 
nécessitant une mise au point rapide.

Pendant la modification :
1(Slow) : la mise au point est 
lente
.
.
.
7(Fast) : la mise au point est 
rapide

Mise au point sur un sujet éloigné

Mise au point sur un sujet proche
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Sensibilité de changement de sujet AF
Vous pouvez régler la sensibilité de 
changement de sujet à l’aide de Focus >AF 
Subj. Shift Sens. (page 83) dans le menu 
Shooting du menu complet.
Lors d’un réglage sur une faible sensibilité, la 
mise au point ne change pas immédiatement 
même si un autre sujet passe devant le 
sujet de la mise au point. Lors d’un réglage 
sur une sensibilité élevée, la mise au point 
change pour donner la priorité au sujet en 
mouvement au premier plan.

[Conseil]
Si AF Speed/Sens. est attribué à une touche 
personnalisable, les barres de niveau pour l’ajustement 
des valeurs s’affichent dans l’ordre suivant à chaque fois 
que vous appuyez sur la touche, ce qui vous permet de 
modifier la vitesse de transition AF et les réglages de 
sensibilité de changement de sujet AF.
Vitesse de transition AF  Sensibilité de changement 
de sujet AF  Pas d’affichage …

AF Subj. Shift Sens. : 1(Locked On) AF Subj. Shift Sens. : 5(Responsive)

Mise au point lente sur un autre sujet Mise au point rapide sur un autre sujet

Modification manuelle de la cible de 
mise au point (AF Assist)

Lorsque vous réglez Focus >AF Assist 
(page 83) sur On dans le menu Shooting du 
menu complet, vous pouvez encore utiliser la 
bague de mise au point de l’objectif pendant 
la mise au point automatique pour régler la 
mise au point sur un sujet.
Lorsque vous arrêtez d’utiliser la bague de 
mise au point, la mise au point automatique 
continue de se faire sur le sujet mis au point 
à l’aide de la bague de mise au point (état 
d’assistance AF).
Après avoir utilisé la bague de mise au point, 
il est légèrement plus difficile de déplacer 
la mise au point sur un autre sujet, quel que 
soit le réglage Focus >AF Subj. Shift Sens. 
(page 83) dans le menu Shooting du menu 
complet.
L’état d’assistance AF est annulé par ce qui 
suit.
ˎˎ Lorsque le sujet mis au point à l’aide de la 
bague de mise au point n’est plus visible
ˎˎ Lors du passage à la mise au point manuelle
ˎˎ Lorsque l’AF de suivi en temps réel est 
démarré

[Conseils]
ˎˎ L’état d’assistance AF peut être annulé rapidement 

en utilisant une touche personnalisable (page 49) 
attribuée avec Push AF/Push MF.
ˎˎ L’AF de suivi en temps réel s’arrête lorsque la bague 

de mise au point est actionnée.
ˎˎ En mode Face/Eye Only AF, la mise au point 

automatique se fait sur le visage le plus proche de la 
position de la bague de mise au point.
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Utilisation temporaire de la mise au 
point manuelle (Push Manual Focus)

Appuyez sur la touche PUSH AUTO FOCUS 
(page 4) en mode de mise au point 
automatique pour changer manuellement la 
mise au point lorsque la touche est enfoncée.
La mise au point repasse en mode 
automatique quand vous relâchez la touche.
Ceci vous permet d’arrêter temporairement la 
mise au point automatique et de l’effectuer 
manuellement lorsqu’un élément n’étant pas 
le sujet de la prise de vue passe devant le 
sujet.

[Conseil]
La même opération est possible avec une touche 
personnalisable (page 49) à laquelle vous avez 
attribué Push AF/Push MF.

Suivi à l’aide de la détection des 
visages/yeux (Face/Eye Detection 
AF)

Le caméscope peut détecter les visages et les 
yeux des personnes en tant que cible à suivre 
et ensuite ajuster la mise au point sur les 
visages et les yeux au sein de la zone de mise 
au point.
Cette fonction est uniquement disponible 
lorsque le mode de mise au point est le mode 
AF ou pendant la mise au point automatique 
par pression.
Lorsque des visages sont détectés, des 
cadres de détection des visages/yeux gris 
sont affichés. Lorsque la mise au point 
automatique est possible, les cadres 
deviennent blancs et le suivi démarre. Lorsque 
des yeux sont détectés et que la mise au point 
est ajustée, le cadre de détection des visages/
yeux s’affiche sur les yeux. Lorsque plusieurs 
personnes sont détectées, le sujet principal 
est déterminé de manière automatique.

[Conseils]
ˎˎ Lorsque vous réglez la zone de mise au point sur 

Zone ou Flexible Spot et que les visages ou les yeux 
chevauchent la zone de mise au point spécifiée, les 
cadres de détection des visages/yeux deviennent 
blancs et le caméscope effectue la mise au point sur 
ces visages/yeux.
ˎˎ Lorsque vous utilisez la mise au point automatique 

par pression (AF-S), les cadres de détection des 
visages/yeux pour les visages/yeux ciblés par la mise 
au point deviennent verts.

Réglez la fonction de détection des visages/
yeux AF à l’aide de Focus >Face/Eye Detection 
AF (page 83) dans le menu Shooting.

Face/Eye Only AF :
La caméra détecte les visages/yeux des sujets 
(personnes), et la mise au point et le suivi se 
font uniquement sur leurs visages/yeux. Tant 
qu’aucun visage ou œil n’est détecté, l’AF est 
temporairement arrêté et l’icône  (pause 
AF) (page 11) s’affiche. Ce mode est utile 
lorsque souhaitez réaliser une mise au point 
automatique et un suivi uniquement sur les 
visages/yeux.

Face/Eye Priority AF :
La caméra détecte les visages/yeux des sujets 
(personnes) et la mise au point/le suivi se 
fait en priorité sur les visages/yeux. Si aucun 
visage ou œil n’est détecté, la mise au point 
repasse en mode AF (réglage par défaut).

Off :
La fonction de détection des visages/yeux AF 
est désactivée.

[Remarques]
ˎˎ Durant la mise au point automatique par pression, 

Face/Eye Priority AF est activé même si Face/Eye Only 
AF est actuellement sélectionné.
ˎˎ Lorsque le commutateur FOCUS est réglé sur MAN, 

la fonction de détection des visages/yeux AF est 
désactivée (sauf pendant l’opération de mise au point 
automatique par pression).
ˎˎ Si vous mettez le caméscope hors tension alors que 

Face/Eye Only AF est sélectionné, le mode passe 
automatiquement à Face/Eye Priority AF lorsque le 
caméscope est ensuite mis sous tension.

Masquer les cadres de détection des 
visages/yeux

Vous pouvez afficher/masquer les cadres 
de détection des visages/yeux à l’aide de 
Display On/Off >Face/Eye Detection Frame 
(page 98) dans le menu Monitoring du 
menu complet.

[Remarque]
Les cadres verts de détection des visages/yeux 
s’affichent pour les visages et les yeux ciblés par la mise 
au point à l’aide de la mise au point automatique par 
pression (AF-S). Ils ne sont pas masqués par l’utilisation 
de la touche DISPLAY ni quand vous réglez Face/Eye 
Detection Frame sur Off.

Commutation de l’opération de 
détection des visages/yeux AF à l’aide 
d’une touche personnalisable

Attribuez Face/Eye Detection AF à une touche 
personnalisable (page 49). Vous pouvez 
alors commuter l’opération de détection des 
visages/yeux AF dans l’ordre Face/Eye Priority 
AF, Face/Eye Only AF, et Off à chaque pression 
de la touche.

Réglage à l’aide du menu direct

Vous pouvez également sélectionner 
l’opération de détection des visages/yeux AF 
à l’aide du menu direct (page 49).
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Suivi d’un sujet spécifié (Realtime 
Tracking AF)

Vous pouvez maintenir la mise au point sur un 
sujet en spécifiant le sujet par une opération 
tactile ou en sélectionnant un cadre de 
détection des visages.
Lorsqu’un sujet est sélectionné, un cadre de 
suivi blanc s’affiche et le suivi démarre.

[Conseils]
ˎˎ Le suivi se produit dans la zone d’image entière, 

indépendamment du réglage de la zone de mise au 
point.
ˎˎ Lorsque Focus >Touch Function in MF (page 83) 

dans le menu Shooting est réglé sur Tracking AF, 
l’AF de suivi en temps réel est pris en charge même 
lorsque le mode de mise au point est le mode MF.

Les actions suivantes se produisent pour 
la cible de suivi, en fonction du mode de 
fonctionnement AF de détection des visages/
yeux.

Face/Eye Only AF, Face/Eye Priority AF :
À utiliser pour la mise au point et le suivi d’un 
sujet spécifié.
Si la cible de suivi est une personne et un 
visage/des yeux sont détectés, la caméra 
effectue la mise au point sur ce visage/ces 
yeux.
Lorsque le visages/les yeux d’une cible de 
suivi sont détectés, le visage de la cible 
de suivi est enregistré. Une fois qu’il est 
enregistré, une icône  (visage de suivi 
enregistré) (page 11) s’affiche.

[Remarque]
Si l’AF de suivi est démarré lors de la mise au point 
manuelle, le visage de la cible de suivi n’est pas 
enregistré.

Off :
Mise au point et suivi du sujet spécifié.
La détection des visages/yeux ne se produit 
pas, même si la cible de suivi est une 
personne.

[Remarque]
La fonction Realtime Tracking AF ne fonctionne pas si 
l’objectif est réglé pour la mise au point manuelle.

Démarrage de l’AF de suivi en temps 
réel

Lorsqu’un sujet spécifique est spécifié comme 
cible de suivi, le suivi de cette cible démarre.

Spécification par une opération tactile
Appuyez sur le sujet ciblé à suivre dans l’un 
des états suivants :
ˎˎ Lorsque le mode de mise au point est 
le mode MF ou lors de la mise au point 
manuelle par pression, et lorsque Focus 
>Touch Function in MF (page 83) dans le 
menu Shooting est réglé sur Tracking AF
ˎˎ Lorsque le mode de mise au point est le 
mode AF ou pendant la mise au point 
automatique (AF) par pression

[Remarque]
La spécification d’une cible par une opération 
tactile n’est pas disponible lorsque Touch Operation 
(page 104) dans le menu Technical est réglé sur Off.

Spécification par la sélection d’un cadre de 
détection des visages
Déplacez le curseur de sélection de visage 
(soulignement orange) sur le sujet cible 
à suivre à l’aide du sélecteur multiple 
(page 7) et appuyez sur le sélecteur 
multiple.

Cadres de détection 
d’autres visages (gris) Cadre de suivi

Curseur de sélection de visage (orange)

[Conseils]
ˎˎ Vous pouvez également changer de cible à suivre lors 

de l’AF de suivi en temps réel.
ˎˎ Si une touche personnalisable (page 49) attribuée 

avec la fonction Focus Magnifier est enfoncée lors de 
l’AF de suivi en temps réel, l’état de suivi est conservé 
et la mise au point est agrandie. Cependant, vous 
ne pouvez pas spécifier de cible à suivre lors de 
l’agrandissement de la mise au point.

[Remarque]
Lors de la mise au point manuelle, le suivi ne peut pas 
être démarré par la sélection de cadre de détection des 
visages.

Arrêt de l’AF de suivi en temps réel

Arrêt par une opération tactile
Appuyez sur la touche  (arrêt de l’AF de 
suivi en temps réel) affichée en haut à gauche 
du panneau tactile.

[Conseils]
ˎˎ L’AF de suivi en temps réel s’arrêtera dans les cas 

suivants :
–– Lorsque le commutateur FOCUS ou la commande 

AUTO/MAN sur l’objectif est commuté
–– Lorsque le mode de mise au point est modifié

–– Lorsque l’aide pour la mise au point automatique 
est exécutée

–– Lorsque le réglage de la zone de mise au point ou 
l’action de l’AF de détection des visages/yeux est 
modifié

–– Lorsqu’une touche personnalisable attribuée avec 
Push AF/Push MF est enfoncée

–– Lorsque la cible de suivi n’est pas comprise dans 
l’écran de prise de vue ou que le sujet est flou 
pendant quelques secondes

ˎˎ Lorsqu’un visage de suivi est enregistré (lorsque 
l’icône «   » (visage de suivi enregistré) s’affiche), 
l’AF de suivi en temps réel reprend lorsque le visage 
de suivi enregistré entre dans la zone d’image. Pour 
effacer le visage de suivi, arrêtez l’AF de suivi en 
temps réel comme indiqué ci-dessus.



3. Prise de vue43

Réglage de la luminosité

B

C
D
E

F
H

I

A

Vous pouvez régler la luminosité en réglant le 
diaphragme, le gain, la vitesse d’obturateur, 
ainsi qu’en réglant le niveau de luminosité à 
l’aide des filtres ND. Vous pouvez également 
procéder à des réglages automatiques.
Le niveau cible pour le réglage automatique 
de la luminosité se règle à l’aide de Auto 
Exposure (page 80) >Level dans le menu 
Shooting du menu complet. Vous pouvez 
également attribuer Auto Exposure Level à 
une touche personnalisable ou à une molette 
personnalisable (page 49).

[Remarques]
ˎˎ Le gain ne peut pas être réglé en mode de prise de 

vue Cine EI/Cine EI Quick. La sensibilité de base est 
fixée. De même, la luminosité ne peut pas être ajustée 
automatiquement en utilisant la vitesse d’obturation. 
L’ajustement automatique de la luminosité à l’aide du 
diaphragme et du filtre ND est pris en charge.
ˎˎ Depuis la version de logiciel 4.0, le réglage 

automatique de la luminosité fonctionne de sorte 
que l’image soit correctement exposée avec le LUT 
appliqué.

Sélection de la sensibilité de base

Vous avez le choix entre deux types de 
sensibilité de base sur le caméscope.
En mode de prise de vue Custom, vous pouvez 
régler la sensibilité de base sur High ou Low 
à l’aide de Base ISO/Sensitivity sur l’écran 
d’état Main (page 14) ou sur l’écran d’état 
Camera (page 14), ou de ISO/Gain/EI >Base 
Sensitivity (page 79) dans le menu Shooting 
du menu complet.
En mode de prise de vue Cine EI/Flexible ISO, 
vous pouvez régler l’ISO de base sur ISO 12800 
ou ISO 800 à l’aide de Base ISO/Sensitivity sur 
l’écran d’état Main (page 14) ou sur l’écran 
d’état Camera (page 14), ou de ISO/Gain/EI 
>Base ISO (page 79) dans le menu Shooting 
du menu complet.
En mode de prise de vue Cine EI Quick, une 
sensibilité de base ISO 12800 ou ISO 800 
adaptée au réglage Exposure Index est 
sélectionnée automatiquement.
Il est recommandé de sélectionner Low ou 
ISO 800 dans des conditions d’éclairage 
normales et de sélectionner High ou ISO 12800 
dans des conditions d’éclairage faibles.

*	 Pouvant également être configurés sur l’écran d’état.

[Conseil]
Vous pouvez également attribuer Base ISO/Sensitivity à 
une touche personnalisable (page 49).

Réglage du diaphragme

Vous pouvez régler le diaphragme pour régler 
la luminosité.

Réglage automatique du diaphragme

Cette fonction règle la luminosité en fonction 
du sujet. Un objectif prenant en charge le 
diaphragme automatique est requis.

1	 Si un objectif avec commutateur Auto Iris 
est fixé, placez le commutateur sur AUTO.

2	 Maintenez enfoncée la touche de fonction 
IRIS (E) pour afficher le menu direct 
(page 49) et sélectionnez Auto.

	 [Conseil]
Vous pouvez également attribuer Auto Iris à une 
touche personnalisable (page 49).

	 [Remarque]
Le diaphragme peut être ajusté automatiquement 
sur un objectif monté en A.

Réglage manuel du diaphragme

1	 Maintenez enfoncée la touche de fonction 
IRIS (E) pour afficher le menu direct 
(page 49) et sélectionnez Manual.

2	 Appuyez sur la touche de fonction IRIS (E) 
pour afficher la valeur du diaphragme sur 
un arrière-plan blanc.

3	 Tournez la molette multifonction pour 
régler la valeur.

	 [Conseils]
ˎˎ Vous pouvez aussi utiliser la molette 

multifonction comme molette IRIS (page 49) 
en affectant la fonction IRIS à la molette 
multifonction.
ˎˎ Vous pouvez également affecter la fonction IRIS 

à une molette personnalisable (page 49).

Réglage automatique temporaire

Appuyez sur la touche personnalisable 
(page 49) à laquelle la fonction Push Auto 
Iris est affectée pour régler automatiquement 
le diaphragme de façon temporaire lorsque la 
touche est enfoncée.
Le diaphragme revient au réglage précédent 
quand vous relâchez la touche.

[Remarques]
ˎˎ Quand le commutateur Auto Iris de l’objectif est réglé 

sur MANUAL, les fonctions Auto Iris et Push Auto 
Iris du caméscope n’ont aucun effet. Les réglages 
manuels de diaphragme sur le caméscope ne 
fonctionnent également pas.
ˎˎ Push Auto Iris ne peut pas être exécuté lorsque Iris > 

Bokeh Control (page 80) dans le menu Shooting 
est réglé sur On.

Réglage du gain

En mode de prise de vue Custom/Flexible 
ISO, vous pouvez régler le gain pour régler la 
luminosité.

Réglage automatique du gain

Maintenez enfoncée la touche de fonction 
ISO/GAIN (H) pour afficher le menu direct 
(page 49) et sélectionnez Auto.

[Conseils]
ˎˎ Vous pouvez aussi effectuer la même action en 

réglant Auto Exposure (page 80) >AGC sur On dans 
le menu Shooting.
ˎˎ Vous pouvez également attribuer AGC à une touche 

personnalisable (page 49).

Réglage manuel du gain

Vous pouvez surveiller le gain lorsque vous 
souhaitez ajuster l’exposition tout en utilisant 
un réglage de diaphragme fixe ou lorsque 
vous souhaitez éviter que le gain n’augmente 
à cause de l’AGC.

1	 Maintenez enfoncée la touche de fonction 
ISO/GAIN (H) pour afficher le menu direct 
(page 49) et sélectionnez Manual.

2	 Réglez le commutateur ISO/GAIN (I) sur H, 
M ou L.
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[Conseils]
ˎˎ Vous pouvez modifier la valeur prédéfinie de 

chaque position de commutateur à l’aide de ISO/
Gain<L>/<M>/<H> (page 14) sur l’écran d’état 
Camera ou de ISO/Gain/EI >ISO/Gain<H>/<M>/<L> 
(page 78) dans le menu Shooting du menu 
complet.
ˎˎ Vous pouvez également attribuer Push AGC à une 

touche personnalisable et régler AGC sur On de 
manière temporaire en appuyant sur la touche et en 
la maintenant enfoncée.

[Remarques]
ˎˎ Push AGC ne peut pas être exécuté lorsque Iris 

>Bokeh Control (page 80) dans le menu Shooting 
du menu complet est réglé sur On.
ˎˎ Push AGC ne peut pas être exécuté en mode de prise 

de vue Cine EI/Cine EI Quick.

Contrôle du gain (réglage précis)

1	 Appuyez sur la touche de fonction ISO/
GAIN (H) pour afficher la valeur de gain 
sur un arrière-plan blanc.

2	 Tournez la molette multifonction pour 
régler la valeur.

[Conseil]
Passez sur une valeur de gain préréglée en fonction du 
réglage du commutateur ISO/GAIN (I).

Contrôle temporaire du gain (réglage 
précis)

Tournez la molette personnalisable 
(page 49) à laquelle la fonction ISO/Gain/
EI est attribuée pour ajuster la valeur de gain 
définie par le commutateur ISO/GAIN (I).
Cela est utile lorsque vous souhaitez régler 
l’exposition d’un seul incrément sans changer 
la profondeur de champ.
La valeur de gain réglée est annulée lors de la 
commutation du commutateur ISO/GAIN (I), 
de la modification de la sensibilité de base, 
du réglage d’AGC sur On ou de la mise hors 
tension.

[Conseils]
ˎˎ Vous pouvez aussi affecter cette fonction à la molette 

multifonction (page 49).
ˎˎ Vous pouvez également attribuer Push AGC à une 

touche personnalisable et régler AGC sur On de 
manière temporaire en appuyant sur la touche et en 
la maintenant enfoncée.

[Remarques]
ˎˎ Push AGC ne peut pas être exécuté lorsque Iris 

>Bokeh Control (page 80) dans le menu Shooting 
du menu complet est réglé sur On.
ˎˎ Push AGC ne peut pas être exécuté en mode de prise 

de vue Cine EI/Cine EI Quick.

Réglage d’Exposure Index

En mode de prise de vue Cine EI/Cine EI Quick, 
il est considéré que la sortie vidéo avec MLUT 
réglé sur Off est enregistrée comme signal 
principal. Lorsque vous changez la luminosité 
de l’image avec MLUT On pour correspondre 
à la valeur EI, vous pouvez vérifier le résultat 
du réglage de la sensibilité d’exposition qui se 
produira pendant la post-production lors de la 
prise de vue.
Vous pouvez changer la valeur EI en réglant le 
commutateur ISO/GAIN (I) sur H, M ou L.
En mode de prise de vue Cine EI Quick, vous 
pouvez modifier la sensibilité de base en 
même temps que la valeur EI.

[Conseil]
Vous pouvez modifier la valeur EI de chaque position 
de commutateur avec ISO/Gain/EI (page 14) dans 
le menu d’état Camera ou à l’aide de ISO/Gain/EI 
>Exposure Index<H>/<M>/<L> (page 78) dans le 
menu Shooting du menu complet.

Réglage précis de l’indice de pose

1	 Appuyez sur la touche de fonction ISO/
GAIN (H) pour afficher la valeur EI sur un 
arrière-plan blanc.

2	 Tournez la molette multifonction pour 
régler la valeur.

[Conseil]
Passez sur une valeur EI préréglée en fonction du 
réglage du commutateur ISO/GAIN (I).

Réglage de l’obturateur

Vous pouvez régler l’obturateur pour régler la 
luminosité.

Réglage automatique de l’obturateur

Maintenez enfoncée la touche de fonction 
SHUTTER (F) pour afficher le menu direct 
(page 49) et sélectionnez Auto pour régler 
automatiquement la vitesse d’obturation 
ou l’angle d’obturation en fonction de la 
luminosité de l’image.

[Conseil]
Vous pouvez aussi effectuer la même action en réglant 
Auto Exposure >Auto Shutter (page 81) sur On dans le 
menu Shooting du menu complet.

Réglage manuel de l’obturateur

1	 Maintenez enfoncée la touche de fonction 
SHUTTER (F) pour afficher le menu direct 
(page 49) et sélectionnez Speed ou 
Angle.

2	 Appuyez sur la touche de fonction 
SHUTTER (F) pour afficher la valeur de 
l’obturateur sur un arrière-plan blanc.

3	 Tournez la molette multifonction pour 
régler la valeur de l’obturateur.

[Conseils]
ˎˎ Pour régler la durée d’exposition afin qu’elle 

corresponde à l’intervalle d’image, sélectionnez Off 
à l’étape 1.

ˎˎ Vous pouvez également définir l’angle et régler la 
fréquence (page 79).

Réglage du niveau de luminosité 
(ND Filter)

Lorsque l’éclairage est trop fort, vous pouvez 
régler la luminosité appropriée en changeant 
le filtre ND.
Le caméscope comporte deux modes de 
filtre ND. Vous pouvez basculer entre les 
deux modes en utilisant le commutateur ND 
PRESET/VARIABLE.

Réglage en mode prédéfini

Placez le commutateur ND PRESET/VARIABLE 
(A) en position PRESET et réglez les touches 
haut/bas ND FILTER POSITION (B) sur l’un des 
réglages suivants.
Clear : pas de filtre ND
1 : transmittance définie par ND Filter >Preset1 
(page 79) dans le menu Shooting du menu 
complet.
2 : transmittance définie par ND Filter >Preset2 
(page 79) dans le menu Shooting du menu 
complet.
3 : transmittance définie par ND Filter >Preset3 
(page 79) dans le menu Shooting du menu 
complet.

Réglage en mode variable

Réglez le commutateur ND PRESET/VARIABLE 
(A) en position VARIABLE. Basculez les touches 
haut/bas ND FILTER POSITION (B) entre CLEAR 
et On.
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Réglage automatique du niveau de luminosité
Vous pouvez régler Auto ND Filter sur On pour 
activer l’ajustement d’exposition automatique 
à l’aide du filtre ND.

1	 Appuyez sur la touche [+] des touches 
haut/bas ND FILTER POSITION (B) pour 
activer le fonctionnement du filtre ND.

2	 Maintenez enfoncée la touche ND 
VARIABLE AUTO (C) jusqu’à sélectionner 
Auto.

Réglage manuel du niveau de luminosité

1	 Appuyez sur la touche [+] des touches 
haut/bas ND FILTER POSITION (B) pour 
activer le fonctionnement du filtre ND.

2	 Maintenez enfoncée la touche ND 
VARIABLE AUTO (C) jusqu’à sélectionner 
Manual.

3	 Tournez la molette ND VARIABLE (D) pour 
régler la transmittance du filtre.

[Conseil]
Vous pouvez également affecter la fonction ND Filter à 
une molette personnalisable (page 49).

Réglage automatique temporaire
Vous pouvez attribuer Push Auto ND à une 
touche personnalisable (page 49), et 
régler de manière temporaire Auto ND Filter 
sur On en appuyant sur cette touche et en 
la maintenant enfoncée. Auto ND Filter sera 
de nouveau réglé sur Off si vous relâchez la 
touche.
Appuyez sur la touche [+] des touches haut/
bas ND FILTER POSITION (B) pour activer le 
fonctionnement du filtre ND.

[Remarques]
ˎˎ Lorsque le filtre ND est basculé sur ou depuis CLEAR 

lors de la prise de vue, le cadre de filtre ND s’affiche 
sur l’image et le son de fonctionnement est inclus 
dans l’audio.
ˎˎ Push Auto ND ne peut pas être exécuté lorsque Iris 

> Bokeh Control (page 80) dans le menu Shooting 
est réglé sur On.

[Conseils]
ˎˎ Vous pouvez régler sur CLEAR en tournant la molette 

ND VARIABLE (D) vers le bas depuis ND1/4. Si depuis 
CLEAR vous tournez la molette vers le haut, vous 
configurez ND1/4. Vous pouvez désactiver cette action 
à l’aide de ND Dial >CLEAR with Dial (page 104) dans 
le menu Technical du menu complet.
ˎˎ Vous pouvez également attribuer ND Filter Position à 

une touche personnalisable (page 49) et appuyer 
sur la touche au lieu d’utiliser les touches haut/bas 
ND FILTER POSITION pour changer le réglage.  
Mode prédéfini : Clear  Preset1  Preset2 
 Preset3  Clear… 
Mode variable : Clear  On  Clear…
ˎˎ Vous pouvez également attribuer Auto ND Filter à une 

touche personnalisable (page 49) et appuyer sur la 
touche pour commuter Auto ND filter entre On et Off.
ˎˎ Lorsque vous filmez un sujet lumineux, une fermeture 

trop importante du diaphragme peut provoquer un 
flou de diffraction, qui crée une image commençant à 
perdre sa netteté (phénomène typique des caméras 
vidéo). Vous pouvez supprimer cet effet pour obtenir 
de meilleurs résultats de prise de vue en utilisant le 
filtre ND.
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Vous pouvez sélectionner le mode de réglage 
pour vous adapter aux conditions de prise de 
vue.

ATW (équilibre des blancs à suivi 
automatique)

Cette fonction ajuste l’équilibre des blancs 
automatiquement à un niveau approprié.
L’équilibre des blancs est automatiquement 
ajusté quand la température de couleur de la 
source de lumière change.
Maintenez enfoncée la touche de fonction 
WHT BAL (G) pour afficher le menu direct 
(page 49) et sélectionnez ATW.
Vous pouvez sélectionner la vitesse de réglage 
(cinq incréments) à l’aide de White Setting 
>ATW Speed (page 82) dans le menu 
Shooting du menu complet.

[Conseil]
Vous pouvez geler le réglage d’équilibre des blancs 
actuel en assignant la fonction ATW Hold à une touche 
personnalisable (page 49) et en appuyant sur la 
touche personnalisable pour mettre temporairement le 
mode ATW en pause.

[Remarques]
ˎˎ ATW ne peut pas être utilisé en mode de prise de vue 

Cine EI/Cine EI Quick.
ˎˎ Il peut ne pas être possible de s’ajuster sur la couleur 

appropriée à l’aide d’ATW, en fonction des conditions 
d’éclairage et de sujet.  
Exemples :
–– Quand une couleur unique domine le sujet, comme 

par exemple le ciel, la mer, la terre ou des fleurs.
–– Quand la température de couleur est extrêmement 

élevée ou faible.
	 Si l’effet approprié ne peut pas être obtenu parce que 

la vitesse de suivi automatique d’ATW est lente ou 
pour d’autres raisons, utilisez l’équilibre des blancs 
automatique.

Réglage manuel de l’équilibre des 
blancs

1	 Lorsque l’équilibre des blancs est réglé sur 
le mode ATW, maintenez enfoncée la 
touche de fonction WHT BAL (G) pour 
afficher le menu direct (page 49) et 
sélectionnez W:P, W:A ou W:B.

2	 Sélectionnez B, A ou PRESET à l’aide du 
commutateur WHT BAL (J).
B : mode de mémoire B
A : mode de mémoire A
PRESET : mode prédéfini

[Conseil]
Vous pouvez activer ATW pour la mémoire B en réglant 
White Setting >White Switch<B> (page 82) sur ATW 
dans le menu Shooting du menu complet.

Mode de mémoire A/mémoire B
Ce mode ajuste l’équilibre des blancs au 
réglage sauvegardé sous la mémoire A ou la 
mémoire B, respectivement.

Mode prédéfini
Ce mode ajuste la température de couleur sur 
une valeur préréglée (la valeur par défaut est 
3200K).

Modification de la valeur prédéfinie par 
défaut

En mode prédéfini, vous pouvez modifier 
directement une valeur prédéfinie existante.
Maintenez enfoncée la touche de fonction 
WHT BAL (G) et sélectionnez l’un des 
paramètres suivants dans le menu direct.
Custom :  3200K,  4300K,  5600K, 

 6300K
Prises de vue Log :  3200K,  4300K, 

 5500K

[Conseil]
Vous pouvez également attribuer Preset White Select à 
une touche personnalisable (page 49) et appuyer sur 
la touche pour changer le réglage.
Custom : 3200K  4300K  5600K  6300K 
 3200K…

Prises de vue Log : 3200K  4300K  5500K 
 3200K…

Modification de la température de 
couleur

1	 Appuyez sur la touche de fonction WHT 
BAL (G) pour afficher la valeur de la 
température de couleur sur un arrière-
plan blanc.

2	 Tournez la molette multifonction pour 
régler la valeur.

[Conseils]
ˎˎ En mode prédéfini, vous pouvez régler la valeur par 

unités de 100K.
ˎˎ En mode mémoire, vous pouvez régler la valeur par 

incréments de 20K dans une plage de 2000K à 5600K. 
Vous pouvez définir les valeurs supérieures à 5600K 
à des intervalles égaux à la quantité de changement 
de couleur (mired) de 5580K à 5600K. Vous pouvez 
aussi régler la valeur de teinte à l’aide de White 
(page 81) >Tint dans le menu Shooting du menu 
complet.

Utilisation de l’équilibre des blancs 
automatique

L’équilibre des blancs à enregistrer dans le 
mode de mémoire A/mémoire B est configuré 
automatiquement.

1	 Sélectionnez le mode de mémoire A ou 
de mémoire B.

2	 Placez une feuille de papier blanc (ou tout 
autre objet) dans un lieu présentant la 
même source et les mêmes conditions de 
lumière que le sujet, puis effectuez un 
zoom avant sur le papier pour montrer la 
zone blanche sur l’écran.

3	 Réglez la luminosité.
Ajustez le diaphragme à l’aide de la 
procédure dans « Réglage manuel du 
diaphragme » (page 43).

4	 Appuyez sur la touche WB SET 
(page 4).
ˎˎ Si la balance des blancs automatique 
est utilisée en mode mémoire, le 
résultat de l’ajustement automatique est 
sauvegardé dans la mémoire (A ou B) 
sélectionnée à l’étape 1.
ˎˎ Si la balance des blancs automatique est 
exécutée en mode ATW, le résultat est 
hérité et le mode ATW reprend lorsque 
l’ajustement automatique est terminé. 
Ceci est utile lorsque vous souhaitez 
ajuster la balance des blancs très 
rapidement, quel que soit le réglage de 
la vitesse ATW.

[Remarque]
Si l’ajustement échoue, un message d’erreur s’affiche sur 
l’écran pendant environ trois secondes. Si le message 
d’erreur persiste après plusieurs tentatives de réglage 
de l’équilibre des blancs, contactez votre technicien 
Sony.

Réglage pour des couleurs naturelles (équilibre des blancs)
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Vous pouvez spécifier l’audio à enregistrer à 
l’aide des connecteurs, des commutateurs et 
des molettes d’entrée du caméscope.

Connecteurs et commutateurs d’entrée 
audio externe

Connecteur INPUT1 (page 7)
Connecteur INPUT2 (page 7)
Griffe à interfaces multiples (page 7)
Commutateur INPUT1 (LINE/MIC/MIC+48V) 
(page 7)
Commutateur INPUT2 (LINE/MIC/MIC+48V) 
(page 7)

Commutateurs permettant de régler le 
niveau audio

Commutateur CH1 (AUTO/MAN) (page 6)
Commutateur CH2 (AUTO/MAN) (page 6)
Molette AUDIO LEVEL (CH1) (page 6)
Molette AUDIO LEVEL (CH2) (page 6)

Écran d’état Audio

Sélection du dispositif d’entrée 
audio

1	 Configurez l’entrée audio à l’aide de CH1/
CH2/CH3/CH4 >Source (page 14) dans 
l’écran d’état Audio ou de Audio Input 
>CH1 Input Select à CH4 Input Select 
(page 101) dans le menu Audio du 
menu complet.
Si vous utilisez un microphone ou un 
adaptateur XLR connecté à la griffe à 
interfaces multiples, spécifiez Shoe CH1 ou 
Shoe CH2. Pour plus de détails sur 
l’adaptateur XLR, voir « Ajout de 
connecteurs d’entrée audio » (page 48).

	 [Remarques]
ˎˎ L’audio n’est pas enregistré en mode Interval Rec 

ou en mode Slow & Quick Motion.
ˎˎ Le caméscope comporte un microphone de 

narration intégré pour l’enregistrement du 
son d’ambiance. Il peut être utilisé pour la 
synchronisation avec d’autres appareils. Dans ce 
cas, spécifiez MIC interne.
ˎˎ Seul le microphone interne de la poignée 

(page 7) est actif pour l’enregistrement 
audio lorsque vous fixez la poignée. Lorsque 
la poignée n’est pas fixée, vous pouvez utiliser 
le microphone de narration (page 6) pour 
l’enregistrement du son d’ambiance.
ˎˎ Lorsque CH1 Input Select et CH2 Input 

Select sont réglés sur Internal MIC, le niveau 
d’enregistrement audio de CH1 et CH2 est 
réglé à l’aide de la molette AUDIO LEVEL(CH1) 
(page 6). Lorsque CH3 Input Select et CH4 
Input Select sont réglés sur Internal MIC, le niveau 
d’enregistrement audio de CH3 et CH4 est réglé à 
l’aide de CH3 Input Level (page 101).

2	 Sélectionnez la source audio d’entrée.
Réglez les commutateurs INPUT1/INPUT2 
(LINE/MIC/MIC+48V) sur les dispositifs 
raccordés aux connecteurs INPUT1/
INPUT2, respectivement.

Dispositif raccordé Position de 
commutateur

Source audio externe (p. 
ex., table de mixage)

LINE

Microphone dynamique, 
microphone à piles

MIC

Microphone à alimentation 
fantôme de +48 V

MIC+48V

ˎˎ Le fait de sélectionner MIC+48V et de 
connecter un microphone qui n’est 
pas compatible avec une source de 
+48 V peut endommager le dispositif 
connecté. Vérifiez le réglage avant de 
connecter le dispositif.
ˎˎ Si le bruit est un problème sur des 
connecteurs sur lesquels aucun 
dispositif n’est connecté, réglez les 
commutateurs INPUT1/INPUT2 (LINE/
MIC/MIC+48V) correspondants sur LINE.

Réglage automatique du niveau 
d’enregistrement audio

Réglez les commutateurs CH1/CH2 (AUTO/
MAN) des canaux sur AUTO pour qu’ils 
s’ajustent automatiquement.
Pour CH3/CH4, réglez la commande de niveau 
audio de l’écran d’état Audio (page 14) ou 
Audio Input >CH3 Level Control et CH4 Level 
Control sur Auto (page 101) dans le menu 
Audio du menu complet.

Réglage manuel du niveau 
d’enregistrement audio

Utilisez la procédure suivante pour régler le 
niveau d’enregistrement audio pour CH1/CH2.

1	 Réglez les commutateurs CH1/CH2 
(AUTO/MAN) des canaux sur MAN pour 
pouvoir les ajuster manuellement.

2	 Pendant la prise de vue ou la veille, 
tournez les molettes AUDIO LEVEL (CH1)/
(CH2) des canaux correspondants pour 
régler le niveau audio.
ˎˎ Pour CH3/CH4, réglez la commande 
de niveau audio à l’aide de CH3/CH4 
(page 14) dans l’écran d’état Audio 
ou de Audio Input >CH3 Level Control ou 
CH4 Level Control dans le menu Audio 
du menu complet sur Manual. Puis, 
réglez le niveau d’enregistrement audio 
à l’aide de CH3 Input Level ou CH4 Input 
Level.
ˎˎ Vous pouvez régler les niveaux de CH1 
à CH4 en tant que groupe. Vous pouvez 
ajuster le niveau d’enregistrement en 
utilisant la molette personnalisable 
(page 49) à laquelle la fonction Audio 
Input Level est attribuée, l’écran d’état 
Audio ou Audio Input >Audio Input Level 
dans le menu Audio du menu complet.

[Conseil]
L’écran d’état Audio est utile pour vérifier le niveau de 
l’entrée audio (page 14).

[Remarques]
ˎˎ Les réglages du niveau d’entrée audio peuvent être 

désactivés, en fonction de la combinaison de réglages 
dans le menu Audio. Pour en savoir plus, reportez-
vous au diagramme dans page 141.
ˎˎ Le caméscope prend en charge des combinaisons de 

plusieurs réglages. Pour en savoir plus, reportez-vous 
au diagramme dans page 141.

Réglage de l’audio à enregistrer
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Ajout de connecteurs d’entrée 
audio

Vous pouvez connecter simultanément jusqu’à 
quatre canaux de dispositifs audio XLR au 
caméscope en utilisant un adaptateur XLR-
K2M XLR (non fourni) ou XLR-K3M XLR (non 
fourni).
Fixez l’adaptateur XLR à la griffe à interfaces 
multiples et réglez CH3 >Source sur Shoe CH1 
et CH4 >Source sur Shoe CH2 dans l’écran 
d’état Audio (page 14). Ou réglez Audio 
Input >CH3 Input Select sur Shoe CH1 et CH4 
Input Select sur Shoe CH2 dans le menu Audio 
du menu complet.
Les fonctions du caméscope qui se 
superposent seront désactivées pour les 
canaux sur lesquels l’adaptateur XLR est 
sélectionné comme entrée. Utilisez les 
commutateurs et les molettes sur l’adaptateur 
XLR pour effectuer les réglages.

[Remarques]
ˎˎ Le caméscope prend en charge l’interface audio 

numérique 2 canaux du XLR-K3M.
ˎˎ Si Audio Input >CH3 Level et CH4 Level dans le menu 

Audio sont réglés sur Audio Input Level, Audio Input 
Level sur le caméscope sera alors multiplié par le 
niveau réglé sur l’adaptateur XLR.  
Audio Input Level est également activé lorsque le 
commutateur de l’adaptateur XLR est réglé sur AUTO.  
Lorsque « Through » est spécifié, l’audio sera 
enregistré au niveau réglé avec l’adaptateur XLR 
(page 142).
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Fonctions utiles

Utilisation du menu Direct

Vous pouvez vérifier l’état et les réglages du 
caméscope affichés sur l’écran du viseur, ainsi 
que sélectionner et modifier directement les 
réglages.
Les éléments suivants peuvent être 
configurés.
ˎˎ Face/Eye Detection AF
ˎˎ SteadyShot
ˎˎ White Mode
ˎˎ Color Temp
ˎˎ Scene File
ˎˎ ND Filter Position / Auto ND Filter
ˎˎ ND Filter Value
ˎˎ Auto Iris
ˎˎ Iris Value
ˎˎ AGC
ˎˎ Gain Value
ˎˎ ISO Value
ˎˎ Exposure Index Value
ˎˎ Auto Shutter / ECS
ˎˎ Shutter Value
ˎˎ Auto Exposure Mode
ˎˎ Auto Exposure Level
ˎˎ S&Q Motion Frame Rate

1	 Appuyez sur la molette multifonction ou 
sur une touche personnalisable à laquelle 
la fonction Direct Menu est attribuée.
Sur l’écran, vous pouvez uniquement 
sélectionner avec le curseur orange les 
éléments pouvant être configurés à l’aide 
du menu direct.

2	 Tournez la molette multifonction pour 
déplacer le curseur vers l’élément de 
menu à régler, puis appuyez sur la 
molette multifonction.
Un menu s’affiche ou l’élément s’affiche 
sur un arrière-plan blanc.

3	 Tournez la molette multifonction pour 
sélectionner un réglage, puis appuyez sur 
la molette multifonction.
Le menu ou l’arrière-plan blanc disparaît 
et le nouveau réglage s’affiche avec un 
curseur orange.
Appuyez à nouveau sur la touche 
personnalisable à laquelle la fonction 
Direct Menu est affectée ou attendez 
3 secondes sans réaliser d’action pour 
fermer menu direct.

	 [Conseils]
ˎˎ Vous pouvez aussi configurer les réglages 

directs en maintenant enfoncée chacune des 
touches de fonction (page 5).
ˎˎ Lorsque des éléments s’affichent sur un arrière-

plan blanc, vous pouvez utiliser la molette 
multifonction comme molette personnalisable.
ˎˎ Vous pouvez aussi utiliser le sélecteur multiple 

(page 9) pour les opérations de sélection.

Touches/molettes 
personnalisables

Il y a neuf touches personnalisables (page 6, 
7, 9) sur le caméscope, auxquelles vous 
pouvez attribuer des fonctions.
Vous pouvez également attribuer des 
fonctions à la molette multifonction 
du caméscope (page 5), à la 
molette personnalisable sur la poignée 
(page 7) et la molette personnalisable sur 
la télécommande de grip (page 9).

Changement de la fonction d’une 
touche

Utilisez Assignable Button (page 88) dans le 
menu Project du menu complet.
Vous pouvez visionner les fonctions 
attribuées sur l’écran d’état Assignable Button 
(page 15).

Fonctions attribuées à chaque touche 
assignable par défaut
Touche 1	 S&Q Motion
Touche 2	 AF Speed/Sens.
Touche 3	 Focus Setting
Touche 4	 Focus Magnifier x3/x6
Touche 5	 Direct Menu
Touche 6	 Off
Touche 7	 Focus Magnifier x3/x6
Touche 8	 Direct Menu
Touche 9	 Video Signal Monitor
Touche Focus Hold	 Focus Hold

Fonctions attribuables
ˎˎ Off
ˎˎ Base ISO/Sensitivity
ˎˎ AGC
ˎˎ Push AGC
ˎˎ ND Filter Position
ˎˎ Auto ND Filter
ˎˎ Push Auto ND
ˎˎ Auto Iris
ˎˎ Push Auto Iris
ˎˎ Bokeh Control
ˎˎ Auto Shutter
ˎˎ Auto Exposure Level
ˎˎ Backlight
ˎˎ Spotlight
ˎˎ Preset White Select
ˎˎ ATW
ˎˎ ATW Hold
ˎˎ AF Speed/Sens.
ˎˎ Focus Setting
ˎˎ Focus Area
ˎˎ Focus Area(AF-S)
ˎˎ Face/Eye Detection AF
ˎˎ Push AF Mode
ˎˎ Push AF/Push MF
ˎˎ Focus Hold
ˎˎ Focus Magnifier x3/x6
ˎˎ Focus Magnifier x3
ˎˎ Focus Magnifier x6
ˎˎ S&Q Motion
ˎˎ SteadyShot

ˎˎ Rec
ˎˎ Picture Cache Rec
ˎˎ Rec Review
ˎˎ Clip Flag OK
ˎˎ Clip Flag NG
ˎˎ Clip Flag Keep
ˎˎ Color Bars
ˎˎ Tally [Front]
ˎˎ DURATION/TC/U-BIT
ˎˎ Display
ˎˎ Lens Info
ˎˎ Video Signal Monitor
ˎˎ Marker
ˎˎ VF Adjust
ˎˎ VF Mode
ˎˎ Gamma Display Assist
ˎˎ Peaking
ˎˎ Zebra
ˎˎ Volume
ˎˎ Thumbnail
ˎˎ Touch Operation
ˎˎ Handle Zoom
ˎˎ NFC
ˎˎ Auto Upload (Proxy)
ˎˎ Direct Menu
ˎˎ User Menu
ˎˎ Menu

Changement de la fonction d’une 
molette

Vous pouvez modifier la fonction de la molette 
multifonction sur le caméscope, de la molette 
personnalisable du grip et de la molette 
personnalisable de la poignée.

Pour la molette multifonction, réglez à l’aide 
de Multi Function Dial (page 91) >Default 
Function dans le menu Project.
Off est attribué par défaut.
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Fonctions attribuables à la molette 
multifonction
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level

[Remarque]
Le réglage est désactivé lorsque le menu est affiché.

Pour la molette personnalisable, réglez avec 
Assignable Dial (page 90) dans le menu 
Project du menu complet.
IRIS est attribué partout par défaut.

[Conseil]
La molette personnalisable du RM-30BP (option) 
applique le réglage Grip/Remote Dial.

Fonctions attribuables à la molette 
personnalisable de la poignée/du grip
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ ND Filter
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level
ˎˎ Multi Function Dial

Vous pouvez visionner les fonctions 
attribuées sur l’écran d’état Assignable Button 
(page 15).

Slow & Quick Motion

Quand le format d’enregistrement (page 85) est réglé sur les valeurs suivantes, vous pouvez 
spécifier différentes valeurs pour la fréquence d’images de prise de vue et la fréquence d’images 
de lecture.

Format d’enregistrement Fréquence 
d’imagesFréquence du 

système
Mode Imager 
Scan

Codec Format vidéo

59.94/50/29.97/ 
25/23.98

FF RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I 4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 
180, 200, 240

XAVC-L 3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 
180, 200, 240

S35 XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

24 FF XAVC-I 4096×2160P 1–60

Vous pouvez activer/désactiver le mode Slow 
& Quick Motion en appuyant sur une touche 
personnalisable (page 49) à laquelle la 
fonction S&Q Motion est attribuée.
Vous pouvez régler la fréquence d’images 
pour la prise de vue en maintenant la touche 
enfoncée.

[Conseil]
Vous pouvez également régler le mode à l’aide de S&Q 
Frame Rate sur l’écran d’état Main, de Rec Function sur 
l’écran d’état Project et de S&Q Motion dans le menu 
Shooting du menu complet.

[Remarques]
ˎˎ Le mode Slow & Quick Motion ne peut pas être réglé 

pendant l’enregistrement, la lecture ou pendant 
l’affichage de l’écran de miniatures.
ˎˎ L’enregistrement audio n’est pas pris en charge en 

mode ralenti et accéléré.
ˎˎ La fonction de diaphragme automatique et la 

fonction d’obturation automatique sont désactivées 
en mode Slow & Quick Motion.

ˎˎ La mise au point automatique présente les limites 
suivantes en mode Slow & Quick Motion.
–– Limites dues au modèle d’objectif, à la fréquence 

du système et à la fréquence d’images de prise 
de vue

Objectif 
Sony

Fréquence du 
système

AF disponible

Autre que 
SEL16F28

– 7 fps ou plus 
pris en charge

SEL16F28 59.94/29.97/ 
23.98

30, 60, 120, 
240 fps pris en 
charge

50.00/25.00 25, 50, 100, 
200 fps pris en 
charge

24.00 Non pris en 
charge

–– La fonction de mise au point automatique est 
temporairement désactivée si le diaphragme est 
réglé sur F18 ou plus.

ˎˎ Pour plus de détails sur l’utilisation de la sortie RAW, 
consultez page 60.

Enregistrement de la vidéo par 
intermittence (Interval Rec)

La fonction Interval Rec du caméscope 
permet de capturer une vidéo en accéléré 
dans la mémoire interne du caméscope. Cette 
fonction est un moyen efficace pour la prise 
de vue de sujets en mouvement lent.
Lorsque vous commencez l’enregistrement, 
le caméscope enregistre automatiquement 
un nombre spécifique d’images (Number of 
Frames) à intervalles (Interval Time) spécifiés.

Intervalle de prise de vue (Interval Time)

Nombre d’images en une prise
(Number of Frames)

Lorsque Interval Rec est activé, la lumière 
de la vidéo HVL-LBPC (en option) s’allume 
automatiquement avant le début de 
l’enregistrement, ce qui vous permet 
d’enregistrer des images sous des conditions 
de lumière stable et de température de 
couleur (fonction de pré-éclairage).
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[Remarques]
ˎˎ Il est possible d’utiliser une seule fonction 

d’enregistrement spéciale, tel que l’enregistrement en 
mode Interval Rec.
ˎˎ Si un autre mode d’enregistrement spécial est activé 

alors que Interval Rec est en cours d’utilisation, ce 
dernier est automatiquement annulé.
ˎˎ Le mode Interval Rec est automatiquement activé 

après avoir modifié les réglages système tel que le 
format vidéo.
ˎˎ Les réglages Interval Rec ne peuvent pas être 

modifiés pendant l’enregistrement ou la lecture ou 
lorsque l’écran de miniatures s’affiche.

Pour régler Interval Rec

Sélectionnez Rec Function >Interval Rec 
sur l’écran d’état Project, et configurez les 
réglages Number of Frames et Interval Time.
Si vous utilisez la lampe vidéo HVL-LBPC 
(en option), réglez la durée d’intervalle pour 
allumer la lampe vidéo avant le démarrage de 
l’enregistrement à l’aide de Interval Rec >Pre-
Lighting dans le menu Project, tel que requis.

[Conseil]
Vous pouvez également configurer le mode à l’aide de 
Interval Rec (page 87) dans le menu Project du menu 
complet.

[Remarques]
ˎˎ Si vous voulez allumer la lampe vidéo avant le début 

de l’enregistrement, mettez l’interrupteur de lampe 
vidéo sur AUTO. La lampe vidéo s’allume et s’éteint 
automatiquement en fonction du réglage de Video 
Light Set (page 106) dans le menu Technical.
ˎˎ Si vous mettez l’interrupteur de la lampe vidéo sur 

On, la lampe reste toujours allumée (la lumière vidéo 
ne s’allume pas et ne s’éteint pas automatiquement).
ˎˎ Si la lampe vidéo est configurée pour s’éteindre 

pendant 5 secondes ou moins, la lampe vidéo ne 
s’éteint pas.

Le caméscope quitte le mode Interval Rec 
lorsqu’il est mis hors tension mais les réglages 
de nombre d’images (Number of Frames), de 
durée d’intervalle (Interval Time) et de pré-
éclairage (Pre-Lighting) sont maintenus. Vous 
n’aurez pas besoin de les régler de nouveau la 
fois suivante lorsque vous effectuez une prise 
de vue en mode Interval Rec.

Prise de vue en mode Interval Rec

Appuyez sur la touche d’enregistrement 
START/STOP pour démarrer l’enregistrement. 
« Int Rec » et « Int Stby » s’affichent 
alternativement dans le viseur.
Si vous utilisez la fonction de pré-éclairage, la 
lampe de la vidéo s’allume avant le démarrage 
de l’enregistrement.

Pour arrêter la prise de vue

Arrêtez l’enregistrement.
A la fin de la prise de vue, les données vidéo 
enregistrées dans la mémoire à ce point sont 
enregistrées sur le support.

Pour quitter le mode Interval Rec

Effectuez l’une des actions suivantes.
ˎˎ Réglez le commutateur POWER sur Off.
ˎˎ En mode d’attente d’enregistrement, réglez 
Rec Function sur un réglage autre que 
Interval Rec sur l’écran d’état Project.

De même, le mode Interval Rec est 
automatiquement relâché lorsque le 
caméscope est redémarré.

Limitations pendant l’enregistrement

ˎˎ L’audio n’est pas enregistré.
ˎˎ Le passage en revue de l’enregistrement 
(Rec Review) n’est pas possible.

Si le caméscope est mis hors tension 
pendant l’enregistrement
ˎˎ Si le commutateur POWER du caméscope 
est réglé sur la position Off, l’accès au 
support s’effectue pendant plusieurs 
secondes pour enregistrer les images 
sauvegardées dans la mémoire jusqu’à 
ce moment, puis l’appareil se met 
automatiquement hors tension.

ˎˎ Si l’alimentation est coupée car la batterie 
est retirée, le cordon d’alimentation CC 
débranché ou l’alimentation coupée à partir 
de l’adaptateur CA, les données vidéo et 
audio prises jusqu’à ce point peuvent être 
perdues (maximum 10 secondes). Faites 
attention en remplaçant la batterie.

Enregistrement d’images en cache 
(Picture Cache Rec)

La fonction Picture Cache Rec vous permet de 
tourner des vidéos à posteriori lorsque vous 
démarrez l’enregistrement en maintenant 
une mémoire cache interne d’une durée 
déterminée lors de la prise de vue.
Réglez Picture Cache Rec sur On dans l’écran 
d’état Project, puis réglez la taille du cache.

Réglage Cache 
Size

Durée de cache 
(approximative)

Short 5 secondes

Medium 10 secondes

Long 20 secondes

Max Valeur maximale ou 
chaque format 
d’enregistrement

[Conseils]
ˎˎ La durée du cache peut être plus courte, selon la 

fréquence d’images de prise de vue et le format 
d’enregistrement. Vérifiez l’affichage en bas à droite 
de l’écran de configuration de la taille du cache.
ˎˎ Vous pouvez également configurer le mode à l’aide 

de Picture Cache Rec (page 87) dans le menu 
Project du menu complet.
ˎˎ Vous pouvez également commuter Picture Cache Rec 

entre On et Off à l’aide d’une touche personnalisable 
(page 49).

[Remarques]
ˎˎ La fonction Picture Cache Rec ne peut pas être 

utilisée en combinaison avec la fonction Interval 
Rec, l’enregistrement simultané sur 2 fentes ou 
l’enregistrement proxy. Lorsque Picture Cache Rec est 
réglé sur On, ces autres fonctions d’enregistrement 
sont réglées sur Off de force.

ˎˎ Le mode Picture Cache Rec ne peut pas être 
sélectionné lorsqu’un enregistrement ou Rec Review 
est en cours.
ˎˎ Lorsque Picture Cache Rec est réglé sur On, le code 

temporel est enregistré en mode Free Run, même s’il 
est réglé sur Regen ou Rec Run (page 95).
ˎˎ Le réglage Output Format ne peut pas être configuré 

en mode Picture Cache Rec. Si celà se produit, 
désactivez temporairement Picture Cache Rec, puis 
modifiez le réglage.

Démarrage de Picture Cache Rec

Lorsque Picture Cache Rec est sur On, 
« Cache » ( vert) apparaît dans le viseur.
Lorsque vous appuyez sur la touche 
d’enregistrement START/STOP, 
l’enregistrement démarre et la vidéo 
est inscrite sur les cartes mémoire, en 
commençant par la vidéo stockée dans la 
mémoire cache.

Pour quitter Picture Cache Rec

Réglez Picture Cache Rec sur Off sur l’écran 
d’état Project, ou appuyez sur une touche 
personnalisable à laquelle est attribuée la 
fonction Picture Cache Rec.

[Remarques]
ˎˎ Si vous modifiez le format d’enregistrement ou le 

look de base, la vidéo dans la mémoire cache stockée 
jusqu’à présent est effacée, et la mise en cache 
d’une nouvelle vidéo démarre. Ainsi, il est impossible 
d’enregistrer des images en mode d’enregistrement 
de cache d’image avant le changement de format, 
même si vous commencez immédiatement à 
enregistrer après avoir changé le format.
ˎˎ Si Picture Cache Rec est réglé sur On ou Off 

immédiatement après avoir inséré une carte 
mémoire, les données de cache peuvent ne pas être 
enregistrées sur la carte.
ˎˎ La vidéo est stockée dans la mémoire cache lorsque 

la fonction Picture Cache Rec est réglée sur On. La 
vidéo précédant le réglage de la fonction sur On n’est 
pas mise en cache.
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ˎˎ La vidéo n’est pas stockée dans la mémoire cache 
tant qu’une carte mémoire est en cours d’accès, 
comme lors de la lecture, de la fonction Rec Review 
ou de l’affichage de l’écran des miniatures. Il est 
impossible d’enregistrer des vidéos en mode 
d’enregistrement de cache d’image pendant cet 
intervalle.

Enregistrement simultané sur les 
cartes mémoire A et B (2-slot 
Simul Rec)

Vous pouvez enregistrer simultanément 
sur la carte mémoire A et la carte mémoire 
B en réglant Simul Rec (page 15) dans 
l’écran d’état Project ou Simul Rec >Setting 
(page 87) dans le menu Project du menu 
complet sur On.

Enregistrement séparé sur la carte 
mémoire A et la carte mémoire B

Vous pouvez démarrer/arrêter 
l’enregistrement vers chaque carte mémoire 
indépendamment à l’aide des touches 
d’enregistrement START/STOP sur le 
caméscope et la poignée.
Par défaut, les deux touches sont réglées 
pour démarrer/arrêter simultanément 
l’enregistrement vers les deux cartes mémoire 
A et B.
ˎˎ « Rec Button:[SlotA SlotB] Handle Rec 
Button:[SlotA SlotB] »

Lorsque les touches sont réglées pour 
contrôler l’enregistrement de différentes 
cartes mémoire, le contrôle de démarrage/
arrêt d’enregistrement SDI/HDMI Rec Control 
(page 88) suit l’état d’enregistrement de la 
fente A.

Pour modifier le réglage

Sélectionnez Simul Rec >Rec Button Set 
(page 87) dans le menu Project.

Rec Button Set Touches et cartes 
mémoire

« Rec Button:[SlotA 
SlotB] Handle Rec 
Button:[SlotA SlotB] »

Démarrez/arrêtez 
simultanément 
l’enregistrement vers 
les cartes mémoire A 
et B à l’aide de l’une 
des touches.

« Rec Button:[SlotA] 
Handle Rec Button: 
[SlotB] »

La touche 
d’enregistrement 
START/STOP démarre/
arrête l’enregistrement 
vers la carte mémoire 
A et la touche 
d’enregistrement 
START/STOP de la 
poignée démarre/
arrête l’enregistrement 
vers la carte mémoire 
B.

« Rec Button:[SlotB] 
Handle Rec 
Button:[SlotA] »

La touche 
d’enregistrement 
START/STOP démarre/
arrête l’enregistrement 
vers la carte mémoire 
B et la touche 
d’enregistrement 
START/STOP de la 
poignée démarre/
arrête l’enregistrement 
vers la carte mémoire 
A.

[Conseil]
La touche d’enregistrement sur la télécommande du 
grip ou la télécommande LANC fonctionne de la même 
manière que la touche d’enregistrement START/STOP de 
l’appareil.

Pour éviter tout fonctionnement 
accidentel de la touche d’enregistrement 
START/STOP de la poignée

Réglez le commutateur HOLD de la poignée 
sur la position HOLD.

[Remarque]
Le commutateur HOLD de la poignée ne fonctionne pas 
lorsque HOLD Switch Setting (page 104) >with Rec 
Button est réglé sur Off dans le menu Technical du menu 
complet. Avec le réglage sur On, réglez Handle HOLD 
Switch sur Rec Button Only.

Pour activer le levier de zoom et les touches 
autres que la touche d’enregistrement START/
STOP de la poignée, réglez HOLD Switch 
Setting >Handle HOLD Switch sur Rec Button 
Only.

À propos du nom de fichier

Dans le cas d’un enregistrement simultané 
sur 2 fentes, le plan généré portera le même 
nom de plan sur les deux supports. Le nom 
de plan sera le même que le nom de plan lors 
de l’enregistrement dans la fente A pendant 
l’enregistrement normal.

Moniteur de signal vidéo

Vous pouvez régler le type de signal vidéo 
à afficher sur l’écran du viseur sur forme 
d’onde, vecteurscope ou histogramme en 
utilisant Display On/Off >Video Signal Monitor 
(page 99) dans le menu Monitoring.
La ligne orange indique la valeur définie du 
niveau zébré.
Vous pouvez également affecter la 
fonction Video Signal Monitor à une touche 
personnalisable (page 49).

Affichage de la cible du moniteur

En modes de prises de vue Log, les 
informations du réglage Color Gamut 
(page 24) ou du réglage Monitor LUT 
(page 83) s’affichent en haut à droite du 
moniteur de signal vidéo pour indiquer la cible 
du moniteur.
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Fonction d’aide pour l’affichage 
gamma

En mode de prise de vue Custom (page 24) 
lorsque Target Display est réglé sur HDR(HLG), 
vous pouvez régler Gamma Display Assist* 
sur l’écran d’état Monitoring sur On pour voir 
un affichage d’assistance dans le viseur qui 
facilite la prise de vue en HDR.
*	 Vous pouvez également configurer le fonction à l’aide 

de Gamma Display Assist >Setting (page 100) dans 
le menu Monitoring du menu complet.

Sélection de l’affichage du viseur 
lorsque la fonction d’aide pour 
l’affichage gamma est activée

Il existe deux méthodes d’affichage prises 
en charge pour l’affichage d’images HDR 
dans le viseur lorsque la fonction d’aide pour 
l’affichage gamma est activée.

Affichage HDR avec un contraste conservé 
entre les zones à faible luminance et les zones 
à forte luminance
Cette méthode tire parti de l’expressivité 
HDR pour afficher l’image dans le viseur sans 
provoquer des noirs cassés ou des réhauts 
accentués, même lors de la prise de vue 
avec une exposition lumineuse ou sombre. 
Cependant, le contraste est légèrement réduit.
Pour utiliser cette méthode d’affichage, réglez 
HDR Setting >VF SDR Preview (page 86) sur 
Off dans le menu Project du menu complet.

Affichage SDR par simple conversion de HDR 
vers SDR
Cette méthode vous permet de faire 
fonctionner la caméra avec la même sensation 
que la SDR conventionnelle.
Vous pouvez ajuster la luminosité de l’image 
HDR en réglant la différence de gain entre 
HDR et SDR à l’aide de SDR Gain.
Pour utiliser cette méthode d’affichage, 
effectuez les configurations selon la procédure 
suivante.

1	 Réglez HDR Setting >VF SDR Preview 
(page 86) sur On dans le menu Project 
du menu complet.

2	 Ajustez la valeur de gain SDR en mode 
HDR à l’aide de HDR Setting >SDR Gain 
(page 87) dans le menu Project du 
menu complet.

[Conseil]
Lors de la conversion d’une image HDR vers SDR à l’aide 
de SR Live Metadata après la prise de vue, SDR Gain 
est appliqué à la conversion de sorte que l’affichage 
d’image SDR ait la même exposition que ce qui était 
visualisé dans le viseur au moment de la prise de vue.

Balises de plan

Vous pouvez ajouter une balise de plan OK à 
un plan en appuyant sur la touche Clip Flag 
(page 5) et en sélectionnant Add OK.
Vous pouvez supprimer une balise de plan 
OK en appuyant deux fois sur la touche et en 
sélectionnant Delete Clip Flag.

[Conseils]
ˎˎ Vous pouvez également utiliser une touche 

personnalisable à laquelle la fonction de balise de 
plan est attribuée pour ajouter des balises de plan 
(page 49).
ˎˎ En outre, vous pouvez ajouter une balise de plan 

à l’aide de Set Clip Flag (page 103) dans le menu 
Thumbnail du menu complet (page 71).
ˎˎ L’écran des miniatures peut être affiché selon le type 

de balise de plan (écran des miniatures de plans 
filtré). Pour plus de détails, consultez « Opérations sur 
les plans » (page 71).

Compensation de la respiration

Vous pouvez définir si vous souhaitez 
effectuer une compensation de respiration 
pour l’objectif à l’aide de Lens >Breathing 
Compensation (page 106) dans le menu 
Technical du menu complet.
Cette fonction corrige le phénomène qui 
modifie l’angle de vue lorsque la position de 
mise au point varie.
Lorsque la compensation de la respiration est 
exécutée, une partie de l’image est recadrée 
électroniquement pour maintenir un angle 
de vue constant afin que le phénomène de 
respiration n’apparaisse pas.

[Remarques]
ˎˎ Lorsque la compensation de la respiration est activée, 

l’angle de vue et la qualité d’image peuvent être 
légèrement modifiés.
ˎˎ Selon l’objectif, il peut être impossible de corriger 

la modification de l’angle de vue lorsque la 
compensation de la respiration est activée.

ˎˎ La compensation n’est pas possible lorsqu’un objectif 
qui ne prend pas en charge la compensation de la 
respiration est fixé.
ˎˎ Cette fonction est réglée sur Off (fixe) dans les cas 

suivants.
–– Lorsque Lens >Distortion Comp. dans le menu 

Technical réglé sur Off
–– Lorsque S&Q Motion >Setting dans le menu 

Shooting est réglé sur On
–– Lorsque Rec Format >Codec dans le menu Project 

est réglé sur RAW ou sur une option incluant RAW

Ajustement du bokeh (Fonction de 
contrôle du bokeh)

Vous pouvez facilement ajuster le degré 
de bokeh en liant le filtre ND et le gain à 
l’opération du diaphragme.

Activation/désactivation de la fonction 
de contrôle du bokeh

Cette fonction ne peut être activée que lors de 
l’ajustement manuel de l’exposition. Réglez le 
filtre ND sur le mode Variable, puis réglez le 
diaphragme, le gain, l’obturateur et le filtre ND 
sur l’ajustement manuel.
Vous pouvez activer/désactiver la fonction 
de contrôle du bokeh à l’aide de Iris >Bokeh 
Control (page 80) dans le menu Shooting 
du menu complet.
Lorsque la fonction de contrôle du bokeh est 
réglée sur On, une icône  s’affiche sur les 
indicateurs de filtre ND et de gain. 

[Conseil]
Vous pouvez également attribuer la fonction Bokeh 
Control à une touche personnalisable (page 49) et 
commuter la fonction de contrôle du bokeh entre On et 
Off en utilisant la touche.
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Ajustement du degré de bokeh

1	 Réglez la fonction de contrôle du bokeh 
sur On.

2	 Ouvrez entièrement le diaphragme. 

3	 Réglez le filtre ND sur 1/128. 

4	 Réglez le gain sur 0 dB et utilisez 
l’éclairage pour ajuster l’exposition. 

5	 Ajustez la mise au point.

6	 Ajustez le diaphragme.
Le degré de bokeh change.

[Conseils]
ˎˎ Lorsque la fonction de contrôle du bokeh est réglée 

sur On, le filtre ND et le gain fonctionnent ensemble 
pour compenser les changements d’exposition dus à 
l’ajustement du diaphragme, ce qui vous permet de 
changer le degré de bokeh.
ˎˎ Le contrôle du bokeh est d’abord lié au filtre ND en 

réponse à l’opération du diaphragme. Lorsque le filtre 
ND ne peut plus être changé, le gain est lié.
ˎˎ En mode MF, il est recommandé d’ouvrir d’abord le 

diaphragme, puis d’ajuster la mise au point.
ˎˎ Si vous utilisez le filtre ND automatique au lieu de 

la fonction de contrôle du bokeh, le filtre ND suit le 
changement de luminosité du sujet.

Affichage pendant l’opération de liaison 
du gain

Lorsque la fonction de contrôle du bokeh est 
réglée sur On, le gain peut changer lorsque le 
diaphragme est ajusté.
Lorsque la liaison du gain est active et que le 
gain change, un message s’affiche en haut 
de l’écran et une icône  sur l’indicateur de 
gain clignote. 

[Remarques]
ˎˎ Cette fonction est activée uniquement sur les 

objectifs à monture E qui peuvent communiquer avec 
l’appareil.
ˎˎ L’effet maximal de cette fonction peut être obtenu 

en utilisant la bague de diaphragme d’un objectif à 
monture E de Sony.
ˎˎ L’apparence peut varier en fonction de la vitesse de 

fonctionnement, de l’objectif, des réglages de prise 
de vue et du sujet, et la luminosité peut également 
changer. Il est fortement recommandé d’effectuer un 
test de la caméra avant la prise de vue.
ˎˎ La luminosité peut changer lorsque le sens de 

fonctionnement du diaphragme change, comme par 
exemple lors de l’ouverture du diaphragme après 
sa fermeture ou lors de la fermeture du diaphragme 
après son ouverture. Dans ce cas, ajustez un peu plus 
que nécessaire au préalable, puis revenez un peu en 
arrière, vérifiez la luminosité, puis commencez la prise 
de vue.  
Par exemple, si vous voulez ouvrir le diaphragme à 
une ouverture F8 et rendre l’arrière-plan flou, fermez 
d’abord le diaphragme au-delà de F8, puis revenez 
à F8, vérifiez la luminosité et commencez la prise de 
vue.
ˎˎ Effectuez les opérations de contrôle du bokeh 

lentement. Si vous devez accélérer l’opération, 
essayez d’ajuster progressivement tout en vérifiant les 
changements apportés à l’image.
ˎˎ La qualité d’image avec contrôle du bokeh n’est pas 

garantie dans toutes les conditions de prise de vue.
ˎˎ La fonction de contrôle du bokeh est réglée sur Off 

lorsque l’une des opérations suivantes se produit.
–– Lorsque le caméscope est mis hors tension
–– Lorsque le diaphragme, le gain, l’obturateur ou le 

filtre ND est réglé sur Auto
–– Lorsque le mode de prise de vue est commuté
–– Lorsque le filtre ND est réglé sur le mode 

d’effacement ou mode prédéfini
–– Lorsque l’objectif est retiré
–– Lorsque l’appareil redémarre, par exemple, après 

une commutation de la fréquence

Réglage de l’affichage dé-squeeze

Vous pouvez filmer avec un objectif 
anamorphique pour créer des images au 
format cinémascope.

Régler l’affichage de dé-squeeze pour qu’il 
corresponde au grossissement de votre 
objectif anamorphique vous permet de 
produire des images sur la sortie HDMI et sur 
l’écran du viseur qui sont ajustées au même 
rapport d’aspect que lorsque vous regardez le 
sujet directement.
Vous pouvez régler l’affichage de dé-squeeze 
à l’aide de De-Squeeze >Ratio (HDMI/VF) 
(page 98) dans le menu Monitoring.

[Remarque]
L’affichage de l’image de sortie HDMI n’est pas dé-
squeezé pendant la sortie RAW et la sortie du signal SD.
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Enregistrement du proxy
Cette fonction vous permet d’enregistrer des 
données proxy à faible résolution en même 
temps que l’enregistrement d’une vidéo de 
données d’origine haute résolution.
Les données proxy peuvent être subdivisées 
en fragments automatiquement dans des 
intervalles courts et les fichiers peuvent être 
transférés avant la fin de l’enregistrement.

Pour plus de détails sur les cartes mémoire compatibles, 
le formatage des cartes mémoire et la vérification de 
la capacité restante, consultez « Utilisation de cartes 
mémoire » (page 26).

Configuration avant la prise de 
vue

1	 Réglez Proxy Rec (page 15) dans l’écran 
d’état Project ou Proxy Rec >Setting 
(page 87) dans le menu Project du 
menu complet sur On.

2	 Insérez une carte mémoire dans un 
logement de carte CFexpress Type A/SD 
(page 6).
ˎˎ Pour les cartes CFexpress, l’étiquette est 
orientée vers la gauche.
ˎˎ Pour les cartes SD, l’étiquette est 
orientée vers la droite, avec le coin 
biseauté en bas.

[Remarque]
Proxy Rec ne peut pas être réglé sur On en même temps 
que S&Q Motion ou Interval Rec. Lorsque Proxy Rec est 
réglé sur On, ces autres modes d’enregistrement sont 
obligatoirement réglés sur Off.

Enregistrement d’un proxy

Appuyez sur la touche d’enregistrement 
START/STOP pour lancer l’enregistrement 
lorsque vous avez terminé les réglages 
nécessaires pour la prise de vue.

[Remarques]
ˎˎ Si le caméscope est arrêté ou la carte mémoire 

enlevée pendant que le système accède à la carte 
mémoire, l’intégrité des données sur la carte ne peut 
pas être garantie. Toutes les données enregistrées sur 
la carte mémoire peuvent être supprimées. Assurez-
vous toujours que l’indicateur d’accès de la carte 
mémoire est éteint avant d’arrêter le caméscope ou 
d’enlever la carte mémoire.
ˎˎ Assurez-vous que la carte mémoire ne s’éjecte pas 

quand vous l’insérez ou la retirez.

Pour quitter, arrêtez l’enregistrement.

Réglage de Audio Channel pour 
Proxy Recording

Sélectionnez Proxy Rec >Audio Channel 
(page 87) dans le menu Project du 
menu complet et réglez le canal audio pour 
l’enregistrement de données proxy.

Enregistrement et téléchargement 
d’un fichier proxy par fragments

Lorsque le réglage de téléchargement 
automatique est réglé sur Chunk et qu’un 
fichier proxy est enregistré par fragments, le 
fichier proxy peut être téléchargé pendant que 
l’enregistrement principal est en cours.

Pour plus de détails sur le téléchargement 
d’un fichier proxy enregistré par fragments, 
consultez « Téléchargement automatique 
des fichiers » (page 67) et « Utilisation de 
Creators' App for enterprise » (page 68).

1	 Sélectionnez Proxy Rec >Chunk 
(page 87) dans le menu Project, puis 
sélectionnez l’intervalle d’enregistrement 
par fragments.
30s : enregistrez le fichier proxy par 
fragments de 30 secondes (réglage par 
défaut).
1min : enregistrez le fichier proxy par 
fragments de 1 minute.
2min : enregistrez le fichier proxy par 
fragments de 2 minutes.

2	 Réglez File Transfer >Auto Upload (Proxy) 
(page 110) dans le menu Network sur 
Chunk.
Le fichier original est enregistré sur le 
support dans la fente A et le fichier proxy 
est enregistré par fragments sur le 
support dans la fente B.

3	 Démarrez l’enregistrement proxy.
Le fichier proxy est enregistré par 
fragments à l’intervalle spécifié et chaque 
fragment est enregistré dans la liste des 
tâches en tant que tâche de transfert.

[Remarques]
ˎˎ Lorsque Auto Upload (Proxy) n’est pas réglé sur 

Chunk, l’enregistrement proxy par fragments ne se 
produit pas.
ˎˎ Le support dans la fente B est dédié à 

l’enregistrement de fichiers proxy par fragments, 
par conséquent, l’enregistrement relais et 
l’enregistrement simultané sur 2 fentes ne sont pas 
pris en charge.

À propos du fichier enregistré

L’extension du nom de fichier est « .mp4 ».
Le code temporel est enregistré 
simultanément aussi.

Destination de stockage du fichier 
enregistré

Le fichier enregistré est stocké dans le 
répertoire suivant.

Support 
d’enregistrement

Chemin d’accès

SDXC /PRIVATE/XDROOT/
GENERAL/PXTMP

CFexpress Type A /XDROOT/GENERAL/
PXTMP

À propos du nom de fichier

Le nom de fichier comprend le nom de 
plan enregistré sur la carte mémoire + un 
suffixe « S03 ». Le nom de fichier d’un fichier 
proxy enregistré par fragments pour le 
téléchargement comprend le nom du fichier 
original + un numéro de fragment + un suffixe 
« S03 ».
Pour plus de détails sur les noms de plans, 
consultez Clip Name Format (page 96) dans 
le menu TC/Media du menu complet.
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Prise de vue avec l’apparence souhaitée (Look)
Lorsque le caméscope est réglé sur le mode 
de prise de vue Custom (page 24), vous 
pouvez régler le noir, la matrice et d’autres 
paramètres pour créer une « apparence » 
basée sur l’apparence de base.

：

Apparence

Matrice

Noir

Apparence de base

De plus, vous pouvez sélectionner rapidement 
une autre apparence en enregistrant 
différentes combinaisons de réglages dans 
des fichiers de scène.
Le caméscope est fourni avec six apparences 
prédéfinies au total.

Sélection d’une apparence

1	 Lorsque l’écran de prise de vue s’affiche, 
appuyez sur la molette multifonction.

2	 Sélectionnez l’icône  (fichier de scène).

3	 Appuyez sur la molette multifonction.

4	 Sélectionnez l’apparence souhaitée dans 
le menu et appuyez sur la molette 
multifonction.

[Conseils]
ˎˎ Les préréglages suivants sont configurés par défaut.

Shooting Mode Custom

Target Display SDR(BT.709) HDR(HLG)

Fichier de scène 1 S-Cinetone HLG Live

Fichier de scène 2 Standard HLG Natural

Fichier de scène 3 Still (Non 

enregistré)

Fichier de scène 4 ITU709 (Non 

enregistré)

Fichiers de scène 5 

à 16

(Non 

enregistré)

(Non 

enregistré)

ˎˎ Vous pouvez aussi sélectionner une apparence à 
l’aide de Scene File (page 14) dans l’écran d’état 
Main ou de Scene File >Recall (page 92) dans le 
menu Paint/Look du menu complet. Vous pouvez 
également rappeler une apparence prédéfinie à l’aide 
de Scene File >Preset Recall.

Importation d’une apparence de 
base souhaitée

Vous pouvez importer un fichier 3D LUT, créé 
sur un ordinateur ou un autre appareil, comme 
apparence de base depuis une carte mémoire 
ou un service Cloud. Jusqu’à 16 fichiers 
peuvent être importés.
ˎˎ Format de fichier : fichier CUBE (*.cube) pour 
un 3D LUT à 17 points ou 33 points créé avec 
Catalyst Browse, RAW Viewer ou DaVinci 
Resolve* (de Blackmagic Design Pty. Ltd.).
*	 Vérifié avec Resolve V9.0, V10.0 et V11.0.

ˎˎ Gamme de couleurs d’entrée/Gamma : 
S-Gamut3.Cine/S-Log3 ou S-Gamut3/S-Log3

Importation depuis une carte mémoire

Vous pouvez importer un fichier 3D LUT depuis 
une carte mémoire.

1	 Sur l’ordinateur ou l’autre appareil, 
enregistrez le fichier 3D LUT dans le 
dossier spécifié ou sur le support 
d’enregistrement.

Support 
d’enregistre-
ment

Chemin d’accès

SDXC /PRIVATE/SONY/PRO/LUT/

CFexpress 
Type A

/SONY/PRO/LUT/

2	 Insérez le support d’enregistrement sur 
lequel les fichiers 3D LUT sont enregistrés 
dans le logement de carte CFexpress Type 
A/SD (B).

3	 Sélectionnez Base Look >Import from 
Media(B) (page 92) dans le menu 
Paint/Look du menu complet.

4	 Sélectionnez une destination 
d’importation.

5	 Sélectionnez un fichier 3D LUT à importer.
Suivez les instructions qui s’affichent à 
l’écran. Le caméscope gère un fichier 3D 
LUT comme une apparence de base.

6	 Sélectionnez le fichier 3D LUT importé à 
l’aide de Base Look >Select (page 92) 
dans le menu Paint/Look du menu 
complet.

7	 Configurez Base Look >Input et Output 
(page 92) dans le menu Paint/Look du 
menu complet pour qu’il corresponde aux 
attributs du fichier 3D LUT importé.

Importation depuis un service Cloud

Vous pouvez importer un fichier 3D LUT depuis 
un service Cloud.

1	 Connectez-vous à l’appareil depuis 
l’application pour smartphone « Creators' 
App for enterprise » (page 68).

2	 Sélectionnez Base Look >Import from 
Cloud(Private) ou Import from 
Cloud(Share) (page 92) dans le menu 
Paint/Look du menu complet.

3	 Sélectionnez une destination 
d’importation.

4	 Sélectionnez un fichier 3D LUT à importer.
Suivez les instructions qui s’affichent à 
l’écran. Le caméscope gère un fichier 3D 
LUT comme une apparence de base.
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5	 Sélectionnez le fichier 3D LUT importé à 
l’aide de Base Look >Select (page 92) 
dans le menu Paint/Look du menu 
complet.

6	 Configurez Base Look >Input et Output 
(page 92) dans le menu Paint/Look du 
menu complet pour qu’il corresponde aux 
attributs du fichier 3D LUT importé.

Réglage pour la sous-exposition

Si vous constatez une tendance à la sous-
exposition lorsque l’exposition automatique 
est sélectionnée alors que vous utilisez 
l’apparence de base importée, réglez Base 
Look >AE Level Offset (page 92) dans le 
menu Paint/Look.

[Remarques]
ˎˎ L’importation d’un fichier 3D LUT n’affecte pas 

l’image. Chargez le fichier 3D LUT importé à l’aide de 
Base Look >Select (page 92) dans le menu Paint/
Look du menu complet.
ˎˎ Si vous ne réglez pas correctement Input, vous 

n’obtiendrez pas l’apparence appropriée.
ˎˎ Les réglages des éléments de menu Input, Output 

et AE Level Offset sont appliqués à l’apparence de 
base sélectionnée à l’aide de Select. Si vous importez 
plusieurs fichiers 3D LUT, sélectionnez Select pour 
chaque fichier 3D LUT, puis configurez Input, Output 
et AE Level Offset individuellement pour chaque 
fichier.
ˎˎ Les réglages Input, Output et AE Level Offset 

configurés sont enregistrés pour chaque fichier 3D 
LUT.
ˎˎ Les options de sélection d’apparence de base/LUT 

pour les fichiers 3D LUT importés sont communes aux 
modes SDR(BT.709)/HDR(HLG)/modes de prise de 
vue Log, mais la conversion de la gamme de couleurs 
et du gamma n’est pas effectuée en fonction de ces 
modes.
ˎˎ Les fichiers 3D LUT ne sont pas supprimés lorsque All 

Reset >Reset (page 111) est exécuté dans le menu 
Maintenance du menu complet.

Personnalisation d’une apparence 
(Look)

Vous pouvez personnaliser l’apparence en 
fonction de l’apparence de base, à l’aide de 
Matrix et d’autres éléments de configuration 
dans le menu Paint/Look du menu complet. 
Pour plus d’informations sur chaque élément 
de configuration, consultez page 92.
Raccordez votre caméscope à un téléviseur ou 
à un moniteur, puis réglez la qualité d’image 
tout en observant l’image sur le téléviseur ou 
le moniteur.

[Remarque]
Lorsque vous importez un fichier 3D LUT et l’appliquez à 
l’image, l’apparence souhaitée définie dans le fichier 3D 
LUT n’est pas obtenue si Matrix et des réglages autres 
que les réglages d’apparence de base sont modifiés 
dans le menu Paint/Look. Vous pouvez réinitialiser 
tous les réglages personnalisés à l’aide de Reset Paint 
Settings >Reset without Base Look (page 92) dans le 
menu Paint/Look du menu complet.

Enregistrement d’une apparence 
(Look)

Vous pouvez enregistrer l’apparence 
actuelle en tant que fichier de scène dans la 
mémoire interne à l’aide de Scene File >Store 
(page 92) dans le menu Paint/Look du 
menu complet.
Vous pouvez enregistrer rapidement à l’aide 
d’opérations dans le menu direct depuis 
l’écran de prise de vue.

[Remarques]
ˎˎ Si vous sélectionnez une autre apparence sans 

enregistrer l’apparence actuelle, l’apparence actuelle 
est supprimée.
ˎˎ Les fichiers de scène ne sont pas supprimés lorsque 

All Reset >Reset (page 111) est exécuté dans le 
menu Maintenance du menu complet.

[Conseil]
Vous pouvez écraser les fichiers de scène prédéfinis.
Pour restaurer un fichier de scène prédéfini, chargez 
l’apparence à restaurer à l’aide de Scene File >Preset 
Recall (page 92) dans le menu Paint/Look du menu 
complet, puis enregistrez le fichier de scène à l’aide de 
Scene File >Store.

Suppression d’une apparence 
enregistrée

Vous pouvez supprimer un fichier de scène 
enregistré dans la mémoire interne à l’aide de 
Scene File >Delete (page 92) dans le menu 
Paint/Look du menu complet.

[Conseil]
Lorsque vous supprimez une apparence, elle n’apparaît 
plus dans le menu direct.

Suppression d’une apparence de 
base

Vous pouvez supprimer un fichier 3D LUT 
importé à l’aide de Base Look >Delete 
(page 92) dans le menu Paint/Look du 
menu complet.
Vous pouvez supprimer tous les fichiers 3D 
LUT importés à l’aide de Base Look >Delete 
All (page 92) dans le menu Paint/Look du 
menu complet.

[Remarques]
ˎˎ Avant de supprimer, vérifiez que l’apparence de 

base n’est pas utilisée par un fichier de scène. Si 
vous supprimez une apparence de base en cours 
d’utilisation, l’apparence des fichiers de scène 
correspondants sera incorrecte.
ˎˎ Les fichiers 3D LUT importés ne sont pas supprimés 

lorsque vous sélectionnez All Reset >Reset 
(page 111) dans le menu Maintenance du menu 
complet.
ˎˎ Une apparence de base supprimée ne peut plus être 

utilisée comme LUT en modes de prise de vue Log 
(page 58).
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Prise de vue avec réglage d’apparence en post-production
En sélectionnant le mode de prise de vue Log 
et en enregistrant les gradations sous forme 
de distribution uniforme des zones sombres 
aux zones lumineuses, vous pouvez effectuer 
des réglages précis, par exemple restaurer 
localement les gradations des zones sombres 
et des zones lumineuses, en post-production.
Toutefois, lorsque vous visionnez les images 
enregistrées sur un moniteur classique, 
le contraste d’ensemble est faible, ce qui 
complique les réglages de mise au point et 
d’exposition.
Vous pouvez appliquer un LUT à la cible de 
moniteur sur le caméscope pour faciliter 
divers réglages lors de la prise de vue. Vous 
pouvez aussi appliquer un LUT à la vidéo de 
lecture pour vérifier le résultat final.
Les LUT sont appliqués par les systèmes 
suivants. Cependant, vous ne pouvez 
appliquer qu’un seul LUT.
ˎˎ Sortie SDI et sortie HDMI
ˎˎ Images du viseur et proxy, streaming
ˎˎ Vidéos enregistrées sur un support 
d’enregistrement

Application d’un LUT à l’image du 
viseur

1	 Appuyez sur la touche MENU pour afficher 
l’écran d’état Monitoring.

2	 Sélectionnez la colonne Gamut/Gamma 
dans la rangée VF.

3	 Sélectionnez On ou Off.

[Remarques]
ˎˎ Le réglage LUT On/Off de VF est également appliqué 

au fichier proxy et à la vidéo en continu.
ˎˎ L’assistance à l’affichage gamma est disponible lors 

de l’utilisation de la loupe de mise au point.

[Conseils]
ˎˎ Vous pouvez aussi régler à l’aide de LUT On/Off >VF/

Proxy/Stream (page 83) dans le menu Shooting du 
menu complet.
ˎˎ Vous pouvez configurer SDI/HDMI de la même 

manière que VF.
ˎˎ Pour une vidéo sur un support d’enregistrement, 

vous pouvez régler à l’aide de LUT On/Off >Internal 
Rec (page 84) dans le menu Shooting du menu 
complet.

Modification d’un LUT

1	 Appuyez sur la touche MENU pour afficher 
l’écran d’état Monitoring.

2	 Sélectionnez le champ Base Look/LUT.

3	 Sélectionnez le LUT à appliquer dans la 
liste des apparences de base.

[Conseils]
ˎˎ L’appareil propose s709, 709(800%) et S-Log3 comme 

LUT prédéfinis.
ˎˎ Vous pouvez aussi importer et appliquer un fichier 

3D LUT. Pour plus de détails, consultez « Importation 
d’une apparence de base souhaitée » (page 56) 
et « Suppression d’une apparence de base » 
(page 57).

ˎˎ L’apparence de base peut également être réglée à 
l’aide de Base Look >Select (page 92) dans le menu 
Paint/Look du menu complet.

Modification de la distribution de 
zones sombres et lumineuses 
dans une vidéo enregistrée

En mode de prise de vue Cine EI/Cine EI Quick, 
vous pouvez modifier la distribution des 
zones sombres et des zones lumineuses si, 
par exemple, vous souhaitez donner la priorité 
aux teintes des zones sombres par rapport 
aux zones lumineuses, en changeant Exposure 
Index dans la sensibilité de base.

1	 Appliquez un LUT à l’image du viseur 
(page 58).

2	 Appuyez sur la touche MENU pour afficher 
l’écran d’état Camera.

3	 Configurez les champs L/M/H de 
Exposure Index.
Les réglages individuels sont attribués 
aux positions L/M/H du commutateur 
ISO/GAIN (page 5).

4	 Sélectionnez la valeur Exposure Index à 
appliquer à l’aide du commutateur ISO/
GAIN.

5	 Réglez l’exposition de l’image du viseur 
selon les besoins.

[Remarque]
L’assistance à l’affichage gamma est disponible lors de 
l’utilisation de la loupe de mise au point. Le réglage 
Exposure Index n’est pas appliqué à l’assistance 
d’affichage gamma.

[Conseils]
ˎˎ Vous pouvez régler l’exposition à l’aide de ISO/

Gain/EI >Exposure Index (page 78) dans le menu 
Shooting du menu complet.
ˎˎ La deuxième valeur numérique du réglage indique 

combien d’incréments d’informations de luminosité 
sont attribués aux zones lumineuses (luminosité 
supérieure à 18 % de gris). Les zones plus lumineuses 
que cela sont surexposées.  
Exemple : dans « 400EI/5.0E » des incréments de 5,0 
sont attribués au côté lumineux.
ˎˎ Vous pouvez également vous servir de ceci comme 

d’un guide pour vérifier la teinte des zones sombres 
et lumineuses pendant la prise de vue. Par exemple, 
si la position M est la sensibilité de base, si la position 
L est de moins 2 incréments et la position H de plus 
2 incréments, vous pouvez vérifier en commutant le 
commutateur ISO/GAIN. N’oubliez pas de revenir en 
position M après avoir vérifié l’exposition.

Enregistrement d’un fichier 3D 
LUT en tant que métadonnées

Vous pouvez enregistrer un fichier 3D LUT 
(fichier CUBE) qui est appliqué à l’image du 
moniteur lors de la prise de vue en tant que 
métadonnées pour le plan.
Pour activer cette fonction, réglez Cine EI/Flex.
ISO Set >Embed LUT File (page 86) sur On 
dans le menu Project du menu complet.
Le fichier 3D LUT (fichier CUBE) sélectionné 
au début de l’enregistrement est enregistré 
en tant que métadonnées. Cependant, 
l’enregistrement en tant que métadonnées 
n’est pas possible dans les circonstances 
suivantes.
ˎˎ Lorsqu’un fichier 3D LUT (fichier ayant 
la marque « ! » avant le nom de fichier 
lorsque Base Look est sélectionné) est 
importé à l’aide d’une version précédente 
sélectionnée
ˎˎ Lorsqu’un fichier 3D LUT pouvant être 
enregistré est sélectionné, mais que les 
données LUT à utiliser sont modifiées et que 
l’enregistrement démarre immédiatement
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ˎˎ Lorsque LUT On/Off >Internal Rec 
(page 84) est réglé sur MLUT On dans le 
menu Shooting du menu complet

[Remarque]
Un seul élément de métadonnées peut être enregistré 
par plan.
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Vous pouvez enregistrer la sortie du signal 
vidéo RAW du connecteur SDI OUT ou du 
connecteur du HDMI OUT du caméscope sur 
un enregistreur externe pris en charge.

Enregistrement depuis le 
connecteur SDI OUT

1	 Branchez un enregistreur RAW externe sur 
le connecteur SDI OUT du caméscope.

2	 Réglez le mode de prise de vue à l’aide de 
l’écran d’état Project (page 15) ou de 
Base Setting >Shooting Mode (page 85) 
dans le menu Project du menu complet 
sur Cine EI.

3	 Réglez le mode de numérisation (FF 
uniquement) à l’aide de Imager Scan sur 
l’écran d’état Project ou de Rec Format 
>Imager Scan Mode (page 85) dans le 
menu Project du menu complet.

4	 Réglez le codec à l’aide de l’écran d’état 
Project ou de Rec Format >Codec 
(page 85) dans le menu Project du 
menu complet sur un codec incluant RAW.
La sélection de RAW & XAVC-I permet 
d’enregistrer simultanément la vidéo sur 
l’enregistreur RAW externe et la vidéo sur 
les cartes mémoire dans le caméscope.

5	 Réglez la résolution à l’aide de l’écran 
d’état Project ou de Rec Format >RAW 
Output Format (page 85) dans le menu 
Project du menu complet.

6	 Vérifiez que l’enregistreur externe est 
activé, puis appuyez sur la touche 
d’enregistrement START/STOP sur le 
caméscope.

	 [Remarque]
Lorsque l’enregistrement est démarré sur un 
enregistreur externe sans utiliser la touche 
d’enregistrement START/STOP sur le caméscope, 
il est possible que les plans ne soient pas 
correctement enregistrés.

Les formats de sortie RAW pris en charge sont 
indiqués ci-dessous.

Fréquence 
du 
système

Codec RAW Output 
Format

59.94/
50/
29.97/
25/
23.98

RAW 4096×2160

3840×2160

RAW & XAVC-I 4096×2160

3840×2160

24 RAW 4096×2160

RAW & XAVC-I 4096×2160

Enregistrement depuis le 
connecteur HDMI OUT

1	 Branchez un enregistreur RAW externe sur 
le connecteur HDMI OUT du caméscope.

2	 Réglez le mode de prise de vue à l’aide de 
l’écran d’état Project (page 15) ou de 
Base Setting >Shooting Mode (page 85) 
dans le menu Project du menu complet 
sur Cine EI.

3	 Réglez le mode de numérisation (FF 
uniquement) à l’aide de Imager Scan sur 
l’écran d’état Project ou de Rec Format 
>Imager Scan Mode (page 85) dans le 
menu Project du menu complet.

4	 Réglez le codec à l’aide de l’écran d’état 
Project ou de Rec Format >Codec 
(page 85) dans le menu Project du 
menu complet sur RAW(HDMI).
La sélection de RAW(HDMI) & XAVC-I 
permet d’enregistrer simultanément la 
vidéo sur l’enregistreur RAW externe et la 
vidéo sur les cartes mémoire dans le 
caméscope.

5	 Vérifiez que l’enregistreur externe est 
activé, puis appuyez sur la touche 
d’enregistrement START/STOP sur le 
caméscope.

[Remarque]
Lorsque l’enregistrement est démarré sur un 
enregistreur externe sans utiliser la touche 
d’enregistrement START/STOP sur le caméscope, il 
est possible que les plans ne soient pas correctement 
enregistrés.

Les formats de sortie RAW pris en charge sont 
indiqués ci-dessous.

Fréquence 
du 
système

Codec RAW Output 
Format

59.94/
50/
29.97/
25/
23.98

RAW(HDMI) 4240×2392

RAW(HDMI) & 
XAVC-I

4240×2392

Indicateur de l’état 
d’enregistrement

Lorsque vous réglez Display On/Off 
(page 98) >RAW Output Control Status 
sur On dans le menu Monitoring du menu 
complet, l’état d’enregistrement RAW est 
indiqué par une icône qui s’affiche sur l’écran 
du viseur.

[Remarque]
Le signal de contrôle d’enregistrement est émis par le 
connecteur SDI OUT du caméscope, mais il n’est pas 
possible d’obtenir l’état de l’enregistreur externe. En 
conséquence, le caméscope pourrait indiquer qu’un 
enregistrement vidéo RAW est en cours alors que 
l’enregistreur externe n’enregistre pas réellement. 
Vérifiez l’indicateur sur l’enregistreur externe pour 
connaître l’état de fonctionnement réel.

[Conseil]
La valeur de réglage de RAW Output Format est 
également affichée.

Enregistrement en ralenti et 
accéléré

Si S&Q Motion >Setting dans le menu 
Shooting est réglé sur On, la vidéo RAW est 
enregistrée en mode Slow & Quick Motion.
Pour plus de détails sur la fréquence d’images 
prises en charge pour la prise de vue, 
consultez page 50.

[Remarque]
L’enregistrement en ralenti et accéléré à partir du 
connecteur HDMI OUT n’est pas pris en charge.

Enregistrement d’une vidéo au format RAW
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Connexion à d’autres dispositifs via le LAN
Le caméscope peut se connecter à des 
smartphones, des tablettes et d’autres 
dispositifs à l’aide d’une connexion LAN.
L’établissement d’une connexion LAN entre 
un dispositif et le caméscope vous permet 
d’effectuer les opérations suivantes à l’aide de 
l’application « Content Browser Mobile ».
ˎˎ Surveillance vidéo 
Vous pouvez surveiller l’image de la caméra 
ou de vidéo de lecture du caméscope à 
l’aide de l’application « Content Browser 
Mobile » sur un dispositif.
ˎˎ Télécommande 
Vous pouvez contrôler le caméscope à 
partir d’un smartphone ou d’une tablette 
connectés au caméscope via un réseau LAN.
ˎˎ Transfert de fichiers 
Vous pouvez transférer un fichier proxy 
(basse résolution) ou un fichier original 
(haute résolution) enregistré sur une carte 
mémoire du caméscope vers le serveur via 
un réseau LAN.

	 [Remarque]
	 La surveillance de la vidéo n’est pas prise en charge 

avec les réglages suivants.
–– Mode Slow & Quick Motion
–– Fréquence du système de 24
–– Mode Interval Rec

Application « Content Browser Mobile »

Vous pouvez utiliser le caméscope à 
distance sur l’écran du dispositif pendant la 
surveillance de la vidéo depuis le caméscope, 
puis configurer les réglages du caméscope 
à l’aide de l’application « Content Browser 
Mobile ».

Pour plus de détails sur l’application « Content Browser 
Mobile », contactez un représentant commercial ou un 
technicien Sony.

Configuration du nom d’utilisateur 
et du mot de passe

Configurez le nom d’utilisateur et le mot de 
passe du caméscope pour utiliser la fonction 
réseau.

1	 Configurez Access Authentication >User 
Name (page 107) dans le menu Network 
du menu complet.

2	 Réglez Access Authentication >Input 
Password (page 107) dans le menu 
Network du menu complet.

	 [Conseils]
ˎˎ Vous pouvez également générer un mot de passe 

automatiquement. Exécutez Generate Password 
au lieu de Input Password.
ˎˎ Le nom d’utilisateur et le mot de passe peuvent 

être affichés sous forme de texte et de code QR à 
l’aide de Show Settings.

	 [Remarque]
Veillez à ce que le code QR et le mot de passe ne 
puissent pas être vus par d’autres personnes.

Connexion à l’aide du mode de 
point d’accès de LAN sans fil

Le caméscope sert de point d’accès et se 
connecte à un dispositif via un réseau local 
sans fil.

Smartphone/tablette

Connexion à un dispositif compatible 
NFC par simple contact

Les dispositifs prenant en charge la 
technologie NFC peuvent être connectés 
(connexion une touche) à l’aide de la NFC.

1	 Ouvrez [Settings] sur le dispositif, 
sélectionnez [More], et cochez la case 
NFC.

2	 Mettez le caméscope sous tension.

3	 Activez la fonction NFC.
Maintenez pressée (pendant 3 secondes) 
une touche personnalisable à laquelle la 
fonction NFC est affectée ou sélectionnez 
Wireless LAN >NFC dans le menu Network 
pour activer le mode de connexion NFC.
La fonction NFC est uniquement 
disponible tant que  apparaît sur l’écran.

4	 Touchez le caméscope avec le dispositif.
Le dispositif se connecte au caméscope et 
« Content Browser Mobile » démarre.

	 [Remarques]
ˎˎ Désactivez le mode de veille et le verrouillage 

d’écran à l’avance.
ˎˎ Touchez et maintenez le dispositif immobile 

jusqu’à ce que l’application « Content Browser 
Mobile » démarre (1 à 2 secondes).
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Connexion à un dispositif compatible 
WPS

Les dispositifs qui prennent en charge le WPS 
peuvent être connectés à l’aide du WPS.

1	 Sélectionnez Wireless LAN >Setting 
>Access Point Mode dans le menu 
Network du menu complet.

2	 Sélectionnez Wireless LAN >WPS >Execute 
dans le menu Network du menu complet.

3	 Ouvrez les réglages réseau ou les 
réglages Wi-Fi sur le dispositif et activez le 
Wi-Fi.

4	 Sélectionnez le SSID du caméscope dans 
la liste des SSID sous Wi-Fi Network sur le 
dispositif, puis sélectionnez WPS Push 
Button sous Option pour connecter le 
dispositif.

	 [Remarques]
ˎˎ La méthode de fonctionnement diffère selon le 

dispositif.
ˎˎ Pour le SSID et le mot de passe du caméscope, 

vérifiez AP Mode Settings >Camera SSID & 
Password (page 107) dans le menu Network du 
menu complet.

5	 Connectez-vous en utilisant l’application 
Content Browser Mobile.

	 [Conseil]
Vous pouvez vérifier les informations requises 
pour la connexion à l’appareil à l’aide de Access 
Authentication >Show Settings (page 107) dans le 
menu Network du menu complet.

Connexion par saisie d’un SSID et d’un 
mot de passe sur un dispositif

Vous pouvez connecter le caméscope à un 
dispositif, en saisissant le SSID et le mot de 
passe de l’appareil sur un dispositif.

1	 Sélectionnez Wireless LAN >Setting 
>Access Point Mode dans le menu 
Network du menu complet.

2	 Ouvrez les réglages réseau ou les 
réglages Wi-Fi sur le dispositif et activez le 
Wi-Fi.

3	 Connectez le dispositif au caméscope en 
sélectionnant le SSID du caméscope dans 
la liste des SSID sous Wi-Fi Network et en 
saisissant le mot de passe.
Pour le SSID et le mot de passe du 
caméscope, vérifiez AP Mode Settings 
>Camera SSID & Password (page 107) 
dans le menu Network.

	 [Remarque]
La méthode de fonctionnement diffère selon le 
dispositif.

4	 Connectez-vous en utilisant l’application 
Content Browser Mobile.

	 [Conseil]
Vous pouvez vérifier les informations requises 
pour la connexion à l’appareil à l’aide de Access 
Authentication >Show Settings (page 107) dans le 
menu Network du menu complet.

Connexion à l’aide du mode de 
station de LAN sans fil

Le caméscope se connecte à un point d’accès 
existant du réseau local sans fil en tant 
que client. Le caméscope et le dispositif se 
connectent via le point d’accès.
Les 10 derniers points d’accès où une 
connexion s’est produite sont affichés dans 
l’historique.
L’historique de connexion est sauvegardé 
dans un fichier ALL file mais les mots de passe 
d’accès ne sont pas enregistrés. La saisie d’un 
mot de passe sera requise à la prochaine 
connexion après le chargement du fichier ALL.

Smartphone/
tablette

Point d’accès

Ordinateur

Connexion à un point d’accès à l’aide de 
la fonction WPS

Si le point d’accès est compatible avec la 
fonction WPS, vous pouvez vous connecter au 
point d’accès avec des réglages simples.

1	 Activez le point d’accès.

2	 Mettez le caméscope sous tension.

3	 Sélectionnez Wireless LAN >Setting 
>Station Mode dans le menu Network du 
menu complet.

4	 Sélectionnez ST Mode Settings >Camera 
Remote Control (page 108) >Enable 
dans le menu Network du menu complet.

5	 Sélectionnez Wireless LAN >WPS >Execute 
dans le menu Network du menu complet.

6	 Appuyez sur la touche WPS du point 
d’accès.
Pour les détails sur le fonctionnement de 
la touche WPS, consultez le mode 
d’emploi du point d’accès.
Une fois la connexion réussie, l’icône 
d’indicateur d’état du réseau affiche une 
puissance de 1 ou plus sur l’écran du 
viseur.

	 [Remarque]
Si la connexion échoue, recommencez toutes les 
étapes à partir de l’étape 1.

7	 Connectez le dispositif au point d’accès.
Pour plus de détails sur la connexion, 
consultez le mode d’emploi du dispositif.

8	 Lancez l’application « Content Browser 
Mobile » sur un dispositif et sélectionnez 
l’appareil.
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	 [Conseil]
Vous pouvez vérifier les informations requises 
pour la connexion à l’appareil à l’aide de Access 
Authentication >Show Settings (page 107) dans le 
menu Network du menu complet.

Connexion à l’aide de la fonction de 
détection automatique de point d’accès

1	 Effectuez les étapes 1 à 3 dans 
« Connexion à un point d’accès à l’aide de 
la fonction WPS » (page 62).

2	 Sélectionnez ST Mode Settings >Scan 
Networks (page 108) >Execute dans le 
menu Network du menu complet.
Le caméscope lance la détection des 
destinations réseau.
Les destinations possibles ayant été 
détectées s’affichent sous forme de liste.

3	 Sélectionnez une destination dans la liste.
L’écran des détails du réseau (point 
d’accès) apparaît. La connexion choisie est 
affichée dans le SSID.

4	 Sélectionnez Password et saisissez le mot 
de passe du point d’accès à connecter sur 
l’écran de saisie du mot de passe.
La sélection d’un SSID dans l’historique de 
connexion configure automatiquement 
les réglages, y compris le mot de passe.
Réglez le mot de passe pour revenir à 
l’écran des détails du réseau (point 
d’accès).

5	 Configurez les réglages de connexion 
suivants.
ˎˎ DHCP 
Définissez le réglage DHCP.  
Lorsque vous réglez sur On, l’adresse 
IP est automatiquement assignée au 
caméscope.  

Pour assigner manuellement l’adresse IP 
au caméscope, réglez sur Off.
ˎˎ IP Address 
Permet de saisir l’adresse IP de l’unité.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.
ˎˎ Subnet Mask 
Permet de saisir le masque de sous-
réseau de l’unité.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.
ˎˎ Gateway 
Permet de saisir la passerelle pour le 
point d’accès.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.
ˎˎ DNS Auto 
Permet de régler s’il faut acquérir 
automatiquement ou non le DNS.  
Avec ce réglage sur On, l’adresse 
du serveur DNS est acquise 
automatiquement. Ce réglage n’est 
disponible que si DHCP est réglé sur On.
ˎˎ Primary DNS Server 
Saisissez le serveur DNS principal du 
point d’accès.  
Ce réglage n’est disponible que si DNS 
Auto est réglé sur Off.
ˎˎ Secondary DNS Server 
Saisissez le serveur DNS secondaire du 
point d’accès.  
Ce réglage n’est disponible que si DNS 
Auto est réglé sur Off.

6	 Lorsque vous avez terminé, sélectionnez 
Connect pour vous connecter au point 
d’accès.

7	 Connectez le dispositif au point d’accès.
Pour plus de détails sur la connexion, 
consultez le mode d’emploi du dispositif.

8	 Lancez l’application « Content Browser 
Mobile » sur un dispositif et sélectionnez 
l’appareil.

	 [Conseil]
Vous pouvez vérifier les informations requises 
pour la connexion à l’appareil à l’aide de Access 
Authentication >Show Settings (page 107) dans le 
menu Network du menu complet.

Connexion manuelle en saisissant les 
informations du point d’accès

1	 Effectuez les étapes 1 à 3 dans 
« Connexion à un point d’accès à l’aide de 
la fonction WPS » (page 62).

2	 Sélectionnez ST Mode Settings >Manual 
Register (page 109) >Execute dans le 
menu Network du menu complet.
L’écran des détails du réseau (point 
d’accès) apparaît momentanément.

3	 Configurez les réglages de connexion 
suivants.
ˎˎ SSID 
Saisissez le SSID pour le point d’accès de 
connexion.
ˎˎ Security 
Sélectionnez la méthode de cryptage.
ˎˎ Password 
Saisissez le mot de passe du point 
d’accès de connexion.
ˎˎ DHCP 
Définissez le réglage DHCP.  
Lorsque vous réglez sur On, l’adresse 
IP est automatiquement assignée au 
caméscope.  
Pour assigner manuellement l’adresse IP 
au caméscope, réglez sur Off.
ˎˎ IP Address 
Permet de saisir l’adresse IP de l’unité.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.

ˎˎ Subnet Mask 
Permet de saisir le masque de sous-
réseau de l’unité.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.
ˎˎ Gateway 
Permet de saisir l’adresse de passerelle.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.
ˎˎ DNS Auto 
Permet de régler s’il faut acquérir 
automatiquement ou non le DNS.  
Avec ce réglage sur On, l’adresse 
du serveur DNS est acquise 
automatiquement. Ce réglage n’est 
disponible que si DHCP est réglé sur On.
ˎˎ Primary DNS Server 
Saisissez l’adresse du serveur DNS 
principal.  
Ce réglage n’est disponible que si DNS 
Auto est réglé sur Off.
ˎˎ Secondary DNS Server 
Saisissez l’adresse du serveur DNS 
secondaire.  
Ce réglage n’est disponible que si DNS 
Auto est réglé sur Off.

4	 Lorsque vous avez terminé, sélectionnez 
Connect pour vous connecter au point 
d’accès.

5	 Connectez le dispositif au point d’accès.
Pour plus de détails sur la connexion, 
consultez le mode d’emploi du dispositif.

6	 Lancez l’application « Content Browser 
Mobile » sur un dispositif et sélectionnez 
l’appareil.

	 [Conseil]
Vous pouvez vérifier les informations requises 
pour la connexion à l’appareil à l’aide de Access 
Authentication >Show Settings (page 107) dans le 
menu Network du menu complet.
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Vous pouvez connecter le caméscope à 
Internet à l’aide d’un raccordement modem 
USB, d’un LAN filaire ou d’un LAN sans fil.
Réglez le nom d’utilisateur et le mot de passe 
du caméscope au préalable (page 61).

Connexion à l’aide d’un 
raccordement modem USB

Vous pouvez connecter l’unité à un 
smartphone via un câble USB, puis connecter 
à Internet à l’aide du smartphone.

Configuration de la communication 
smartphone

Activez la communication par raccordement 
modem sur le smartphone.
Pour plus de détails, reportez-vous au manuel 
d’utilisation du smartphone.

Fixation d’un smartphone au caméscope

Connectez un câble USB au connecteur USB-C 
(page 7) du caméscope, puis connectez le 
smartphone.

[Remarques]
ˎˎ Fixez/retirez le smartphone lorsque le caméscope est 

hors tension.
ˎˎ Le raccordement modem USB ne peut pas être utilisé 

si le smartphone est connecté via un concentrateur 
USB.
ˎˎ Vous ne pouvez pas utiliser le raccordement modem 

USB si un ordinateur est relié au connecteur USB/
Multi (page 7).

Connexion à un réseau

1	 Mettez le caméscope sous tension.

2	 Réglez Modem >Setting (page 109) dans 
le menu Network du menu complet sur 
On.

Activation d’opération depuis un 
smartphone

Vous pouvez contrôler le caméscope à 
distance à l’aide de l’application Content 
Browser Mobile sur un smartphone connecté à 
l’aide d’un câble USB.

1	 Réglez Modem >Camera Remote Control 
(page 109) sur Enable dans le menu 
Network du menu complet.

2	 Lancez l’application « Content Browser 
Mobile » sur un smartphone et 
sélectionnez l’appareil.

	 [Conseil]
Vous pouvez vérifier les informations requises pour 
la connexion à l’appareil à partir de l’application 
Content Browser Mobile à l’aide de Access 
Authentication >Show Settings (page 107) dans le 
menu Network du menu complet.

Connexion à l’aide mode de 
station de LAN sans fil (mode 
Wi-Fi Station)

Vous pouvez connecter le caméscope à 
Internet en mode de station Wi-Fi à l’aide d’un 
routeur Wi-Fi en option ou par raccordement 
au Wi-Fi avec un smartphone.
Connectez-vous au routeur Wi-Fi ou au 
dispositif comme indiqué dans « Connexion 
à l’aide du mode de station de LAN sans fil » 
(page 62).

Smartphone/
tablette

Routeur Wi-Fi

Ordinateur

Internet

Smartphone/
tablette

Internet

Connexion à l’aide d’un câble LAN

Vous pouvez vous connecter à Internet en 
connectant le connecteur LAN filaire d’un 
adaptateur LAN filaire (option) relié au 
connecteur USB-C (page 7) du caméscope 
à un routeur Wi-Fi (en option) à l’aide d’un 
câble LAN.

Smartphone/
tablette

Ordinateur

Routeur Wi-Fi

Adaptateur 
LAN filaire

Internet

Connexion à Internet
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Connexions à l’aide d’un câble LAN et 
réglages du LAN filaire

1	 Fixez un adaptateur LAN filaire sur le 
connecteur USB-C du caméscope.

2	 Connectez le connecteur LAN filaire de 
l’adaptateur LAN filaire à un routeur Wi-Fi 
à l’aide d’un câble LAN.

3	 Mettez le caméscope sous tension.

4	 Réglez Wired LAN >Setting (page 109) 
dans le menu Network du menu complet 
sur On.

5	 Configurez les réglages de connexion à 
l’aide de Wired LAN >Detail Settings 
(page 109) dans le menu Network.
ˎˎ DHCP 
Définissez le réglage DHCP.  
Lorsque vous réglez sur On, l’adresse 
IP est automatiquement assignée au 
caméscope.  
Pour assigner manuellement l’adresse IP 
au caméscope, réglez sur Off.
ˎˎ IP Address 
Permet de saisir l’adresse IP de l’unité.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.
ˎˎ Subnet Mask 
Permet de saisir le masque de sous-
réseau de l’unité.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.
ˎˎ Gateway 
Permet de saisir l’adresse de passerelle.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.

ˎˎ DNS Auto 
Permet de régler s’il faut acquérir 
automatiquement ou non le DNS.  
Avec ce réglage sur On, l’adresse 
du serveur DNS est acquise 
automatiquement. Ce réglage n’est 
disponible que si DHCP est réglé sur On.
ˎˎ Primary DNS Server 
Saisissez l’adresse du serveur DNS 
principal.  
Ce réglage n’est disponible que si DNS 
Auto est réglé sur Off.
ˎˎ Secondary DNS Server 
Saisissez l’adresse du serveur DNS 
secondaire.  
Ce réglage n’est disponible que si DNS 
Auto est réglé sur Off.

6	 Lorsque vous avez terminé, sélectionnez 
Set pour appliquer les réglages.

[Remarques]
ˎˎ Sélectionnez toujours Set après avoir modifié les 

réglages de connexion. Les réglages ne sont pas 
appliqués si Set n’est pas sélectionné.
ˎˎ Utilisez un adaptateur LAN filaire USB Type C. Nous 

vous conseillons d’utiliser un adaptateur compatible 
Gigabit Ethernet. Toutefois, le fonctionnement n’est 
pas garanti avec tous les appareils.
ˎˎ Vous ne pouvez pas utiliser d’adaptateur LAN filaire 

USB (option) si un ordinateur est relié au connecteur 
USB/Multi (page 7).
ˎˎ La fonction de communication Wi-Fi intégrée peut 

être affectée, selon le modèle de l’adaptateur LAN 
filaire (en option).

Activation du fonctionnement à partir 
d’un smartphone via un LAN filaire

Pour utiliser le caméscope à distance à l’aide 
de l’application Content Browser Mobile sur 
un smartphone via Wi-Fi à l’aide d’un routeur 
connecté par LAN filaire, réglez Wired LAN 
>Camera Remote Control (page 109) dans le 
menu Network du menu complet sur Enable.
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Téléchargement de fichiers
Vous pouvez télécharger un fichier proxy ou 
un fichier original enregistré sur le caméscope 
vers un serveur sur Internet ou un serveur sur 
un réseau local via un smartphone ou un point 
d’accès.

Préparatifs

Connexion à un réseau

Connectez le caméscope à Internet ou au 
réseau local comme indiqué dans « Connexion 
à Internet » (page 64) ou « Connexion à 
d’autres dispositifs via le LAN » (page 61).

Enregistrement d’une destination de 
transfert de fichier

Enregistrez au préalable le serveur pour le 
téléchargement.

1	 Sélectionnez File Transfer >Server 
Settings1 (ou Server Settings2, Server 
Settings3) dans le menu Network du 
menu complet.
L’écran de configuration de la destination 
de transfert s’affiche.

2	 Réglez chaque élément sur l’écran de 
configuration de la destination de 
transfert.
Display Name
Saisissez le nom du serveur à afficher 
dans la liste de destinations de transfert.
Service
Affiche le type de serveur.
« FTP » : serveur FTP
Host Name
Saisissez l’adresse du serveur.

Port
Saisissez le numéro de port du serveur 
pour effectuer la connexion.
User Name
Saisissez le nom d’utilisateur.
Password
Saisissez le mot de passe.
Passive Mode
Activez/désactivez le mode passivité.
Destination Directory
Saisissez le nom de répertoire sur le 
serveur de destination.

	 [Remarques]
ˎˎ Les fichiers originaux sont téléchargés dans 

le dossier « Main » dans le répertoire spécifié 
comme destination de transfert.
ˎˎ Lors de la modification, «  » indique des 

caractères ne pouvant pas être modifiés. Le 
fonctionnement correct n’est pas garanti lors de 
la modification d’un nom de répertoire contenant 
ces caractères.  
Si la modification est nécessaire, supprimez tous 
les caractères et saisissez à nouveau une valeur.
ˎˎ Si des caractères non valides sur le serveur de 

destination sont saisis dans Destination Directory, 
les fichiers seront transférés dans le répertoire 
original de l’utilisateur. Les caractères non valides 
varient en fonction du serveur.

Using Secure Protocol
Indiquez si vous exécutez ou non le 
téléchargement sur FTP sécurisé.
Root Certificate
Chargez/effacez un certificat.
ˎˎ Load 
Sélectionnez Set à l’étape 3 pour 
importer un certificat CA.

*	 Le certificat à charger doit être au format PEM 
avec le nom de fichier « certification.pem », et 
doit être écrit dans le répertoire racine de la 
carte mémoire insérée dans le logement de carte 
CFexpress Type A/SD (B).

ˎˎ Clear 
Sélectionnez Set à l’étape 3 pour effacer 
un certificat CA.
ˎˎ None 
Vous ne pouvez ni charger ni effacer un 
certificat.

	 [Remarques]
ˎˎ Réglez l’horloge du caméscope sur l’heure 

correcte avant d’importer un certificat CA.
ˎˎ Lors de l’enregistrement en XAVC-I 4096×2160P/ 

3840×2160P 59.94/50P, Load ne peut pas être 
sélectionné.
ˎˎ En état de tension faible, Load/Clear ne peut pas 

être sélectionné pour un certificat CA.

Root Certificate Status
Affiche l’état de chargement du certificat.
Reset
Réinitialisez les réglages de Server 
Settings aux réglages par défaut.

3	 Lorsque vous avez terminé, sélectionnez 
Set pour appliquer les réglages.
Sélectionnez toujours Set après avoir 
modifié les réglages. Les réglages ne sont 
pas appliqués si Set n’est pas sélectionné.

Sélection d’un fichier et 
téléchargement

Vous pouvez sélectionner des fichiers proxy 
ou des fichiers originaux enregistrés sur des 
cartes mémoire pour le transfert vers un 
serveur.

[Remarque]
Les fichiers proxy enregistrés par fragments sont 
des fichiers dédiés au téléchargement automatique. 
Ils ne peuvent pas être sélectionnés et téléchargés 
manuellement.

Téléchargement d’un fichier proxy sur 
une carte mémoire à partir d’un écran 
de miniatures

1	 Connectez le caméscope et le dispositif à 
l’aide d’une connexion LAN (page 61).

2	 Sélectionnez Transfer Clip (Proxy) >Select 
Clip dans le menu Thumbnail du menu 
complet.
L’affichage passe du menu complet à 
l’écran des miniatures.
Les plans peuvent être transférés de 
l’écran des miniatures ou de l’écran des 
miniatures de plans filtrés.

3	 Sélectionnez le plan à transférer et 
appuyez sur la touche MENU.
Un écran de confirmation de transfert 
apparaît.

4	 Sélectionnez Execute.
Le fichier proxy correspondant au fichier 
sélectionné est enregistré comme tâche 
de transfert et le chargement commence.
Si l’enregistrement de la tâche de transfert 
réussit, l’écran des résultats du transfert 
s’affiche.
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5	 Sélectionnez OK.

Pour télécharger tous les fichiers
Sélectionnez All Clips au lieu de Select Clip 
à l’étape 2 pour transférer les fichiers proxy 
correspondant à tous les fichiers.

[Remarque]
Jusqu’à 200 fichiers peuvent être transférés.

Téléchargement d’un fichier original sur 
une carte mémoire à partir d’un écran 
de miniatures

[Remarque]
Les fichiers originaux sont téléchargés dans le dossier 
« Main » dans le répertoire spécifié comme destination 
de transfert.

1	 Connectez le caméscope et le dispositif à 
l’aide d’une connexion LAN (page 61).

2	 Sélectionnez Transfer Clip >Select Clip 
dans le menu Thumbnail du menu 
complet.
L’affichage passe du menu complet à 
l’écran des miniatures.
Les plans peuvent être transférés de 
l’écran des miniatures ou de l’écran des 
miniatures de plans filtrés.

3	 Sélectionnez le plan à transférer et 
appuyez sur la touche MENU.
Un écran de confirmation de transfert 
apparaît.

4	 Sélectionnez Execute.
Le fichier sélectionné est enregistré 
comme tâche de transfert et le 
chargement commence.
Si l’enregistrement de la tâche de transfert 
réussit, l’écran des résultats du transfert 
s’affiche.

5	 Sélectionnez OK.

Pour télécharger tous les fichiers
Sélectionnez All Clips au lieu de Select Clip à 
l’étape 2 pour transférer tous les fichiers.

[Remarque]
Jusqu’à 200 fichiers peuvent être transférés.

Vérification du transfert de fichiers

Vous pouvez vérifier l’état du transfert de 
fichier en sélectionnant File Transfer >View Job 
List (page 110) dans le menu Network du 
menu complet.
Vous pouvez aussi vérifier l’état du transfert de 
fichier depuis l’écran de l’application Content 
Browser Mobile.

[Conseil]
Si File Transfer >Auto Upload (page 110) ou Auto 
Upload (Proxy) (page 110) dans le menu Network du 
menu complet est réglé sur On et qu’une connexion 
réseau existe, les fichiers originaux et proxy sont 
automatiquement téléchargés sur le serveur spécifié 
à l’aide de Default Upload Server (page 110) à la fin 
de l’enregistrement. Si les fichiers originaux et proxy 
sont tous deux configurés pour le téléchargement 
automatique, le téléchargement automatique des 
fichiers proxy est prioritaire.

[Remarques]
ˎˎ Un maximum de 200 tâches de transfert peuvent être 

enregistrées.
ˎˎ La liste des tâches est conservée lorsque le 

caméscope est mis hors tension, mais vous pouvez 
perdre jusqu’à 10 minutes d’informations de 
progression récente si le pack batterie est retiré ou si 
le caméscope est mis hors tension sans avoir placé au 
préalable le commutateur POWER sur STANDBY.
ˎˎ Les tâches ajoutées après l’état de tension faible de 

la batterie ne sont pas enregistrées dans la liste des 
tâches.
ˎˎ Si une erreur se produit lors du transfert de fichiers, 

le transfert d’un plan ayant le même nom qu’un plan 
transféré peut ne pas se poursuivre en fonction des 
paramètres et de l’état du serveur de destination du 
transfert. Si cela se produit, vérifiez les paramètres et 
l’état du serveur de destination du transfert.

Téléchargement automatique des 
fichiers

Téléchargement automatique d’un 
fichier original

Les fichiers originaux peuvent être 
téléchargés sur le serveur spécifié à la fin de 
l’enregistrement. Pour activer cette fonction, 
réglez File Transfer >Auto Upload (page 110) 
sur On dans le menu Network du menu 
complet.

Téléchargement automatique d’un 
fichier proxy

Les fichiers proxy peuvent être téléchargés sur 
le serveur spécifié à la fin de l’enregistrement. 
Pour activer cette fonction, réglez File Transfer 
>Auto Upload (Proxy) (page 110) sur On dans 
le menu Network du menu complet.
Ou bien, lorsque Auto Upload (Proxy) est réglé 
sur Chunk, vous pouvez enregistrer un fichier 
proxy par fragments, puis télécharger les 
fragments sur un serveur spécifié pendant que 
l’enregistrement continue. Le téléchargement 
d’un fichier proxy enregistré par fragments est 
prioritaire sur les autres tâches de transfert de 
fichiers.
Pour plus de détails sur la configuration, 
consultez « Enregistrement et téléchargement 
d’un fichier proxy par fragments » 
(page 55).

Téléchargement à l’aide d’un FTP 
sécurisé

Vous pouvez télécharger des fichiers cryptés 
à l’aide de FTPS en mode Explicit (FTPES) pour 
la connexion avec le serveur de fichiers de 
destination.

Réglage d’un transfert FTP sécurisé

Pour un transfert FTP sécurisé, réglez Using 
Secure Protocol dans les réglages du serveur 
du fichier de destination sur ON et importez 
un certificat.
Pour plus de détails sur la configuration, 
consultez « Enregistrement d’une destination 
de transfert de fichier » (page 66).
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Utilisation de Creators' App for enterprise
Vous pouvez facilement transférer des fichiers 
sur le service Cloud C3 Portal en reliant 
l’appareil à l’application pour smartphone 
« Creators' App for enterprise ».
D’abord, créez un compte C3 Portal et 
installez Creators' App for enterprise sur un 
smartphone.
Pour plus de détails sur la création d’un 
compte de service Cloud C3 Portal, contactez 
l’administrateur de votre organisation.

[Remarques]
ˎˎ Le service peut ne pas être disponible, en fonction de 

la région où vous vivez.
ˎˎ Pour plus de détails sur l’utilisation de Creators' App 

for enterprise, reportez-vous au Manuel d’aide de 
Creators' App for enterprise.

Téléchargement des fichiers sur C3 
Portal

1	 Sélectionnez Setup for Mobile App >Setup 
(page 107) dans le menu Network.
Un écran de confirmation apparaît pour 
les éléments qui seront automatiquement 
mis à jour.
Les réglages suivants dans le menu 
Network sont sélectionnés 
automatiquement.
ˎˎ Wired LAN >Setting : Off
ˎˎ Modem >Setting : On
ˎˎ Modem >Camera Remote Control : 
Enable
ˎˎ Access Authentication >Input Password : 
(Généré automatiquement si non 
spécifié)

2	 Vérifiez les réglages et sélectionnez OK.
La configuration démarre. Un message 
« Now changing » apparaît pendant la 
configuration.

Lorsque la configuration est terminée, 
l’écran suivant apparaît dans le viseur.

Les informations suivantes pour 
l’authentification d’accès sont affichées.
Nom d’utilisateur, mot de passe, 
empreinte digitale, nom du modèle de 
caméscope, numéro de série

	 [Conseil]
Cet écran n’est pas émis dans la sortie vidéo.

	 [Remarque]
Veillez à ce que le mot de passe ne puisse pas être 
visualisé et que l’image du code QR ne puisse pas 
être copiée par d’autres personnes.

3	 Lancez Creators' App for enterprise sur le 
smartphone et connectez-vous au service 
Cloud.

4	 Connectez le smartphone via un câble 
USB au connecteur USB-C de l’appareil.

5	 Activez le raccordement modem USB sur 
l’écran du smartphone.
Pour plus de détails sur la configuration, 
consultez « Connexion à l’aide d’un 
raccordement modem USB » (page 64).
L’opération diffère en fonction de votre 
smartphone. Reportez-vous au manuel 
d’utilisation du smartphone.

6	 Scannez le code QR dans le viseur 
conformément aux instructions sur l’écran 
de Creators' App for enterprise.
Les informations de configuration du 
transfert de fichiers sont envoyées du 

smartphone à l’appareil et le message 
suivant apparaît.

7	 Sélectionnez OK.
Les informations de configuration 
commencent à charger.
Lorsque la configuration est chargée avec 
succès, un message « Network File 
loaded. » apparaît.

[Remarques]
ˎˎ Creators' App for enterprise écrase le réglage File 

Transfer (page 110) dans le menu Network de 
l’appareil.
ˎˎ Root Certificate ne peut pas être réglé 

automatiquement. Configurez-le manuellement.

Téléchargement d’un fichier original

Réglez File Transfer >Auto Upload (page 110) 
dans le menu Network sur On pour activer le 
téléchargement des fichiers originaux sur C3 
Portal.
Chaque fois qu’un enregistrement se termine, 
le fichier est téléchargé sur l’emplacement 
associé à votre compte C3 Portal.

Téléchargement d’un fichier proxy

Réglez File Transfer >Auto Upload (Proxy) 
(page 110) dans le menu Network sur On 
pour activer le téléchargement de fichiers 
proxy sur C3 Portal.
Chaque fois qu’un enregistrement se termine, 
le fichier est téléchargé sur l’emplacement 
associé à votre compte C3 Portal.
Lorsque Auto Upload (Proxy) est réglé sur 
Chunk, le fichier proxy est divisé en fragments 
et téléchargé à intervalles réguliers depuis 
le démarrage de l’enregistrement. Pour plus 
de détails sur la configuration, consultez 

« Enregistrement et téléchargement d’un 
fichier proxy par fragments » (page 55).

Téléchargement de fichiers arbitraires

Consultez « Sélection d’un fichier et 
téléchargement » (page 66).

[Conseils]
ˎˎ Les fichiers envoyés par l’appareil sont mis en cache 

dans Creators' App for enterprise et transférés dans 
C3 Portal. L’affichage d’état du transfert de fichiers sur 
l’appareil indique l’état de transfert de Creators' App 
for enterprise.
ˎˎ Lorsque le transfert de fichiers de l’appareil sur 

Creators' App for enterprise sur le smartphone est 
terminé, vous pouvez mettre l’appareil hors tension, 
mais notez que le transfert de fichiers depuis le 
téléphone peut encore continuer. Soyez attentif à la 
charge restante de la batterie sur le smartphone.

Autres fonctions qui utilisent C3 
Portal

Gestion des fichiers 3D LUT

Vous pouvez importer des fichiers 3D LUT 
stockés dans C3 Portal vers l’appareil. 
Consultez « Importation depuis un service 
Cloud » (page 56).

Gestion de fichiers ALL

Vous pouvez enregistrer un fichier ALL créé 
par l’appareil dans C3 Portal et charger 
un fichier ALL depuis C3 Portal. Consultez 
« Enregistrement d’un fichier ALL sur un 
service Cloud » (page 119) et « Chargement 
d’un fichier ALL depuis un service Cloud » 
(page 120).
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Ecran de miniatures
Lorsque vous appuyez sur la touche THUMBNAIL (page 5), les plans enregistrés sur la carte mémoire s’affichent sous forme de miniatures à l’écran.
Vous pouvez sélectionner un plan dans l’écran de miniatures et démarrer la lecture de ce plan. L’image de lecture peut être affichée sur le viseur et sur un moniteur externe.
Appuyer à nouveau sur la touche THUMBNAIL ferme l’écran de miniatures et revient à l’image de caméra.

[Remarque]
Seuls les plans enregistrés au format d’enregistrement actuellement sélectionné sont affichés dans l’écran de miniatures. Si un plan enregistré que vous vous attendiez à voir n’est pas affiché, vérifiez le format d’enregistrement. Gardez ceci à 
l’esprit avant de formater (initialiser) le support.

Disposition de l’écran

Les informations du plan à la position du curseur sont affichées au bas de l’écran.

4 5

6

3

1

2

Indicateur de la carte mémoire actuellement sélectionnée
(Une icône de verrou s’affiche si la carte est protégée.)

Curseur (jaune)

Numéro de plan/Nombre total de plans

1.	 Miniature (image d’index)
Affiche l’image d’index d’un plan. Lorsqu’un 
plan est enregistré, sa première image est 
automatiquement définie comme image 
d’index.
Les informations du plan/de l’image sont 
affichées sous la miniature. Vous pouvez 
changer les informations affichées en utilisant 
Customize View (page 103) >Thumbnail 
Caption dans le menu Thumbnail du menu 
complet.

2.	 Nom de plan
Affiche le nom du plan sélectionné.

3.	 Format vidéo pour l’enregistrement
Affiche le format de fichier du plan 
sélectionné.

4.	 Informations d’enregistrement spécial
Affiche le mode d’enregistrement uniquement 
si le plan a été enregistré à l’aide d’un mode 
d’enregistrement spécial.
Pour les plans en ralenti et accéléré, la 
fréquence d’images est affichée à droite.

5.	 Durée du plan

6.	 Date de création
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Lecture de plans

Lecture de plans enregistrés

Lorsque le caméscope est en mode de veille 
d’enregistrement (Stby), vous pouvez lire les 
plans enregistrés.

1	 Insérez la carte mémoire à lire.

2	 Appuyez sur la touche THUMBNAIL.

3	 Utilisez le sélecteur multiple (page 7) 
ou la molette multifonction (page 5) 
pour déplacer le curseur vers la miniature 
du plan que vous souhaitez lire.

4	 Appuyez sur la touche de mise en 
application du sélecteur multiple ou la 
molette multifonction.
La lecture commence au début du plan 
sélectionné.

Vous pouvez contrôler la lecture en appuyant 
sur l’une des touches suivantes.
Appuyez sur la touche de mise en application 

du sélecteur multiple ou la molette 
multifonction : 
La lecture se met en pause.  
Appuyez de nouveau sur la molette pour 
revenir à la lecture normale.

Appuyez sur les touches gauche/droite du 
sélecteur multiple : 
Passe au début du plan ou au plan 
précédent/suivant.

Maintenez les touches gauche/droite du 
sélecteur multiple enfoncées : 
Lecture accélérée arrière/avant.  
Revient en lecture normale lorsque vous 
relâchez la touche.

Touche CANCEL/BACK : 
Arrête la lecture et revient en mode de 
veille d’enregistrement.

[Remarques]
ˎˎ Il peut y avoir une interruption temporaire de l’image 

ou une image fixe entre les plans. Vous ne pouvez 
pas utiliser le caméscope durant cette période.
ˎˎ Lorsque vous sélectionnez un plan dans l’écran de 

miniatures et commencez la lecture, il peut y avoir 
une interruption temporaire de l’image au début du 
plan. Pour voir le début du plan sans interruption, 
mettez le caméscope en mode de lecture, mettez 
la lecture en pause, utilisez la touche gauche du 
sélecteur multiple pour revenir au début du plan et 
redémarrez la lecture.

[Conseil]
Lors de la lecture d’un plan enregistré en mode de 
prise de vue Log, la valeur EI et le LUT utilisés lors 
de l’enregistrement du plan sont appliqués. Le LUT 
à appliquer est déterminé à partir des informations 
contenues dans le fichier 3D LUT enregistré en tant que 
métadonnées.
Si le plan a été enregistré avec Cine EI/Flex.ISO Set 
>Embed LUT File (page 86) dans le menu Project du 
menu complet réglé sur On lors de la prise de vue, ce 
LUT s’applique pour la lecture si le fichier 3D LUT utilisé 
lors de la prise de vue est installé sur l’appareil.
Si le plan a été enregistré avec Cine EI/Flex.ISO Set 
>Embed LUT File (page 86) dans le menu Project 
du menu complet réglé sur Off lors de la prise de 
vue, le LUT sélectionné à l’aide de Base Look >Select 
(page 92) dans le menu Paint/Look du menu complet 
s’applique pour la lecture.
Le même LUT s’applique si le fichier 3D LUT utilisé lors 
de la prise de vue n’est pas installé sur l’appareil.
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Sur l’écran de miniatures, vous pouvez utiliser 
des plans ou vérifier les propriétés d’un plan 
en utilisant le menu Thumbnail du menu 
complet.
Le menu Thumbnail (page 103) apparaît 
lorsque vous maintenez la touche MENU 
enfoncée et sélectionnez Thumbnail.

Opérations sur le menu de 
miniatures

Avec le sélecteur multiple (page 7) 
ou la molette multifonction (page 5), 
sélectionnez une fonction, puis appuyez sur 
la touche de mise en application du sélecteur 
multiple ou sur la molette multifonction.
Appuyez sur la touche CANCEL/BACK 
(page 5) pour retourner à l’écran 
précédent.

[Remarque]
Certains éléments ne peuvent pas être sélectionnés, 
selon l’état lorsque le menu a été affiché.

Éléments de menu destinés aux 
opérations sur les plans

ˎˎ Display Clip Properties
ˎˎ Set Clip Flag
ˎˎ Lock/Unlock Clip
ˎˎ Delete Clip
ˎˎ Transfer Clip
ˎˎ Transfer Clip (Proxy)
ˎˎ Filter Clips
ˎˎ Customize View

Pour plus de détails concernant les éléments 
de menu d’opérations sur les plans, voir le 
menu Thumbnail (page 103).

Affichage des propriétés de plan

Sélectionnez Display Clip Properties 
(page 103) dans le menu de miniatures pour 
afficher l’écran de propriétés de plan.
Appuyez sur les touches gauche/droite 
du sélecteur multiple pour passer au plan 
précédent/suivant.

Ajout de balises de plan

Vous pouvez ajouter des balises (repères OK, 
NG ou KP) aux plans pour filtrer l’affichage des 
plans en fonction des balises.
Sélectionnez la miniature du plan auquel 
ajouter une balise de plan, puis sélectionnez 
la balise de plan à l’aide de Set Clip Flag 
(page 103) dans le menu Thumbnail du 
menu complet.

Réglage Balise de plan ajoutée

Add OK OK

Add NG NG

Add KEEP KP

[Conseils]
ˎˎ Vous pouvez également utiliser une touche 

personnalisable à laquelle la fonction de balise de 
plan est attribuée pour ajouter des balises de plan 
(page 49).
ˎˎ Vous pouvez ajouter une balise de plan OK 

(page 53) à la miniature du plan sélectionné en 
appuyant sur la touche Clip Flag (page 5).

Affichage de l’écran de miniatures de 
plans filtré

Sélectionnez Filter Clips (page 103) dans 
le menu Thumbnail du menu complet et 
sélectionnez un type de balise de plan pour 
afficher uniquement les plans qui possèdent 
la balise spécifiée.
Pour afficher tous les plans, sélectionnez All.

[Conseil]
Vous pouvez également commuter les filtres dans 
l’ordre à l’aide de la touche DISPLAY.

Suppression de plans

Vous pouvez supprimer des plans de cartes 
mémoire.
Sélectionnez Delete Clip >Select Clip ou All 
Clips dans le menu Thumbnail du menu 
complet.
Select Clip : 

Supprime le plan sélectionné. Il est 
possible de sélectionner plusieurs plans.

All Clips : 
Supprime tous les plans affichés.

Modification des informations affichées 
sur l’écran de miniatures

Vous pouvez modifier les informations de 
plans/images affichées sous la miniature.
Sélectionnez Customize View >Thumbnail 
Caption dans le menu Thumbnail du menu 
complet et sélectionnez les informations à 
afficher.

Date Time : 
Affiche la date et l’heure à laquelle le plan 
a été créé et modifié pour la dernière fois.

Time Code : 
Affiche le code temporel.

Duration : 
Affiche la durée du plan.

Sequential Number : 
Affiche un numéro séquentiel sur chaque 
miniature.

Opérations sur les plans
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Configuration et hiérarchie du menu complet
Maintenez la touche MENU enfoncée pour 
afficher le menu complet dans le viseur et 
spécifier divers éléments pour la prise de 
vue, l’enregistrement et la lecture (le menu 
peut également être affiché sur un moniteur 
externe). Le menu complet se compose des 
menus suivants.

Configuration du menu

Menu User
Contient des éléments de menu 
configurés par l’utilisateur depuis le menu 
Edit User.

Menu Edit User
Contient des éléments de menu pour 
éditer le menu User.

Menu Shooting
Contient des réglages liés à la prise de 
vue.

Menu Project
Contient des réglages de base du projet.

Menu Paint/Look
Contient des réglages liés à la qualité 
d’image.

Menu TC/Media
Contient des réglages liés aux codes 
temporels et au support d’enregistrement.

Menu Monitoring
Contient des réglages liés à la sortie vidéo 
et à l’affichage du viseur.

Menu Audio
Contient des réglages liés à l’audio.

Menu Thumbnail
Contient des réglages liés à l’affichage de 
miniatures.

Menu Technical
Contient des réglages liés aux éléments 
techniques.

Menu Network
Contient des réglages liés aux réseaux.

Menu Maintenance
Contient des réglages liés aux appareils, 
par exemple l’horloge et la langue.

Hiérarchie du menu complet

User 
(réglages par 
défaut)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Assignable Button

Assignable Dial

Multi Function Dial

All File

Clip Name Format

Format Media

VF Setting

Zebra

Zoom

Menu Settings

Edit User Menu Add Item

Customize Reset

Shooting ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project Base Setting

Rec Format

Cine EI/Flex.ISO Set

HDR Setting

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Assignable Dial

Multi Function Dial

User File

All File

Paint/Look Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

TC/Media Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Monitoring Output On/Off

Output Format

De-Squeeze

Output Display

Display On/Off

Marker

VF Setting

Gamma Display Assist

Peaking

Zebra

Audio Audio Input

Audio Output

Thumbnail Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical Color Bars

ND Dial

Tally

HOLD Switch Setting

Touch Operation

Rec Review

Zoom

Handle Zoom

Menu Settings

Menu Page On/Off

Fan Control

Lens

Video Light Set

APR

Camera Battery Alarm

Camera DC IN Alarm
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Network Access Authentication

Wireless LAN

AP Mode Settings

ST Mode Settings

Wired LAN

Modem

File Transfer

Network Reset

Maintenance Language

Clock Set

All Reset

Hours Meter

Version
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Opérations du menu complet
Maintenez la touche MENU enfoncée pour 
afficher le menu complet dans le viseur et 
spécifier divers réglages détaillés (le menu 
peut également être affiché sur un moniteur 
externe).

Commandes de menu

Touche MENU (page 5)
Appuyez longuement pour afficher le 
menu complet. Appuyez à nouveau 
lorsque le menu complet est affiché pour 
le masquer.

Sélecteur multiple (touches 8 voies D-pad et 
de mise en application) (page 7)

Appuyez sur les touches 8 voies D-pad 
pour déplacer le curseur vers le haut/le 
bas/la gauche/la droite et sélectionner 
des éléments ou des réglages de menu.
Appuyez sur la touche de mise en 
application du sélecteur multiple pour 
appliquer l’élément sélectionné.

Molette multifonction (page 5)
Tournez la molette multifonction pour 
déplacer le curseur vers le haut/bas et 
sélectionner des éléments ou des 
réglages de menu.
Appuyez sur la molette multifonction pour 
appliquer l’élément sélectionné.

Touche CANCEL/BACK (page 5)
Appuyez pour revenir au menu précédent. 
Toute modification incomplète est 
annulée.

[Remarques]
ˎˎ Le menu complet ne peut pas être actionné en mode 

de loupe de mise au point (page 37).
ˎˎ Certains éléments ne peuvent pas être sélectionnés, 

selon l’état lorsque le menu a été affiché.

Réglage d’éléments de menu

Appuyez sur les touches 8 voies D-pad 
ou tournez la molette multifonction pour 
déplacer le curseur vers l’élément de menu à 
régler, puis appuyez sur la touche de mise en 
application ou la molette multifonction pour 
sélectionner l’élément.
ˎˎ La zone de sélection d’élément de menu 
affiche jusqu’à huit lignes. Si les options 
disponibles pour un élément ne peuvent 
pas être affichées en même temps, faites 
défiler l’affichage en déplaçant le curseur 
vers le haut/bas.
ˎˎ Pour les sous-éléments avec une grande 
plage de réglages (par exemple –99 à +99), 
la zone des réglages n’est pas affichée. Le 
paramètre actuel est mis en surbrillance 
pour indiquer que la valeur peut être 
changée.
ˎˎ Le fait de sélectionner [Execute] pour une 
fonction permet d’exécuter la fonction 
correspondante.
ˎˎ Le fait de sélectionner un élément qui 
nécessite confirmation avant exécution 
cache temporairement le menu et affiche 
un message de confirmation. Vérifiez le 
message, puis sélectionnez l’exécution ou 
l’annulation de la fonction.

Saisie d’une chaîne de caractères

Quand vous sélectionnez un élément, tel 
qu’un nom de fichier, qui exige la saisie de 
caractères, l’écran de saisie de caractères 
s’affiche.

1

2 3

1	 Appuyez sur les touches 8 voies D-pad ou 
tournez la molette multifonction pour 
sélectionner un type de caractère, puis 
appliquez le réglage.
ABC : lettres majuscules
abc : lettres minuscules
123 : caractères numériques
!#$ : caractères spéciaux

2	 Sélectionnez un caractère dans le type de 
caractère sélectionné, puis appliquez le 
réglage.
Le curseur passe au champ suivant.

Space : permet de saisir un espace au 
niveau du curseur.

/ : permet de déplacer le curseur.
BS : permet de supprimer le caractère à 

gauche du curseur (espacement 
arrière).

3	 Lorsque vous avez terminé, sélectionnez 
[Done] et appliquez le réglage.
La chaîne de caractères est confirmée et 
l’écran de saisie de caractères disparaît.

Verrouillage et déverrouillage du 
menu

Vous pouvez verrouiller le menu complet de 
sorte que seul le menu User s’affiche.
Dans cet état, vous ne pouvez pas modifier les 
réglages à l’aide des écrans d’état.

Verrouillage du menu

1	 Maintenez la molette multifonction 
enfoncée et maintenez la touche MENU.

2	 Sélectionnez Menu Settings >User Menu 
with Lock dans le menu Technical.

	 [Remarque]
Lorsque vous maintenez enfoncée uniquement 
la touche MENU pour afficher le menu complet 
normal, User Menu Only s’affiche sous Menu 
Settings dans le menu Technical. Maintenez la 
molette multifonction enfoncée et maintenez la 
touche MENU pour afficher User Menu with Lock.

3	 Réglez sur On et appuyez sur la touche de 
mise en application ou la molette 
multifonction.
L’affichage de l’écran du viseur bascule 
sur l’écran de saisie du numéro de code.

4	 Saisissez un numéro arbitraire.
Saisissez un numéro à 4 chiffres compris 
entre 0000 et 9999. La valeur par défaut 
est 0000.
Saisissez un numéro et appuyez sur la 
touche de mise en application ou la 
molette multifonction pour déplacer le 
curseur sur le chiffre suivant.
Une fois tous les chiffres saisis, déplacez 
le curseur sur SET.

5	 Appuyez sur la touche de mise en 
application ou la molette multifonction.
La saisie s’applique.
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Un message de confirmation apparaît, et 
l’écran bascule sur l’affichage du menu 
User.

Déverrouillage du menu

1	 Maintenez la molette multifonction 
enfoncée et maintenez la touche MENU.

2	 Sélectionnez Menu Settings >User Menu 
with Lock dans le menu User.

	 [Remarque]
Lorsque vous maintenez enfoncée uniquement 
la touche MENU pour afficher le menu complet 
normal, User Menu Only s’affiche sous Menu 
Settings dans le menu Technical. Maintenez la 
molette multifonction enfoncée et maintenez la 
touche MENU pour afficher User Menu with Lock.

3	 Réglez sur Off et appuyez sur la touche de 
mise en application ou la molette 
multifonction.
L’affichage de l’écran du viseur bascule 
sur l’écran de saisie du numéro de code.

4	 Saisissez le numéro de code utilisé pour 
verrouiller le menu.
Saisissez un numéro et appuyez sur la 
touche de mise en application ou la 
molette multifonction pour déplacer le 
curseur sur le chiffre suivant.
Une fois tous les chiffres saisis, déplacez 
le curseur sur Set.

5	 Appuyez sur la touche de mise en 
application ou la molette multifonction.
La saisie s’applique.
Si le numéro de code saisi correspond au 
numéro de code utilisé pour verrouiller le 
menu, le menu se déverrouille et s’affiche.

[Remarques]
ˎˎ Si le numéro de code saisi ne correspond pas au 

numéro de code utilisé pour verrouiller le menu, le 
menu n’est pas déverrouillé.

ˎˎ Il est recommandé de prendre note du numéro 
de code et le laisser à proximité, au cas où vous 
l’oublieriez. Si vous oubliez votre numéro de code, 
contactez votre représentant du service à la clientèle 
Sony.
ˎˎ Si le menu est verrouillé avant l’enregistrement des 

éléments du menu complet depuis le tableau suivant 
dans le menu User, ces fonctions ne pourront pas être 
affectées aux touches personnalisables.
ˎˎ Si ces fonctions ont déjà été affectées aux touches 

attribuables, le réglage affecté est forcément 
désactivé lorsque le menu est verrouillé.

Élément du menu 
complet

Sélection de la 
touche 
personnalisable

Shooting >ISO/Gain/EI 
>Base Sensitivity,  
Shooting >ISO/Gain/EI 
>Base ISO

Base ISO/Sensitivity

Shooting >Auto 
Exposure >AGC

AGC

— Auto ND Filter

Shooting >Iris >Bokeh 
Control

Bokeh Control

Shooting >Auto 
Exposure >Auto Shutter

Auto Shutter

Shooting >Auto 
Exposure >Level

Auto Exposure Level

Shooting >Auto 
Exposure >Mode

Backlight

Shooting >Auto 
Exposure >Mode

Spotlight

Shooting >White > 
Preset White

Preset White Select

Shooting >Focus > 
AF Transition Speed,  
Shooting >Focus > 
AF Subj. Shift Sens.

AF Speed/Sens.

Shooting >Focus > 
Focus Area

Focus Area

Shooting >Focus > 
Focus Area(AF-S)

Focus Area(AF-S)

Shooting >Focus > 
Face/Eye Detection AF

Face/Eye Detection 
AF

Élément du menu 
complet

Sélection de la 
touche 
personnalisable

Shooting >Focus > 
Push AF Mode

Push AF Mode

Shooting >S&Q Motion 
>Setting

S&Q Motion

Shooting >SteadyShot 
>Setting

SteadyShot

Project >Picture Cache 
Rec >Setting

Picture Cache Rec

Technical >Rec Review 
>Setting

Rec Review

Thumbnail >Set Clip 
Flag >Add OK

Clip Flag OK

Thumbnail >Set Clip 
Flag >Add NG

Clip Flag NG

Thumbnail >Set Clip 
Flag >Add KEEP

Clip Flag Keep

Technical >Color Bars 
>Setting

Color Bars

Monitoring >Display 
On/Off >Lens Info

Lens Info

Monitoring >Display 
On/Off >Video Signal 
Monitor

Video Signal 
Monitor

Monitoring >Marker 
>Setting

Marker

Monitoring >VF Setting 
>Color Mode

VF Mode

Monitoring >Gamma 
Display Assist >Setting

Gamma Display 
Assist

Monitoring >Peaking 
>Setting

Peaking

Monitoring >Zebra 
>Setting

Zebra

Audio >Audio Output 
>Volume

Volume

Technical >Touch 
Operation >Setting

Touch Operation

Technical >Handle 
Zoom >Setting

Handle Zoom

Élément du menu 
complet

Sélection de la 
touche 
personnalisable

Network >Wireless LAN 
>NFC

NFC

Network >File Transfer 
>Auto Upload (Proxy)

Auto Upload (Proxy)

User User Menu
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Menu User
Cette section décrit la fonction et les réglages des éléments de chaque menu.

User

Élément Description

Base Setting Élément Project >Base Setting

Focus Élément Shooting >Focus

S&Q Motion Élément Shooting >S&Q Motion

LUT On/Off Élément Shooting >LUT On/Off

Simul Rec Élément Project >Simul Rec

Proxy Rec Élément Project >Proxy Rec

Interval Rec Élément Project >Interval Rec

Assignable Button Élément Project >Assignable Button

Assignable Dial Élément Project >Assignable Dial

Multi Function Dial Élément Project >Multi Function Dial

All File Élément Project >All File

Clip Name Format Élément TC/Media >Clip Name Format

Format Media Élément TC/Media >Format Media

VF Setting Élément Monitoring >VF Setting

Zebra Élément Monitoring >Zebra

Zoom Élément Technical >Zoom

Menu Settings Élément Technical >Menu Settings

Edit User Menu Affiche l’écran de menu Edit User.

[Remarque]
Vous pouvez ajouter et supprimer des éléments de menu dans le menu User à l’aide du menu Edit User. Jusqu’à 
20 éléments peuvent être configurés.
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Menu Edit User
Le menu Edit User est affiché au niveau supérieur quand Edit User Menu est sélectionné dans le 
menu User.

Edit User

Élément Réglage de sous-éléments Description

Add Item
Ajouter un élément au 
menu User

Ajoute un élément de menu au 
menu User.

Customize Reset
Réinitialiser les 
éléments dans le menu 
User

Restaure les éléments de menu 
enregistrés dans le menu User aux 
réglages par défaut.

Elément de menu 
sélectionné pendant 
l’édition

Delete Supprime l’élément de menu 
enregistré du menu User.

Move Réorganise les éléments de menu 
enregistrés du menu User.

Edit Sub Item Édite (enregistrer/supprimer) les 
sous-éléments de menu enregistrés 
dans le menu User.
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Menu Shooting
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Shooting >ISO/Gain/EI
Définit les réglages de gain.

Élément Réglage de sous-éléments Description

Mode ISO/dB Sélectionne le mode de réglage du gain.

[Remarque]
En modes de prise de vue Log, ce réglage est 
défini sur ISO (fixe).

ISO/Gain<H> Pour plus de détails sur les réglages, 
consultez « Réglages et valeurs par défaut 
d’ISO/Gain » (page 112).

Règle la valeur prédéfinie de gain <H>.

[Remarque]
Cette fonction ne peut pas être configurée en 
mode de prise de vue Cine EI/Cine EI Quick.

ISO/Gain<M> Pour plus de détails sur les réglages, 
consultez « Réglages et valeurs par défaut 
d’ISO/Gain » (page 112).

Règle la valeur prédéfinie de gain <M>.

[Remarque]
Cette fonction ne peut pas être configurée en 
mode de prise de vue Cine EI/Cine EI Quick.

ISO/Gain<L> Pour plus de détails sur les réglages, 
consultez « Réglages et valeurs par défaut 
d’ISO/Gain » (page 112).

Règle la valeur prédéfinie de gain <L>.

[Remarque]
Cette fonction ne peut pas être configurée en 
mode de prise de vue Cine EI/Cine EI Quick.

Shooting >ISO/Gain/EI
Définit les réglages de gain.

Élément Réglage de sous-éléments Description

Exposure 
Index<H>

Cine EI
Lorsque Base ISO est réglé sur ISO 800 :

200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E

Lorsque Base ISO est réglé sur ISO 
12800 :

3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Règle la valeur d’indice de pose <H>.
Activé uniquement en mode de prise de 
vue Cine EI/Cine EI Quick.
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Shooting >ISO/Gain/EI
Définit les réglages de gain.

Élément Réglage de sous-éléments Description

Exposure 
Index<H>

Cine EI Quick
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Règle la valeur d’indice de pose <H>.
Activé uniquement en mode de prise de 
vue Cine EI/Cine EI Quick.

Exposure 
Index<M>

(Mêmes réglages qu’Exposure Index<H>)
Cine EI

Lorsque Base ISO est réglé sur ISO 800 :
1000EI / 6.3E

Lorsque Base ISO est réglé sur ISO 
12800 :

16000EI / 6.3E
Cine EI Quick

800EI / 6.0E

Règle la valeur d’indice de pose <M>.

Shooting >ISO/Gain/EI
Définit les réglages de gain.

Élément Réglage de sous-éléments Description

Exposure 
Index<L>

(Mêmes réglages qu’Exposure Index<H>)
Cine EI

Lorsque Base ISO est réglé sur ISO 800 :
800EI / 6.0E

Lorsque Base ISO est réglé sur ISO 
12800 :

12800EI / 6.0E
Cine EI Quick

800EI / 6.0E

Règle la valeur d’indice de pose <L>.

Shockless 
Gain

On / Off Active/désactive la fonction Shockless 
gain.

Base 
Sensitivity

High / Low Règle la sensibilité de base pour le mode 
de prise de vue Custom.

Base ISO ISO 12800 / ISO 800 Règle la sensibilité ISO de base pour le 
mode de prise de vue mode Flexible ISO/
Cine EI.

[Remarque]
Cette fonction ne peut pas être configurée 
en mode de prise de vue Cine EI Quick. 
La sensibilité ISO de base est configurée 
automatiquement en lien avec Exposure Index.

Shooting >ND Filter
Règle les valeurs prédéfinies pour le filtre ND.

Élément Réglage de sous-éléments Description

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Règle la valeur prédéfinie 1 pour le filtre 
ND.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Règle la valeur prédéfinie 2 pour le filtre 
ND.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Règle la valeur prédéfinie 3 pour le filtre 
ND.

Shooting >Shutter
Règle le fonctionnement de l’obturateur électronique.

Élément Réglage de sous-éléments Description

Mode Speed / Angle Sélectionne le mode de fonctionnement 
de l’obturateur électronique.
Utilisé pour filmer de manière nette des 
sujets se déplaçant rapidement. 
Sélectionne le mode pour régler la 
vitesse d’obturateur en secondes (Speed) 
ou comme angle d’obturateur (Angle).
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Shooting >Shutter
Règle le fonctionnement de l’obturateur électronique.

Élément Réglage de sous-éléments Description

Shutter 
Speed  
On/Off

On / Off Définit si, lorsque le mode Speed est 
sélectionné, la durée d’exposition suit la 
valeur de Shutter Speed ou est réglée 
pour l’exposition totale.

Shutter 
Speed

64F à 1/8000
Les réglages disponibles varient en 
fonction de la fréquence du système du 
format d’enregistrement sélectionné.
59.94P : 

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

50P : 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

29.97P : 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

25P : 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

24P/23.98P : 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 
1/250 / 1/500 / 1/1000 / 1/2000 / 
1/4000 / 1/8000

Règle la vitesse d’obturateur quand 
Mode est réglé sur Speed.

Shutter Angle 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 360.0° / 300.0° /  
270.0° / 240.0° / 216.0° / 210.0° /  
180.0° / 172.8° / 150.0° / 144.0° /  
120.0° / 90.0° / 86.4° / 72.0° / 45.0° / 
30.0° / 22.5° / 11.25° / 5.6°

Règle l’angle d’obturateur quand Mode 
est réglé sur Angle.

Shooting >Shutter
Règle le fonctionnement de l’obturateur électronique.

Élément Réglage de sous-éléments Description

ECS On/Off On / Off Permet d’activer/de désactiver la 
fonction d’atténuation de balayage 
étendue.

ECS 
Frequency

23.99 à 8000
Les réglages disponibles varient en 
fonction de la fréquence du système du 
format d’enregistrement sélectionné.
Les valeurs par défaut sont données 
ci-dessous.
59.94P : 60.00
50P : 50.00
29.97P : 30.00
23.98P : 23.99
25P : 25.02
24P : 24.02

Règle la fréquence d’ECS quand Mode 
est réglé sur ECS.

Shooting >Iris
Définit les réglages de la fonction de contrôle du bokeh.

Élément Réglage de sous-éléments Description

Bokeh 
Control

On / Off Active/désactive la fonction de contrôle 
du bokeh.

Shooting >Auto Exposure
Définit les réglages d’ajustement de l’exposition automatique.

Élément Réglage de sous-éléments Description

Level +3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 / 
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 / 
±0 / –0.25 / –0.5 / –0.75 / –1.0 / –1.25 / 
–1.5 / –1.75 / –2.0 / –2.25 / –2.5 / –2.75 / 
–3.0

Règle le niveau de luminosité pour 
l’exposition détectée de manière 
automatique.

Mode Backlight / Standard / Spotlight Règle le mode de fonctionnement du 
réglage d’exposition automatique.
Backlight : 

Mode Backlight (mode qui atténue 
l’obscurité d’un sujet lorsque le sujet 
est rétroéclairé)

Standard : 
Mode Standard

Spotlight : 
Mode Spotlight (mode qui atténue 
les blancs écrêtés lorsque le sujet est 
éclairé par la lumière d’un spot)

Speed –99 à +99 (±0) Règle la vitesse de réglage du réglage 
d’exposition automatique.
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Shooting >Auto Exposure
Définit les réglages d’ajustement de l’exposition automatique.

Élément Réglage de sous-éléments Description

AGC On / Off Active/désactive la fonction AGC 
(commande de gain automatique).

[Remarque]
Ceci est réglé sur Off (fixe) en mode de prise de 
vue Cine EI/Cine EI Quick.

AGC Limit Pour plus de détails sur les réglages, 
consultez « Réglages et valeurs par défaut 
de AGC Limit » (page 115).

Règle le gain maximum de la fonction 
AGC.

[Remarque]
Cette fonction ne peut pas être configurée en 
mode de prise de vue Cine EI/Cine EI Quick.

AGC Point F2.8 / F4 / F5.6 Règle la valeur F-stop du diaphragme là 
où démarre l’opération de commande de 
gain automatique lorsque la fonction 
AGC est réglée sur On.

[Remarque]
Cette fonction ne peut pas être configurée en 
mode de prise de vue Cine EI/Cine EI Quick.

Auto Shutter On / Off Active/désactive la fonction de 
commande d’obturateur automatique.

[Remarque]
Ceci est réglé sur Off (fixe) en mode de prise de 
vue Cine EI/Cine EI Quick.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 Règle la vitesse d’obturateur la plus 
rapide de la fonction d’obturateur 
automatique.

[Remarque]
Cette fonction ne peut pas être configurée en 
mode de prise de vue Cine EI/Cine EI Quick.

A.SHT Point F5.6 / F8 / F11 / F16 Règle la valeur F-stop du diaphragme là 
où démarre l’opération de commande 
d’obturateur automatique.

[Remarque]
Cette fonction ne peut pas être configurée en 
mode de prise de vue Cine EI/Cine EI Quick.

Clip High 
light

On / Off Active/désactive la fonction qui ignore 
les zones les plus lumineuses pour 
fournir une réponse plus plate avec une 
luminance élevée.

Shooting >Auto Exposure
Définit les réglages d’ajustement de l’exposition automatique.

Élément Réglage de sous-éléments Description

Detect 
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom Règle la plage d’intégrateur de lumière 
pour l’ajustement automatique de 
l’exposition en fonction de la luminosité 
du sujet. (Non disponible en cas de 
réglage manuel de la pose)

Detect 
Window 
Indication

On / Off Active/désactive l’indication de la plage 
d’intégrateur de lumière.

Custom 
Width

40 à 999 (500) Permet de régler la largeur de la plage 
d’intégrateur de lumière.

Custom 
Height

70 à 999 (500) Permet de régler la hauteur de la plage 
d’intégrateur de lumière.

Custom H 
Position

–479 à +479 (±0) Permet de régler la position horizontale 
de la plage d’intégrateur de lumière.

Custom V 
Position

–464 à +464 (±0) Permet de régler la position verticale de 
la plage d’intégrateur de lumière.

Shooting >White
Définit les réglages de l’équilibre des blancs.

Élément Réglage de sous-éléments Description

Preset White 2000K à 15000K (3200K) Règle la valeur prédéfinie de l’équilibre 
des blancs.

Color Temp 
<A>

2000K à 15000K (3200K) Règle la température de couleur de 
l’équilibre des blancs stockée dans la 
mémoire A.

[Remarque]
Comme Color Temp est écrêté à 2000K et 
15000K pendant l’opération R/B Gain, il n’est 
pas possible d’afficher la valeur correcte de 
Color Temp pour la valeur R/B Gain.

Tint<A> –99 à +99 (±0) Permet de régler la valeur de teinte de la 
balance des blancs stockée dans la 
mémoire des blancs A.

[Remarque]
Comme Tint est écrêté à ±99 pendant 
l’opération R/B Gain, il n’est pas possible 
d’afficher la valeur correcte de Tint pour la 
valeur R/B Gain.

R Gain <A> –99.0 à +99.0 (±0.0) Règle la valeur de gain R de l’équilibre 
des blancs stockée dans la mémoire A.

B Gain <A> –99.0 à +99.0 (±0.0) Règle la valeur de gain B de l’équilibre 
des blancs stockée dans la mémoire A.
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Shooting >White
Définit les réglages de l’équilibre des blancs.

Élément Réglage de sous-éléments Description

Color Temp 
<B>

2000K à 15000K (3200K) Règle la température de couleur de 
l’équilibre des blancs stockée dans la 
mémoire B.

[Remarque]
Comme Color Temp est écrêté à 2000K et 
15000K pendant l’opération R/B Gain, il n’est 
pas possible d’afficher la valeur correcte de 
Color Temp pour la valeur R/B Gain.

Tint<B> –99 à +99 (±0) Permet de régler la valeur de teinte de la 
balance des blancs stockée dans la 
mémoire des blancs B.

[Remarque]
Comme Tint est écrêté à ±99 pendant 
l’opération R/B Gain, il n’est pas possible 
d’afficher la valeur correcte de Tint pour la 
valeur R/B Gain.

R Gain <B> –99.0 à +99.0 (±0.0) Règle la valeur de gain R de l’équilibre 
des blancs stockée dans la mémoire B.

B Gain <B> –99.0 à +99.0 (±0.0) Règle la valeur de gain B de l’équilibre 
des blancs stockée dans la mémoire B.

Shooting >White Setting
Définit les réglages de balance des blancs.

Élément Réglage de sous-éléments Description

Shockless 
White

Off / 1 / 2 / 3 Règle la vitesse de réaction d’équilibre 
des blancs en cas de commutation du 
mode d’équilibre des blancs.
Off : commute instantanément.
1 à 3 : plus la valeur est élevée, plus la 

commutation est lente.

ATW Speed 1 / 2 / 3 / 4 / 5 Règle la vitesse de réaction en mode 
ATW.
1 : vitesse de réaction la plus rapide

White 
Switch<B>

Memory / ATW Sélectionne le mode de réglage 
d’équilibre des blancs sélectionné quand 
le commutateur WHT BAL est réglé sur B.

[Remarque]
Ceci est réglé sur Memory (fixe) en mode de 
prise de vue Cine EI/Cine EI Quick.

Shooting >White Setting
Définit les réglages de balance des blancs.

Élément Réglage de sous-éléments Description

Filter White 
Memory

On / Off Active/désactive la fonction de réglage 
de la zone de mémoire d’équilibre des 
blancs pour chaque filtre ND.
On : règle la mémoire d’équilibre des 

blancs pour chaque filtre ND.

	 [Conseil]
En mode prédéfini, quatre réglages 
existent (CLEAR/1/2/3). En mode variable, 
deux réglages existent (CLEAR/On).

Off : règle la mémoire d’équilibre des 
blancs commune à tous les filtres ND.

Shooting >Offset White
Définit les réglages de correction de l’équilibre des blancs.

Élément Réglage de sous-éléments Description

Offset White 
<A>

On / Off Choisit d’ajouter (On) ou non (Off) une 
valeur de décalage à l’équilibre des 
blancs dans la mémoire A.

[Remarque]
Ceci est réglé sur OFF (fixe) en modes de prise 
de vue Log.

Offset Color 
Temp<A>

–99 à +99 (±0) Règle la correction de température de 
couleur à ajouter à l’équilibre des blancs 
dans la mémoire A quand Offset White 
<A> est réglé sur On.

Offset 
Tint<A>

–99 à +99 (±0) Règle la correction de valeur Tint à 
ajouter à l’équilibre des blancs dans la 
mémoire A quand Offset White <A> est 
réglé sur On.

Offset White 
<B>

On / Off Permet de choisir d’ajouter (On) ou de ne 
pas ajouter (Off) une valeur de correction 
à l’équilibre des blancs dans la mémoire 
B.

[Remarque]
Ceci est réglé sur OFF (fixe) en modes de prise 
de vue Log.

Offset Color 
Temp<B>

–99 à +99 (±0) Règle la correction de température de 
couleur à ajouter à l’équilibre des blancs 
dans la mémoire B quand Offset White 
<B> est réglé sur On.
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Shooting >Offset White
Définit les réglages de correction de l’équilibre des blancs.

Élément Réglage de sous-éléments Description

Offset 
Tint<B>

–99 à +99 (±0) Règle la correction de valeur Tint à 
ajouter à l’équilibre des blancs dans la 
mémoire B quand Offset White <B> est 
réglé sur On.

Offset White 
<ATW>

On / Off Permet de choisir d’ajouter (On) ou de ne 
pas ajouter (Off) une valeur de correction 
à l’équilibre des blancs ATW.

Offset Color 
Temp<ATW>

–99 à +99 (±0) Règle la correction de température de 
couleur à ajouter à l’équilibre des blancs 
ATW quand Offset White <ATW> est réglé 
sur On.

Offset 
Tint<ATW>

–99 à +99 (±0) Règle la correction de valeur Tint à 
ajouter à l’équilibre des blancs ATW 
quand Offset White <ATW> est réglé sur 
On.

Shooting >Focus
Définit les réglages de mise au point.

Élément Réglage de sous-éléments Description

AF Transition 
Speed

1(Slow) / 2 / 3 / 4 / 5 / 6 / 7(Fast) Permet de régler la vitesse 
d’entraînement de la mise au point pour 
le changement de sujet lors de la mise 
au point automatique.

AF Subj. Shift 
Sens.

1(Locked On) / 2 / 3 / 4 / 5(Responsive) Permet de régler la sensibilité de la mise 
au point en cas de changement de sujet 
pendant la mise au point automatique.

Focus Area Wide / Zone / Flexible Spot Règle la zone cible pour la mise au point 
automatique et la mise au point 
automatique par pression (AF) 
(page 38).
Wide : 

Recherche un sujet dans un grand 
angle de l’image lors de la mise au 
point.

Zone : 
Recherche automatiquement un 
point de mise au point dans la zone 
spécifiée.

Flexible Spot : 
Effectue la mise au point sur une 
position spécifique dans l’image.

Shooting >Focus
Définit les réglages de mise au point.

Élément Réglage de sous-éléments Description

Focus Area 
(AF-S)

Flexible Spot Règle la zone cible pour la mise au point 
automatique par pression (AF-S).

Face/Eye 
Detection AF

Face/Eye Only AF / Face/Eye Priority AF / 
Off

Active/désactive la détection des visages 
AF.

Push AF 
Mode

AF / Single-shot AF(AF-S) Règle le mode de mise au point 
automatique par pression pendant la 
mise au point manuelle.

Touch 
Function in 
MF

Tracking AF / Spot Focus Règle l’action qui se produit lorsque vous 
appuyez sur le panneau tactile pendant 
la mise au point manuelle.

AF Assist On / Off Quand ce réglage est réglé sur On, il est 
possible de changer temporairement la 
mise au point automatique et d’effectuer 
la mise au point manuellement.

Shooting >S&Q Motion
Définit les réglages du mode Slow & Quick Motion (page 50).

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive le mode 
d’enregistrement ralenti et accéléré.
Lorsqu’il est activé, les fonctions 
suivantes sont désactivées.

ˎˎ Diaphragme automatique
ˎˎ Mise au point automatique

Frame Rate 1fps à 60fps / 100fps / 120fps / 150fps / 
180fps / 200fps / 240fps

Règle la fréquence d’images pour la prise 
de vue au ralenti et accéléré.

[Remarque]
Les réglages disponibles varient en fonction 
de la fréquence du système, du codec et du 
format vidéo sélectionnés.

Shooting >LUT On/Off
Définit les réglages LUT.

Élément Réglage de sous-éléments Description

SDI/HDMI MLUT On / MLUT Off Sélectionne l’application ou non de 
Monitor LUT aux sorties vidéo SDI et 
HDMI.

VF/Proxy/
Stream

MLUT On / MLUT Off Sélectionne l’application ou non de 
Monitor LUT aux sorties vidéo du viseur, 
proxy et streaming.
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Shooting >LUT On/Off
Définit les réglages LUT.

Élément Réglage de sous-éléments Description

Internal Rec MLUT On / MLUT Off Sélectionne l’application ou non de 
Monitor LUT à la vidéo d’enregistrement 
interne.

Shooting >Noise Suppression
Définit les réglages de suppression de bruit.

[Conseil]
Les réglages Setting(Custom) et Level(Custom) sont reflétés dans le réglage Target Display (page 118).

Élément Réglage de sous-éléments Description

Setting 
(Custom)

On / Off Active/désactive la fonction de 
suppression de bruit en mode de prise 
de vue Custom.

[Remarque]
Cette fonction ne peut pas être configurée en 
modes de prise de vue Log.

Level 
(Custom)

Low / Mid / High Règle le niveau de suppression de bruit 
en mode de prise de vue Custom.

[Remarque]
Cette fonction ne peut pas être configurée en 
modes de prise de vue Log.

Setting 
(Cine EI/Flex. 
ISO)

On / Off Active/désactive la fonction de 
suppression de bruit en modes de prise 
de vue Log.

[Remarque]
Cette fonction ne peut pas être configurée en 
mode de prise de vue Custom.

Level 
(Cine EI/Flex. 
ISO)

Low / Mid / High Règle le niveau de suppression de bruit 
en modes de prise de vue Log.

[Remarque]
Cette fonction ne peut pas être configurée en 
mode de prise de vue Custom.

Shooting >Flicker Reduce
Définit les réglages de correction de scintillement.

Élément Réglage de sous-éléments Description

Mode Auto / On / Off Règle le mode de correction de 
scintillement.

Frequency 50Hz / 60Hz Règle la fréquence de la source 
d’alimentation qui fournit l’éclairage qui 
cause le scintillement.

Shooting >SteadyShot
Définit les réglages de stabilisation d’image.

Élément Réglage de sous-éléments Description

Setting Active / Standard / Off Règle la fonction de stabilisation 
d’image.

[Remarque]
Activé lorsqu’un objectif compatible est fixé.
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Menu Project
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Project >Base Setting
Définit les réglages de base.

Élément Réglage de sous-éléments Description

Shooting 
Mode

Custom / Flexible ISO / Cine EI Quick / 
Cine EI

Règle le mode de prise de vue 
(page 24).

Target 
Display

SDR(BT.709) / HDR(HLG) Règle la norme vidéo pour 
l’enregistrement/la sortie en mode de 
prise de vue Custom.

Project >Rec Format
Définit les réglages du format d’enregistrement.

Élément Réglage de sous-éléments Description

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 Sélectionne la fréquence du système.

Imager Scan 
Mode

FF / S35 Sélectionne la taille de l’imageur.

Codec RAW / RAW & XAVC-I / RAW(HDMI) /  
RAW(HDMI) & XAVC-I / XAVC-I / XAVC-L

Règle le codec d’enregistrement/de 
lecture de plan.

RAW Output 
Format

Les réglages disponibles varient selon les 
réglages Frequency et Codec.

Règle la taille de l’image de la sortie 
RAW.

[Remarque]
Lorsque Codec est réglé sur RAW & XAVC-I, le 
réglage Video Format change en lien avec le 
réglage RAW Output Format.

Frequency Codec Options de 
sélection

59.94/
50/
29.97/
25/
23.98

RAW 4096×2160

3840×2160

RAW & 
XAVC-I

4096×2160

3840×2160

RAW(HDMI) 4240×2392

RAW(HDMI) 
& XAVC-I

4240×2392

24 RAW 4096×2160

RAW & 
XAVC-I

4096×2160

Project >Rec Format
Définit les réglages du format d’enregistrement.

Élément Réglage de sous-éléments Description

Video Format Les réglages disponibles varient selon les 
réglages Frequency et Codec.

Règle la taille de l’image et le débit 
binaire.

Frequency Codec Options de 
sélection

59.94 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

50 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35
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Project >Rec Format
Définit les réglages du format d’enregistrement.

Élément Réglage de sous-éléments Description

Video Format 29.97 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

25 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

Project >Rec Format
Définit les réglages du format d’enregistrement.

Élément Réglage de sous-éléments Description

Video Format 23.98 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

24 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

Project >Cine EI/Flex.ISO Set
Règle le mode de prise de vue Log (Cine EI, Cine EI Quick, Flexible ISO).

Élément Réglage de sous-éléments Description

Color Gamut S-Gamut3/SLog3 /  
S-Gamut3.Cine/SLog3

Règle la gamme de couleurs pour les 
modes de prise de vue Log.

Embed LUT 
File

On / Off Active/désactive l’enregistrement des 
métadonnées du fichier 3D LUT file 
(fichier CUBE).

Project >HDR Setting
Règle les réglages du mode HDR.

Élément Réglage de sous-éléments Description

VF SDR 
Preview

On / Off En mode HDR, active/désactive la 
fonction qui convertit l’image du viseur 
de HDR vers SDR lorsque l’aide pour 
l’affichage gamma est activée.

[Conseil]
Avec ce réglage sur On, SDR Gain est appliqué 
à l’image du viseur.
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Project >HDR Setting
Règle les réglages du mode HDR.

Élément Réglage de sous-éléments Description

SDR Gain 0dB à –15dB (–6dB) En mode HDR, règle le réglage SDR Gain 
qui est appliqué au viseur lorsque VF SDR 
Preview est réglé sur On.

Project >Simul Rec
Permet de configurer les réglages du mode d’enregistrement simultané (page 52).

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction 
d’enregistrement simultané et définit le 
support de destination d’enregistrement.

Rec Button 
Set

Rec Button:[SlotA SlotB] Handle Rec 
Button:[SlotA SlotB] / Rec Button:[SlotA] 
Handle Rec Button:[SlotB] / Rec 
Button:[SlotB] Handle Rec Button:[SlotA]

Assigne les touches d’enregistrement 
utilisées pour contrôler chaque support 
d’enregistrement.

Project >Proxy Rec
Permet de configurer les réglages du mode d’enregistrement proxy.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive le mode 
d’enregistrement proxy.

Audio 
Channel

CH1/CH2 / CH3/CH4 Sélectionne le canal audio pour 
enregistrer les données proxy.

Chunk 30s / 1min / 2min Sélectionne l’intervalle d’enregistrement 
par fragments pour les fichiers proxy.

Project >Interval Rec
Permet de configurer les réglages du mode d’enregistrement par intervalles (page 50).

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive le mode 
d’enregistrement à intervalle. (Le réglage 
de ce mode sur On met tous les autres 
modes spéciaux sur Off.)

Interval Time 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 
20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 / 
30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (h)

Règle l’intervalle entre les 
enregistrements en mode 
d’enregistrement Interval Rec (lorsque 
Interval Rec est réglé sur On).

Project >Interval Rec
Permet de configurer les réglages du mode d’enregistrement par intervalles (page 50).

Élément Réglage de sous-éléments Description

Number of 
Frames

1frame / 2frames / 3frames / 6frames / 
9frames / 12frames
Les réglages disponibles varient en 
fonction de la fréquence d’images du 
format vidéo sélectionné.
59.94P/50P : 

2frames / 6frames / 12frames
29.97P/25P/24P/23.98P : 

1frame / 3frames / 6frames / 9frames

Règle le nombre d’images à enregistrer 
par prise en mode d’enregistrement 
Interval Rec (lorsque Interval Rec est 
réglé sur On).

Pre-Lighting Off / 2 s / 5 s / 10 s Règle le nombre de secondes après 
lesquelles la lampe vidéo s’allume avant 
le démarrage de l’enregistrement en 
mode d’enregistrement Interval Rec.

[Conseil]
Disponible uniquement lors de l’utilisation du 
HVL-LBPC (optionnel).

Project >Picture Cache Rec
Définit les réglages du mode d’enregistrement en cache d’image (page 51).

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive le mode 
d’enregistrement de cache d’image.

Cache Size Short / Medium / Long / Max Règle le temps pour l’accumulation 
d’images dans la mémoire de cache 
d’image (temps d’enregistrement de 
cache d’image).

Cache Rec 
Time

Affiche le temps pour l’accumulation 
d’images dans la mémoire de cache 
d’image (temps d’enregistrement de 
cache d’image).
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Project >SDI/HDMI Rec Control
Définit les réglages de contrôle d’enregistrement SDI/HDMI.

Élément Réglage de sous-éléments Description

Setting Off / SDI/HDMI Remote I/F / Parallel Rec Permet de configurer le contrôle de 
démarrage/d’arrêt d’enregistrement d’un 
dispositif externe via le signal de sortie 
SDI/HDMI.
Off : 

Ne pas utiliser la télécommande.
SDI/HDMI Remote I/F : 

Contrôle d’arrêt/de démarrage 
d’enregistrement d’un dispositif 
externe connecté, quand aucun 
support n’est inséré dans le 
caméscope. Pas de synchronisation 
avec la précision d’images pour le 
support du caméscope.

Parallel Rec : 
Contrôle d’arrêt/de démarrage 
d’enregistrement d’un dispositif 
externe connecté, quand un support 
est inséré dans le caméscope. 
Synchronisation avec la précision 
d’images pour le support du 
caméscope.

[Remarque]
Pour le contrôle à l’aide du signal de 
sortie HDMI, réglez HDMI TC Out >Setting 
(page 95) dans le menu TC/Media du menu 
complet sur On.

Project >Assignable Button
Règle les attributions de fonction des touches personnalisables.

Élément Réglage de sous-éléments Description

<1> à <9>, 
Focus Hold 
Button

Off / Base ISO/Sensitivity / AGC / Push 
AGC / ND Filter Position / Auto ND Filter / 
Push Auto ND / Auto Iris / Push Auto Iris / 
Bokeh Control / Auto Shutter / Auto 
Exposure Level / Backlight / Spotlight / 
Preset White Select / ATW / ATW Hold / AF 
Speed/Sens. / Focus Setting / Focus Area / 
Focus Area(AF-S) / Face/Eye Detection AF / 
Push AF Mode / Push AF/Push MF / Focus 
Hold / Focus Magnifier x3/x6 / Focus 
Magnifier x3 / Focus Magnifier x6 / S&Q 
Motion / SteadyShot / Rec / Picture Cache 
Rec / Rec Review / Clip Flag OK / Clip Flag 
NG / Clip Flag Keep / Color Bars / Tally 
[Front] / DURATION/TC/U-BIT / Display / 
Lens Info / Video Signal Monitor / Marker / 
VF Adjust / VF Mode / Gamma Display 
Assist / Peaking / Zebra / Volume / 
Thumbnail / Touch Operation / Handle 
Zoom / NFC / Auto Upload (Proxy) / Direct 
Menu / User Menu / Menu

Attribue des fonctions aux touches 
personnalisables.
Base ISO/Sensitivity : 

Permet de changer la sensibilité de 
base du capteur d’image.

AGC : 
Active/désactive la fonction AGC.

Push AGC : 
Active la fonction AGC pendant 
l’activation de la touche.

ND Filter Position : 
Commute entre les filtres ND.

Auto ND Filter : 
Active/désactive la fonction Auto ND 
Filter.

Push Auto ND : 
Active la fonction Auto ND Filter 
pendant l’activation de la touche.

Auto Iris : 
Active/désactive la fonction de 
diaphragme.

Push Auto Iris : 
Active la fonction de diaphragme 
automatique pendant l’activation de 
la touche.

Bokeh Control : 
Active/désactive le mode de contrôle 
du bokeh.

Auto Shutter : 
Active/désactive la fonction 
d’obturation automatique.

Auto Exposure Level : 
Affiche/ferme le menu direct Auto 
Exposure Level.

Backlight : 
Bascule entre les fonctions Backlight 
et Standard.

Spotlight : 
Bascule entre les fonctions Spotlight 
et Standard.

Preset White Select : 
Change la valeur de mode prédéfinie 
de l’équilibre des blancs.

ATW : 
Active/désactive la fonction ATW.
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Project >Assignable Button
Règle les attributions de fonction des touches personnalisables.

Élément Réglage de sous-éléments Description

<1> à <9>, 
Focus Hold 
Button

ATW Hold : 
Met la fonction ATW en pause.

AF Speed/Sens. : 
Commute le réglage de la vitesse de 
transition AF et le réglage de la 
sensibilité de changement de sujet 
AF.

Focus Setting : 
Permet de régler la zone de mise au 
point. 

Focus Area : 
Permet de régler la zone de mise au 
point pour AF et Push AF.

Focus Area(AF-S) : 
Permet de régler la zone de mise au 
point pour Push AF (AF-S).

Face Eye Detection AF : 
Commute les réglages de la 
détection des visages/yeux AF.

Push AF Mode : 
Commute le réglage du mode Push 
AF.

Push AF/Push MF : 
En mode de mise au point MF, active 
AF tant que la touche est enfoncée. 
En mode de mise au point AF, active 
MF tant que la touche est enfoncée.

Focus Hold : 
En mode de mise au point AF, la mise 
au point est fixée tant que la touche 
est enfoncée.

Focus Magnifier x3/x6 :
Focus Magnifier x3 :
Focus Magnifier x6 : 

Active/désactive la fonction 
d’agrandissement de la mise au 
point.

S&Q Motion : 
Active/désactive le mode ralenti et 
accéléré. 
Règle la fréquence d’images de prise 
de vue si elle est maintenue 
enfoncée.

SteadyShot : 
Alterne entre Active, Standard et Off. 

Rec : 
Démarre/arrête l’enregistrement.

Project >Assignable Button
Règle les attributions de fonction des touches personnalisables.

Élément Réglage de sous-éléments Description

<1> à <9>, 
Focus Hold 
Button

Picture Cache Rec : 
Active/désactive le mode 
d’enregistrement de cache d’image.

Rec Review : 
Active/désactive la fonction Rec 
Review.

Clip Flag OK : 
Exécute la fonction Add OK. 
Appuyez deux fois pour exécuter 
Delete Clip Flag.

Clip Flag NG : 
Exécute la fonction Add NG. 
Appuyez deux fois pour exécuter 
Delete Clip Flag.

Clip Flag Keep : 
Exécute la fonction Add Keep. 
Appuyez deux fois pour exécuter 
Delete Clip Flag.

Color Bars : 
Active/désactive les barres de 
couleur.

Tally [Front] : 
Active/désactive la fonction 
d’éclairage continu/de clignotement 
du témoin d’enregistrement/de 
signalisation.

DURATION/TC/U-BIT : 
Commute entre Time Code, Users Bit 
et Duration.

Display : 
Active/désactive les indicateurs de 
l’écran.

Lens Info : 
Commute l’indicateur de profondeur 
de champ.

Video Signal Monitor : 
Commute le moniteur de signal vidéo 
(tel que le moniteur de forme 
d’onde).

Marker : 
Active/désactive la fonction de 
marqueur.

VF Adjust : 
Affiche les barres de niveau pour 
l’ajustement de la luminosité de 
l’écran du viseur.

VF Mode : 
Commute l’affichage du viseur entre 
couleur et noir et blanc.
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Project >Assignable Button
Règle les attributions de fonction des touches personnalisables.

Élément Réglage de sous-éléments Description

<1> à <9>, 
Focus Hold 
Button

Gamma Display Assist : 
Commute la fonction d’aide pour 
l’affichage gamma.

Peaking : 
Active/désactive la fonction de 
réglage du contour.

Zebra : 
Active/désactive la fonction des 
zébrures.

Volume : 
Ajuste la sortie de niveau audio du 
moniteur vers la prise casque et le 
haut-parleur intégré.

Thumbnail : 
Affiche/ferme l’écran de miniatures.

Touch Operation : 
Active/désactive les opérations 
tactiles.

Handle Zoom : 
Commute le zoom de la poignée.

NFC : 
Exécute la fonction NFC.

Auto Upload (Proxy) : 
Active/désactive le téléchargement 
automatique de fichiers proxy ou 
règle le mode Chunk.

Direct Menu : 
Affiche/ferme le menu direct.

User Menu : 
Affiche/ferme le menu User.

Menu : 
Affiche/ferme le menu complet.

Project >Assignable Dial
Règle les attributions de fonction de la molette personnalisable et règle la direction de rotation.

Élément Réglage de sous-éléments Description

Grip/Remote 
Dial

Off / ISO/Gain/EI / ND Filter / IRIS /  
Auto Exposure Level / Audio Input Level / 
Multi Function Dial

Attribue des fonctions à la molette 
personnalisable du grip.
ISO/Gain/EI : 

Ajuste le gain ou EI.
ND Filter : 

Règle le filtre ND.
IRIS : 

Ajuste le diaphragme.
Auto Exposure Level : 

Ajuste le niveau d’exposition 
automatique.

Audio Input Level : 
Règle le niveau d’enregistrement 
audio.

Multi Function Dial : 
Fonctionne comme une molette 
multifonction.

Grip Dial 
Direction

Normal / Opposite Règle le sens de rotation de la molette 
personnalisable du grip.
Normal : tourne dans le sens normal.
Opposite : tourne dans le sens opposé.

Handle Dial Off / ISO/Gain/EI / ND Filter / IRIS / Auto 
Exposure Level / Audio Input Level / Multi 
Function Dial

Attribue des fonctions à la molette 
personnalisable de la poignée.
ISO/Gain/EI : 

Ajuste le gain ou EI.
ND Filter : 

Règle le filtre ND.
IRIS : 

Ajuste le diaphragme.
Auto Exposure Level : 

Ajuste le niveau d’exposition 
automatique.

Audio Input Level : 
Règle le niveau d’enregistrement 
audio.

Multi Function Dial : 
Fonctionne comme une molette 
multifonction.

Handle Dial 
Direction

Normal / Opposite Règle le sens de rotation de la molette 
personnalisable de la poignée.
Normal : tourne dans le sens normal.
Opposite : tourne dans le sens opposé.
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Project >Multi Function Dial
Affecte des fonctions à la molette multifonction.

Élément Réglage de sous-éléments Description

Default 
Function

Off / IRIS / ISO/Gain/EI / Auto Exposure 
Level / Audio Input Level

Affecte la fonction par défaut à la 
molette multifonction.
IRIS : 

Ajuste le diaphragme.
ISO/Gain/EI : 

Ajuste le gain ou EI.
Auto Exposure Level : 

Ajuste le niveau d’exposition 
automatique.

Audio Input Level : 
Règle le niveau d’enregistrement 
audio.

Project >User File
Définit les réglages relatifs aux opérations sur les fichiers utilisateur.

Élément Réglage de sous-éléments Description

Load from 
Media(B)

Execute / Cancel Charge les réglages du fichier utilisateur 
d’une carte mémoire insérée dans le 
logement de carte CFexpress Type A/SD 
(B).
Execute : fonction Execute.

Save to 
Media(B)

Execute / Cancel Enregistre les réglages du fichier 
utilisateur d’une carte mémoire insérée 
dans le logement de carte CFexpress 
Type A/SD (B).
Execute : fonction Execute.

File ID Affiche un écran pour l’affichage/l’édition 
de l’identifiant de fichier des fichiers 
utilisateur.

Load 
Customize 
Data

On / Off Définit le chargement ou non des 
informations personnalisées du menu 
User lorsque Load from Media(B) est 
exécuté.

Load White 
Data

On / Off Définit le chargement ou non des 
informations de balance des blancs 
lorsque Load from Media(B) est exécuté.

Project >All File
Définit les réglages liés aux fichiers ALL.

Élément Réglage de sous-éléments Description

Load from 
Media(B)

Execute / Cancel Charge les réglages du fichier ALL d’une 
carte mémoire insérée dans le logement 
de carte CFexpress Type A/SD (B).
Execute : fonction Execute.

Load from 
Cloud(Private)

Execute / Cancel Charge un fichier ALL téléchargé depuis 
le service Cloud C3 Portal (privé).
Execute : fonction Execute.

Load from 
Cloud(Share)

Execute / Cancel Charge un fichier ALL depuis le service 
Cloud C3 Portal (partagé).
Execute : fonction Execute.

Save to 
Media(B)

Execute / Cancel Enregistre les réglages du fichier ALL 
d’une carte mémoire insérée dans le 
logement de carte CFexpress Type A/SD 
(B).
Execute : fonction Execute.

Save to 
Cloud(Private)

Execute / Cancel Enregistre les réglages du fichier ALL sur 
le service Cloud C3 Portal (privé).
Execute : fonction Execute.

Save to 
Cloud(Share)

Execute / Cancel Enregistre les réglages du fichier ALL sur 
le service Cloud C3 Portal (partagé).
Execute : fonction Execute.

File ID Attribue un nom au fichier.

Load Network 
Data

On / Off Définit le chargement ou non des 
informations des réglages du menu 
Network lorsque Load from Media(B), 
Load from Cloud(Private) ou Load from 
Cloud(Share) est exécuté.
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Menu Paint/Look
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Paint/Look >Scene File
Définit les réglages liés aux fichiers de scène.

	 [Remarque]
Activé en mode de prise de vue Custom uniquement.

Élément Réglage de sous-éléments Description

Recall Charge un fichier de scène stocké dans la 
mémoire interne et applique les réglages 
en tant que réglages de qualité d’image 
actuels.

Store Enregistre l’état de qualité d’image actuel 
sous forme de fichier de scène dans la 
mémoire interne.

Delete Supprime un fichier de scène stocké dans 
la mémoire interne.

Preset Recall Lorsque Shooting Mode est réglé sur 
Custom et Target Display est réglé sur 
SDR(BT.709) :

S-Cinetone / Standard / Still / ITU709
Lorsque Shooting Mode est réglé sur 
Custom et Target Display est réglé 
HDR(HLG) :

HLG Live / HLG Natural

Applique les réglages de qualité d’image 
prédéfinis (non réinscriptibles) en tant 
que réglages de qualité d’image actuels.

Paint/Look >Base Look
Définit les réglages liés à l’apparence de base.

Élément Réglage de sous-éléments Description

Select Lorsque Shooting Mode est réglé sur 
Custom et Target Display est réglé sur 
SDR(BT.709) :

S-Cinetone / Standard / Still / ITU709 / 
User1 à User16

Lorsque Shooting Mode est réglé sur 
Custom et Target Display est réglé 
HDR(HLG) :

HLG Live / HLG Natural / User1 à 
User16

Dans les modes de prises de vue Log :
s709 / 709(800) / S-Log3 / User1 à 
User16

Permet de sélectionner une apparence 
de base.

Delete Supprime l’apparence de base 
sélectionnée.

Delete All Supprime toutes les apparences de base.

Paint/Look >Base Look
Définit les réglages liés à l’apparence de base.

Élément Réglage de sous-éléments Description
Import from 
Media(B)

Execute / Cancel Importe un fichier d’apparence de base 
d’une carte mémoire insérée dans le 
logement de carte CFexpress Type A/SD 
(B).
Execute : fonction Execute.

Import from 
Cloud(Private)

Execute / Cancel Importe un fichier d’apparence de base 
téléchargé depuis le service Cloud C3 
Portal (privé).
Execute : fonction Execute.

Import from 
Cloud(Share)

Execute / Cancel Importe un fichier d’apparence de base 
téléchargé depuis le service Cloud C3 
Portal (partagé).
Execute : fonction Execute.

Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Définit la gamme d’entrée de l’apparence 
de base sélectionnée.

Output BT.709 / HLG Définit la gamme de couleurs de sortie 
de l’apparence de base sélectionnée.

AE Level 
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV /  
5/3EV / 2EV

Définit la valeur de référence d’exposition 
de l’apparence de base sélectionnée.

Paint/Look >Reset Paint Settings
Réinitialise les réglages du menu Paint/Look, à l’exclusion de l’apparence de base.

	 [Remarque]
Activé en mode de prise de vue Custom uniquement.

Élément Réglage de sous-éléments Description

Reset without 
Base Look

Execute / Cancel Réinitialise les réglages du menu Paint/
Look, à l’exclusion de l’apparence de 
base.
Execute : fonction Execute.

Paint/Look >Black
Définit les réglages des noirs.

	 [Remarque]
Activé en mode de prise de vue Custom uniquement.

Élément Réglage de sous-éléments Description

Master Black –99.0 à +99.0 (±0.0) Règle le niveau de noir maître.

R Black –99.0 à +99.0 (±0.0) Règle le niveau de noir R.

B Black –99.0 à +99.0 (±0.0) Règle le niveau de noir B.



6. Affichage et réglages de menu : Menu Paint/Look93

Paint/Look >Knee
Définit les réglages de correction de courbe.

	 [Remarque]
Activé en mode de prise de vue Custom uniquement.

Élément Réglage de sous-éléments Description

Setting Lorsque Target Display est réglé sur 
SDR(BT.709) :

On / Off / ---
Lorsque Target Display est réglé sur 
HDR(HLG) :

On / Off / ---

Active/désactive la fonction de correction 
de courbe.

[Conseil]
Activé uniquement lorsque Base Look >Select 
est réglé sur Standard, ITU709, HLG Live ou HLG 
Natural.

Auto Knee Lorsque Target Display est réglé sur 
SDR(BT.709) :

On / Off / ---
Lorsque Target Display est réglé sur 
HDR(HLG) :

On / Off / ---

Active/désactive la fonction de courbe 
automatique.

[Conseil]
Activé uniquement lorsque la fonction de 
correction de courbe est réglée sur On et que 
Base Look >Select est réglé sur Standard ou 
ITU709. 

Point 75% à 109% (90%) Règle le point de courbe.

Slope –99 à +99 (±0) Règle la pente de courbe.

Paint/Look >Detail
Définit les réglages d’ajustement des détails.

	 [Remarque]
Activé en mode de prise de vue Custom uniquement.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction de détails.

Level –7 à +7 (±0) Règle le niveau de détail.

Manual 
Setting

On / Off / --- Active/désactive la fonction de réglage 
manuel des détails.

V/H Balance –2 à +2 (±0) Règle l’équilibre entre les détails 
verticaux (V) et horizontaux (H) pour le 
réglage manuel des détails.

B/W Balance Type1 / Type2 / Type3 / Type4 / Type5 Définit l’équilibre entre les détails de noir 
(B) pour les zones de faible luminance et 
les détails de blanc (W) pour les zones de 
forte luminance pour le réglage manuel 
des détails.

Limit 0 à 7 Règle le niveau de limite de détails pour 
le réglage manuel des détails.

Crispening 0 à 7 Règle le niveau de netteté pour le 
réglage manuel des détails.

Paint/Look >Detail
Définit les réglages d’ajustement des détails.

	 [Remarque]
Activé en mode de prise de vue Custom uniquement.

Élément Réglage de sous-éléments Description

High Light 
Detail

0 à 4 Règle le niveau des détails des zones de 
forte luminance pour le réglage manuel 
des détails.

Paint/Look >Matrix
Définit les réglages de correction de matrice.

	 [Remarque]
Activé en mode de prise de vue Custom uniquement.

Élément Réglage de sous-éléments Description

User Matrix On / Off Active ou désactive la fonction de 
correction de matrice utilisateur.

User Matrix 
Level

–99 à +99 (±0) Ajuste la saturation de couleur de l’image 
entière.

User Matrix 
Phase

–99 à +99 (±0) Ajuste la nuance de couleur (phase) de 
l’image entière.

User Matrix 
R-G

–99 à +99 (±0) Règle une matrice utilisateur R-V définie 
par l’utilisateur.

User Matrix 
R-B

–99 à +99 (±0) Règle une matrice utilisateur R-B définie 
par l’utilisateur.

User Matrix 
G-R

–99 à +99 (±0) Règle une matrice utilisateur V-R définie 
par l’utilisateur.

User Matrix 
G-B

–99 à +99 (±0) Règle une matrice utilisateur V-B définie 
par l’utilisateur.

User Matrix 
B-R

–99 à +99 (±0) Règle une matrice utilisateur B-R définie 
par l’utilisateur.

User Matrix 
B-G

–99 à +99 (±0) Règle une matrice utilisateur B-V définie 
par l’utilisateur.

Paint/Look >Multi Matrix
Définit les réglages de correction de matrice multiple.

	 [Remarque]
Activé en mode de prise de vue Custom uniquement.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction de correction 
de matrice multiple.

Reset Execute / Cancel Réinitialise la teinte et la saturation de 
chaque couleur d’axe aux valeurs par 
défaut.



6. Affichage et réglages de menu : Menu Paint/Look94

Paint/Look >Multi Matrix
Définit les réglages de correction de matrice multiple.

	 [Remarque]
Activé en mode de prise de vue Custom uniquement.

Élément Réglage de sous-éléments Description

Axis B / B+ / MG– / MG / MG+ / R / R+ / YL– / 
YL / YL+ / G– / G / G+ / CY / CY+ / B–

Sélectionne l’axe.

Hue –99 à +99 (±0) Règle la teinte de la couleur utilisée pour 
la correction de matrice multiple.

Saturation –99 à +99 (±0) Règle la saturation de la couleur utilisée 
pour la correction de matrice multiple.
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Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

TC/Media >Timecode
Définit les réglages de code temporel.

Élément Réglage de sous-éléments Description

Mode Preset / Regen / Clock Règle le mode de fonctionnement du 
code temporel.
Preset : 

Commence à fonctionner à partir 
d’une valeur préréglée.

Regen : 
Commence à fonctionner à partir du 
code temporel de la fin du plan 
précédent.

Clock : 
Utilise l’horloge interne comme code 
temporel.

Run Rec Run / Free Run Rec Run : fonctionne uniquement en 
cours d’enregistrement.

Free Run : fonctionne en permanence, 
quelle que soit l’opération réalisée 
par le caméscope.

Setting Règle le code temporel sur une valeur 
arbitraire.
SET : règle la valeur.

Reset Execute / Cancel Réinitialise le code temporel sur 
00:00:00:00.
Execute : fonction Execute.

TC Format DF / NDF Règle le format de code temporel.
DF : mode temps réel
NDF : mode temps non réel

TC/Media >TC Display
Définit les réglages d’affichage des données temporelles.

Élément Réglage de sous-éléments Description

Display Select Timecode / Users Bit / Duration Commute l’affichage des données 
temporelles.

TC/Media >Users Bit
Définit les réglages liés aux bits d’utilisateur.

Élément Réglage de sous-éléments Description

Mode Fix / Time Règle le mode de bit d’utilisateur.
Fix : utilise une valeur fixe arbitraire dans 

les bits d’utilisateur.
Time : utilise l’heure, les minutes et les 

secondes actuelles dans les bits 
d’utilisateur.

Setting Règle les bits d’utilisateur sur une valeur 
arbitraire.

TC/Media >HDMI TC Out
Définit les réglages liés à la sortie du code temporel lors de l’utilisation de HDMI.

Élément Réglage de sous-éléments Description

Setting On / Off Règle s’il faut envoyer le code temporel 
vers des dispositifs à d’autres fins à l’aide 
de la sortie HDMI.

Menu TC/Media
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TC/Media >Clip Name Format
Configure les réglages relatifs à l’attribution d’un nom et à la suppression de plan.

Élément Réglage de sous-éléments Description

Auto Naming Cam ID + Reel# / Title Sélectionne le format d’attribution de 
nom de plan.
Cam ID + Reel# : 

Camera ID + Reel Number + Shot 
Number + date + chaîne aléatoire

Title :  
Chaîne arbitraire spécifiée par Title 
Prefix + numéro de plan

Camera ID A à Z Règle l’ID de caméra utilisé lors de la 
génération de noms de plan.

[Remarque]
Configurable uniquement lorsque Auto Naming 
est réglé sur Cam ID + Reel#.

Reel Number 001 à 999 Définit la partie numérique de Reel 
Number utilisée lors de la génération de 
noms de plan.

[Remarque]
Configurable uniquement lorsque Auto Naming 
est réglé sur Cam ID + Reel#.

Camera 
Position

C / L / R Définit la partie du premier caractère du 
Shot Number utilisé lors de la génération 
de noms de plan.

[Remarque]
Configurable uniquement lorsque Auto Naming 
est réglé sur Cam ID + Reel#.

TC/Media >Clip Name Format
Configure les réglages relatifs à l’attribution d’un nom et à la suppression de plan.

Élément Réglage de sous-éléments Description

Title Prefix nnn_ (nnn correspond aux 3 derniers 
chiffres du numéro de série)

Règle la partie de titre (4 à 46 caractères) 
du nom de plan.
Ouvre un écran de saisie de chaîne de 
caractères.

Structure de l’écran de saisie des 
chaînes de caractères
Zone de sélection de caractère (3 lignes) : 

Sélectionne les caractères à insérer à 
la position du curseur de la zone Title 
Prefix.  
!#$%()+.-.;=@[ ]^_~0123456789 
abcdefghijklmnopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUVWXYZ

Zone d’opération du curseur (1 ligne) : 
Space : insère une espace à la 
position du curseur.  
 : déplace le curseur vers la 
gauche.  
 : déplace le curseur vers la droite.  
BS : permet de supprimer le caractère 
à gauche de la position du curseur.

Zone Title Prefix (1 ligne) : 
Zone de saisie du titre.

Pour définir le titre
1.	 Sélectionnez le caractère à insérer à 

la position du curseur de la zone Title 
Prefix depuis la zone de sélection des 
caractères à l’aide du sélecteur 
multiple (page 7), puis appuyez 
sur la touche de mise en application 
du sélecteur multiple. (Le caractère 
sélectionné est inséré et le curseur se 
déplace vers la droite.)

2.	 Recommencez l’étape 1 pour définir 
le titre. (Utilisez BS, selon les besoins.)

3.	 Après avoir défini le titre, 
sélectionnez Done pour fermer 
l’écran de saisie de caractères.
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TC/Media >Clip Name Format
Configure les réglages relatifs à l’attribution d’un nom et à la suppression de plan.

Élément Réglage de sous-éléments Description

Number Set 0001 à 9999 Règle le suffixe numérique à 4 chiffres du 
nom de plan.

TC/Media >Update Media
Met à jour le fichier de gestion sur les cartes mémoire.

Élément Réglage de sous-éléments Description

Media(A) Execute / Cancel Met à jour le fichier de gestion sur la 
carte mémoire dans le logement A.
Execute : fonction Execute.

Media(B) Execute / Cancel Met à jour le fichier de gestion sur la 
carte mémoire dans le logement B.
Execute : fonction Execute.

TC/Media >Format Media
Initialise les cartes mémoire.

Élément Réglage de sous-éléments Description

Media(A) Full Format / Quick Format / Cancel Formate la carte mémoire insérée dans le 
logement A.

Media(B) Full Format / Quick Format / Cancel Formate la carte mémoire insérée dans la 
logement B.
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Menu Monitoring
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Monitoring >Output On/Off
Définit les réglages de sortie vidéo.

Élément Réglage de sous-éléments Description

SDI On / Off Active/désactive la sortie SDI.

HDMI On / Off Active/désactive la sortie HDMI.

Monitoring >Output Format
Définit les réglages du format de sortie.

Élément Réglage de sous-éléments Description

SDI Pour plus de détails sur les réglages, 
consultez « Formats de sortie et limites » 
(page 126).

Règle la résolution de sortie SDI et HDMI.

HDMI

Monitoring >De-Squeeze
Définit les réglages De-Squeeze.

Élément Réglage de sous-éléments Description

Ratio (HDMI/
VF)

Off(1.0×) / 1.3× / 2.0× Sélectionne le ratio dé-squeeze pour 
l’image de sortie HDMI et l’image 
affichée dans le viseur lors de la prise de 
vue avec un objectif anamorphique.

Monitoring >Output Display
Définit les réglages de sortie d’affichage de l’écran.

Élément Réglage de sous-éléments Description

SDI On / Off Définit si le menu, l’état et l’affichage de 
l’écran sont intégrés dans le signal de 
sortie SDI.

HDMI On / Off Définit si le menu, l’état et l’affichage de 
l’écran sont intégrés dans le signal de 
sortie HDMI.

Monitoring >Display On/Off
Définit les réglages de l’élément d’affichage.

Élément Réglage de sous-éléments Description

Network 
Status

On / Off Sélectionne les éléments à afficher dans 
le viseur.

File Transfer 
Status

On / Off

Rec/Play 
Status

On / Off

RAW Output 
Control 
Status

On / Off

Tally On / Off

Battery 
Remain

On / Off

Focus Mode On / Off

Focus 
Position

On / Off

Focus Area 
Indicator

On / Off

Focus Area 
Ind.(AF-S)

On / Off

Face/Eye 
Detection 
Frame

On / Off

Lens Info On / Off

Imager Scan 
Mode

On / Off

Rec Format On / Off

Frame Rate On / Off

Zoom 
Position

On / Off

UWP RF Level On / Off

SteadyShot On / Off
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Monitoring >Display On/Off
Définit les réglages de l’élément d’affichage.

Élément Réglage de sous-éléments Description

Base Look/
Rec Look

On / Off

SDI/HDMI 
Rec Control

On / Off

Monitoring 
Look

On / Off

Proxy Status On / Off

Base ISO/
Sensitivity

On / Off

Media Status On / Off

Video Signal 
Monitor

Off / Waveform / Vector / Histogram

Clip Name On / Off

White 
Balance

On / Off

Scene File On / Off

Focus 
Indicator

On / Off

Auto 
Exposure 
Mode

On / Off

Auto 
Exposure 
Level

On / Off

Timecode On / Off

ND Filter On / Off

Iris On / Off

ISO/Gain/EI On / Off

Shutter On / Off

Level Gauge On / Off

Audio Level 
Meter

On / Off

Video Level 
Warning

On / Off

Clip Number On / Off

Notice 
Message

On / Off

Monitoring >Marker
Définit les réglages d’affichage de repère.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive l’affichage de tous les 
repères.

Color White / Yellow / Cyan / Green / Magenta / 
Red / Blue

Sélectionne la couleur du signal de 
repère.

Center 
Marker

1 / 2 / 3 / 4 / Off Sélectionne le repère central.

Safety Zone On / Off Active/désactive le repère de la zone de 
sécurité.

Safety Area 80% / 90% / 92.5% / 95% Sélectionne la taille du repère de la zone 
de sécurité (en tant que pourcentage de 
la taille totale de l’écran).

Aspect 
Marker

Line / Mask / Off Sélectionne le type de marqueur de 
format.

Aspect Mask 0 à 15 (12) Règle le niveau du signal vidéo en 
dehors du marqueur.

Aspect Safety 
Zone

On / Off Active/désactive le repère de la zone de 
sécurité.

Aspect Safety 
Area

80% / 90% / 92.5% / 95% Sélectionne la taille du repère de la zone 
de sécurité de format (en tant que 
pourcentage de la taille totale de l’écran).

Aspect Select 1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 / 17:9 / 
1.66:1 / 1.85:1 / 2.35:1 / 2.39:1 / Custom

Règle le mode en affichant le marqueur 
de format.

[Remarque]
Ceci est réglée sur 2.39:1 (fixe) lorsque De-
Squeeze >Ratio (HDMI/VF) (page 98) est 
réglé sur une valeur autre que Off(1.0×) dans le 
menu Monitoring.

Custom 
Aspect Ratio

Saisissez une valeur arbitraire 
(01.00:01.00)

Règle le rapport d’aspect sur une valeur 
arbitraire.

[Remarque]
Ce réglage est activé lorsque Aspect Select est 
réglé sur Custom.

Guide Frame On / Off Active/désactive l’affichage du cadre 
guide.

100% Marker On / Off Active/désactive le repère 100%.

User Box On / Off Active/désactive l’affichage du marqueur 
de cadre utilisateur.

User Box 
Width

3 à 479 (240) Règle la largeur du marqueur de cadre 
utilisateur (distance du centre aux bords 
gauche et droit).
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Monitoring >Marker
Définit les réglages d’affichage de repère.

Élément Réglage de sous-éléments Description

User Box 
Height

3 à 269 (135) Règle la hauteur du marqueur de cadre 
utilisateur (distance du centre aux bords 
haut et bas).

User Box H 
Position

–476 à +476 (0) Définit la position horizontale du centre 
du marqueur de cadre utilisateur.

User Box V 
Position

–266 à +266 (0) Définit la position verticale du centre du 
marqueur de cadre utilisateur.

Monitoring >VF Setting
Définit les réglages du viseur.

Élément Réglage de sous-éléments Description

Brightness 1 à 15 (8) Permet d’ajuster la luminosité de l’image 
du viseur.

Color Mode Color / B&W Sélectionne le mode d’affichage du 
viseur dans le mode E-E/enregistrement.

Monitoring >Gamma Display Assist
Configure les réglages de l’aide pour l’affichage gamma.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction d’aide 
d’affichage gamma en mode de prise de 
vue Custom lorsque Target Display est 
réglé sur HDR(HLG).

[Remarque]
Ceci est réglé sur OFF (fixe) en modes de prise 
de vue Log.

Monitoring >Peaking
Définit les réglages du contour.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction de réglage 
du contour.

Peaking Level High / Mid / Low Règle le niveau de signal du contour de 
couleur.

Color B&W / Red / Yellow / Blue Sélectionne la couleur du signal de 
réglage du contour de couleur.

Monitoring >Zebra
Définit les réglages du motif de zébrures.

Élément Réglage de sous-éléments Description

Setting Off / Zebra1 / Zebra2 Sélectionne le type de motif de zébrures 
(Off, Zebra 1, Zebra 2).

Zebra1 Level 0% à 109% (70%) Définit le niveau d’affichage de Zebra 1.

Zebra1 
Aperture 
Level

2% à 20% (10%) Définit le niveau d’ouverture de Zebra 1.

Zebra2 Level 0% à 109% (100%) Définit le niveau d’affichage de Zebra 2.
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Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).
Reportez-vous à « Diagrammes bloc » (page 141).

Audio >Audio Input
Définit les réglages d’entrée audio.

Élément Réglage de sous-éléments Description

CH1 Input 
Select

INPUT1 / Internal MIC / Shoe CH1 Commute la source d’entrée pour 
l’enregistrement sur le canal 1.

CH2 Input 
Select

INPUT1 / INPUT2 / Internal MIC / Shoe CH2 Commute la source d’entrée pour 
l’enregistrement sur le canal 2.

CH3 Input 
Select

Off / INPUT1 / Internal MIC / Shoe CH1 Commute la source d’entrée pour 
l’enregistrement sur le canal 3.

CH4 Input 
Select

Off / INPUT1 / INPUT2 / Internal MIC / 
Shoe CH2

Commute la source d’entrée pour 
l’enregistrement sur le canal 4.

INPUT1 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Règle le niveau d’enregistrement de 
référence pour l’entrée du microphone 
XLR à partir d’INPUT1.

INPUT2 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Règle le niveau d’enregistrement de 
référence pour l’entrée du microphone 
XLR à partir d’INPUT2.

Line Input 
Reference

+4dB / 0dB / –3dB / EBUL Sélectionne le niveau d’entrée de 
référence quand le commutateur INPUT1/
INPUT2 est réglé sur LINE.

Reference 
Level

–20dB / –18dB / –16dB / –12dB / EBUL Sélectionne le niveau d’enregistrement 
du signal de tonalité de référence de 
1 kHz.

CH1 Wind 
Filter

On / Off Active/désactive le filtre de réduction 
anti-vent pour l’enregistrement sur le 
canal 1.

CH2 Wind 
Filter

On / Off Active/désactive le filtre de réduction 
anti-vent pour l’enregistrement sur le 
canal 2.

CH3 Wind 
Filter

On / Off Active/désactive le filtre de réduction 
anti-vent pour l’enregistrement sur le 
canal 3.

CH4 Wind 
Filter

On / Off Active/désactive le filtre de réduction 
anti-vent pour l’enregistrement sur le 
canal 4.

Audio >Audio Input
Définit les réglages d’entrée audio.

Élément Réglage de sous-éléments Description

CH3 Level 
Control

Auto / Manual Sélectionne le réglage du niveau d’entrée 
audio ou le réglage manuel pour le canal 
d’enregistrement 3.

[Remarque]
Si CH3 Input Select et CH4 Input Select 
sont tous deux réglés sur Internal MIC, CH4 
est commuté sur automatic/manual en 
conjonction avec ce réglage.

CH4 Level 
Control

Auto / Manual Sélectionne le réglage du niveau d’entrée 
audio ou le réglage manuel pour le canal 
d’enregistrement 4.

[Remarque]
Si CH3 Input Select et CH4 Input Select 
sont tous deux réglés sur Internal MIC, CH4 
est commuté sur automatic/manual en 
conjonction avec le réglage CH3 Level Control.

CH3 Input 
Level

0 à 99 (49) Règle le niveau d’entrée pour 
l’enregistrement du canal 3.

CH4 Input 
Level

0 à 99 (49) Règle le niveau d’entrée pour 
l’enregistrement du canal 4.

Audio Input 
Level

0 à 99 Règle le niveau d’entrée audio.
Peut être utilisé comme volume principal 
en fonction des réglages de CH1 Level à 
CH4 Level.

Limiter Mode Off / –6dB / –9dB / –12dB / –15dB / –17dB Sélectionne la caractéristique du limiteur 
pour les forts signaux d’entrée lors du 
réglage manuel du niveau d’entrée 
audio.

CH1&2 AGC 
Mode

Mono / Stereo Règle le mode de réglage automatique 
de niveau pour le canal d’enregistrement 
1 et canal 2. Lorsque vous réglez sur 
Stereo, AGC est relié entre les canaux.

CH3&4 AGC 
Mode

Mono / Stereo Règle le mode de réglage automatique 
de niveau pour le canal d’enregistrement 
3 et canal 4. Lorsque vous réglez sur 
Stereo, AGC est relié entre les canaux.

AGC Spec –6dB / –9dB / –12dB / –15dB / –17dB Sélectionne la caractéristique AGC.

Menu Audio
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Audio >Audio Input
Définit les réglages d’entrée audio.

Élément Réglage de sous-éléments Description

1kHz Tone on 
Color Bars

On / Off Active/désactive le signal de tonalité de 
référence de 1 kHz lors de l’affichage des 
barres de couleur.

[Remarque]
Lorsqu’il est activé, le signal de tonalité 
de référence de 1 kHz est réglé pour 
l’enregistrement sur le canal 3 et canal 4, 
même si CH3 Input Select et CH4 Input Select 
sont désactivés.

CH1 Level Entrée sans adaptateur XLR
Audio Input Level / Side / Level+Side

Entrée avec adaptateur XLR (page 48)
Audio Input Level / Through

Règle la combinaison des ajustements 
de niveau d’entrée audio activés pour le 
canal d’enregistrement 1.

[Remarque]
« Side » se rapporte à la molette AUDIO 
LEVEL (CH1) sur le côté du caméscope. 
Lorsque Level+Side est sélectionné, le niveau 
d’enregistrement audio est déterminé par la 
combinaison des réglages Audio Input Level et 
dial (page 141).

CH2 Level Entrée sans adaptateur XLR
Audio Input Level / Side / Level+Side

Entrée avec adaptateur XLR (page 48)
Audio Input Level / Through

Règle la combinaison des ajustements 
de niveau d’entrée audio activés pour le 
canal d’enregistrement 2.

[Remarque]
« Side » se rapporte à la molette AUDIO 
LEVEL (CH2) sur le côté du caméscope. 
Lorsque Level+Side est sélectionné, le niveau 
d’enregistrement audio est déterminé par la 
combinaison des réglages Audio Input Level et 
dial (page 141).

CH3 Level Entrée sans adaptateur XLR
Audio Input Level / CH3 Input Level / 
Level+CH3 Input Level

Entrée avec adaptateur XLR (page 48)
Audio Input Level / Through

Règle la combinaison des ajustements 
de niveau d’entrée audio activés pour le 
canal d’enregistrement 3.

CH4 Level Entrée sans adaptateur XLR
Audio Input Level / CH4 Input Level / 
Level+CH4 Input Level

Entrée avec adaptateur XLR (page 48)
Audio Input Level / Through

Règle la combinaison des ajustements 
de niveau d’entrée audio activés pour le 
canal d’enregistrement 4.

Audio >Audio Output
Définit les réglages de sortie audio.

Élément Réglage de sous-éléments Description

Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1 / 
CH2 / CH3 / CH4

Sélectionne la sortie du canal audio vers 
la prise casque et le haut-parleur intégré.

[Remarque]
Si l’audio pour plusieurs canaux est réglée sur 
la sortie simultanée, le niveau de sortie pour 
chaque canal est réduit pour la sortie pour 
éviter le détourage.

Volume 0 à 50 Ajuste la sortie de niveau audio du 
moniteur vers la prise casque et le 
haut-parleur intégré.

Headphone 
Out

Mono / Stereo Sélectionne le mode de sortie de la prise 
casque : monaural (Mono) ou stéréo 
(Stereo).

Alarm Level 0 à 7 (4) Ajuste le volume de l’alarme.

HDMI Output 
CH

CH1/CH2 / CH3/CH4 Règle la combinaison des canaux audio 
sur la sortie HDMI.
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Menu Thumbnail
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Thumbnail

Élément Réglage de sous-éléments Description

Display Clip 
Properties

Affiche l’écran de propriétés de plans.

Thumbnail >Set Clip Flag
Définit les réglages de balise de plan.

Élément Réglage de sous-éléments Description

Add OK Ajoute une balise OK.

Add NG Ajoute une balise NG.

Add KEEP Ajoute une balise KEEP.

Delete Clip 
Flag

Supprime toutes les balises.

Thumbnail >Lock/Unlock Clip
Définit les réglages de protection de plan.

Élément Réglage de sous-éléments Description

Select Clip Sélectionne et verrouille/déverrouille un 
plan.

Lock All Clips Verrouille tous les plans.

Unlock All 
Clips

Déverrouille tous les plans.

Thumbnail >Delete Clip
Supprime les plans.

Élément Réglage de sous-éléments Description

Select Clip Supprime le plan sélectionné.

All Clips Supprime tous les plans.

Thumbnail >Transfer Clip
Transfère des plans.

[Remarque]
Transfer Clip ne peut pas être configuré s’il n’y a pas de mot de passe configuré à l’aide Access Authentication 
dans le menu Network.

Élément Réglage de sous-éléments Description

Select Clip Transfert les plans sélectionnés.

All Clips Transfert tous les plans.

[Remarque]
Jusqu’à 200 plans peuvent être transférés.

Thumbnail >Transfer Clip (Proxy)
Transfère des plans proxy.

[Remarque]
Transfer Clip (Proxy) ne peut pas être configuré s’il n’y a pas de mot de passe configuré à l’aide Access 
Authentication dans le menu Network.

Élément Réglage de sous-éléments Description

Select Clip Transfère les plans proxy correspondant 
aux plans sélectionnés.

All Clips Transfère les plans proxy correspondant à 
tous les plans.

[Remarque]
Jusqu’à 200 plans peuvent être transférés.

Thumbnail >Filter Clips
Définit les réglages des plans à afficher.

Élément Réglage de sous-éléments Description

OK Affiche uniquement les plans comportant 
une balise OK.

NG Affiche uniquement les plans comportant 
une balise NG.

KEEP Affiche uniquement les plans comportant 
une balise KEEP.

None Affiche uniquement les plans ne 
comportant pas de balise.

All Affiche tous les plans, que des balises 
soient présentes ou non.

Thumbnail >Customize View
Bascule l’affichage de l’écran de miniatures.

Élément Réglage de sous-éléments Description

Thumbnail 
Caption

Date Time / Time Code / Duration / 
Sequential Number

Commute l’information affichée sous les 
miniatures.
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Menu Technical
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Technical >Color Bars
Définit les réglages de barres de couleur.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive les barres de couleur.

Type ARIB / 100% / 75% / SMPTE Sélectionne le type de barres de couleur.

Technical >ND Dial
Configure les réglages relatifs aux opérations de la molette ND VARIABLE.

Élément Réglage de sous-éléments Description

CLEAR with 
Dial

On / Off Permet d’autoriser ou d’interdire la 
commutation d’état ND (CLEAR  On) 
en utilisant la molette ND VARIABLE.

Technical >Tally
Configure les réglages du témoin d’enregistrement/de signalisation.

Élément Réglage de sous-éléments Description

Front On / Off Active/désactive le témoin 
d’enregistrement/de signalisation (avant).

Rear On / Off Active/désactive le témoin 
d’enregistrement/de signalisation (arrière).

Technical >HOLD Switch Setting
Définit les réglages du commutateur Hold.

Élément Réglage de sous-éléments Description

with Rec 
Button

On / Off Règle s’il faut verrouiller le 
fonctionnement de la touche 
d’enregistrement START/STOP.

with Hand 
Grip Remote

On / Off Règle s’il faut verrouiller le 
fonctionnement de la télécommande de 
grip.

Technical >HOLD Switch Setting
Définit les réglages du commutateur Hold.

Élément Réglage de sous-éléments Description

Handle HOLD 
Switch

Normal / Rec Button Only Définit si la cible de maintien du 
commutateur HOLD de la poignée est 
uniquement la touche d’enregistrement 
START/STOP de la poignée.
Normal : 

Toutes les commandes d’opération 
sur la poignée sont des cibles de 
l’opération de maintien.  
Cependant, la touche 
d’enregistrement START/STOP de la 
poignée suit le réglage « with Rec 
Button ».

Rec Button Only : 
Seule la touche d’enregistrement 
START/STOP de la poignée est la 
cible de l’opération de maintien.

Technical >Touch Operation
Définit les réglages relatifs aux opérations tactiles.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive les opérations tactiles.

Technical >Rec Review
Définit les réglages du passage en revue de l’enregistrement.

Élément Réglage de sous-éléments Description

Setting 3 s / 10 s / Clip Sélectionne le temps pour la lecture de 
plans venant d’être enregistrés pour le 
passage en revue de l’enregistrement.

Technical >Zoom
Définit les réglages de zoom.

Élément Réglage de sous-éléments Description

Zoom Type Optical Zoom Only / On(Clear Image 
Zoom)

Définit le type de zoom.
Optical Zoom Only : 

Le zoom optique est réglé à l’aide de 
l’objectif.

On(Clear Image Zoom) : 
Zoom électronique avec aucune ou 
peu de détérioration de la qualité de 
l’image.
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Technical >Handle Zoom
Définit les réglages de zoom à poignée.

Élément Réglage de sous-éléments Description

Setting Off / Low / High / Variable Règle la vitesse du zoom à poignée.

High 1 à 8 (8) Règle la vitesse de zoom du levier de 
zoom de la poignée lorsque la vitesse de 
zoom de la poignée High est 
sélectionnée.

Low 1 à 8 (3) Règle la vitesse de zoom du levier de 
zoom de la poignée lorsque la vitesse de 
zoom de la poignée Low est 
sélectionnée.

[Remarque]
Une vitesse de zoom réglée sur une faible 
valeur peut provoquer un zoom irrégulier.

Technical >Menu Settings
Définit les réglages liés au menu.

Élément Réglage de sous-éléments Description

User Menu 
Only

On / Off Configure s’il faut afficher le menu User 
uniquement (On) ou afficher la liste des 
menus (Off) lorsque le caméscope 
affiche le menu.

User Menu 
with Lock

On / Off Règle le verrouillage ou non de 
l’affichage du menu, affichant le menu 
User uniquement.

[Remarque]
En cas d’affichage normal du menu, cet 
élément ne s’affiche pas. Pour plus de détails 
sur l’affichage du menu, consultez page 74.

Technical >Menu Page On/Off
Règle les réglages relatifs à l’affichage d’écrans d’état.

Élément Réglage de sous-éléments Description

Main On / Off Active/désactive l’affichage de l’écran 
d’état Main.

Camera On / Off Active/désactive l’affichage de l’écran 
d’état Camera.

Audio On / Off Active/désactive l’affichage de l’écran 
d’état Audio.

Project On / Off Active/désactive l’affichage de l’écran 
d’état Project.

Technical >Menu Page On/Off
Règle les réglages relatifs à l’affichage d’écrans d’état.

Élément Réglage de sous-éléments Description

Monitoring On / Off Active/désactive l’affichage de l’écran 
d’état Monitoring.

Assignable 
Button

On / Off Active/désactive l’affichage de l’écran 
d’état Assignable Button.

Battery On / Off Active/désactive l’affichage de l’écran 
d’état Battery.

Media On / Off Active/désactive l’affichage de l’écran 
d’état Media.

Network On / Off Active/désactive l’affichage de l’écran 
d’état Network.

File Transfer On / Off Active/désactive l’affichage de l’écran 
d’état File Transfer.

Technical >Fan Control
Définit les réglages de mode de commande du ventilateur.

Élément Réglage de sous-éléments Description

Setting Auto / Minimum / Off in Rec Règle le mode de commande du 
ventilateur du caméscope.

[Remarque]
Même lorsque Off in Rec est sélectionné, le 
ventilateur fonctionnera si la température 
interne du caméscope dépasse une certaine 
valeur.

Technical >Lens
Définit les réglages liés aux objectifs.

Élément Réglage de sous-éléments Description

Zoom Ring 
Direction

Left(W)/Right(T) / Right(W)/Left(T) Règle la direction du fonctionnement de 
la bague de zoom.

[Remarque]
Activé uniquement lors de l’utilisation d’un 
objectif à monture E prenant en charge le 
changement de direction de la bague de zoom.

Shading 
Compensation

Auto / Off Définit la compensation automatique 
d’ombrage.

Chroma 
Aberration 
Comp.

Auto / Off Définit la compensation automatique 
d’aberrations chromatiques.

Distortion 
Comp.

Auto / Off Définit la compensation automatique de 
distorsion.
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Technical >Lens
Définit les réglages liés aux objectifs.

Élément Réglage de sous-éléments Description

Breathing 
Compensation

Auto / Off Définit la compensation de la respiration 
de l’objectif.

Distance 
Display

Meter / Feet Configure les unités d’affichage pour les 
informations d’objectif et la position de 
mise au point.

Zoom 
Position 
Display

Focal Length / Number / Bar Définit le format d’affichage de position 
de zoom.

Technical >Video Light Set
Règle la méthode d’éclairage de la lampe vidéo. Disponible uniquement lors de l’utilisation du 
HVL-LBPC (optionnel).

Élément Réglage de sous-éléments Description

Video Light 
Set

Power Link / Rec Link / Rec Link + Stby Règle la méthode de contrôle d’éclairage 
pour la lumière vidéo fixée à la griffe 
d’interface multiple.
Power Link : 

Allume/éteint la lampe vidéo quand 
le caméscope est en marche/à l’arrêt.

Rec Link : 
Allume/éteint la lampe vidéo quand 
le caméscope commence/arrête 
l’enregistrement.

Rec Link + Stby : 
Allume/met en veille la lampe vidéo 
quand le caméscope commence/
arrête l’enregistrement.

Technical >APR
Exécute l’APR.

Élément Réglage de sous-éléments Description

APR Execute / Cancel Exécute l’APR (restauration automatique 
des pixels) pour l’ajustement 
automatique du capteur d’images.
Execute : fonction Execute.

[Remarque]
Fixez toujours le capuchon de l’objectif avant 
d’exécuter l’APR.

Technical >Camera Battery Alarm
Définit les réglages d’alarme de basse tension de batterie.

Élément Réglage de sous-éléments Description

Low Battery 5% / 10% / 15% / … / 45% / 50% Règle le niveau de batterie devant rester 
pour déclencher l’affichage d’une alarme 
de basse tension de batterie (par 
incréments de 5%).

Battery 
Empty

3% à 7% Règle le niveau de batterie devant rester 
pour déclencher l’affichage d’une alarme 
de batterie vide.

Technical >Camera DC IN Alarm
Définit les réglages d’alarme de tension en entrée.

Élément Réglage de sous-éléments Description

DC Low 
Voltage1

16.0V à 19.0V (16.5V) Règle la tension nécessaire pour 
déclencher l’affichage d’une alarme de 
basse tension en entrée DC IN.

DC Low 
Voltage2

15.5V à 18.5V Règle la tension nécessaire pour 
déclencher l’affichage d’une alarme de 
tension insuffisante en entrée DC IN.
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Menu Network
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Network >Setup for Mobile App
Exécute l’outil d’aide pour la configuration réseau.

Élément Réglage de sous-éléments Description

Setup Démarre l’outil d’aide pour la 
configuration réseau.

Network >Access Authentication
Définit les réglages liés à l’authentification d’accès.

Élément Réglage de sous-éléments Description

User Name Règle le nom d’utilisateur pour 
l’authentification d’accès.

Input 
Password

Règle le mot de passe pour 
l’authentification d’accès.

[Remarque]
Du point de vue de la sécurité, il est 
recommandé de définir un mot de passe avec 
une chaîne de caractères suffisamment longue, 
difficile à deviner par les autres, et de le stocker 
en toute sécurité.

Generate 
Password

Execute / Cancel Génère automatiquement un mot de 
passe pour l’authentification d’accès.
Execute : fonction Execute.

Show 
Settings

Affiche les informations pour 
l’authentification d’accès.
Affiche le nom d’utilisateur, le mot de 
passe, l’empreinte digitale, le numéro de 
série et le nom du modèle sous forme de 
texte et de code QR.

[Remarque]
Veillez à ce que le mot de passe ne puisse pas 
être visualisé et que l’image du code QR ne 
puisse pas être copiée par d’autres personnes.

Network >Wireless LAN
Définit les réglages liés aux connexions LAN sans fil.

Élément Réglage de sous-éléments Description

Setting Access Point Mode / Station Mode / Off Sélectionne le mode d’utilisation de la 
connexion au réseau local sans fil.

WPS Execute / Cancel Établit une connexion à l’aide d’un WPS 
(Wi-Fi Protected Setup).
Execute : fonction Execute.

Network >Wireless LAN
Définit les réglages liés aux connexions LAN sans fil.

Élément Réglage de sous-éléments Description

NFC Execute / Cancel Établit une connexion à l’aide d’un NFC 
(Near Field Communication).
Execute : fonction Execute.

MAC Address Affiche l’adresse MAC de l’interface LAN 
sans fil du caméscope.

Network >AP Mode Settings
Définit les réglages liés aux connexions du mode de point d’accès.

Élément Réglage de sous-éléments Description

Channel Auto(5GHz) / Auto / CH1 / CH2 /  
CH3 / CH4 / CH5 / CH6 / CH7 / CH8 / CH9 / 
CH10 / CH11

Définit le canal LAN sans fil.
Auto(5GHz) est uniquement disponible 
avec le modèle ILME‑FX6V/VK.

Camera SSID 
& Password

Affiche le SSID et le mot de passe du 
caméscope.

Regenerate 
Password

Execute / Cancel Crée un nouveau mot de passe.
Execute : fonction Execute.

IP Address Affiche l’adresse IP du caméscope en 
mode de point d’accès.

Subnet Mask Affiche le masque de sous-réseau du 
caméscope en mode de point d’accès.
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Network >ST Mode Settings
Définit les réglages liés aux connexions du mode de station.

Élément Réglage de sous-éléments Description

Camera 
Remote 
Control

Enable / Disable Règle si la télécommande doit être 
activée depuis un dispositif connecté au 
caméscope par LAN sans fil en mode de 
station.

Connected 
Network

Affiche le réseau LAN sans fil connecté 
(point d’accès).

SSID Affiche le SSID du point d’accès pour la 
connexion.

Security Affiche le type de sécurité du point 
d’accès pour la connexion.

Password Affiche le mot de passe du point d’accès 
pour la connexion.
Lorsque Security est réglé sur WEP ou 

WPA : *******
Lorsque Security est réglé sur None : 

(vide)

DHCP Affiche l’état d’activation/désactivation 
du DHCP.

IP Address Affiche l’adresse IP du caméscope 
lorsque DHCP est réglé sur Off.

Subnet Mask Affiche le masque de sous-réseau du 
caméscope lorsque DHCP est réglé sur 
Off.

Gateway Affiche la passerelle par défaut du 
caméscope lorsque DHCP est réglé sur 
Off.

DNS Auto Affiche l’état d’activation/désactivation 
d’acquisition du DNS.

Primary DNS Server Affiche le serveur DNS principal du 
caméscope lorsque DNS Auto est réglé 
sur Off.

Secondary DNS Server Affiche le serveur DNS secondaire du 
caméscope lorsque DNS Auto est réglé 
sur Off.

Network >ST Mode Settings
Définit les réglages liés aux connexions du mode de station.

Élément Réglage de sous-éléments Description

Scan 
Networks

Détecte les réseaux LAN sans fil (points 
d’accès) et affiche une liste.
Sélectionnez une destination depuis la 
liste pour la connexion.

SSID Affiche le SSID du point d’accès pour la 
connexion.

Security Affiche le type de sécurité du point 
d’accès pour la connexion.

Password Saisissez le mot de passe du point 
d’accès pour la connexion.

DHCP 
On / Off

Active/désactive DHCP.

IP Address Saisissez l’adresse IP du caméscope 
lorsque DHCP est réglé sur Off.

Subnet Mask Saisissez le masque de sous-réseau du 
caméscope lorsque DHCP est réglé sur 
Off.

Gateway Saisissez la passerelle par défaut du 
caméscope lorsque DHCP est réglé sur 
Off.

DNS Auto 
On / Off

Active/désactive la fonction d’acquisition 
automatique de DNS.

Primary DNS Server Saisissez le serveur DNS principal du 
caméscope lorsque DNS Auto est réglé 
sur Off.

Secondary DNS Server Saisissez le serveur DNS secondaire du 
caméscope lorsque DNS Auto est réglé 
sur Off.
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Network >ST Mode Settings
Définit les réglages liés aux connexions du mode de station.

Élément Réglage de sous-éléments Description

Manual 
Register

Enregistre les réglages pour la connexion 
manuelle à un point d’accès.

SSID Saisissez le SSID du point d’accès pour la 
connexion.

Security 
None / WEP / WPA

Configurez le type de sécurité du point 
d’accès pour la connexion. Sélectionnez 
WPA si le type de sécurité du point 
d’accès de destination est WPA ou WPA2.

Password Saisissez le mot de passe du point 
d’accès pour la connexion.

DHCP 
On / Off

Active/désactive DHCP.

IP Address Saisissez l’adresse IP du caméscope 
lorsque DHCP est réglé sur Off.

Subnet Mask Saisissez le masque de sous-réseau du 
caméscope lorsque DHCP est réglé sur 
Off.

Gateway Saisissez la passerelle par défaut du 
caméscope lorsque DHCP est réglé sur 
Off.

DNS Auto 
On / Off

Active/désactive la fonction d’acquisition 
automatique de DNS.

Primary DNS Server Saisissez le serveur DNS principal lorsque 
DNS Auto est réglé sur Off.

Secondary DNS Server Saisissez le serveur DNS secondaire 
lorsque DNS Auto est réglé sur Off.

Network >Wired LAN
Définit les réglages liés aux connexions LAN filaires.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction du LAN 
filaire.

Camera 
Remote 
Control

Enable / Disable Règle si la télécommande doit être 
activée depuis un dispositif connecté au 
caméscope par LAN filaire.

Detail 
Settings

Configure les propriétés de la connexion 
par LAN filaire.

DHCP 
On / Off

Active/désactive DHCP.

IP Address Saisissez l’adresse IP du caméscope 
lorsque DHCP est réglé sur Off.

Subnet Mask Saisissez le masque de sous-réseau du 
caméscope lorsque DHCP est réglé sur 
Off.

Gateway Saisissez la passerelle par défaut du 
caméscope lorsque DHCP est réglé sur 
Off.

DNS Auto 
On / Off

Active/désactive la fonction d’acquisition 
automatique de DNS.

Primary DNS Server Saisissez le serveur DNS principal lorsque 
DNS Auto est réglé sur Off.

Secondary DNS Server Saisissez le serveur DNS secondaire 
lorsque DNS Auto est réglé sur Off.

Network >Modem
Définit les réglages liés au raccordement modem USB.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la connexion au 
smartphone.

Camera 
Remote 
Control

Enable / Disable Définit la permission pour la 
télécommande via le raccordement 
modem USB en utilisant une application 
de smartphone, telle que CBM (Content 
Browser Mobile) ou Creators' App for 
enterprise.

Device Name Affiche le nom de dispositif du 
smartphone.

IP Address Affiche l’adresse IP du smartphone.

Subnet Mask Affiche le masque de sous-réseau du 
smartphone.
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Network >File Transfer
Définit les réglages liés aux transferts de fichiers.

Élément Réglage de sous-éléments Description

Auto Upload On / Off Active/désactive le téléchargement 
automatique des fichiers originaux.

[Remarque]
Lorsque Simul Rec >Setting (page 87) dans 
le menu Project est réglé sur On, les plans 
enregistrés sur le support dans la fente B ne 
sont pas téléchargés automatiquement.

Auto Upload 
(Proxy)

On / Off / Chunk On :
Active le téléchargement 
automatique des fichiers proxy.

Off :
Désactive le téléchargement 
automatique des fichiers proxy.

Chunk :
Télécharge un fichier proxy enregistré 
par fragments automatiquement.

[Remarque]
Lorsque Simul Rec >Setting (page 87) dans 
le menu Project est réglé sur On, les plans 
enregistrés sur le support dans la fente B 
ne sont pas téléchargés automatiquement. 
Chunk est également grisé et ne peut pas être 
sélectionné.

Default 
Upload 
Server

Sélectionne le serveur de téléchargement 
pour les fichiers. Le serveur sélectionné 
ici devient la destination de 
téléchargement automatique pour les 
fichiers originaux et proxy ainsi que la 
destination de téléchargement pour les 
fichiers à partir de l’écran des miniatures.
Affiche le nom d’affichage configuré 
dans Server Settings 1 à 3.

Clear 
Completed 
Jobs

Execute / Cancel Supprime de la liste les tâches de 
transfert terminées.
Execute : fonction Execute.

Clear All Jobs Execute / Cancel Supprime de la liste toutes les tâches de 
transfert.
Execute : fonction Execute.

View Job List Affiche la liste des tâches de transfert.

Network >File Transfer
Définit les réglages liés aux transferts de fichiers.

Élément Réglage de sous-éléments Description

Server 
Settings1

Display Name Règle le nom d’affichage indiqué dans le 
menu de configuration de destination de 
transfert.

Service 
FTP

Permet d’afficher le type de serveur.

Host Name Règle le nom d’hôte du serveur de 
destination de transfert.

Port (1 à 65535 (21)) Règle le numéro de port du serveur de 
destination de transfert.

User Name Règle le nom d’utilisateur pour 
l’authentification de la connexion au 
serveur de destination de transfert.

Password Règle le mot de passe d’authentification 
de la connexion au serveur de 
destination de transfert.

Passive Mode 
On / Off

Active/désactive le mode PASV.

Destination Directory Saisissez le nom du répertoire de 
destination de transfert.

Using Secure Protocol 
On / Off

Règle l’utilisation (On) ou non (Off) d’un 
transfert FTP sécurisé (Mode FTPS 
Explicit : FTPES).

Root Certificate 
Load / Clear / None

Charge un certificat racine pour un 
transfert FTP sécurisé et supprime les 
réglages.

Root Certificate Status 
Loaded / No Certificate

Affiche l’état de chargement du certificat 
racine pour un transfert FTP sécurisé.

Reset 
Execute / Cancel

Réinitialise les réglages de Server 
Settings aux réglages par défaut.
Execute : fonction Execute.

Server 
Settings2

Identique à Server Settings1.

Server 
Settings3

Identique à Server Settings1.

Network >Network Reset
Réinitialise les réglages de réseau.

Élément Réglage de sous-éléments Description

Reset Execute / Cancel Réinitialise les réglages de réseau.
Execute : fonction Execute.
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Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Maintenance >Language
Règle la langue d’affichage.

Élément Réglage de sous-éléments Description

Select Règle la langue d’affichage.
SET : règle la langue.

Maintenance >Clock Set
Définit les réglages de l’horloge interne.

Élément Réglage de sous-éléments Description

Time Zone UTC – 12:00 à UTC + 14:00 Règle le décalage horaire par rapport au 
temps universel, par incréments de 30 
minutes.

Date Mode YYMMDD / MMDDYY / DDMMYY Sélectionne le format d’affichage pour 
les dates.
YYMMDD : année, mois, jour
MMDDYY : mois, jour, année
DDMMYY : jour, mois, année

12h/24h 12h / 24h Sélectionne le format d’affichage de 
l’horloge.
12h : mode 12 heures
24h : mode 24 heures

Date Règle la date actuelle.
SET : règle la valeur.

Time Règle l’heure actuelle.
SET : règle la valeur.

Maintenance >All Reset
Réinitialise les réglages aux valeurs par défaut.

Élément Réglage de sous-éléments Description

Reset Execute / Cancel Réinitialise tous les réglages à leurs 
valeurs par défaut.
Execute : fonction Execute.

[Remarque]
Un fichier 3D LUT importé à l’aide de Base 
Look >Import from Media(B), Import from 
Cloud(Private) ou Import from Cloud(Share) 
(page 92) dans le menu Paint/Look ne peut 
pas être supprimé. Pour supprimer tous les 
fichiers 3D LUT importés, sélectionnez Base 
Look >Delete All dans le menu Paint/Look 
(page 92).

Maintenance >All Reset
Réinitialise les réglages aux valeurs par défaut.

Élément Réglage de sous-éléments Description

Reset without 
Network

Execute / Cancel Réinitialise les réglages du menu, à 
l’exception des réglages du menu 
Network, à l’état d’usine par défaut.

Maintenance >Hours Meter
Affiche la durée de fonctionnement cumulée.

Élément Réglage de sous-éléments Description

Hours 
(System)

Affiche les heures d’utilisation cumulées 
(ne peut pas être réinitialisé).

Hours(Reset) Affiche les heures d’utilisation cumulées 
(peut être réinitialisé).

Reset Execute / Cancel Réinitialise l’affichage de Hours(Reset) à 
0.
Execute : fonction Execute.

Maintenance >Version
Affiche les informations de version.

Élément Réglage de sous-éléments Description

Version 
Number

Vx.xx Affiche la version du logiciel du 
caméscope.

Version Up Execute / Cancel Met à jour le caméscope.*

Execute : fonction Execute.
*	 Cette fonction met le logiciel du caméscope 

à jour.

Lens Version 
Number

Vxx Affiche le numéro de version du logiciel 
d’un objectif à monture E.

Menu Maintenance



6. Affichage et réglages de menu112

Réglages et valeurs par défaut du menu Shooting

Réglages et valeurs par défaut d’ISO/Gain

La plage des réglages et valeurs par défaut ISO/Gain (page 78) varie selon les réglages Mode, Target Display, Base Look >Select, Base Sensitivity et Base ISO. Les options disponibles sont 
surlignées en gris.

Lorsque Mode est réglé sur ISO

Custom
Target Display SDR(BT.709) HDR(HLG) SDR(BT.709) et HDR(HLG) ordinaires

Base Look >Select S-Cinetone / Standard / ITU709 / Still HLG Live / HLG Natural User1 à User16

Base Sensitivity Low High Low High Low High

ISO 320 ISO/Gain<L> défaut

ISO 400

ISO 500

ISO 640 ISO/Gain<M> défaut

ISO 800 ISO/Gain<L> défaut ISO/Gain<L> défaut

ISO 1000

ISO 1250 ISO/Gain<H> défaut

ISO 1600 ISO/Gain<M> défaut ISO/Gain<M> défaut

ISO 2000

ISO 2500

ISO 3200 ISO/Gain<H> défaut ISO/Gain<H> défaut

ISO 4000

ISO 5000 ISO/Gain<L> défaut

ISO 6400

ISO 8000

ISO 10000 ISO/Gain<M> défaut

ISO 12800 ISO/Gain<L> défaut ISO/Gain<L> défaut

ISO 16000

ISO 20000 ISO/Gain<H> défaut

ISO 25600 ISO/Gain<M> défaut ISO/Gain<M> défaut

ISO 32000

ISO 40000

ISO 51200 ISO/Gain<H> défaut ISO/Gain<H> défaut

ISO 64000

ISO 80000

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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Flexible ISO
Base ISO ISO 12800 ISO 800

ISO 320

ISO 400

ISO 500

ISO 640

ISO 800 ISO/Gain<L> défaut

ISO 1000

ISO 1250

ISO 1600 ISO/Gain<M> défaut

ISO 2000

ISO 2500

ISO 3200 ISO/Gain<H> défaut

ISO 4000

ISO 5000

ISO 6400

ISO 8000

ISO 10000

ISO 12800 ISO/Gain<L> défaut

ISO 16000

ISO 20000

ISO 25600 ISO/Gain<M> défaut

ISO 32000

ISO 40000

ISO 51200 ISO/Gain<H> défaut

ISO 64000

ISO 80000

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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Lorsque Mode est réglé sur dB

Plage de réglages

–3dB

–2dB

–1dB

0dB ISO/Gain<L> défaut

1dB

2dB

3dB

4dB

5dB

6dB ISO/Gain<M> défaut

7dB

8dB

9dB

10dB

11dB

12dB ISO/Gain<H> défaut

13dB

14dB

15dB

16dB

17dB

18dB

19dB

20dB

21dB

22dB

23dB

24dB

25dB

26dB

27dB

28dB

29dB

30dB
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Réglages et valeurs par défaut de AGC Limit

La plage des réglages et valeurs par défaut AGC Limit (page 81) varie selon les réglages Mode, Target Display, Base Look >Select, Base Sensitivity et Base ISO. Les options disponibles sont 
surlignées en gris.

Lorsque Mode est réglé sur ISO

Custom
Target Display SDR(BT.709) HDR(HLG) HDR(HLG) SDR(BT.709) et HDR(HLG) ordinaires

Base Look >Select S-Cinetone / Standard / ITU709 / Still HLG Live HLG Natural User1 à User16

Base Sensitivity Low High Low High Low High Low High

ISO 400

ISO 500

ISO 640

ISO 800

ISO 1000

ISO 1250

ISO 1600

ISO 2000 Défaut

ISO 2500

ISO 3200

ISO 4000

ISO 5000 Défaut Défaut Défaut

ISO 6400

ISO 8000

ISO 10000

ISO 12800

ISO 16000

ISO 20000

ISO 25600

ISO 32000 Défaut

ISO 40000

ISO 51200

ISO 64000

ISO 80000 Défaut Défaut Défaut

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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Flexible ISO
Base ISO ISO 12800 ISO 800

ISO 400

ISO 500

ISO 640

ISO 800

ISO 1000

ISO 1250

ISO 1600

ISO 2000

ISO 2500

ISO 3200

ISO 4000

ISO 5000 Défaut

ISO 6400

ISO 8000

ISO 10000

ISO 12800

ISO 16000

ISO 20000

ISO 25600

ISO 32000

ISO 40000

ISO 51200

ISO 64000

ISO 80000 Défaut

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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Lorsque Mode est réglé sur dB

Plage de réglages

3dB

6dB

9dB

12dB

15dB Défaut

18dB

21dB

24dB

27dB

30dB
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Réglages de qualité d’image sauvegardés pour chaque mode de prise de vue
L’état actuel des éléments de configuration liés à la qualité d’image est sauvegardé pour chacun des modes de prise de vue suivants (page 24). Lorsque vous changez de mode de prise de vue, 
les réglages correspondants qui sont sauvegardés sont appliqués au mode de prise de vue cible.
ˎˎ Mode de prise de vue Custom SDR(BT.709)
ˎˎ Mode de prise de vue Custom HDR(HLG)
ˎˎ Modes de prise de vue Log (Cine EI, Cine EI Quick, Flexible ISO)

Les éléments de configuration relatifs à la qualité d’image qui sont sauvegardés pour chaque mode de prise de vue sont indiqués ci-dessous.
Oui : L’élément est enregistré.
Non : L’élément n’est pas enregistré.

Élément de configuration Mode de prise de vue

Custom Flexible ISO Cine EI Quick Cine EI

SDR(BT.709) HDR(HLG)

Menu Shooting ISO/Gain/EI ISO/Gain Oui1) Oui Non

Exposure Index Non Non Oui Oui

Base Sensitivity Oui Non

Base ISO Non Oui4) Non3) Oui4)

White Preset White Oui Oui

Autre que ci-dessus Oui

White Setting Oui

Offset White Oui Non

LUT On/Off Non Oui

Noise Suppression Setting(Custom) Oui Oui Non

Level(Custom) Oui Oui Non

Setting (Cine EI/Flex. ISO) Non Oui

Level (Cine EI/Flex. ISO) Non Oui

Menu Paint/Look Base Look Select Oui Oui Oui

Input2) Oui

Output2) Oui

AE Level Offset2) Oui

Black Oui Oui Non

Knee Auto Knee Oui Non Non

Autre que ci-dessus Oui Oui Non

Detail Oui Oui Non

Matrix Oui Oui Non

Multi Matrix Oui Oui Non

1)	 Les réglages de sensibilité ISO distincts sont sauvegardés pour le mode de prise de vue Custom SDR(BT.709) et HDR(HLG).
2)	Les réglages sont sauvegardés pour chaque Base Look, et ne dépendent pas du mode de prise de vue.
3)	La sensibilité ISO de base change en lien avec Exposure Index.
4)	Valeur de réglage commune aux modes de prise de vue Flexible ISO et Cine EI.
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Données de configuration

Vous pouvez enregistrer les réglages du menu 
complet sur une carte mémoire insérée dans 
le logement de carte CFexpress Type A/SD (B). 
Vous pouvez également enregistrer un fichier 
ALL sur un service Cloud. Cela vous permet de 
rappeler rapidement un ensemble de réglages 
de menu approprié à la situation actuelle.
Les données de configuration sont 
sauvegardées dans les catégories suivantes.

Fichiers utilisateur
Les fichiers utilisateur enregistrent les 
éléments et les données de réglage du menu 
User personnalisable.
Vous pouvez enregistrer jusqu’à 64 fichiers sur 
une carte mémoire.
En chargeant ce fichier dans la mémoire du 
caméscope, vous pouvez personnaliser la 
configuration du menu User.

Les fichiers ALL (tous les réglages)
Les fichiers ALL sauvegardent les données 
de configuration de tous les menus. Vous 
pouvez enregistrer jusqu’à 64 fichiers sur une 
carte mémoire. Jusqu’à 120 fichiers peuvent 
être enregistrés sur C3 Portal (service Cloud), 
comprenant jusqu’à 60 fichiers privés et 
60 fichiers partagés.

[Remarque]
Pour plus de détails sur le contenu enregistré dans un 
fichier ALL, consultez « Eléments enregistrés dans les 
fichiers » (page 133).

Sauvegarde d’un fichier 
utilisateur/fichier ALL

Enregistrement sur une carte mémoire

1	 Insérez une carte mémoire dans le 
logement de carte CFexpress Type A/SD 
(page 6).
ˎˎ Pour les cartes CFexpress, l’étiquette est 
orientée vers la gauche.
ˎˎ Pour les cartes SD, l’étiquette est 
orientée vers la droite, avec le coin 
biseauté en bas.

2	 Pour un fichier utilisateur, sélectionnez 
User File >Save to Media(B) (page 91) 
>Execute dans le menu Project du menu 
complet.
Pour un fichier ALL, sélectionnez All File 
>Save to Media(B) (page 91) >Execute 
dans le menu Project du menu complet.
Un écran de destination de sauvegarde de 
fichiers apparaît.

3	 Sélectionnez une rangée « No File » dans 
l’écran de destination d’enregistrement.
Sélectionner une rangée avec la saisie File 
ID écrasera le fichier sélectionné.
L’identifiant de fichier attribué lors de la 
sauvegarde peut être modifié à l’aide du 
menu. Pour plus de détails sur la 
configuration, consultez « Modification de 
l’identifiant de fichier » (page 120).

4	 Sélectionnez Execute sur l’écran de 
confirmation.

Enregistrement d’un fichier ALL sur un 
service Cloud

1	 Connectez-vous à l’appareil depuis 
l’application pour smartphone « Creators' 
App for enterprise » (page 68).

2	 Sélectionnez All File >Save to 
Cloud(Private) ou Save to Cloud(Share) 
(page 91) >Execute dans le menu 
Project du menu complet.
Un écran de destination de sauvegarde de 
fichiers apparaît.

3	 Sélectionnez une rangée « No File » dans 
l’écran de destination d’enregistrement.
Sélectionner une rangée avec la saisie File 
ID écrasera le fichier sélectionné.
L’identifiant de fichier attribué lors de la 
sauvegarde peut être modifié à l’aide du 
menu. Pour plus de détails sur la 
configuration, consultez « Modification de 
l’identifiant de fichier » (page 120).

4	 Sélectionnez Execute sur l’écran de 
confirmation.

Chargement d’un fichier 
utilisateur/fichier ALL

Chargement depuis une carte mémoire

1	 Insérez une carte mémoire sur laquelle un 
fichier est enregistré dans le logement de 
carte CFexpress Type A/SD (page 6).
ˎˎ Pour les cartes CFexpress, l’étiquette est 
orientée vers la gauche.
ˎˎ Pour les cartes SD, l’étiquette est 
orientée vers la droite, avec le coin 
biseauté en bas.

2	 Pour un fichier utilisateur, sélectionnez 
User File >Load from Media(B) 
(page 91) >Execute dans le menu 
Project du menu complet.
Pour un fichier ALL, sélectionnez All File 
>Load from Media(B) (page 91) 
>Execute dans le menu Project du menu 
complet.
Un écran de liste de fichiers s’affiche.

3	 Sélectionnez un fichier à charger.
Un écran de confirmation apparaît.

4	 Sélectionnez Execute.

[Remarques]
ˎˎ L’appareil redémarrera automatiquement après avoir 

chargé les données de configuration.
ˎˎ Lorsque All File >Load Network Data dans le menu 

Project du menu complet est réglé sur Off, tous les 
réglages du fichier ALL sont chargés à l’exception des 
réglages du menu Network.

Enregistrement et chargement des données de configuration



6. Affichage et réglages de menu : Enregistrement et chargement des données de configuration120

Chargement d’un fichier ALL depuis un 
service Cloud

1	 Connectez-vous à l’appareil depuis 
l’application pour smartphone « Creators' 
App for enterprise » (page 68).

2	 Sélectionnez All File >Load from 
Cloud(Private) ou Load from Cloud(Share) 
(page 91) >Execute dans le menu 
Project du menu complet.
Un écran de liste de fichiers s’affiche.

3	 Sélectionnez un fichier à charger.
Un écran de confirmation apparaît.

4	 Sélectionnez Execute.

[Remarques]
ˎˎ L’appareil redémarrera automatiquement après avoir 

chargé les données de configuration.
ˎˎ Lorsque All File >Load Network Data dans le menu 

Project du menu complet est réglé sur Off, tous les 
réglages du fichier ALL sont chargés à l’exception des 
réglages du menu Network.

Modification de l’identifiant de 
fichier

1	 Pour un fichier utilisateur, sélectionnez 
User File >File ID (page 91) dans le 
menu Project du menu complet.
Pour un fichier ALL, sélectionnez All File 
>File ID (page 91) dans le menu Project 
du menu complet.
Un écran permettant de modifier 
l’identifiant de fichier apparaît.

2	 Sélectionnez un caractère à l’aide du 
sélecteur multiple (page 7) ou de la 
molette multifonction (page 5), puis 
appuyez sur la touche de mise en 
application du sélecteur multiple ou sur la 
molette multifonction.

3	 Répétez l’étape 2 si nécessaire.

4	 Lorsque vous avez saisi tous les 
caractères, sélectionnez Done.
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Connexion des moniteurs externes et des dispositifs d’enregistrement
Pour afficher les images enregistrées/lues sur 
un moniteur externe, sélectionnez le signal 
de sortie du caméscope et utilisez un câble 
approprié pour le moniteur à raccorder.
Vous pouvez également raccorder des 
dispositifs d’enregistrement, tels qu’un 
magnétoscope, et enregistrer le signal de 
sortie depuis le caméscope.
Vous pouvez afficher les mêmes informations 
qui sont visibles dans le viseur, telles que 
les informations d’état et les menus, sur 
un moniteur externe. Réglez Info. Disp. 
(page 15) dans l’écran d’état Monitoring 
ou Output Display (page 98) dans le menu 
Monitoring du menu complet sur On en 
fonction du signal à transmettre au moniteur.

[Remarque]
Veillez aux points suivants lors de la connexion d’un 
moniteur externe ou d’un dispositif d’enregistrement 
à l’appareil. Sinon, des courants importants peuvent 
circuler dans les circuits internes de l’appareil et 
endommager les composants électroniques.
1.	 À propos des câbles CC 

Utilisez des câbles CC avec une faible impédance 
de ligne GND pour connecter un moniteur externe, 
des dispositifs d’enregistrement et tous les autres 
dispositifs.

2.	 Vérification de la différence de potentiel 
Avant l’utilisation, assurez-vous qu’il n’y a pas de 
différence de potentiel entre tous les dispositifs 
connectés et l’appareil.
(1)	 Déconnectez de l’appareil tous les dispositifs 

connectés, tels qu’un moniteur externe et des 
dispositifs d’enregistrement. 
Vérifiez que le câble coaxial 75 Ω, le câble HDMI et 
les autres câbles ne sont pas connectés.

(2)	 Connectez les câbles CC de tous les dispositifs 
connectés et de l’appareil, puis mettez sous 
tension chaque dispositif connecté et l’appareil.

(3)	 Utilisez un testeur ou un autre dispositif pour 
confirmer qu’il n’y a pas de différence de potentiel 
entre l’appareil et chaque dispositif connecté.

	 S’il y a une différence de potentiel, il est possible 
que l’impédance de la ligne GND de l’un des câbles 
CC soit élevée. Remplacez ces câbles par des 
câbles ayant une faible impédance de ligne GND, 
si nécessaire, afin d’éliminer toute différence de 
potentiel.

3.	 Connexion et séquence de mise sous tension 
Connectez chaque câble et mettez l’appareil sous 
tension dans l’ordre suivant.
(1)	 Mettez hors tension l’appareil, le moniteur 

externe, les dispositifs d’enregistrement et tous 
les autres dispositifs.

(2)	 Connectez les câbles CC de tous les dispositifs.
(3)	 Connectez le câble coaxial 75 Ω, HDMI et les autres 

câbles.
(4)	 Mettez sous tension tous les dispositifs connectés 

et ensuite l’appareil.
Pour plus de détails, contactez un technicien Sony.

Connecteur SDI OUT (de type BNC)

Définissez le réglage d’activation/de 
désactivation de la sortie, ainsi que le 
format de sortie dans le menu Monitoring 
(page 98).
Utilisez un câble coaxial de 75 Ω disponible 
dans le commerce pour le branchement.

Pour commencer l’enregistrement sur le 
caméscope et sur le dispositif externe 
de manière simultanée

Lorsque la sortie de signal SDI est activée, 
réglez SDI/HDMI Rec Control (page 88) 
>Setting dans le menu Project du menu 
complet sur SDI/HDMI Remote I/F ou Parallel 
Rec pour activer la sortie d’un signal de 
déclenchement REC vers le dispositif externe 
raccordé au connecteur SDI OUT. Cela 
permettra de synchroniser l’enregistrement 
sur le dispositif externe avec le caméscope.

[Remarques]
ˎˎ Si un dispositif externe raccordé ne prend pas en 

charge le signal de déclenchement REC, le dispositif 
ne peut pas être utilisé.
ˎˎ Seul le signal de déclenchement REC est émis 

lorsqu’aucun support n’est inséré.

Connecteur HDMI OUT (connecteur 
de type A)

Définissez le réglage On/Off de la sortie, 
ainsi que le format de sortie dans le menu 
Monitoring (page 98) du menu complet.

Pour commencer l’enregistrement sur le 
caméscope et sur le dispositif externe 
de manière simultanée

Lorsque la sortie de signal HDMI est activée, 
réglez HDMI TC Out >Setting (page 95) 
dans le menu TC/Media du menu complet sur 
On, et réglez SDI/HDMI Rec Control >Setting 
(page 88) dans le menu Project sur SDI/
HDMI Remote I/F ou Parallel Rec pour activer 
la sortie d’un signal de déclenchement 
REC vers le dispositif externe raccordé au 
connecteur HDMI OUT. Cela permettra de 

synchroniser l’enregistrement sur le dispositif 
externe avec le caméscope.

[Remarques]
ˎˎ Si un dispositif externe raccordé ne prend pas en 

charge le signal de déclenchement REC, le dispositif 
ne peut pas être utilisé.
ˎˎ Lorsqu’il est réglé sur SDI/HDMI Remote I/F, seul le 

signal de déclenchement REC est émis lorsqu’aucun 
support d’enregistrement n’est inséré.
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Synchronisation des codes temporels
Vous pouvez synchroniser le code temporel de 
l’unité avec d’autres dispositifs.

Verrouillage du code temporel sur 
d’autres dispositifs

Réglez l’appareil fournissant le code temporel 
sur un mode dans lequel la sortie de code 
temporel continue à défiler (comme Free Run 
ou Clock).

1	 Réglez Timecode (page 95) dans le 
menu TC/Media du menu complet de la 
manière suivante.
Mode : Preset
Run : Free Run

2	 Appuyez sur la touche personnalisable 
(page 49) à laquelle la fonction 
DURATION/TC/U-BIT consistant à afficher 
le code temporel sur l’écran est attribuée.

3	 Vérifiez que le commutateur de sélection 
TC IN/OUT (page 4) est positionné sur 
IN, puis envoyez un code temporel de 
référence pour synchroniser la fréquence 
du système du caméscope au connecteur 
TC IN/TC OUT.

Le générateur de code temporel du 
caméscope acquiert le verrou avec le code 
temporel de référence et « EXT-LK » apparaît à 
l’écran.
Une fois que 10 secondes environ se sont 
écoulées après le verrouillage du code 
temporel, l’état de verrouillage externe 
est maintenu, même si la source de 
code temporel de référence externe est 
déconnectée.

[Remarques]
ˎˎ Lors de l’utilisation d’un verrou externe, le code 

temporel acquiert instantanément le verrou avec 
le code temporel externe et la valeur de code 
temporel externe apparaît dans la zone d’affichage 
des données. Cependant, ne commencez pas 
immédiatement l’enregistrement. Patientez quelques 
secondes le temps que le générateur de code 
temporel se stabilise avant l’enregistrement.
ˎˎ Si la fréquence du code temporel de référence et 

la fréquence d’images du caméscope ne sont pas 
identiques, un verrou ne peut pas être acquis et le 
caméscope ne fonctionnera pas correctement. Si cela 
se produit, le code temporel n’acquerra pas de verrou 
correctement avec le code temporel externe.
ˎˎ Le code temporel peut changer d’une image par 

heure par rapport au code temporel de référence.

Pour déverrouiller le verrou externe

Changez le réglage Timecode dans le menu 
TC/Media du menu complet.
La synchronisation externe se déclenche 
également en cas de modification de la 
fréquence du système et lorsque vous 
démarrez un enregistrement en mode 
d’enregistrement spécial (Slow & Quick Motion 
ou Interval Rec).

Synchronisation du code temporel 
d’un autre dispositif avec le code 
temporel du caméscope

Réglez l’appareil fournissant le code temporel 
sur un mode dans lequel la sortie de code 
temporel continue à défiler (comme Free Run 
ou Clock).

1	 Réglez le code temporel du caméscope en 
utilisant Timecode (page 95) dans le 
menu TC/Media du menu complet.

2	 Vérifiez que le commutateur de sélection 
TC IN/OUT (page 4) est réglé sur la 
position OUT et connectez le connecteur 
TC IN/TC OUT au connecteur d’entrée de 
code temporel du dispositif que vous 
souhaitez synchroniser.
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Gestion/Edition de plans grâce à un ordinateur

Connexion à l’aide d’un câble USB

Utilisation d’un lecteur de carte (en 
option)

Connectez un lecteur de carte CFexpress Type 
A ou un lecteur de carte SD à un ordinateur à 
l’aide d’un câble USB, puis insérez une carte 
mémoire dans le logement du lecteur de 
carte. La carte mémoire est reconnue comme 
un lecteur d’extension de l’ordinateur. Sur 
les ordinateurs compatibles, vous pouvez 
importer des plans à haute vitesse à l’aide du 
mode de stockage de masse du caméscope.

Utilisation du mode de stockage de 
masse

[Remarque]
Le mode de stockage de masse ne peut pas être utilisé 
lorsque Modem >Setting dans le menu Network du 
menu complet est réglé sur On ou lorsque Wired LAN 
>Setting dans le menu Network est réglé sur On. Réglez 
ces deux paramètres sur Off.

Raccordez le caméscope à l’aide d’un câble 
USB et insérez une carte mémoire dans le 
logement de carte A ou B. La carte mémoire 
est reconnue comme un lecteur d’extension 
de l’ordinateur.

1	 Raccordez le connecteur USB-C 
(page 7) ou le connecteur USB/Multi 
(page 7) à l’ordinateur à l’aide d’un 
câble USB.

2	 Placez le commutateur POWER du 
caméscope sur ON.
Un message apparaît sur l’écran du viseur, 
vous demandant si vous souhaitez activer 
la connexion USB.

	 [Remarque]
Le message de confirmation de connexion USB 
n’est pas affiché tant qu’un autre message de 
confirmation ou de progression est affiché, par 
exemple, lors du formatage ou de la restauration 
d’une carte mémoire.
Le message de confirmation est affiché lorsque 
l’exécution du formatage ou de la restauration est 
terminée. Le message de confirmation USB n’est 
pas non plus affiché lorsque l’écran des propriétés 
du plan est affiché. Le message est affiché lorsque 
le traitement se termine ou lorsque vous revenez à 
l’écran de miniatures.

3	 Tournez la molette multifonction pour 
sélectionner Execute.

4	 Sous Windows, vérifiez que la carte est 
ajoutée en tant que disque amovible dans 
la fenêtre « Poste de travail ».
Sous Mac, vérifiez que le dossier appelé 
« NO NAME » ou « Untitled » (éditable) est 
créé sur le bureau.

[Remarques]
ˎˎ N’effectuez pas les opérations suivantes si l’indicateur 

d’accès est allumé en rouge.
–– Mise hors tension ou débranchement du cordon 

d’alimentation
–– Retrait de la carte mémoire
–– Déconnexion du câble USB

ˎˎ Le fonctionnement n’est pas garanti avec tous les 
ordinateurs.

Utilisation d’un système de 
montage non linéaire

Dans un système de montage non linéaire, 
un logiciel de montage (en option) qui prend 
en charge les formats enregistrés par le 
caméscope est nécessaire.
Utilisez un logiciel d’application dédié pour 
enregistrer au préalable les plans que vous 
souhaitez éditer sur le disque dur de votre 
ordinateur.
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Précautions d’utilisation
Concernant la condensation

Si l’appareil est soudainement déplacé 
d’un endroit froid à un endroit chaud, ou 
si la température ambiante augmente 
brusquement, de l’humidité peut se former 
sur la surface externe de l’appareil et/ou à 
l’intérieur de l’appareil. Ce phénomène est 
connu sous le nom de condensation. Si de 
la condensation se produit, mettez l’appareil 
hors tension et patientez le temps que la 
condensation disparaisse avant d’utiliser 
l’appareil. L’utilisation de l’appareil avec de la 
condensation pourrait endommager l’appareil.

Concernant les écrans LCD

L’écran LCD intégré à cet appareil est fabriqué 
avec une technologie de haute précision, 
ce qui permet d’obtenir un taux d’au moins 
99,99% de pixels qui fonctionnent. Ainsi, 
un infime pourcentage de pixels peut être 
« bloqué », c’est-à-dire toujours éteint (noir), 
toujours éclairé (rouge, vert ou bleu), ou 
clignotant. En outre, après une longue période 
d’utilisation, en raison des caractéristiques 
physiques de l’afficheur à cristaux liquides, 
de tels pixels « bloqués » peuvent apparaître 
spontanément. Ces problèmes ne sont pas 
graves. Notez que ces problèmes n’ont aucun 
effet sur les données enregistrées.

Phénomènes spécifiques aux capteurs 
d’images CMOS de caméra

[Remarque]
Les phénomènes suivants, qui peuvent se produire 
sur les images, sont propres aux capteurs d’images. Ils 
n’indiquent en aucun cas un dysfonctionnement.

Taches blanches
Bien que les capteurs soient fabriqués à 
l’aide de technologies de haute précision, 
il peut arriver (dans de rares cas) que des 
petites taches blanches apparaissent sur 
l’écran, celles-ci sont causées par les rayons 
cosmiques, etc.
Ce phénomène est inhérent à la technologie 
des capteurs d’images et ne signale en aucun 
cas un dysfonctionnement.
Les taches blanches sont surtout visibles dans 
les cas suivants :
ˎˎ Lors du fonctionnement à haute 
température ambiante
ˎˎ Lorsque vous avez augmenté le gain (la 
sensibilité)

Scintillement
Si l’enregistrement est effectué sous un 
éclairage fluorescent, des lampes au sodium, 
à vapeur de mercure ou LED, l’écran peut 
scintiller ou les couleurs peuvent varier.

Concernant les pièces consommables

ˎˎ Le ventilateur et la batterie sont 
des consommables qui doivent être 
régulièrement remplacés.  
Lorsque vous utilisez l’appareil à 
température ambiante, le cycle de 
remplacement est d’environ 5 ans. Mais, 
ce cycle de remplacement ne représente 
qu’une indication et ne garantit pas la durée 
de vie de ces consommables. Pour plus de 
détails sur le remplacement de ces pièces, 
veuillez contacter votre revendeur.
ˎˎ La durée de vie l’adaptateur CA et du 
condensateur électrolytique est de 
5 ans environ, sous des températures de 
fonctionnement normales et pour un usage 
normal (8 heures par jour, 25 jours par 
mois). Si l’utilisation dépasse la fréquence 
d’utilisation normale, la durée de vie peut 
être réduite en conséquence.

ˎˎ La borne de batterie de cet appareil 
(le connecteur pour les packs batterie 
et les adaptateurs CA) est une pièce 
consommable.  
L’appareil risque de ne pas être alimenté 
correctement si les broches de la borne de 
batterie sont cintrées ou déformées par 
les chocs ou les vibrations, ou si elles sont 
touchées par la corrosion en raison d’une 
utilisation prolongée en extérieur.  
Des inspections périodiques sont 
recommandées pour que l’appareil 
continue à fonctionner correctement et 
pour prolonger la durée de son utilisation. 
Contactez un vendeur ou un technicien Sony 
pour plus d’informations sur les inspections.

A propos de la batterie rechargeable 
intégrée

Le caméscope possède une batterie 
rechargeable intégrée afin de stocker la 
date, l’heure et d’autres réglages, même 
lorsque le caméscope est éteint. La batterie 
rechargeable intégrée sera chargée après 
24 h si l’unité est connectée à une prise 
électrique grâce à l’adaptateur CA, ou si un 
pack batterie complètement chargé est fixé, 
que le caméscope soit allumé ou éteint. 
La batterie rechargeable sera entièrement 
déchargée après environ 2 mois si l’adaptateur 
CA n’est pas branché ou si le caméscope 
est utilisé sans que le pack batterie ne soit 
fixé. Utilisez votre caméscope après avoir 
chargé la batterie. Néanmoins, même si la 
batterie rechargeable n’est pas chargée, le 
fonctionnement du caméscope n’est pas 
affecté tant que vous n’avez pas besoin 
d’enregistrer la date.

Emplacements d’utilisation et de 
stockage

Stockez dans un lieu aéré et de niveau.
Évitez d’utiliser ou de stocker l’unité dans les 
endroits suivants.
ˎˎ Les endroits excessivement chauds ou froids 
(plage de température de fonctionnement : 
0 °C à 40 °C (32 °F à 104 °F))  
N’oubliez pas qu’en été, dans les climats 
chauds, la température à l’intérieur d’un 
véhicule aux vitres fermées peut facilement 
dépasser 50 °C (122 °F).
ˎˎ Les endroits humides ou poussiéreux. Lieux 
où l’appareil pourrait recevoir la pluie
ˎˎ Lieux soumis à de violentes vibrations
ˎˎ À proximité de puissants champs 
magnétiques
ˎˎ À proximité d’émetteurs radio ou de 
télévision générant de puissants champs 
magnétiques
ˎˎ Sous la lumière directe du soleil ou à 
proximité de chauffages pendant de 
longues périodes

Remarque sur les faisceaux laser

Les faisceaux laser peuvent endommager le 
capteur d’image CMOS. Si vous filmez une 
scène comprenant un faisceau laser, veillez à 
ce que celui-ci ne soit pas dirigé directement 
vers l’objectif de l’appareil. En particulier, les 
faisceaux laser haute puissance provenant de 
dispositifs médicaux ou d’autres dispositifs 
peuvent causer des dommages dus à la 
lumière réfléchie et à la lumière diffuse.
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Pour empêcher les interférences 
électromagnétiques dues aux dispositifs 
de communication portables

L’utilisation des téléphones portables et 
d’autres dispositifs de communication à 
proximité de la caméra peut provoquer des 
dysfonctionnements et des interférences avec 
les signaux audio et vidéo. Il est recommandé 
de désactiver les dispositifs de communication 
portables à proximité de la caméra.

Mesures de sécurité

ˎˎ SONY NE PEUT ÊTRE TENUE RESPONSABLE 
DE TOUT DOMMAGE, DE QUELQUE NATURE 
QUE CE SOIT, RÉSULTANT D’UNE INCAPACITÉ 
À METTRE EN PLACE DES MESURES DE 
SÉCURITÉ ADAPTÉES POUR LES DISPOSITIFS 
DE TRANSMISSION, DE FUITES DE DONNÉES 
INÉVITABLES DUES AUX SPÉCIFICATIONS 
DE TRANSMISSION OU DE TOUT AUTRE 
PROBLÈME DE SÉCURITÉ.
ˎˎ Selon l’environnement d’exploitation, il est 
possible que des tiers non autorisés sur le 
réseau puissent accéder à l’appareil. Avant 
de connecter l’appareil au réseau, vérifiez 
que le réseau est bien protégé.
ˎˎ Le contenu des communications peut être 
intercepté à votre insu par des tiers non 
autorisés à proximité des signaux. Lors de 
communications LAN sans fil, appliquez des 
mesures de sécurité adaptées pour protéger 
le contenu des communications.
ˎˎ Lorsque vous connectez ce produit à 
un réseau, connectez-le via un système 
fournissant une fonction de protection, 
tel qu’un routeur ou un pare-feu. Si vous 
vous connectez sans cette protection, des 
problèmes de sécurité pourraient survenir.
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Les réglages par défaut sont affichés en gras (par exemple, 1920×1080P (Level A)).

[Remarques]
ˎˎ La résolution du format de sortie est limitée par les réglages Rec Format >Frequency, Codec et Video Format dans 

le menu Project du menu complet (page 85).
ˎˎ La résolution du format de sortie est également limitée par l’association à la fréquence d’images S&Q. En plus du 

tableau des formats de sortie du connecteur SDI OUT/HDMI OUT ci-dessous, la sortie HDMI passe en Full HD ou 
inférieur lorsque toutes les conditions suivantes sont réunies.
–– S&Q Motion >Setting dans le menu Shooting est réglé sur On
–– S&Q Motion >Frame Rate dans le menu Shooting est supérieur à 60fps
–– Rec Format >Codec dans le menu Project est réglé sur RAW ou RAW & XAVC-I, ou Output On/Off >SDI dans le 

menu Monitoring est réglé sur On
ˎˎ Lorsque les conditions ci-dessus sont réunies, les options de sélection 4096×2160P et 3840×2160P de la sortie 

HDMI pour Output Format >SDI/HDMI (page 98) dans le menu Monitoring sont grisées et ne peuvent pas être 
sélectionnées.
ˎˎ L’image n’est pas émise si une résolution supérieure à celle de l’image de lecture est configurée.

Formats de sortie du connecteur SDI OUT/HDMI OUT

Réglage de la 
fréquence de 
système
(Rec Format 
>Frequency dans 
le menu Project)

Réglage de codec
(Rec Format 
>Codec dans le 
menu Project)

Réglage du format 
d’enregistrement/
RAW
(Rec Format >RAW 
Output Format/Video 
Format dans le menu 
Project)

Format de sortie (Output Format 
dans le menu Monitoring)

SDI HDMI

50/59.94Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

3840×2160P

1920×1080P

1920×1080i

3840×2160(RAW) (3840×2160 RAW) 3840×2160P

1920×1080P

1920×1080i

RAW(HDMI)
RAW(HDMI) & 
XAVC-I

4240×2392(RAW) 1920×1080P 
(Level A)

(4240×2392 HDMI 
RAW)

1920×1080P 
(Level B)

1920×1080i

Réglage de la 
fréquence de 
système
(Rec Format 
>Frequency dans 
le menu Project)

Réglage de codec
(Rec Format 
>Codec dans le 
menu Project)

Réglage du format 
d’enregistrement/
RAW
(Rec Format >RAW 
Output Format/Video 
Format dans le menu 
Project)

Format de sortie (Output Format 
dans le menu Monitoring)

SDI HDMI

50/59.94Hz XAVC-I
XAVC-L

4096×2160(Video) 4096×2160P1) 4096×2160P

4096×2160P 1920×1080P

4096×2160P 1920×1080i

3840×2160P 3840×2160P

3840×2160P 1920×1080P

3840×2160P 1920×1080i

1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level A)

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080P 
(Level B)

1920×1080i

1920×1080i 1920×1080i

3840×2160(Video) 3840×2160P 3840×2160P

3840×2160P 1920×1080P

3840×2160P 1920×1080i

1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level A)

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080P 
(Level B)

1920×1080i

1920×1080i 1920×1080i

Formats de sortie et limites



8. Annexe : Formats de sortie et limites127

Réglage de la 
fréquence de 
système
(Rec Format 
>Frequency dans 
le menu Project)

Réglage de codec
(Rec Format 
>Codec dans le 
menu Project)

Réglage du format 
d’enregistrement/
RAW
(Rec Format >RAW 
Output Format/Video 
Format dans le menu 
Project)

Format de sortie (Output Format 
dans le menu Monitoring)

SDI HDMI

50/59.94Hz XAVC-I
XAVC-L

1920×1080(Video) 1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level A)

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080P 
(Level B)

1920×1080i

1920×1080i 1920×1080i

(Sortie arrêtée) 720×480P1) 2)

720×576P1) 3)

25/29.97Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

3840×2160P

1920×1080P

1920×1080i

3840×2160(RAW) (3840×2160 RAW) 3840×2160P

1920×1080P

1920×1080i

RAW(HDMI)
RAW(HDMI) & 
XAVC-I

4240×2392(RAW) 1920×1080P (4240×2392 HDMI 
RAW)1920×1080PsF

XAVC-I
XAVC-L

4096×2160(Video) 4096×2160P1) 4096×2160P

4096×2160P 1920×1080P

3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

1920×1080PsF 1920×1080i

3840×2160(Video) 3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

1920×1080PsF 1920×1080i

1920×1080(Video) 1920×1080P 1920×1080P

1920×1080PsF 1920×1080i

Réglage de la 
fréquence de 
système
(Rec Format 
>Frequency dans 
le menu Project)

Réglage de codec
(Rec Format 
>Codec dans le 
menu Project)

Réglage du format 
d’enregistrement/
RAW
(Rec Format >RAW 
Output Format/Video 
Format dans le menu 
Project)

Format de sortie (Output Format 
dans le menu Monitoring)

SDI HDMI

23.98Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

3840×2160P

1920×1080P

3840×2160(RAW) (3840×2160 RAW) 3840×2160P

1920×1080P

RAW(HDMI)
RAW(HDMI) & 
XAVC-I

4240×2392(RAW) 1920×1080P (4240×2392 HDMI 
RAW)

XAVC-I
XAVC-L

4096×2160(Video) 4096×2160P1) 4096×2160P

4096×2160P 1920×1080P

3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

3840×2160(Video) 3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

1920×1080(Video) 1920×1080P 1920×1080P

24Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

1920×1080P

XAVC-I 4096×2160(Video) 4096×2160P1) 4096×2160P

1920×1080P 1920×1080P

1)	 L’affichage de l’écran ne peut pas être intégré.
2)	Lorsque la fréquence de système est de 59.94
3)	Lorsque la fréquence de système est de 50
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Alimentation

Symptôme Cause Solution

Le caméscope ne se met pas 
sous tension.

Le pack batterie n’est pas 
mis en place et aucune 
alimentation n’est fournie au 
connecteur DC IN.

Mettez en place un pack batterie 
(page 17) ou connectez-vous à une 
source d’alimentation CA à l’aide d’un 
adaptateur CA (page 18).

Le pack batterie est 
totalement déchargé.

Remplacez-le par un pack batterie 
totalement chargé (page 17).

L’alimentation est 
interrompue pendant le 
fonctionnement.

Le pack batterie se décharge. Remplacez-le par un pack batterie 
totalement chargé (page 17).

Le pack batterie se décharge 
très rapidement.

La température ambiante est 
très basse.

Cela est dû aux caractéristiques de la 
batterie et ne constitue pas une 
anomalie.

La charge du pack batterie 
est inadéquate.

Rechargez le pack batterie (page 17).
Si le pack batterie se décharge 
rapidement même après avoir été 
totalement chargé, il se peut que sa 
durée de vie en service touche à sa fin. 
Remplacez-le par un neuf.

Enregistrement/lecture

Symptôme Cause Solution

L’enregistrement ne démarre 
pas lorsque vous appuyez 
sur la touche 
d’enregistrement START/
STOP.

La carte mémoire est pleine. Remplacez la carte mémoire par une 
autre possédant suffisamment 
d’espace.

La carte mémoire nécessite 
une restauration.

Restaurez la carte mémoire 
(page 33).

L’enregistrement audio est 
impossible.

Les molettes AUDIO LEVEL 
(CH1/CH2) sont réglées sur le 
niveau minimal.

Ajustez les niveaux d’enregistrement 
audio avec les molettes AUDIO LEVEL 
(CH1/CH2) (page 47).

Le son enregistré est 
déformé.

Le niveau sonore est trop 
élevé.

Ajustez les niveaux d’enregistrement 
audio avec les molettes AUDIO LEVEL 
(CH1/CH2) (page 47).

Symptôme Cause Solution

L’enregistrement audio 
présente un niveau sonore 
élevé.

Le niveau sonore est trop 
bas.

Ajustez les niveaux d’enregistrement 
audio avec les molettes AUDIO LEVEL 
(CH1/CH2) (page 47).
Ajustez également le réglage INPUT 
MIC Reference sous Audio Input dans le 
menu Audio (page 101) lorsqu’un 
microphone externe est sélectionné.

Impossible de lire les plans. Le plan est en cours de 
modification.

La lecture des plans est impossible si 
vous avez modifié les noms de fichiers 
ou les dossiers ou si le plan est en cours 
d’utilisation sur un ordinateur. Il ne 
s’agit pas d’un dysfonctionnement.

Le plan est en cours 
d’enregistrement sur un 
autre appareil.

Il se peut que les plans enregistrés sur 
d’autres appareils soient illisibles ou 
s’affichent dans une taille incorrecte. Il 
ne s’agit pas d’un dysfonctionnement.

Dispositifs externes

Symptôme Solution

L’ordinateur ne reconnaît pas le 
caméscope.

Débranchez le câble USB de l’ordinateur, puis rebranchez-le 
correctement.

Débranchez le câble USB de l’ordinateur, redémarrez votre 
ordinateur, et suivez de nouveau les étapes dans le bon ordre.

Raccordez l’ordinateur et le caméscope en insérant un câble USB 
dans le connecteur USB-C ou dans le connecteur USB/Multi.

Le chargement de plans sur 
l’ordinateur est impossible.

Débranchez le câble USB de l’ordinateur, redémarrez le caméscope, 
puis rebranchez-le.

Il faut installer un logiciel d’application pour charger des plans sur 
votre ordinateur (page 123).

Dépannage
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Connexion LAN sans fil

[Remarque]
Les obstructions et les interférences électromagnétiques entre le caméscope et le point d’accès au réseau LAN 
sans fil ou le terminal, ou l’environnement ambiant (comme les matériaux muraux) pourraient raccourcir la plage 
de communication ou empêcher complètement les connexions. Si vous rencontrez ces problèmes, vérifiez l’état 
de la connexion/communication après avoir déplacé le caméscope vers un nouvel emplacement ou rapproché le 
caméscope et le point d’accès/terminal.

Symptôme Solution

Un terminal ne peut pas accéder 
au caméscope.

ˎˎ Vérifiez la connexion LAN sans fil (adresse IP, etc.).
ˎˎ Il se peut que le réglage de la communication entre le point 
d’accès et le client soit invalide. Pour plus de détails, consultez le 
mode d’emploi du point d’accès.

Vous ne pouvez pas vous 
connecter au caméscope.

Vérifiez le nom d’utilisateur et le mot de passe que vous avez 
définis.

Connexion Internet

Symptôme Solution

Échec de téléchargement du 
fichier.

Il se peut que le nom d’utilisateur et le mot de passe du serveur ne 
soient pas corrects.
Saisissez le nom d’utilisateur et le mot de passe corrects.

Le téléchargement du fichier 
n’est pas disponible.

Il se peut que l’état du signal soit mauvais.
Déplacez-vous vers un autre emplacement, et réessayez.

Lors de l’utilisation du filtre ND

Symptôme Solution

Le filtre ND ne se déplace pas. Vous pouvez positionner manuellement le filtre sur la position 
Clear à l’aide de la procédure suivante.

1	 Placez le commutateur POWER du caméscope en position off.

2	 Retirez le capuchon rond situé sur le côté inférieur.

3	 Insérez un tournevis dans l’orifice et tournez-le dans le sens contraire des aiguilles d’une 
montre.
ˎˎ Le filtre ND se place en position Clear lorsque vous tournez dans le sens contraire des 
aiguilles d’une montre. Continuez à tourner jusqu’à atteindre la position Clear.
ˎˎ Utilisez un tournevis de 2,4 mm de diamètre ou moins. La profondeur d’insertion du 
tournevis est d’environ 3,0 cm (1 3/16 po.).

Orifice de tournevis
(avec le capuchon retiré)

4	 Placez le commutateur ND PRESET/VARIABLE (page 5) en position PRESET et réglez les 
touches haut/bas ND FILTER POSITION (page 5) sur la position CLEAR.

[Remarques]
ˎˎ N’utilisez pas la procédure ci-dessus pendant le fonctionnement normal. Utilisez uniquement cette procédure 

si le filtre ND ne se déplace pas. Le filtre ND peut être endommagé si cette procédure est utilisée pendant le 
fonctionnement normal.
ˎˎ Après avoir utilisé la procédure ci-dessus, consultez un centre de service Sony pour faire réparer le caméscope.
ˎˎ Si un message d’erreur apparaît toujours après avoir utilisé la procédure ci-dessus, la prise de vue est toujours 

possible.
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Si le caméscope détecte un avertissement, une précaution ou une opération qui nécessite une 
confirmation, un message s’affiche dans le viseur, le témoin d’enregistrement/de signalisation 
commence à clignoter et un avertissement sonore est émis.
Le son d’avertissement est émis depuis les écouteurs connectés au connecteur pour casque.

Messages d’erreur

Le caméscope arrêtera l’opération si l’un des écrans suivants s’affiche.

Message du viseur Avertissement 
sonore

Témoin 
d’enregis-
trement/de 
signalisa-
tion

Cause et solution

E + code d’erreur Continu Clignotement 
rapide

Indique une anomalie dans le caméscope. 
L’enregistrement s’arrête, même lorsque REC est 
affiché dans le viseur.
Mettez le caméscope hors tension, et vérifiez si 
vous détectez un problème au niveau des 
dispositifs, des câbles ou du support raccordés. Si 
l’erreur persiste après avoir remis le caméscope 
sous tension, contactez votre technicien Sony.
(Si le caméscope ne peut pas être mis hors 
tension en réglant le commutateur POWER sur 
OFF, retirez la batterie ou débranchez 
l’alimentation DC IN.)
Il se peut qu’aucun affichage d’erreur ni aucune 
alerte sonore d’avertissement ne survienne selon 
l’état du caméscope.

Messages d’avertissement

Suivez les instructions fournies si l’écran suivant s’affiche.

Message du viseur Avertissement 
sonore

Témoin 
d’enregis-
trement/de 
signalisa-
tion

Cause et solution

Battery Near End Intermittent Clignotement La capacité restante du pack batterie est faible.
Rechargez-le dès que possible.

Battery End Continu Clignotement 
rapide

Le pack batterie est vide. L’enregistrement est 
désactivé.
Arrêtez les opérations et remplacez le pack 
batterie.

Temperature High Intermittent Clignotement La température interne est élevée.
Mettez le caméscope hors tension et laissez-le 
refroidir avant de le faire fonctionner à nouveau.

Message du viseur Avertissement 
sonore

Témoin 
d’enregis-
trement/de 
signalisa-
tion

Cause et solution

Media Temperature 
High

Intermittent Clignotement La température de la carte CFexpress est élevée.
Remplacez la carte ou et laissez-la refroidir avant 
de l’utiliser à nouveau.

Voltage Low Intermittent Clignotement La tension DC IN est faible (niveau 1). Vérifiez la 
source d’alimentation.

Insufficient Voltage Continu Clignotement 
rapide

La tension DC IN est trop faible (niveau 2). 
L’enregistrement est désactivé.
Raccordez une source d’alimentation différente.

Media Near Full Intermittent Clignotement La capacité restante de la carte mémoire est 
faible.
Remplacez-la dès que possible.

Media Full Continu Clignotement 
rapide

Les plans n’ont pas pu être enregistrés ni copiés 
car la capacité restante de la carte mémoire n’est 
pas suffisante.
Remplacez-la immédiatement.

Clips Near Full Intermittent Clignotement Le nombre de plans supplémentaires pouvant 
être enregistrés sur la carte mémoire diminue.
Remplacez-la dès que possible.

Clips Full Continu Clignotement 
rapide

Le nombre maximal de plans pouvant être 
enregistrés sur la carte mémoire a été atteint.
L’enregistrement ou la copie de plus de plans est 
impossible. Remplacez-la immédiatement.

Last Clip Recording Intermittent Clignotement Le plan en cours d’enregistrement est le dernier 
plan qui peut être enregistré, étant donné que le 
nombre maximum de plans a été atteint.
Préparez une nouvelle carte mémoire.

Media(A)1) Life Near 
End

Intermittent Clignotement La carte mémoire approche de la fin de sa durée 
de vie. Remplacez-la dès que possible.

Media(A)1) Life End Continu Clignotement 
rapide

La carte mémoire a atteint la fin de sa durée de 
vie. Remplacez-la immédiatement.

Media(A)1) Near Full Intermittent Clignotement Lorsque vous utilisez la fonction Simul Rec

Media(A)1) Full Continu Clignotement 
rapide

Lorsque vous utilisez la fonction Simul Rec

Media(A)1) Clips Near 
Full

Intermittent Clignotement Lorsque vous utilisez la fonction Simul Rec

Media(A)1) Clips Full Continu Clignotement 
rapide

Lorsque vous utilisez la fonction Simul Rec

Media(A) 1) Last Clip 
Rec

Intermittent Clignotement Lorsque vous utilisez la fonction Simul Rec

Transfer Jobs Near 
Full

– – Le nombre de tâches de transfert de fichiers FTP 
pouvant être enregistrées diminue.

Avertissements de fonctionnement
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Message du viseur Avertissement 
sonore

Témoin 
d’enregis-
trement/de 
signalisa-
tion

Cause et solution

Transfer Jobs Full – – Le nombre de tâches de transfert de fichiers FTP 
pouvant être enregistrées a atteint la limite 
supérieure. Pour ajouter une autre tâche, 
supprimez d’abord toute tâche non désirée.2)

1)	 « (B) » s’affiche pour la carte située dans le logement B.
2)	Vous pouvez sélectionner et supprimer des tâches à l’aide de File Transfer >View Job List (page 110) dans le 

menu Network du menu complet. Vous pouvez également supprimer des tâches depuis la liste de tâche CBM.

Messages de précaution concernant l’opération

Les messages de précaution et d’opération suivants peuvent apparaître au centre de 
l’écran. Suivez les instructions fournies pour résoudre le problème.

Message du viseur Cause et solution

Battery Error
Please Change Battery

Une erreur a été détectée au niveau du pack batterie.
Remplacez-le par un pack batterie normal.

Backup Battery End
Please Change

La capacité restante de la batterie de secours est insuffisante.
Rechargez la batterie de secours.

Unknown Media (A) 1)

Please Change
Une carte mémoire qui a été divisée en plusieurs parts ou une 
carte mémoire contenant plus de plans que ceux permis pour 
la manipulation du caméscope a été insérée.
La carte ne peut pas être utilisée dans le caméscope et doit 
être remplacée.

Cannot Use Media (A) 1)

Unsupported File System
Une carte utilisant un système de fichiers différent ou une 
carte non formatée a été insérée.
La carte ne peut pas être utilisée dans le caméscope et doit 
être remplacée ou formatée à l’aide du caméscope.

Media Error
Media (A) 1) Needs to be Restored

Une erreur s’est produite avec la carte mémoire et la carte doit 
être restaurée.
Restaurez la carte mémoire.

Media Error
Cannot Record to Media(A) 1)

La carte mémoire peut être endommagée et ne peut plus être 
utilisée pour l’enregistrement.
La lecture est possible, il est donc recommandé d’effectuer 
une copie et de remplacer la carte mémoire.

Media Error
Cannot Use Media (A) 1)

La carte mémoire peut être endommagée et ne peut plus être 
utilisée pour l’enregistrement ou la lecture.
La carte ne peut pas être utilisée dans le caméscope et doit 
être remplacée.

Media (A) 1) Error
Recording Halted
Playback Halted

L’enregistrement et la lecture se sont arrêtés parce qu’une 
erreur s’est produite pendant l’utilisation de la carte mémoire.
Si le problème persiste, remplacez la carte mémoire.

Media Reached Rewriting Limit
Change Media (A) 1)

La carte mémoire a atteint la fin de sa durée de vie.
Effectuez une copie de sauvegarde et remplacez la carte 
immédiatement. Si vous continuez à utiliser la carte, la carte 
risque de ne plus pouvoir enregistrer ou lire.
Pour plus de détails, reportez-vous au mode d’emploi de la 
carte mémoire.

The specified address is invalid. L’adresse spécifiée est invalide.
Vérifiez que le réglage est correct.

Cannot Use Specified Port Number Le numéro de port spécifié est invalide.
Vérifiez que le réglage est correct.
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Message du viseur Cause et solution

Fan Stopped Le ventilateur intégré s’est arrêté.
Evitez l’utilisation à des températures élevées, débranchez 
l’alimentation et prenez contact avec votre technicien Sony.

LENS Error Une erreur d’objectif a été détectée dans la communication 
I/F de l’objectif lors de la fixation d’un objectif à monture E.
Vérifiez l’état du raccordement à l’objectif à monture E.

This Multi Term. acc is not supported 
by the device and cannot be used.
Please verify the compatibility.

Un accessoire incompatible a été détecté.
Le seul accessoire à terminaux multiples compatible avec 
l’unité est la télécommande de grip fournie.

Failed Cette erreur peut apparaître si une adresse ne peut pas être 
obtenue avec DHCP réglé sur On.
Vérifiez les réglages du serveur DHCP.

Addition of auto upload job failed. Le nombre maximum de tâches de transfert a été atteint.
Effacez toute tâche non désirée. Il est possible que le réglage 
de destination de téléchargement automatique pour les 
fichiers originaux ou proxy soit également incorrect. Vérifiez 
que le réglage est correct.

<SSID>Not found. Le réseau (point d’accès) avec le <SSID> spécifié est 
introuvable.
Vérifiez que le réglage est correct.

<SSID>Authentication Failed L’authentification de connexion sur le réseau (point d’accès) 
avec le <SSID> spécifié a échoué.
Vérifiez que le mot de passe et les autres réglages sont 
corrects.

An IP address conflict has occurred. 
Please check the network settings.

Il y a un conflit entre les adresses réseau du LAN sans fil, du 
LAN filaire ou du raccordement modem USB.
Changez l’adresse manuellement ou changez les réglages du 
routeur réseau.

The IP address of the Wireless LAN 
Access Point Mode has been 
changed due to an IP address 
conflict.

L’adresse IP du mode de point d’accès de LAN sans fil a été 
modifiée en raison d’un conflit entre les adresses réseau du 
mode de point d’accès de LAN sans fil, du LAN filaire ou du 
raccordement modem USB.
Vérifiez le réglage de l’adresse IP.

1)	 « (B) » s’affiche pour la carte située dans le logement B.
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Éléments configurés dans le menu complet

Oui : L’élément est enregistré.
Non : L’élément n’est pas enregistré.
– : non enregistré (réglage temporaire)

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting ISO/Gain/EI Mode Oui Non 

ISO/Gain<H> Oui Non 

ISO/Gain<M> Oui Non 

ISO/Gain<L> Oui Non 

Exposure Index<H> Oui Non 

Exposure Index<M> Oui Non 

Exposure Index<L> Oui Non 

Shockless Gain Oui Non 

Base Sensitivity Oui Non 

Base ISO Oui Non 

ND Filter Preset1 Oui Non 

Preset2 Oui Non 

Preset3 Oui Non 

Shutter Mode Oui Non 

Shutter Speed On/Off Oui Non 

Shutter Speed Oui Non 

Shutter Angle Oui Non 

ECS On/Off Oui Non 

ECS Frequency Oui Non 

Iris Bokeh Control Non Non

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Auto Exposure Level Oui Non 

Mode Oui Non 

Speed Oui Non 

AGC Oui Non 

AGC Limit Oui Non 

AGC Point Oui Non 

Auto Shutter Oui Non 

A.SHT Limit Oui Non 

A.SHT Point Oui Non 

Clip High light Oui Non

Detect Window Oui Non

Detect Window Indication Oui Non 

Custom Width Oui Non

Custom Height Oui Non

Custom H Position Oui Non

Custom V Position Oui Non

White Preset White Oui Non

Color Temp <A> Oui Non 

Tint<A> Oui Non 

R Gain <A> Oui Non 

B Gain <A> Oui Non 

Color Temp <B> Oui Non 

Tint<B> Oui Non 

R Gain <B> Oui Non 

B Gain <B> Oui Non 

White Setting Shockless White Oui Non

ATW Speed Oui Non

White Switch<B> Oui Non 

Filter White Memory Oui Non

Eléments enregistrés dans les fichiers
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Offset White Offset White <A> Oui Non

Offset Color Temp<A> Oui Non

Offset Tint<A> Oui Non

Offset White <B> Oui Non

Offset Color Temp<B> Oui Non

Offset Tint<B> Oui Non

Offset White<ATW> Oui Non

Offset Color Temp<ATW> Oui Non

Offset Tint<ATW> Oui Non

Focus AF Transition Speed Oui Non

AF Subj. Shift Sens. Oui Non

Focus Area Oui Non

Focus Area (AF-S) Oui Non

Face/Eye Detection AF Oui Non

Push AF Mode Oui Non

Touch Function in MF Oui Non

AF Assist Oui Non

S&Q Motion Setting Oui Non

Frame Rate Oui Non

LUT On/Off SDI/HDMI Oui Non

VF/Proxy/Stream Oui Non

Internal Rec Oui Non

Noise Suppression Setting(Custom) Oui Non 

Level(Custom) Oui Non 

Setting (Cine EI/Flex. ISO) Oui –

Level (Cine EI/Flex. ISO) Oui –

Flicker Reduce Mode Oui Non

Frequency Oui Non

SteadyShot Setting Oui Non

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project Base Setting Shooting Mode Oui –

Target Display Oui –

Rec Format Frequency Oui Non

Imager Scan Mode Oui Non

Codec Oui Non

RAW Output Format Oui Non

Video Format Oui Non

Cine EI/Flex.ISO Set Color Gamut Oui –

Embed LUT File Oui Non

HDR Setting VF SDR Preview Oui Non

SDR Gain Oui Non

Simul Rec Setting Oui Non

Rec Button Set Oui Non

Proxy Rec Setting Oui Non

Audio Channel Oui Non

Chunk Oui Non

Interval Rec Setting Non Non

Interval Time Oui Non

Number of Frames Oui Non

Pre-Lighting Oui Non

Picture Cache Rec Setting Oui Non

Cache Size Oui Non

Cache Rec Time – –

SDI/HDMI Rec Control Setting Oui Non

Assignable Button <1> Oui Non

<2> Oui Non

<3> Oui Non

<4> Oui Non

<5> Oui Non

<6> Oui Non

<7> Oui Non

<8> Oui Non

<9> Oui Non

Focus Hold Button Oui Non

Assignable Dial Grip/Remote Dial Oui Non

Grip Dial Direction Oui Non

Handle Dial Oui Non

Handle Dial Direction Oui Non

Multi Function Dial Default Function Oui Non
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project User File Load from Media(B) – –

Save to Media(B) – –

File ID Non Non

Load Customize Data Oui Non

Load White Data Oui Non

All File Load from Media(B) – –

Load from Cloud(Private) – –

Load from Cloud(Share) – –

Save to Media(B) – –

Save to Cloud(Private) – –

Save to Cloud(Share) – –

File ID Oui Non

Load Network Data Non Non

Paint/Look Scene File Recall – –

Store – –

Delete – –

Preset Recall – –

Base Look Select Oui Oui

Delete – –

Delete All – –

Import from Media(B) – –

Import from Cloud(Private) – –

Import from Cloud(Share) – –

Input Oui Oui

Output Oui Oui

AE Level Offset Oui Oui

Reset Paint Settings Reset without Base Look – –

Black Master Black Oui Oui

R Black Oui Oui

B Black Oui Oui

Knee Setting Oui Oui

Auto Knee Oui Oui

Point Oui Oui

Slope Oui Oui

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint/Look Detail Setting Oui Oui

Level Oui Oui

Manual Setting Oui Oui

V/H Balance Oui Oui

B/W Balance Oui Oui

Limit Oui Oui

Crispening Oui Oui

High Light Detail Oui Oui

Matrix User Matrix Oui Oui

User Matrix Level Oui Oui

User Matrix Phase Oui Oui

User Matrix R-G Oui Oui

User Matrix R-B Oui Oui

User Matrix G-R Oui Oui

User Matrix G-B Oui Oui

User Matrix B-R Oui Oui

User Matrix B-G Oui Oui

Multi Matrix Setting Oui Oui

Reset – –

Axis Non Oui

Hue Oui Oui

Saturation Oui Oui

TC/Media Timecode Mode Oui Non

Run Oui Non

Setting Non Non

Reset – –

TC Format Oui Non

TC Display Display Select Oui Non

Users Bit Mode Oui Non

Setting Non Non

HDMI TC Out Setting Oui Non

Clip Name Format Auto Naming Oui Non

Camera ID Non Non

Reel Number Non Non

Camera Position Non Non

Title Prefix Oui Non

Number Set Non Non
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

TC/Media Update Media Media(A) – –

Media(B) – –

Format Media Media(A) – –

Media(B) – –

Monitoring Output On/Off SDI Oui Non

HDMI Oui Non

Output Format SDI Oui Non

HDMI Oui Non

De-Squeeze Ratio (HDMI/VF) Oui Non

Output Display SDI Oui Non

HDMI Oui Non

Display On/Off Network Status Oui Non

File Transfer Status Oui Non

Rec/Play Status Oui Non

RAW Output Control Status Oui Non

Tally Oui Non

Battery Remain Oui Non

Focus Mode Oui Non

Focus Position Oui Non

Focus Area Indicator Oui Non

Focus Area Ind.(AF-S) Oui Non

Face/Eye Detection Frame Oui Non

Lens Info Oui Non

Imager Scan Mode Oui Non

Rec Format Oui Non

Frame Rate Oui Non

Zoom Position Oui Non

UWP RF Level Oui Non

SteadyShot Oui Non

Base Look/Rec Look Oui Non

SDI/HDMI Rec Control Oui Non

Monitoring Look Oui Non

Proxy Status Oui Non

Base ISO/Sensitivity Oui Non

Media Status Oui Non

Video Signal Monitor Oui Non

Clip Name Oui Non

White Balance Oui Non

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off Scene File Oui Non

Focus Indicator Oui Non

Auto Exposure Mode Oui Non

Auto Exposure Level Oui Non

Timecode Oui Non

ND Filter Oui Non

Iris Oui Non

ISO/Gain/EI Oui Non

Shutter Oui Non

Level Gauge Oui Non

Audio Level Meter Oui Non

Video Level Warning Oui Non

Clip Number Oui Non

Notice Message Oui Non

Marker Setting Oui Non

Color Oui Non

Center Marker Oui Non

Safety Zone Oui Non

Safety Area Oui Non

Aspect Marker Oui Non

Aspect Mask Oui Non

Aspect Safety Zone Oui Non

Aspect Safety Area Oui Non

Aspect Select Oui Non

Custom Aspect Ratio Oui Non

Guide Frame Oui Non

100% Marker Oui Non

User Box Oui Non

User Box Width Oui Non

User Box Height Oui Non

User Box H Position Oui Non

User Box V Position Oui Non

VF Setting Brightness Oui Non

Color Mode Oui Non

Gamma Display Assist Setting Oui Non

Peaking Setting Oui Non

Peaking Level Oui Non

Color Oui Non
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Zebra Setting Oui Non

Zebra1 Level Oui Non

Zebra1 Aperture Level Oui Non

Zebra2 Level Oui Non

Audio Audio Input CH1 Input Select Oui Non

CH2 Input Select Oui Non

CH3 Input Select Oui Non

CH4 Input Select Oui Non

INPUT1 MIC Reference Oui Non

INPUT2 MIC Reference Oui Non

Line Input Reference Oui Non

Reference Level Oui Non

CH1 Wind Filter Oui Non

CH2 Wind Filter Oui Non

CH3 Wind Filter Oui Non

CH4 Wind Filter Oui Non

CH3 Level Control Oui Non

CH4 Level Control Oui Non

CH3 Input Level Oui Non

CH4 Input Level Oui Non

Audio Input Level Oui Non

Limiter Mode Oui Non

CH1&2 AGC Mode Oui Non

CH3&4 AGC Mode Oui Non

AGC Spec Oui Non

1kHz Tone on Color Bars Oui Non

CH1 Level Oui Non

CH2 Level Oui Non

CH3 Level Oui Non

CH4 Level Oui Non

Audio Output Monitor CH Oui Non

Volume Non Non

Headphone Out Oui Non

Alarm Level Oui Non

HDMI Output CH Oui Non

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Thumbnail Display Clip Properties – –

Set Clip Flag Add OK – –

Add NG – –

Add KEEP – –

Delete Clip Flag – –

Lock/Unlock Clip Select Clip – –

Lock All Clips – –

Unlock All Clips – –

Delete Clip Select Clip – –

All Clips – –

Transfer Clip Select Clip – –

All Clips – –

Transfer Clip (Proxy) Select Clip – –

All Clips – –

Filter Clips OK – –

NG – –

KEEP – –

None – –

All – –

Customize View Thumbnail Caption Oui –

Technical Color Bars Setting Non Non

Type Oui Non

ND Dial CLEAR with Dial Oui Non

Tally Front Oui Non

Rear Oui Non

HOLD Switch Setting with Rec Button Oui Non

with Hand Grip Remote Oui Non

Handle HOLD Switch Oui Non

Touch Operation Setting Oui Non

Rec Review Setting Oui Non

Zoom Zoom Type Oui Non

Handle Zoom Setting Oui Non

High Oui Non

Low Oui Non

Menu Settings User Menu Only Oui Non

User Menu with Lock Non Non
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Menu Page On/Off Main Oui Non

Camera Oui Non

Audio Oui Non

Project Oui Non

Monitoring Oui Non

Assignable Button Oui Non

Battery Oui Non

Media Oui Non

Network Oui Non

File Transfer Oui Non

Fan Control Setting Oui Non

Lens Zoom Ring Direction Oui Non

Shading Compensation Oui Non

Chroma Aberration Comp. Oui Non

Distortion Comp. Oui Non

Breathing Compensation Oui Non

Distance Display Oui Non

Zoom Position Display Oui Non

Video Light Set Video Light Set Oui Non

APR APR – –

Camera Battery Alarm Low Battery Oui Non

Battery Empty Oui Non

Camera DC IN Alarm DC Low Voltage1 Oui Non

DC Low Voltage2 Oui Non

Network Setup for Mobile App Setup – –

Access Authentication User Name Non Non

Input Password Non Non

Generate Password – –

Show Settings – –

Wireless LAN Setting Oui Non

WPS – –

NFC – –

MAC Address – –

AP Mode Settings Channel Oui Non

Camera SSID & Password – –

Regenerate Password – –

IP Address – –

Subnet Mask – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network ST Mode Settings Camera Remote Control Oui Non

Connected Network

SSID – –

Security – –

Password – –

DHCP – –

IP Address – –

Subnet Mask – –

Gateway – –

DNS Auto – –

Primary DNS Server – –

Secondary DNS Server – –

Scan Networks

SSID – –

Security – –

Password Non Non

DHCP Oui Non

IP Address Oui Non

Subnet Mask Oui Non

Gateway Oui Non

DNS Auto Oui Non

Primary DNS Server Oui Non

Secondary DNS Server Oui Non

Manual Register

SSID Oui Non

Security Oui Non

Password Non Non

DHCP Oui Non

IP Address Oui Non

Subnet Mask Oui Non

Gateway Oui Non

DNS Auto Oui Non

Primary DNS Server Oui Non

Secondary DNS Server Oui Non
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network Wired LAN Setting Oui Non

Camera Remote Control Oui Non

Detail Settings

DHCP Oui Non

IP Address Oui Non

Subnet Mask Oui Non

Gateway Oui Non

DNS Auto Oui Non

Primary DNS Server Oui Non

Secondary DNS Server Oui Non

Modem Setting Oui Non

Camera Remote Control Oui Non

Device Name – –

IP Address – –

Subnet Mask – –

File Transfer Auto Upload Oui Non

Auto Upload (Proxy) Oui Non

Default Upload Server Oui Non

Clear Completed Jobs – –

Clear All Jobs – –

View Job List – –

Server Settings1/Server Settings2/Server Settings3

Display Name Oui Non

Service Oui Non

Host Name Oui Non

Port Oui Non

User Name Non Non

Password Non Non

Passive Mode Oui Non

Destination Directory Oui Non

Using Secure Protocol Oui Non

Root Certificate – –

Root Certificate Status – –

Reset – –

Network Reset Reset – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Maintenance Language Select Oui Non

Clock Set Time Zone Oui Non

Date Mode Oui Non

12h/24h Oui Non

Date Non Non

Time Non Non

All Reset Reset – –

Reset without Network – –

Hours Meter Hours(System) – –

Hours(Reset) – –

Reset – –

Version Version Number – –

Version Up – –

Lens Version Number – –
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Éléments configurés avec les touches personnalisables

Oui : L’élément est enregistré.
Non : L’élément n’est pas enregistré.
– : non enregistré (réglage temporaire)

Sélection de la touche personnalisable All File Scene File

ND Filter Position Oui Non

Auto Iris Oui Non

ATW Oui Non

Focus Setting Oui Non

Display Oui –

VF Adjust Oui –

Éléments configurés avec la molette personnalisable

Oui : L’élément est enregistré.
Non : L’élément n’est pas enregistré.
– : non enregistré (réglage temporaire)

Sélection de la molette 
personnalisable

All File Scene File

IRIS Oui Non

ND Filter Oui Non

Audio Input Level Oui Non
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Consultez les éléments associés dans « Réglage de l’audio à enregistrer » (page 47) et « Menu User » (page 76).

Audio Input (CH1&CH2)

Le schéma suivant montre le bloc-diagramme avec la poignée attachée.

INPUT1

L

R

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

CH1

[CH1 Input Select]
INPUT1
Internal MIC
Shoe CH1

[CH2 Input Select]
INPUT1
INPUT2
Internal MIC
Shoe CH2

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

<CH1 LEVEL
   CONTROL>*
AUTO
MAN

<CH1 INPUT LEVEL>
0 ~ 10

[CH1 Wind Filter]
On
O�

[CH2 Wind Filter]
On
O�

CH2

<CH2 LEVEL
   CONTROL>*
AUTO
MAN

<CH2 INPUT LEVEL>
0 ~ 10

[CH1&2 AGC Mode]
Mono
Stereo [Color Bars]

[1kHz Tone on Color
Bars]
On
O�

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,

-9dB, -12dB,
-15dB, -17dB SG

[CH1 Level]
Audio Input Level
Side
Level + Side
Through

[CH2 Level]
Audio Input Level
Side
Level + Side
Through

*	 Réglez sur Manual lorsque l’audio est entré par l’adaptateur XLR.

Diagrammes bloc
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Audio Input (CH3&CH4)

Le schéma suivant montre le bloc-diagramme avec la poignée attachée.

L

R

CH3

[CH3 Level
 Control]*
Auto
Manual

[CH4 Level
 Control]*
Auto
Manual

[CH3 Input Level]
0 ~ 99

CH4

[CH4 Input Level]
0 ~ 99

[CH3&4 AGC Mode]
Mono
Stereo

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,
-9dB, -12dB,
-15dB, -17dB SG

OFF

[CH3 Input Select]
O�
INPUT1
Internal MIC
Shoe CH1

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

[CH3 Wind Filter]
On
O�

[CH4 Wind Filter]
On
O�

[CH4 Input Select]
O�
INPUT1
INPUT2
Internal MIC
Shoe CH2

INPUT1

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

[CH3 Level]
Audio Input Level
CH3 Input Level
Level+CH3 Input Level
Through

[CH4 Level]
Audio Input Level
CH4 Input Level
Level+CH4 Input Level
Through

[Color Bars]
[1kHz Tone on Color
Bars]
On
O�

 
*	 Réglez sur Manual lorsque l’audio est entré par l’adaptateur XLR.
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Audio Output

L

R

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

[VOLUME]
0 ～ 50

[Alarm Level]
0 ～ 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

CH2

CH3

CH4



8. Annexe144

Vous pouvez mettre à jour le logiciel d’un 
objectif à monture E en utilisant le caméscope.
Consultez le site Web pour connaître les 
objectifs qui peuvent être mis à jour, ainsi que 
le logiciel correspondant.

Vérification de la version

1	 Fixez un objectif à monture E sur le 
caméscope (page 22).

2	 Sélectionnez Version dans le menu 
Maintenance du menu complet pour 
afficher Lens Version Number 
(page 111).
Le numéro de version du logiciel de 
l’objectif à monture E est affiché sur le 
côté.

Mise à jour du logiciel

Réglez le caméscope sur le mode de stockage 
de masse (page 123).
Actualisez le logiciel en appliquant la 
procédure fournie avec le logiciel de l’objectif.

Mise à jour du logiciel de l’objectif à monture E
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Licence MPEG-4 AVC Patent 
Portfolio

CE PRODUIT EST SOUS LICENCE AVC 
PATENT PORTFOLIO POUR L’UTILISATION 
PERSONNELLE DU CONSOMMATEUR OU TOUT 
AUTRE UTILISATION N’IMPLIQUANT PAS DE 
REMUNERATION
(i)	 ENCODAGE VIDEO EN CONFORMITÉ AVEC LE 

STANDARD AVC (« AVC VIDEO ») ET/OU
(ii)	DÉCODAGE VIDEO AVC ENCODÉ PAR UN 

CONSOMMATEUR ENGAGÉ DANS UNE 
ACTIVITÉ PERSONNELLE ET/OU OBTENU 
D’UN FOURNISSEUR VIDEO AYANT LA 
LICENCE DE DISTRIBUTION AVC VIDEO.

AUCUNE LICENCE N’EST ATTRIBUEE OU 
NE DOIT ETRE DESTINEE POUR TOUT 
AUTRE USAGE. DES INFORMATIONS 
SUPPLEMENTAIRES PEUVENT ETRE OBTENUES 
DE MPEG LA, L.L.C. VOIR  
HTTP://WWW.MPEGLA.COM

Obtention d’un logiciel sous 
licence GPL/LGPL

Ce produit utilise le logiciel auquel s’applique 
la licence GPL/LGPL. Ceci vous informe 
que vous disposez d’un droit d’accès, de 
modification et de redistribution du code 
source de ces logiciels dans les conditions de 
la GPL/LGPL.
Le code source est disponible sur Internet. 
Reportez-vous à l’adresse URL suivante et 
suivez les instructions de téléchargement.
https://oss.sony.net/Products/Linux/

Nous préférerions que vous ne nous 
contactiez pas au sujet du contenu du code 
source.

Les licences (en anglais) sont enregistrées 
dans la mémoire interne de votre produit.
Établissez une connexion de stockage de 
masse entre le produit et un ordinateur pour 
lire les licences du dossier « PMHOME » - 
« LICENSE ».

Si vous utilisez un Mac, le dossier « PMHOME »  
- « LICENCE » peut ne pas être accessible.
Pour visualiser les fichiers, utilisez un 
ordinateur autre qu’un Mac ou visitez l’URL 
suivante.
https://oss.sony.net/License/ILME-FX6/

CONTRAT DE LICENCE 
D’UTILISATEUR FINAL

IMPORTANT: 
BEFORE USING THE SOFTWARE CONTAINED IN THE 
SOLID STATE MEMORY CAMCORDER, PLEASE READ THIS 
END USER LICENSE AGREEMENT (“EULA”) CAREFULLY. BY 
USING THE SOFTWARE YOU ARE ACCEPTING THE TERMS 
OF THIS EULA. IF YOU DO NOT ACCEPT THE TERMS OF 
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and Sony 
Corporation (“SONY”). This EULA governs your rights 
and obligations regarding the software of SONY and/or 
its third party licensors (including SONY’s affiliates) and 
their respective affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”) contained in the wireless adapter, together 
with any updates/ upgrades provided by SONY, any 
printed, on-line or other electronic documentation for 
such software, and any data files created by operation of 
such software (collectively, the “SOFTWARE”).

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user license 

agreement (including, but not limited to, GNU General 
Public license and Lesser/Library General Public License) 
shall be covered by such applicable separate end user 
license agreement in lieu of the terms of this EULA to 
the extent required by such separate end user license 
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The SOFTWARE is 
protected by copyright and other intellectual property 
laws and international treaties.

COPYRIGHT
All right and title in and to the SOFTWARE (including, 
but not limited to, any images, photographs, animation, 
video, audio, music, text and “applets” incorporated into 
the SOFTWARE) is owned by SONY or one or more of the 
THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the SOFTWARE 
solely in connection with the wireless adapter and only 
for your individual use. SONY and the THIRD-PARTY 
SUPPLIERS expressly reserve all rights, title and interest 
(including, but not limited to, all intellectual property 
rights) in and to the SOFTWARE that this EULA does not 
specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, attempt 
to derive source code, modify, reverse engineer, 
decompile, or disassemble any of the SOFTWARE, 
whether in whole or in part, or create any derivative 
works from or of the SOFTWARE unless such derivative 
works are intentionally facilitated by the SOFTWARE. 
You may not modify or tamper with any digital rights 
management functionality of the SOFTWARE. You 
may not bypass, modify, defeat or circumvent any of 
the functions or protections of the SOFTWARE or any 
mechanisms operatively linked to the SOFTWARE. You 
may not separate any individual component of the 
SOFTWARE for use on more than one wireless adapter 
unless expressly authorized to do so by SONY. You 
may not remove, alter, cover or deface any trademarks 
or notices on the SOFTWARE. You may not share, 
distribute, rent, lease, sublicense, assign, transfer or 
sell the SOFTWARE. The software, network services 

or other products other than SOFTWARE upon which 
the SOFTWARE’S performance depends might be 
interrupted or discontinued at the discretion of the 
suppliers (software suppliers, service suppliers, or 
SONY). SONY and such suppliers do not warrant that the 
SOFTWARE, network services, contents or other products 
will continue to be available, or will operate without 
interruption or modification. 

EXCLUDED SOFTWARE AND OPEN SOURCE 
COMPONENTS
Notwithstanding the foregoing limited license grant, 
you acknowledge that the SOFTWARE may include 
EXCLUDED SOFTWARE. Certain EXCLUDED SOFTWARE 
may be covered by open source software licenses 
(“Open Source Components”), which means any 
software licenses approved as open source licenses by 
the Open Source Initiative or any substantially similar 
licenses, including but not limited to any license that, 
as a condition of distribution of the software licensed 
under such license, requires that the distributor make 
the software available in source code format. If and to 
the extent disclosure is required, please visit www.sony.
com/linux or other SONY-designated web site for a list 
of applicable OPEN SOURCE COMPONENTS included in 
the SOFTWARE from time to time, and the applicable 
terms and conditions governing its use. Such terms 
and conditions may be changed by the applicable 
third party at any time without liability to you. To the 
extent required by the licenses covering EXCLUDED 
SOFTWARE, the terms of such licenses will apply in lieu 
of the terms of this EULA. To the extent the terms of the 
licenses applicable to EXCLUDED SOFTWARE prohibit 
any of the restrictions in this EULA with respect to such 
EXCLUDED SOFTWARE, such restrictions will not apply 
to such EXCLUDED SOFTWARE. To the extent the terms 
of the licenses applicable to Open Source Components 
require SONY to make an offer to provide source code 
in connection with the SOFTWARE, such offer is hereby 
made. 

Licences

https://oss.sony.net/Products/Linux/
https://oss.sony.net/License/ILME-FX6/
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USE OF SOFTWARE WITH COPYRIGHTED 
MATERIALS
The SOFTWARE may be capable of being used by you 
to view, store, process and/or use content created by 
you and/or third parties. Such content may be protected 
by copyright, other intellectual property laws, and/
or agreements. You agree to use the SOFTWARE only 
in compliance with all such laws and agreements that 
apply to such content. You acknowledge and agree 
that SONY may take appropriate measures to protect 
the copyright of content stored, processed or used by 
the SOFTWARE. Such measures include, but are not 
limited to, counting the frequency of your backup and 
restoration through certain SOFTWARE features, refusal 
to accept your request to enable restoration of data, and 
termination of this EULA in the event of your illegitimate 
use of the SOFTWARE. 

CONTENT SERVICE 
PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE 
DESIGNED TO BE USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT SERVICES 
(“CONTENT SERVICE”). USE OF THE SERVICE AND THAT 
CONTENT IS SUBJECT TO THE TERMS OF SERVICE OF 
THAT CONTENT SERVICE. IF YOU DECLINE TO ACCEPT 
THOSE TERMS, YOUR USE OF THE SOFTWARE WILL 
BE LIMITED. You acknowledge and agree that certain 
content and services available through the SOFTWARE 
may be provided by third parties over which SONY has 
no control. USE OF THE CONTENT SERVICE REQUIRES AN 
INTERNET CONNECTION. THE CONTENT SERVICE MAY BE 
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY 
SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet connection 
for which you are solely responsible. Further, you are 
solely responsible for payment of any third party fees 
associated with your Internet connection, including 
but not limited to Internet service provider or airtime 
charges. Operation of the SOFTWARE may be limited 
or restricted depending on the capabilities, bandwidth 
or technical limitations of your Internet connection 
and service. The provision, quality and security of such 
Internet connectivity are the sole responsibility of the 
third party providing such service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export and re-
export restrictions and regulations of the area or country 
in which you reside, and not to transfer, or authorize 
the transfer, of the SOFTWARE to a prohibited country 
or otherwise in violation of any such restrictions or 
regulations.

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not designed, 
manufactured or intended for use or resale as on-
line control equipment in hazardous environments 
requiring fail-safe performance, such as in the 
operation of nuclear facilities, aircraft navigation or 
communication systems, air traffic control, direct life 
support machines, or weapons systems, in which the 
failure of the SOFTWARE could lead to death, personal 
injury, or severe physical or environmental damage 
(“HIGH RISK ACTIVITIES”). SONY, each of the THIRD-
PARTY SUPPLIERS, and each of their respective affiliates 
specifically disclaim any express or implied warranty, 
duty or condition of fitness for HIGH RISK ACTIVITIES.

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the SOFTWARE 
is at your sole risk and that you are responsible for use 
of the SOFTWARE. The SOFTWARE is provided “AS IS,” 
without warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) EXPRESSLY DISCLAIM ALL WARRANTIES, DUTIES 
OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY, NONINFRINGEMENT AND 
FITNESS FOR A PARTICULAR PURPOSE. SONY 
DOES NOT WARRANT OR MAKE ANY CONDITIONS 
OR REPRESENTATIONS (A) THAT THE FUNCTIONS 
CONTAINED IN ANY OF THE SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE UPDATED, (B) 
THAT THE OPERATION OF ANY OF THE SOFTWARE WILL 
BE CORRECT OR ERROR-FREE OR THAT ANY DEFECTS 
WILL BE CORRECTED, (C) THAT THE SOFTWARE WILL 
NOT DAMAGE ANY OTHER SOFTWARE, HARDWARE OR 
DATA, (D) THAT ANY SOFTWARE, NETWORK SERVICES 
(INCLUDING THE INTERNET) OR PRODUCTS (OTHER 

THAN THE SOFTWARE) UPON WHICH THE SOFTWARE’S 
PERFORMANCE DEPENDS WILL CONTINUE TO BE 
AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND 
(E) REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, OR OTHERWISE. 

NO ORAL OR WRITTEN INFORMATION OR ADVICE 
GIVEN BY SONY OR AN AUTHORIZED REPRESENTATIVE 
OF SONY SHALL CREATE A WARRANTY, DUTY OR 
CONDITION OR IN ANY WAY INCREASE THE SCOPE OF 
THIS WARRANTY. SHOULD THE SOFTWARE PROVE 
DEFECTIVE YOU ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION. SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES, SO THESE EXCLUSIONS MAY NOT 
APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) SHALL NOT BE LIABLE FOR ANY INCIDENTAL 
OR CONSEQUENTIAL DAMAGES FOR BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, BREACH OF 
CONTRACT, NEGLIGENCE, STRICT LIABILITY OR UNDER 
ANY OTHER LEGAL THEORY RELATED TO THE SOFTWARE, 
INCLUDING, BUT NOT LIMITED TO, ANY DAMAGES 
ARISING OUT OF LOSS OF PROFITS, LOSS OF REVENUE, 
LOSS OF DATA, LOSS OF USE OF THE SOFTWARE OR 
ANY ASSOCIATED HARDWARE, DOWN TIME AND USER'S 
TIME, EVEN IF ANY OF THEM HAVE BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, 
EACH AND ALL OF THEIR AGGREGATE LIABILITY UNDER 
ANY PROVISION OF THIS EULA SHALL BE LIMITED TO 
THE AMOUNT ACTUALLY PAID FOR THE PRODUCT. 
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION 
OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE EXCLUSION OR LIMITATION 
MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA 
SECURITY
You acknowledge and agree that SONY and its 
affiliates, partners and agents may read, collect, 
transfer, process and store certain information 

collected from the SOFTWARE, including but not 
limited to information about (i) the SOFTWARE and 
(ii) the software applications, contents and peripheral 
devices that interact with your wireless adapter and the 
SOFTWARE (“Information”). Information includes, but 
is not limited to: (1) unique identifiers relating to your 
wireless adapter and its components; (2) performance 
of the wireless adapter, the SOFTWARE and their 
components; (3) configurations of your wireless adapter, 
the SOFTWARE and the software applications, contents 
and peripheral devices that interact with the wireless 
adapter and the SOFTWARE; (4) use and frequency of 
use of the functions of (x) the SOFTWARE, and (y) the 
software applications, contents and peripheral devices 
that interact with the SOFTWARE; and (5) location data, 
as indicated below. SONY and its affiliates, partners 
and agents may use and disclose Information subject 
to applicable laws in order to improve its products and 
services or to provide products or services to you. Such 
uses include, but are not limited to: (a) administering 
the functionalities of the SOFTWARE; (b) to improve, 
service, update or upgrade the SOFTWARE; (c) 
improving, developing and enhancing the current and 
future products and services of SONY and other parties; 
(d) to provide you with information about the products 
and services offered by SONY and other parties; (e) 
complying with applicable laws or regulations; and (f) 
to the extent offered, providing you with location-based 
services of SONY and other parties, as indicated below. 
In addition, SONY retains the right to use Information 
to protect itself and third parties from illegal, criminal or 
harmful conduct.

Certain services available through the SOFTWARE may 
rely upon location information, including, but not limited 
to, the geographic location of the wireless adapter. You 
acknowledge that for the purpose of providing such 
services, SONY, the THIRDPARTY SUPPLIERS or their 
partners may collect, archive, process and use such 
location data, and that such services are governed by 
the privacy policies of SONY or such third party. By 
reviewed the privacy policies applicable to such services 
and consent to such activities. 
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SONY, its affiliates, partners and agents will not 
intentionally use Information to personally identify 
the owner or user of the SOFTWARE without your 
knowledge or consent. Any use of Information will be 
in accordance with the privacy policies of SONY or such 
third party. 
Please contact applicable contact address of each area or 
country for SONY’s current privacy policy. Please contact 
applicable third parties for privacy policies relating 
to personally identifiable and other information you 
provide when you use or access third party software or 
services. 

Information may be processed, stored or transferred 
to SONY, its affiliates or agents which are located in 
countries outside of your country of residence. Data 
protection and information privacy laws in certain 
countries may not offer the same level of protection 
as your country of residence and you may have fewer 
legal rights in relation to Information processed and 
stored in, or transferred to, such countries. SONY will 
use reasonable efforts to take appropriate technical and 
organizational steps to prevent unauthorized access to 
or disclosure of Information, but does not warrant it will 
eliminate all risk of misuse of such Information.

AUTOMATIC UPDATE FEATURE
From time to time, SONY or the THIRD-PARTY SUPPLIERS 
may automatically update or otherwise modify the 
SOFTWARE, including, but not limited to, for purposes 
of enhancement of security functions, error correction 
and improvement of functions, at such time as you 
interact with SONY’s or third parties’ servers, or 
otherwise. Such updates or modifications may delete 
or change the nature of features or other aspects of the 
SOFTWARE, including, but not limited to, functions you 
may rely upon. You acknowledge and agree that such 
activities may occur at SONY’s sole discretion and that 
SONY may condition continued use of the SOFTWARE 
upon your complete installation or acceptance of such 
update or modifications. Any updates/modifications 
shall be deemed to be, and shall constitute part of, the 
SOFTWARE for purposes of this EULA. By acceptance of 
this EULA, you consent to such update/modification.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY
This EULA and SONY’s privacy policy, each as amended 
and modified from time to time, together constitute the 
entire agreement between you and SONY with respect 
to the SOFTWARE. The failure of SONY to exercise or 
enforce any right or provision of this EULA shall not 
constitute a waiver of such right or provision. If any part 
of this EULA is held invalid, illegal, or unenforceable, 
that provision shall be enforced to the maximum extent 
permissible so as to maintain the intent of this EULA, 
and the other parts will remain in full force and effect.

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for the 
International Sale of Goods shall not apply to this EULA. 
This EULA shall be governed by the laws of Japan, 
without regards to conflict of laws provisions. Any 
dispute arising out of this EULA shall be subject to the 
exclusive venue of the Tokyo District Court in Japan, and 
the parties hereby consent to the venue and jurisdiction 
of such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this EULA to the 
contrary, you acknowledge and agree that any violation 
of or noncompliance with this EULA by you will cause 
irreparable harm to SONY, for which monetary damages 
would be inadequate, and you consent to SONY 
obtaining any injunctive or equitable relief that SONY 
deems necessary or appropriate in such circumstances. 
SONY may also take any legal and technical remedies 
to prevent violation of and/or to enforce this EULA, 
including, but not limited to, immediate termination of 
your use of the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to violate 
this EULA. These remedies are in addition to any other 
remedies SONY may have at law, in equity or under 
contract.

TERMINATION
Without prejudice to any of its other rights, SONY may 
terminate this EULA if you fail to comply with any of its 
terms. In case of such termination, you must: (i) cease 
all use, and destroy any copies, of the SOFTWARE; (ii) 
comply with the requirements in the section below 
entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND ANY OF THE 
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY 
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, BY 
EMAIL NOTIFICATION TO AN EMAIL ADDRESS PROVIDED 
BY YOU, BY PROVIDING NOTICE AS PART OF THE 
PROCESS IN WHICH YOU OBTAIN UPGRADES/ UPDATES 
OR BY ANY OTHER LEGALLY RECOGNIZABLE FORM OF 
NOTICE. If you do not agree to the amendment, you 
should promptly contact SONY for instructions. Your 
continued use of the SOFTWARE after the effective date 
of any such notice shall be deemed your agreement to 
be bound by such amendment.

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express intended 
thirdparty beneficiary of, and shall have the right to 
enforce, each provision of this EULA with respect to the 
SOFTWARE of such party. 

Should you have any questions concerning this EULA, 
you may contact SONY by writing to SONY at applicable 
contact address of each area or country.

Copyright © 2012 Sony Corporation.

Licences de logiciels libres

Sur la base des contrats de licence entre Sony 
et les détenteurs de copyright des logiciels, ce 
produit utilise des logiciels libres.
Pour répondre aux exigences des détenteurs 
de copyright des logiciels, Sony est dans 
l’obligation de vous informer sur le contenu de 
ces licences.
Les licences (en anglais) sont enregistrées 
dans la mémoire interne de votre produit.
Établissez une connexion de stockage de 
masse entre le produit et un ordinateur pour 
lire les licences du dossier « PMHOME » - 
« LICENSE ».

Si vous utilisez un Mac, le dossier « PMHOME »  
- « LICENCE » peut ne pas être accessible.
Pour visualiser les fichiers, utilisez un 
ordinateur autre qu’un Mac ou visitez l’URL 
suivante.
https://oss.sony.net/License/ILME-FX6/

https://oss.sony.net/License/ILME-FX6/
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Généralités

Poids
	 Environ 890 g (1 lb 15 oz) (boîtier principal 

uniquement)
	 Environ 2,59 kg (5 lb 11 oz) (y compris 

l’objectif SEL24105G, le pare-soleil, 
la batterie (BP-U35), le viseur, la 
poignée, le grip)

Dimensions

	 Consultez page 151.

Besoins en alimentation

	 19,5 V CC (18,0 V à 20,5 V)

Consommation électrique
	 Environ 18,0 W (boîtier, objectif, 

enregistrement XAVC-I QFHD 
59.94P, viseur activé, aucun 
dispositif externe connecté)

	 Environ 36,0 W (boîtier, objectif, 
enregistrement XAVC-I QFHD 
59.94P (S&Q 120 fps), viseur 
activé, HDMI, SDI, aucun dispositif 
externe connecté)

Température de fonctionnement

	 0 °C à 40 °C (32 °F à 104 °F)

Température de stockage

	 –20 °C à +60 °C (–4 °F à +140 °F)

Durée d’utilisation continue

	 Environ 105 minutes (avec BP-U35) 

(boîtier, objectif, enregistrement 

XAVC-I QFHD 59.94P, viseur 

activé, aucun dispositif externe 

connecté)

Format d’enregistrement (vidéo)

	 XAVC Intra

		  Mode XAVC-I 4K/QFHD : 

VBR, débit binaire 600 Mbps 

(max), MPEG-4 AVC/H.264

		  Mode XAVC-I HD : 

CBG, débit binaire 223 Mbps 

(max), MPEG-4 AVC/H.264

	 XAVC Long

		  Mode XAVC-L QFHD : 

VBR, débit binaire 150 Mbps 

(max), MPEG-4 H.264/AVC

		  Mode XAVC-L HD 50 : 

VBR, débit binaire 50 Mbps (max), 

MPEG-4 H.264/AVC

		  Mode XAVC-L HD 35 : 

VBR, débit binaire 35 Mbps (max), 

MPEG-4 H.264/AVC

Format d’enregistrement (audio)

	 LPCM 24 bits, 48 kHz, 4 canaux

Fréquence d’enregistrement élevée

	 XAVC Intra

		  Mode XAVC-I 4K : 

4096×2160/59.94P, 50P, 29.97P, 

25P, 24P, 23.98P

		  Mode XAVC-I QFHD : 

3840×2160/59.94P, 50P, 29.97P, 

25P, 23.98P

		  Mode XAVC-I HD : 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

	 XAVC Long

		  Mode XAVC-L QFHD : 

3840×2160/59.94P, 50P, 29.97P, 

25P, 23.98P

		  Mode XAVC-L HD 50 : 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

		  Mode XAVC-L HD 35 : 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

Durées d’enregistrement/de lecture

	 XAVC Intra

		  Mode XAVC-I QFHD :

			   59.94P

			   Environ 30 minutes  

(avec CEA-G160T)

		  Mode XAVC-I HD :

			   59.94P

			   Environ 78 minutes  

(avec CEA-G160T)

	 XAVC Long

		  Mode XAVC-L QFHD :

			   59.94P

			   Environ 115 minutes  

(avec CEA-G160T)

		  Mode XAVC-L HD 50 :

			   59.94P

			   Environ 155 minutes  

(avec CEA-G80T)

		  Mode XAVC-L HD 35 :

			   59.94P

			   Environ 210 minutes  

(avec CEA-G80T)

[Remarque]
La durée d’enregistrement/lecture peut varier 
en fonction des conditions d’utilisation et 
des caractéristiques de mémoire. Les durées 
d’enregistrement et de lecture concernent un 
enregistrement continu en tant que plan unique. Les 
durées réelles peuvent être plus courtes selon le nombre 
de plans enregistrés.

Section de caméra

Imageur (type)

	 Capteur d’image CMOS à puce unique, 

équivalent à plein format 35 mm

Nombre de pixels

	 12,9M (total)

	 10,2M (effectif)

Auto focus

	 Méthode de détection : détection de phase/

détection de contraste

Filtres ND internes

	 CLEAR : OFF

	 1 : 1/4ND

	 2 : 1/16ND

	 3 : 1/64ND

	 ND variable linéairement : 1/4ND à 1/128ND

Sensibilité ISO

	 ISO 800/12800 (Cine EI Quick/Cine EI, source 

lumineuse D55)

Monture d’objectif

	 Monture E

Latitude

	 15+ arrêt

Vitesse d’obturateur

	 64F à 1/8000 sec (23.98P)

Angle d’obturateur

	 5,6° à 360°, 2 à 64 images

Ralenti et accéléré

	 XAVC QFHD : 1 fps à 120 fps

	 XAVC HD : 1 fps à 240 fps

	 XAVC 4K : 1 fps à 60 fps

	 XAVC HD (S35) : 1 fps à 120 fps

Equilibre des blancs

	 2000 K à 15000 K

Gain

	 –3 dB à +30 dB (incréments de 1 dB)

Base look

	 S-Cinetone, Standard, Still, ITU709, s709, 

709(800%), S-Log3, HLG Live, 

HLG Natural

Section audio

Fréquence d’échantillonnage

	 48 kHz

Quantification

	 24 bits

Réponse de fréquence

	 Mode MIC entrée XLR : 20 Hz à 20 kHz  

(±3 dB ou moins)

	 Mode LINE entrée XLR : 20 Hz à 20 kHz  

(±3 dB ou moins)

Caractéristiques techniques
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Plage dynamique

	 Mode MIC entrée XLR : 80 dB (typique)

	 Mode LINE entrée XLR : 90 dB (typique)

Distorsion

	 Mode MIC entrée XLR : 0,08% ou moins 

(niveau d’entrée –40 dBu)

	 Mode LINE entrée XLR : 0,08% ou moins 

(niveau d’entrée +14 dBu)

Haut-parleur intégré

	 Monaural

Microphone interne 

	 Monaural

Microphone interne de la poignée

	 Microphone à condensateur électret stéréo 

omnidirectionnel

[Remarque]
Seul le microphone interne de la poignée est actif 
lorsque vous fixez la poignée.

Section entrée/sortie

Entrées
INPUT 1/2 :

	 Type XLR, 3 broches, femelle

	 Commutable LINE / MIC / MIC+48V

	 MIC : référence –30 dBu à –80 dBu

TC IN :

	 Type BNC

Sorties
SDI OUT :

	 Type BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level 

A/B), HD-SDI

Casque (mini-prise stéréo) :

	 –16 dBu (sortie du niveau de référence, 

volume maximal du moniteur, 

charge de 16 Ω)

HDMI :

	 Type A, 19 broches

TC OUT :

	 Type BNC

Autre
DC IN :

	 Conforme à la norme EIAJ, 18 V à 20,5 V CC

Griffe à interfaces multiples :

	 Dédié (21 broches)

REMOTE :

	 Type mini-sub à 3 pôles de 2,5 mm

Connecteur de la télécommande de grip :

	 Mini-prise stéréo de 3,5 mm et à 4 broches 

(connecteur fourni pour la 

télécommande de grip)

USB-C :

	 USB 3.2 Gen 1

USB/Multi :

	 Conforme à la norme USB 2.0, type micro B 

pour stockage de masse (1)

VF :

	 Dédié (40 broches)

Section d’affichage

Viseur (LCD)
Taille d’écran

	 8,8 cm (3,5 pouces) de diagonale

Rapport d’aspect

	 16:9

Nombre de pixels

	 1280 (H) × 720 (V)

Section de logement de support

Logement de carte CFexpress Type A/SD (2)

LAN sans fil

Normes prises en charge

	 IEEE 802.11 a/b/g/n/ac (ILME-FX6V/VK)

	 IEEE 802.11 b/g/n (ILME-FX6T/TK)

Bande de fréquences

	 2,4 GHz

	 5 GHz (ILME-FX6V/VK uniquement)

Protocoles de sécurité pris en charge

	 WEP/WPA-PSK/WPA2-PSK

Méthode de connexion

	 Wi-Fi Protected Setup™ (WPS)/Manuel

Méthode d’accès

	 Mode Infrastructure

Chargeur de batterie (BC-CU1)

Poids

	 Environ 60 g (2,1 oz)

Dimensions

	 Environ 57 × 26 × 101 mm  

(2 1/4 × 1 1/16 × 4 po)  

(largeur / hauteur / profondeur)

Input

	 19,5 V CC, 26 W

Output

	 16,4 V CC, 1,4 A

Température de fonctionnement

	 0 °C à 40 °C (32 °F à 104 °F)

Température de stockage

	 –20 °C à +60 °C (–4 °F à +140 °F)

Accessoires fournis

Adaptateur secteur (1)

Cordon d’alimentation (1) 

Chargeur de batterie (1) 

Pack batterie (1)

Poignée (1)

Moniteur LCD (1)

Câble USB-C (1)

Télécommande de grip (1)

Cache LCD (1)

Kit de griffe porte-accessoires (1) 

(griffe porte-accessoires (1), plaque à ressort de la 

griffe (1), vis (4))

Capuchon de la monture d’objectif (1)

Capuchon protecteur du connecteur de la 

poignée (1)

Avant d’utiliser cet appareil (1)

Livret de garantie (1)

La conception et les caractéristiques 
techniques sont sujettes à modification sans 
préavis.
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Remarques
ˎˎ �Effectuez toujours un essai 
d’enregistrement pour vérifier que 
l’enregistrement s’est fait correctement. 
SONY N’ASSUMERA PAS DE 
RESPONSABILITÉ POUR LES DOMMAGES 
DE QUELQUE SORTE QU’ILS SOIENT, 
INCLUANT MAIS NE SE LIMITANT PAS À LA 
COMPENSATION OU AU REMBOURSEMENT, 
SUITE AU MANQUEMENT DE CET APPAREIL 
OU DE SON SUPPORT D’ENREGISTREMENT, 
OU DE TOUT AUTRE SUPPORT OU SYSTÈME 
DE MÉMOIRE À ENREGISTRER UN CONTENU 
DE TOUT TYPE.
ˎˎ Vérifiez toujours que l’appareil fonctionne 
correctement avant l’utilisation. SONY 
NE PEUT ÊTRE TENUE RESPONSABLE DE 
TOUT DOMMAGE, DE QUELQUE NATURE 
QUE CE SOIT, Y COMPRIS MAIS SANS 
LIMITATION, LA COMPENSATION OU LE 
REMBOURSEMENT SUITE À LA PERTE 
DES BÉNÉFICES PRÉSENTS ET À VENIR 
RÉSULTANT D’UN DYSFONCTIONNEMENT 
DE CET APPAREIL NI PENDANT LA PÉRIODE 
DE GARANTIE OU UNE FOIS LE DÉLAI DE 
GARANTIE EXPIRÉ OU POUR TOUTE AUTRE 
RAISON QUE CE SOIT.
ˎˎ �SONY N’ASSUMERA PAS DE RESPONSABILITÉ 
POUR LES RÉCLAMATIONS, QUELLE 
QU’ELLES SOIENT, EFFECTUÉES PAR LES 
UTILISATEURS DE CET APPAREIL OU PAR DES 
TIERCES PARTIES.
ˎˎ �SONY N’ASSUMERA PAS DE RESPONSABILITÉ 
POUR LA PERTE, LA RÉPARATION OU LA 
REPRODUCTION DE TOUTES DONNÉES 
ENREGISTRÉES SUR LE SYSTÈME DE 
MÉMOIRE INTÉRIEUR, LE SUPPORT 
D’ENREGISTREMENT OU TOUT AUTRE 
SUPPORT OU SYSTÈME DE MÉMOIRE.
ˎˎ �SONY N’ASSUMERA PAS DE RESPONSABILITÉ 
POUR LA CESSATION OU L’INTERRUPTION 
DE TOUT SERVICE LIÉ À CET APPAREIL, 
RÉSULTANT DE QUELQUE CIRCONSTANCE 
QUE CE SOIT.
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Dimensions externes

Unité : mm (po.)

UNC 1/4-20, Profondeur : 6

UNC 3/8-16, Profondeur : 5,5

2-UNC 1/8-20, Profondeur : 6

UNC 1/4-20, Profondeur : 6 UNC 1/4-20, Profondeur : 6

UNC 1/4-20, 
Profondeur : 5,5

98,6 (4)

11,9  
(15/32)

8-UNC 1/4-20, Profondeur : 6

143 (5 3/4) 60  
(2 3/8)

98,6 (4) 89,8 (3 5/8)

82,5 (3 1/4)

114 (4 1/2)

62,8  
(2 1/2)

60,6 
(2 1/2)

258 (10 1/4)

90,1  
(3 5/8)

60,6 
(2 1/2)

25 (1)
25 (1)

25 (1)

4,9 (7/32)

25 (1)

117  
(4 5/8)228 (9)

74 
(3)

116 (4 5/8)

153 (6 1/8)26,1 (1 1/16)

6,9 (9/32) 28 (1 1/8)

UNC 1/4-20, 
Profondeur : 6

Les dimensions sont des valeurs approximatives.
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Marques commerciales

ˎˎ  est une marque commerciale de Sony 
Corporation.
ˎˎ XAVC et  sont des marques déposées 
de Sony Corporation.
ˎˎ Les termes HDMI et High-Definition 
Multimedia Interface ainsi que le logo 
HDMI sont des marques commerciales ou 
des marques déposées de HDMI Licensing 
Administrator, Inc. aux États-Unis et dans 
d’autres pays.
ˎˎ Microsoft et Windows sont des marques 
déposées ou des marques enregistrées de 
Microsoft Corporation aux États-Unis et/ou 
dans d’autres pays.
ˎˎ Mac et macOS sont des marques déposées 
d’Apple Inc. aux États-Unis et dans d’autres 
pays.
ˎˎ « Catalyst Browse », « Content Browser 
Mobile » et le logo « Content Browser 
Mobile » sont des marques commerciales ou 
des marques déposées de Sony Corporation.
ˎˎ iOS est une marque déposée ou une 
marque commerciale de Cisco Systems, Inc. 
et/ou de ses filiales aux États-Unis et dans 
certains autres pays.
ˎˎ Android et Google Play sont des marques 
commerciales de Google Inc.
ˎˎ Wi-Fi, le logo Wi-Fi et Wi-Fi PROTECTED 
SETUP sont des marques commerciales ou 
des marques déposées de Wi-Fi Alliance.
ˎˎ N-Mark est une marque commerciale ou 
une marque déposée de NFC Forum, Inc., 
aux États-Unis et dans d’autres pays.
ˎˎ Le logo SDXC est une marque commerciale 
de SD-3C, LLC.
ˎˎ CFexpress et le logo CFexpress Type 
A sont des marques commerciales de 
CompactFlash Association.
ˎˎ QR Code est une marque commerciale de 
Denso Wave Inc.
ˎˎ USB-C est une marque déposée d’USB 
Implementers Forum.

Tous les autres noms d’entreprises ou de 
produits sont des marques commerciales ou 
des marques déposées de leurs détenteurs 
respectifs. Les éléments de marques 
commerciales ne sont pas indiqués par les 
symboles ™ ou ® dans ce document.
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